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NOTE  Help instructions are typically for a computer with a Microsoft® Windows® 7 operating system. If you have 
a different operating system, some instructions may vary slightly. See your operating system's Help for more 
information. For example, Alt+click in a Windows operating system is accomplished by Ctrl+Alt+click in a Linux® 
operating system. Or, Ctrl+click on a Windows computer is accomplished by Command+click on a Mac. 
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An i-Vu® system is a web-based building automation system that can be accessed from anywhere in the world 
through a web browser, without the need for special software on the workstation. Through the web browser, you 
can perform building management functions such as:  

• adjust setpoints and other control parameters 

• set and change schedules 

• graphically trend important building conditions  

• view and acknowledge alarms 

• run preconfigured and custom reports on energy usage, occupant overrides, and much more 

 

  i-Vu® Standard  i-Vu® Plus 

Part number CIV-OPN CIV-OPNPL 

Networks supported BACnet and CCN BACnet and CCN 

Routing devices • USB-CCN Adapter 

• USB-MS/TP Adapter 

• Open/CCN routers 

• Carrier® ChillerVu™ 

• XT Router 

• USB-CCN Adapter 

• USB-MS/TP Adapter 

• Open/CCN Routers 

• Open/CCN Links 

• Carrier® ChillerVu™ 

• XT Router 

Maximum controllers supported 750 750 

Trend storage 7 days 62 days 

Alarms storage 500 500 

Audit Log storage 30 days 30 days 

Custom Equipment and Trend 
Reports   

Tenant Override Billing Reports   

Weather Add-on   

Web Services (XML/SOAP) Data 
Access   

BACnet/Modbus®/LonWorks® 
integration   

Location-dependent access   
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i-Vu® Standard and Plus web server specifications 

 i-Vu® web server   

Operating temperature 32°F  to 122°F (0°C to 50°C). For indoor use only 

Storage temperature -4°F to 158°F (-20°C to 70°C) 

Storage humidity 5% to 90% RH 

Weight 2.4 lb (1.09 kg) 

Dimensions 4.52 in. (115 mm) deep x 4.37 in. (111 mm) wide x 1.9 in. (48.7 mm) high 

USB ports 4 USB 3.0 ports for i-Vu® network connection or for backing up/restoring 
system data 

LAN port Integrated Intel® 10/100/1000 Mbps port for Ethernet  

VESA mounting plate Attach the web server to the back of a flat monitor 

Mini DisplayPorts Connect to a monitor for troubleshooting 

Safety Compliance IEC, UL, EN, CAN/CSA 

Environmental Compliance RoHS 2011/65/EU, WEEE 2002/96/EC, China RoHS MII Order #39 

EMC Compliance FCC CFR Title 47, Chapter I, Part 15, Subparts A, B 
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i-Vu® tools 

Develop and configure graphics and a system database for your i-Vu® system using the following i-Vu® tools. 

NOTE  The i-Vu® tools have a built-in license that expires 2 years after the software is released. Contact Carrier 
Control System Support for updates concerning your license. 

 

Use... To... 

ViewBuilder Create or edit graphics 

 

Tech tools for the Installer only: 

Use... To... 

EquipmentBuilder Build or edit control programs (.equipment files) for programmable 
controllers. Can also produce graphics, sequence of operation, and 
screen files  

Alarm Notfication Receive a message on any networked computer that is running the i-
Vu® Alarm Notification Client application 

Virtual BACview® View and change property values and the controller's real time clock 

BBMD Configuration Tool Configure BACnet/IP Broadcast Management Devices (BBMDs) 

NOTE  If your system has multiple routers that reside on different IP 
subnets, you must set up one router on each IP subnet as a BACnet/IP 
Broadcast Management Device (BBMD).  

MSTP Capture Utility Capture BACnet traffic on MS/TP. It is intended for use in situations 
where Carrier Control Systems Support needs a network capture to 
troubleshoot communications.  

Test & Balance • Calibrate airflow in a VAV or VVT Zone controller  
• Calibrate the static pressure in a VVT Bypass controller  
• Commission air terminals 
• Override reheat and terminal fans 
NOTE  Use Test & Balance to manipulate the controllers associated with 
an air source, but not the air source itself, or heating and cooling 
equipment, such as chillers and boilers. 

Snap Build custom control programs using individual blocks of programming 
code called microblocks 

LonWorks Integration Tool Generate the microblock addresses automatically for third-party 
LonWorks points 

AppLoader Use to download .clipping files to restore factory defaults and check 
Module Status (Modstat) via the Rnet port 

Field Assistant Service or start up and commission a piece of equipment or a network of 
controllers. 
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What's new in the i-Vu® Standard/Plus v6.5 application 

   

Feature Improvement 

New in v6.5:  

Smart phone support (page 10)  
and  
enhanced small screen 
navigation (page 18) 

The i-Vu® application can now detect if you are accessing it on a small-screen 
device such as a smart phone or small tablet, and it will deliver a new 
interface that accommodates the smaller screen. 

Web browser support The i-Vu® application:  

• No longer supports IE8, IE9, or IE10. 

• Now supports the Microsoft® Edge web browser. 

New i-Vu® Standard/Plus web 
server 

There is a new upcoming web server. It has a much smaller footprint, a faster 
processor, and can be mounted on the back of a monitor without additional 
cables.  

 WARNING  The i-Vu® software will no longer function if you change any 
BIOS settings whatsoever.  

Enhanced trends The speed at which trends display and are deleted has greatly increased 
because of a new trend database structure. 

Display gap in trend graph line 
(page 30) 

To show a gap in a trend graph line if trend data is missing, you can check 
Display gap in graph line for missing data on an individual trend graph page, 
or you can go to the System Options > General tab to set this for all future 
trend graphs. 

Security enhancements • Apache Tomcat web server has been upgraded to v7.0.61. 

• The i-Vu® application has been upgraded to Java 8 update 51. 

• The i-Vu® v6.5 application includes SHA-2 certificate support 

Password requirement If you create a new system in v6.5, you are now required to enter a password 
on the Startup page. 
If you upgrade a system, that does not have an Installer password, to v6.5, 
you can continue without an Installer password; however, we recommend that 
you define this password. 

New FDD Alarm Categories Fault Detection and Diagnostics (FDD) logic analyzes the performance of 
mechanical equipment to detect problems and pinpoint the most likely cause 
of the problem. When FDD is performed in a control program, you can now use 
three new FDD alarm categories. The new categories and their icons that will 
appear on the Alarms page are: 

FDD Maintenance         FDD Critical         FDD General   

Carrier® ChillerVu™  You can discover the Carrier® ChillerVu™ as an Open device and can also 
configure it as a CCN Gateway or Bridge.  

What's new in v6.5 
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Feature Improvement 

New features for handling 
parameter mismatches (page 
56) 

Any parameter mismatch now appears on the Properties page with a purple 
box around it and hover text to help determine what action needs to take 
place. If a change was made in the controller, the Properties page now shows 
the controller value. 

The i-Vu® application determines where a change occurred, what action 
needs to take place, and provides a new Resolve button that you can click to 
have any mismatches automatically handled. Clicking the Details button 
shows an additional Resolve column that indicates whether a mismatch will 
be resolved through upload or download. This same Resolve column has also 
been added to the Parameter Mismatch report.  

On the Devices > Manage tab for the router, the driver now appears so that 
you can choose to solve parameter mismatches in the driver, the control 
program(s), or both.   

Downloading after reloading a 
control program 

If you change only a control program's parameters in the Snap application and 
then reload the control program, the controller will be marked for an Only 
Parameters download instead of an All Content download.  
Exception: Changing a reference name still requires an All Content download. 

Logic pages (page 48) A live Logic page is now available for the Installer role to view custom control 
programs. Select the control program in the navigation tree and then select 
the Logic page. 

BACnet Objects tab on 
Properties page (page 136) 

The BACnet Points tab has been renamed BACnet Objects and now includes 
information specific to Display microblocks if they are included in the control 
program. 

Easier CCN setup Devices > CCN Setup tab 

On the CCN Setup tab, for servers with multiple NICs, you can edit the Server 
IP Address that the controllers will use to connect to the server, before you 
connect to the CCN Gateway. 

CCN Discovery (page 114) tab Devices > CCN Discovery tab 

• The previous CCN > Devices page is now the Devices page > CCN 
Discovery tab 

• Once you start scanning for your devices, you can leave the page and the 
process continues   

NOTE  You must use Network Service Tool to change CCN addresses. 

Optimize download (page 145) The default for Optimize download for Open PIC controllers is now off 
(unchecked), which results in Full Source download, unless you check it to 
enable optimizing. 

Control program's  
Object Instance number 

A control program's Object Instance number is now editable in the i-Vu® 
interface. Right-click the control program, and then select Configure. Click  
next to the field for additional information. 

Management Tool • Every time you open the Management Tool, you must login again. 

• The Operation Status displays more detailed descriptions and a progress 
status bar. 

Interface Changes An increased focus on the i-Vu® product brand resulted in new look and 
relocation of logos within the i-Vu® interface and a new System Menu icon 

. 
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What's new in the Snap application 

NOTE  To edit a v5.1 ApplicationBuilder or Snap equipment file, you must first save it as a v6.5 file.  

For ApplicationBuilder files, open EquipmentBuilder v6.5 and either recreate the control program or browse to the 
equipment file to open it and then save it.  

For a Snap v5.1 equipment file, open it in v6.5 and save it.  

Feature Improvement 

New in v6.5:  

Find/Replace The feature that you previously used to find a microblock, label, or text can 
now be used to find and replace text in Property Editor text fields. 

Display microblocks (page 1) Snap now includes Display microblocks for some control program types. 

Support for new wireless 
sensors 

The Network I/O microblock family has a new BACnet Binary Sensed Value 
Input (BSVI) microblock (page 165). 

The following new Rnet tags identify system values in wireless sensors: 
  

Rnet tag In this microblock 

005 - Signal Strength % 
006 - Battery Strength % 
007 - Lux 
118 - Sensed Occupancy 
119 - Contact Sensor 

ASVI 
ASVI 
ASVI 
BSVI 
BSVI 

 

 

 

 
 

What's new in the Field Assistant application 

  

Feature Improvement 

New in v6.5:  

Web browser support The i-Vu® application:  

• No longer supports IE8, IE9, or IE10. 

• Now supports the Microsoft® Edge web browser. 

Supported database type i-Vu® uses an Apache Derby database and no longer supports an Access® 
database type. If you have an Access database from a previous i-Vu® version 
that you want to use in v6.5, you will have to convert the database to Derby 
first. 

You must use the upgrade tool on the Tech Tools v6.5 Installation DVD to 
convert Access databases from previous Field Assistant version. See 
Converting Access databases to Derby. 
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Feature Improvement 

Optimize download (page 145) The default for Optimize download for Open PIC controllers is now off 
(unchecked), which results in Full Source download, unless you check it to 
enable optimizing. 

New features for handling 
parameter mismatches (page 
56) 

Any parameter mismatch now appears on the Properties page with a purple 
box around it and hover text to help determine what action needs to take 
place. If a change was made in the controller, the Properties page now shows 
the controller value. 

The i-Vu® application determines where a change occurred, what action 
needs to take place, and provides a new Resolve button that you can click to 
have any mismatches automatically handled. Clicking the Details button 
shows an additional Resolve column that indicates whether a mismatch will 
be resolved through upload or download. This same Resolve column has also 
been added to the Parameter Mismatch report.  

On the Devices > Manage tab for the router, the driver now appears so that 
you can choose to solve parameter mismatches in the driver, the control 
program(s), or both.   

Security enhancements • Apache Tomcat web server has been upgraded to v7.0.61. 

• The i-Vu® application has been upgraded to Java 8 update 51. 

• The i-Vu® v6.5 application includes SHA-2 certificate support. 

Display gap in trend graph line 
(page 30) 

To show a gap in a trend graph line if trend data is missing, you can check 
Display gap in graph line for missing data on an individual trend graph page. 

BACnet Firewall The v6-02 drivers for Carrier controllers with Ethernet capability have a new 
BACnet firewall feature that allows you to restrict communication with the 
controller to all private IP addresses and/or to a whitelist of IP addresses that 
you define. To set this up, right-click the controller in the navigation tree, 
select Driver Properties and then BACnet Firewall. Follow the instructions in 
the interface. 

BACnet Objects tab on 
Properties page (page 136) 

The BACnet Points tab has been renamed BACnet Objects and now includes 
information specific to Display microblocks if they are included in the control 
program. 

Carrier® ChillerVu™   You can find and upload the Carrier® ChillerVu™ (OPN-PSM-MPCXPE) as an 
Open device if it is on a BACnet over MS/TP or BACnet over ARC156 network.    
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What's new in the ViewBuilder application 

 

Feature Improvement 

New in v6.5:  

New Linear and Angular Gauge 
controls 

You can now quickly and easily create and configure a linear or angular 
Gauge. 

System Touch screens You can create a custom interface for the System Touch, an interactive device 
that can act as a front-end interface to controllers on a BACnet network.  

Layers You can now create a graphic in layers. This allows you to turn off or lock a 
layer in ViewBuilder to simplify the workspace. You can also show or hide a 
layer's objects in i-Vu® based on a single microblock's value. 

Table fill color and border style You can define a fill color for the entire table, and a style (squared or rounded) 
for the table border. 

Local variables  You can use variables in conditional expressions to make various controls 
react to user interaction in i-Vu®. You can also use local variables to test your 
graphic. 
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The i-Vu® system can be viewed on the following client devices and web browsers. 
  

Computers  
The client computer should have at least: 
•  Dual core processor  
•  1.5 GB RAM 
•  Communications link of 10 Mbps or higher 
  
The i-Vu® application will work with slower computers and slower links, but the results may not be satisfactory. 
  

A computer with this 
operating system... 

Supports these web browsers... 

Windows® GoogleTM ChromeTM v44.0 or later 1 

Internet Explorer® v11 Desktop 

Microsoft® Edge 

Mozilla® Firefox® v39.0 or later 

Mac® OS X® 
(Apple® Mac only) 

Safari® v8 or later 2 

Google Chrome v44.0 or later 

Mozilla Firefox v39.0 or later 

Linux® Google Chrome v44.0 or later 

Mozilla Firefox v39.0 or later 

1 Best performance 

2 Best performance unless browser is running on a Mac® Mini or a MacBook: 

 WARNING If machine is running Mountain Lion 10.8x with an integrated Intel HD 400 graphics card, 
it will experience display issues. Use one of these workarounds for better performance: 
• If an additional NVIDIA graphics card is available, manually switch the graphic card setting in MAC® OS 

X® to use that card. 
• If not, use GoogleTM ChromeTM v44.0 or later. 
 

 

Mobile devices 
NOTES 

• Most mobile devices do not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so some i-
Vu® add-on applications and other features may not work. The following do support plug-ins: 
• Surface Pro with IE 11 Desktop 
• Surface 3 

• Touch functionality on mobile devices not tested by Carrier may or may not work with the i-Vu® application. 
Use at your own risk. 

   

Setting up i-Vu® client devices and web browsers 
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A tablet with this operating 
system 

Web browser Tested tablets 

iOS Safari v8 or later Apple® iPad®  

Windows® RT Internet Explorer® 11 or 
Metro-style Internet Explorer® 11 

Microsoft® Surface  

Windows® 8.1 Pro Internet Explorer® 11 or 
Metro-style Internet Explorer® 11 

Microsoft® SurfaceTM Pro 

Windows® 10 Internet Explorer® 11  

Microsoft® Edge 

Microsoft® SurfaceTM Pro 

Microsoft® SurfaceTM 3 

AndroidTM GoogleTM ChromeTM v23.0 or later GoogleTM NexusTM 7 and 10  

A smart phone  
with this operating system 

Web browser Tested smart phones 

AndroidTM  GoogleTM ChromeTM v44.0 or later Nexus 6 

iOS  Safari v8.4 Apple® iPhone 6 

Apple® iPhone 6 Plus 

Windows® Phone 10  Microsoft® Edge Nokia LumiaTM 830 

 
 

Setting up and using a computer with the i-Vu® system 

  

• Set the monitor's screen resolution to a minimum of 1024 x 768 with 24- or 32-bit color quality 

• You may want to disable the computer's navigation sounds. 
  

Mac only 
NOTE  The instructions below are for a Mac OS X 10.8. Other versions may vary slightly. See your computer's Help 
if necessary. 
  

Computer settings To change setting... 

Enable right-clicking to see 
right-click menus: 

 

      On a Mac 1 Select System Preferences > Mouse. 

2 Click the drop-down list that points to the mouse's right-click button, 
then select Secondary Button. 

      On a MacBook 1 Select System Preferences > Trackpad. 

2 Enable Secondary click.  

 

The instructions in Help are for a Windows computer. For instructions that include the Ctrl key, replace Ctrl with 
Command. For example, replace Ctrl+click with Command+click.  
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Setting up and using a web browser to view the i-Vu® interface 

To set up and use Internet Explorer 

NOTES 

• The instructions below are for Internet Explorer® 11. Other versions may vary slightly. See your web browser's 
Help if necessary. 

• If the menu bar is not visible, right-click on the window's header, and then select Menu bar. 

   

Web browser settings To set in Internet Explorer... 

Accept First-party and  
Third-party cookies 

Tools > Internet Options > Privacy > Advanced button 

Automatically check for newer 
versions of stored pages 

Tools > Internet Options > General > Browsing history > Settings button 

Load ActiveX Control Tools > Internet Options > Security > Custom Level button. Under 
ActiveX controls and plug-ins, set the following: 
• Download signed ActiveX controls > Prompt 
• Download unsigned ActiveX controls > Disable 
• Run ActiveX controls and plug-ins > Enable 
• Script ActiveX controls marked safe for scripting > Enable 

Select Play animations in web pages Tools > Internet Options > Advanced > under Multimedia  

Disable all the options on the Explorer 
Bar 

View > Explorer Bars 

Disable web browser's pop-up 
blockers 

Tools > Pop-up Blocker > Turn Off Pop-Up Blocker 

Disable external toolbar  
pop-up blockers 

Varies 

Hide the web browser's toolbars View > Toolbars 

  

To... Do the following... 

Maximize the web browser window Press F11 to turn full-screen mode on\off, or use the 
minimize/maximize button in the top right corner of the browser window. 

Have 2 different users logged in to 
the i-Vu® system on the same 
computer 

Start a new web browser session. Select File > New Session. 

Clear browser cache 1 Select Tools > Internet Options. 

2 Click Delete. 

3 If you had the i-Vu® system saved as a Favorite, uncheck Preserve 
Favorites website data. 

4 Click Delete again. 
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To set up and use Microsoft Edge 

The instructions below are for Microsoft® Edge. 
  

Web browser settings To set in Microsoft Edge... 

Do not block cookies More Actions > Settings > View Advanced Settings > Cookies 

Disable web browser's pop-up 
blockers * 

More Actions > Settings > View Advanced Settings > Block pop-ups  

  

To... Do the following... 

Maximize the web browser window * Use the minimize/maximize button in the top right corner of the browser 
window. 

Have 2 different users logged in to 
the i-Vu® system on the same 
computer * 

More Actions > New Window  

Clear browser cache More Actions > Settings > Clear browsing data > Clear 

* Does not apply to Microsoft Edge on a phone. 

 

 
 

To set up and use Safari 

NOTES   

• The instructions below are for Safari® v8. Other versions may vary slightly. See your web browser's Help if 
necessary. 

• We recommend that you do not run Safari in full-screen mode. If you do, i-Vu® pop-ups will open full-screen, 
covering the main application window. 
  

On an Apple® computer (Mac®) 
Web browser settings To set in Safari... 

Disable pop-up blocker Preferences > Security > uncheck Block pop-up windows 

Enable JavaScript Preferences > Security > check Enable JavaScript 

Enable Plug-ins Preferences > Security > check Enable plug-ins 

Prevent pop-ups from opening in a 
new browser tab 

Preferences > Tabs > uncheck Command-click opens a link in a new 
tab 

Prevent Safari from automatically 
opening zip files exported from the i-
Vu® application 

Preferences > General > uncheck Open "safe" files after downloading 
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To... Do the following... 

Clear browser cache History > Clear History 

Have 2 different users logged in to 
the i-Vu® system on the same 
computer 

Start a new web browser session. Select Safari > Private Browsing > 
File > New window 

  

On an Apple® iPad 
Web browser settings To set on the iPad... 

Disable pop-up blocker Settings> Safari > set Block pop-ups to Off 

Enable JavaScript Settings > Safari > set JavaScript to On 

  

To... Do the following... 

Clear browser cache Settings > Safari > Clear History 

  

On an Apple® iPhone 6 
Web browser settings To set on the iPad... 

Enable JavaScript Settings > Safari > Advanced  

 

 

 
 

To set up and use Mozilla Firefox 

NOTES 

• The instructions below are for Mozilla® Firefox® v39.0 on a Windows operating system. Other versions may 
vary slightly. See your web browser's Help if necessary. 

• For the first two items in the table below, Linux instructions are in parentheses. All other instructions are the 
same for Windows and Linux. 

• If the menu bar is not visible, click  in the top left corner, and then select Options > Menu 
bar. 

• If a message appears in the i-Vu® interface that includes the checkbox Prevent this page from creating 
additional dialogs, DO NOT check this box. 
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Web browser settings To set in Firefox... 

Disable Pop-up blocker Tools > Options > Content > uncheck Block pop-up windows 
(In Linux:  Edit > Preferences > Content) 

Enable JavaScript 

 

1 Tools > Options > Content > Enable JavaScript. 
(In Linux:  Select Edit > Preferences > Content) 

2 Click the Advanced button to the right of Enable JavaScript, then 
verify the following options are checked: 

• Move or resize popup windows 

• Raise or lower windows 

• Disable or replace context menus 

 Add-ons Manager 

 

Select Tools > Add-ons. On this page, you can enable/disable installed 
add-ons such as: 

• Adobe® Acrobat® Reader (to view PDF's) 

• QuickTime Plug-in (to play audible alarms) 

Only installed Firefox add-ons will show up in the list.  

  

To... Do the following... 

Maximize the web browser window Press F11 to turn full-screen mode on\off. 

Clear browser cache Tools > Options > Advanced > Network > Cached Web Content > Clear 
Now 

Have 2 different users logged in to 
the i-Vu® system on the same 
computer 

Start a new web browser session. Select File > New Private Window. 

 
 

To set up and use Google Chrome 

NOTES   

• The instructions below are for GoogleTM ChromeTM v44.0. Other versions may vary slightly. See your web 
browser's Help if necessary.  

• If a message appears in the i-Vu® interface that includes the checkbox Prevent this page from creating 
additional dialogs, DO NOT check this box. 
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On a computer 
Web browser settings To set in Chrome... 

Enable pop-ups 
1 Click  on the browser toolbar.  

2 Select Settings.  

3 Click Show advanced settings. 

4 Under Privacy, click Content settings.  

5 Under Pop-ups, do one of the following: 

• Select Allow all sites to show pop-ups. 

• Click Manage exceptions. Type your system's IP address or 
server name in the Hostname pattern field, then set Behavior to 
Allow. 

  

To... Do the following... 

Clear browser cache 
1 Click  on the browser toolbar.  

2 Select Tools > Clear browsing data.  

3 Check the types of information that you want to remove.  

4 Select a time range in the drop-down list. 

5 Click Clear browsing data. 

Maximize the web browser window Press F11 on your keyboard to turn full-screen mode on/off. 

Have 2 different users logged in to 
the i-Vu® system on the same 
computer 

Start a new web browser session. Click , then select New incognito 
window. 

  

On a Google Nexus 
Web browser settings In the Chrome menu... 

Turn off desktop mode Uncheck Request desktop site 

Disable pop-up blocker Settings > Advanced > Content Settings > uncheck Block  
pop-ups 

Enable JavaScript Settings > Advanced > Content Settings > check Enable JavaScript 

Enable Cookies Settings > Advanced > Content Settings > check Accept Cookies 

  

To... In the Chrome menu... 

Clear browser cache Settings > Advanced > Privacy > CLEAR BROWSING DATA 
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Web browser and operating system limitations 

You can view your i-Vu® system on tablets with the operating systems and web browsers listed in Setting up i-Vu® 
client devices and web browsers (page 10), but some functionality may be limited as described below.  
  

All tablets and smart phones 
• Audible alarms do not generate a sound. 

• Firefox currently has many problems supporting touch gestures on tablets. 
   

iPad and iPhone 6 
• The Jump To feature on a Logic page does not work in Safari® on an iPad® due to way Safari handles 

JavaScript on secondary tabs. 
    

• iOS restricts access to a file system so i-Vu® features that upload or download files on a computer client are 
disabled on an iPad. This applies to the following configuration features: 
• Configure > Edit Existing or Add New (views, control programs, screen files, drivers) 
• Import clipping 
• System Options > General > Source Files > Export or Import 
• System Options > General > Logs > Download 
• System Options > Security > Permissions > Add 
• System Options > Daylight Saving > Import 
• System Options > Add-ons > Install Add-on 
• Update (patches, service packs, drivers, language packs, graphics libraries, help) 
• Reports saved as XLS 

    
• iOS does not support plug-ins (Java Runtime Environment, Flash, etc.) so some i-Vu® add-on applications will 

not work on an iPad. 

• When you change a text field in the i-Vu® interface, minimize the keyboard before you click Accept to 
guarantee that your changes are saved.  
  

Microsoft Surface, Surface Pro, and Surface 3 tablets 
• The Surface RT and IE 10 or 11 Metro do not support plug-ins (Java Runtime Environment, Flash, PDF reader, 

etc.) so the following features will not work.  
• Some i-Vu® add-on applications 
• The Reports page PDF button  
You can use the Surface Pro with IE 10 or 11 Desktop if you need these features. 
  

Google Nexus tablet and Nexus 6 phone 
• The Nexus does not support plug-ins (Java Runtime Environment, Flash, PDF reader, etc.) so the following 

features will not work.  
• Some i-Vu® add-on applications 
• The Reports page PDF button   
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Computer and large-screen mobile interface 
 

 
  

  

Small-screen mobile interface 
Most of the i-Vu® interface is the same on small-screen mobile devices except for the differences shown below. 
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• When you click  to hide the tree, the button changes to . 

• Help and Print are in the  menu.  

  

   

NOTES 

• After you log in, you will see the page defined as your starting location on the My Settings page. To change 
your opening page, see To change My Settings (page 26). 

• Roles/privileges control what an operator can see or do in the i-Vu® system. If you cannot see or do 
something that you read about in Help, ask your System Administrator to check your role/privileges. 

• Use only the i-Vu® interface to navigate; do not use the web browser’s navigation buttons. 

• Click on any tab to refresh the page. 

 

 
 

Navigating the system 

To navigate in the i-Vu® interface: 

1 Select the item you want in the navigation tree. 

2 Select the action buttons and their drop-down lists. 

3 Use the tabs to filter the information further. 

NOTE  Use only the i-Vu® interface to navigate; do not use the browser’s navigation buttons. 

4 Click on any tab to refresh the page. 

System Options 

Click  and select System Options (page 25) to view or change the administrative settings in your i-Vu® 
application.  
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To show, hide, or resize the navigation tree 

 

On a computer or large screen mobile device 
 

Click  at the top of the navigation tree to hide or show the tree.  

Click and drag the tab on the right side of the tree to adjust its width. 
 

 
In the Installer view, click and drag the tab at the top of Arrange User View to adjust the height of the window. 

 
  

On a small-screen mobile device 

Touch  at the top of the navigation tree to hide the tree. Touch  to show it. 

Double-tap the arrow on the right side of the tree to widen the tree. Double-tap again to return to the original size. 
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Zooming in and out 

On a computer 
• To zoom in and out on the i-Vu® interface: 

○ Hold down Ctrl and press + or -. Press Ctrl+0 to return to 100%. 

○ Hold down Ctrl while rolling your mouse wheel. 

○ Use your web browser's zoom functions. 

• If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. 
Select Scale to Fit again to return the graphic to its original size.  

  

On a mobile device 
Apple® iPad and iPhone 

• Double-tap to zoom in/out. 

  

Microsoft® SurfaceTM 

• Pinch-zoom works on individual frames, instead of the whole screen. So, you can zoom and scroll the 
navigation pane and action pane separately. 

• If browser text is too small, use Ctrl + to increase Internet Explorer's zoom level, then reload the page. 

 

GoogleTM NexusTM and Nexus Lumia  

• Pinch-zoom to zoom in/out. 

 

 
 

Using right-click menus 

On a computer 
You can right-click the following items to select options: 
 

A tree item  The action pane 
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A tree item  The action pane 

 

 

A property A trend 

 

 
  

On a mobile device 
To access the right-click menu for: 
• A tree item–Select the item first, then touch and hold the item for several seconds. 
• The action pane–Touch and hold the item for several seconds. 
 

To print the action pane 

On a computer 

Click  at the top of the page to print the contents of the action pane. Set the print orientation to Landscape 
in the Print dialog box.  

 TIPS 

• To print a Graphics page that exceeds the size of the action pane, right-click the graphic and select Scale to 
Fit. 

• If you do not want to print the black background, in your browser's Internet Options dialog box, disable 
background printing. 
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On a mobile device 

Touch  and then select Print. 

 

 
 

Colors and status in the i-Vu® interface 

The following colors indicate equipment status throughout i-Vu® interface. These colors are visible on Property 
pages, Graphics pages and in the setpoint graphs.  
  

Color Color Name Status Code Condition Indicated 

 Purple 0 or 15 In a controller—non-operational or no communications 
In equipment—a hardware or software error 

 Charcoal 14 In a controller—a download is required or is already in 
progress 
In equipment—a controller has stopped 

 Coral 13 Control program error 

 Red 2 or 9 Heating or cooling alarm 

 Orange 8 Maximum cooling 

 Dark blue 3 Maximum heating 

 Yellow 7 Moderate cooling 

 Light blue 4 Moderate heating 

 Grey 1 Unoccupied/inactive 

 White 10 Occupied/active 

 Light green 6 Free cooling 

 Green 5 In a controller—operational or operational read-only 
In equipment—No heating or cooling 

 

Colors and setpoints 

Thermographic colors indicate how much a zone’s actual temperature differs from its setpoints.  

Five conditions may affect a zone’s thermographic color:  
• Setpoint adjust 
• Timed local override (TLO) 
• Optimal start 
• Demand level 
• Hysteresis 
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In the examples below, a zone’s heating occupied setpoint is 70° and its cooling occupied setpoint is 74°. 
  

If you 
normally 
see... 

when the zone 
temp is... 

but... then you will 
see... 

green 

 

72.5° someone adjusts the setpoints (for example, with a setpoint 
adjust of two degrees, the new setpoints would be 68 and 
72°) 

yellow 

 

gray 

 

73° 
(unoccupied) 

someone presses the Override button on a zone sensor to 
use the occupied setpoints 

green 

 
gray 

 

77° 
(unoccupied) 

the zone is in optimal start and is ramping up to its occupied 
setpoint in the few hours before occupancy 

an occupied 
color 

yellow 

 

75°  the zone’s electric meter is in demand level 2 with relaxed 
setpoints of 68 and 76° 

green 

 
green 

 

73.5° cooling began when the temperature rose above 74° and 
the temperature has not yet dropped beyond the 1° 
hysteresis (to 73°) 

yellow 
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Click  and select System Options for the following tasks. On the: 

• My Settings (page 26) tab, change the Installer's: 

○ Password 

○ Starting view and page 

○ Preferences to automatically collapse trees, automatically download schedules on each change, and 
alarm notification 

•  Operators (page 26) tab, set up: 

○ Login names and passwords 

○ Logoff rules 

○ Starting locations 

○ Levels of access (roles) 

• General (page 30) tab 

○ View system statistics - number of devices in the system, number of trends, estimated time for importing 
or exporting system clipping. 

○ Download weekly logs 

○ Access the Management Tool (page 32)  

○ Set system date, time, timezone, and time/date format 

○ Enable time synchronization schedule  

○ Enable Alarm Notification Client 

○ Import/export Source Files, which include control programs, drivers, BACview® files, and graphics 

○ Enable or disable full source download to Open PIC controllers and select to include or not include 
graphics in download 

○ Import/export clipping files 

• Security (page 34) tab - Set advanced password and operator control 

• Update  (page 36)tab 

○ Install .update files 

○ Update SAL libraries 

○ View current Help updates and current libraries 

• Daylight Saving (page 38) tab - update scheduled DST dates 

• Add-ons (page 38) tab - Install add-ons such as Tenant Override Billing or Weather (i-Vu Open Plus application 
only)  

 

NOTES 

• Some operators will not see all of the System Options tabs, depending on their assigned roles. 

• See the i-Vu® Help for more details on the System Options tabs. 
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My Settings tab 

To change your settings: 

1  Click , then select System Options > My Settings tab. 

2 See table below for explanation of settings.  

3 Click Accept or Apply. 

4 Changes become effective when operator logs in again. 

 

Field Notes 

Login Enable this field, then type your current and new password and confirm. Limit 
is minimum of 8 and maximum 40 characters of any type.  

Starting Location and Starting 
Page 

The i-Vu® location and page  that will display after you log in. Select the User 
or Installer tree, if you have Installer role. 

Automatically collapse trees Expands only one tree branch at a time. 

Automatically download 
schedules on each change 

Select to automatically download all new schedules that you create and 
schedules that you change 

Play sound at browser when 
server receives 

The system audibly notifies you when one of the selected alarms is received.  

Check Non-critical alarms or Critical alarms if you want the system to audibly 
notify you when that type of alarm is received.  

 

NOTE  An operator with the Guest role cannot edit any settings on this page. 

 

 
 

Operators tab 

Select the necessary settings and assign Roles (access rights) to set up operators. 

NOTES  

• Optimal number of simultaneous users:  

○ 2 in the i-Vu® Standard application 

○ 10 in the i-Vu® Plus application 

• We highly recommended that only 1 user at a time commission the system. 
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To add or edit operators, passwords, and roles 

1 Click , then select System Options. 

2 Select Operators tab. 

3 Click Add to enter a new operator, or, select an operator to edit his settings. 

4 Enter information as needed. The required fields are Name, Login Name, and Roles. See table below. 

5 Click Accept or Apply. 

  

Field Notes 

Login Name Must be unique within the system. 

Force user to change 
password at login 

Forces the operator to change his password immediately after his next login. 

NOTE  You can combine the use of this field and the Change Password field to create a 
temporary password that the operator must change after his next login. 

Starting Location Set the starting location for each individual operator by choosing the specific area or 
controller in the navigation tree and the starting page from the drop-down menu. 

Roles See table below. 

 
 

This privilege... allows an operator to... 

Installer   • Add, edit, and delete operators, operator groups, and privilege sets. 

• Update the i-Vu® system with service packs and patches. 

• Register the i-Vu® software.  

• Enable and set up the advanced password policy (page 35).  

• Add and remove i-Vu® add-ons. 

 

Access privileges 

     

The following can be accessed but not edited... 

     User tree  

     
Control program tables and Properties pages 

     Scheduling Groups pages in the User view navigation tree 

     System Options Items 



Using System Options for administrative utilities  
 

 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 28 

 

     

The following can be accessed but not edited... 

     User tree  

     Alarms 

     
Logic Pages 

  

Functional privileges 

     

The following allows an operator to... 

     
Manage Alarm Messages and Actions - add, edit, and delete alarm 
messages and actions. 

     
Maintain System Parameters - edit all properties on the System 
Options pages. 

     Maintain Schedules - add, edit, delete, and download schedules. 

     
Maintain Schedule Group Members - add, edit, and delete schedule 
groups. 

     Maintain Categories - add, edit, and delete categories. 

     
Acknowledge Non-Critical Alarms - acknowledge all non-critical 
alarms. 

     Acknowledge Critical Alarms - acknowledge all critical alarms. 

     
Force Normal Non-Critical Alarms - force non-critical alarms to return 
to normal. 

     
Force Normal Critical Alarms - force critical alarms to return to 
normal. 

     Delete Non-Critical Alarms - delete non-critical alarms. 

     Delete Critical Alarms - delete critical alarms. 

     
Execute Audit Log Report - run the Location Audit Log and System 
Audit Log reports. 

     
Download Controllers - mark equipment for download and initiate a 
download. 

     
System Shutdown - issue the Shutdown manual command that shuts 
down i-Vu® Server. 
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The following allows an operator to... 

     

Access Commissioning Tools: 
• Equipment Checkout 
• Airflow Configuration 
• Trend, Report, and Graphic categories that require this privilege 
• Discovery tool (i-Vu® Plus only) 

     
Maintain Graphs and Reports - add, edit, and delete trend graphs and 
reports. 

     
Remote Data Access-SOAP - retrieve i-Vu® data through an 
Enterprise Data Exchange (SOAP) application. (i-Vu® Plus only) 

     
Manual Commands/Console Operations - access the manual 
command dialog box and issue basic manual commands. 

     
Manual Commands/File IO - execute manual commands that access 
the server's file system. 

     
Manual Commands/Adv Network - execute manual commands that 
directly access network communications. 

     
Change My Settings - edit preferences on operator's My Settings 
page. 

 

 

Parameter privileges 

     

The following allows an operator to edit properties such as... 

     
Setpoint Parameters - occupied and unoccupied heating and cooling 
setpoints 

     

Setpoint Tuning Parameters - demand level setpoint offsets, color band 
offsets, heating and cooling capacities and design temperatures, color 
hysteresis, and learning adaptive optimal start capacity adjustment 
values 

     
Tuning Parameters - gains, limits, trip points, hysteresis, color 
bandwidths, design temperatures, and optimal start/stop. 

     
Manual Override Parameters - locks on input, output, and network 
point. 

     
Point Setup Parameters - point number, type, range, and network 
source and destination 

     
Restricted Parameters - properties the installer restricted with this 
privilege 
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The following allows an operator to edit properties such as... 

     
Category Assignments - Alarm, Graphic, Trend, and Report category 
assignments 

     
History Value Reset - elapsed active time and history resets, and 
runtime hours 

     
Trend Parameters - enable trend logging, log intervals, and log 
start/stop time. 

     Calibration Parameters - point calibration offsets 

     Hardware Controller Parameters - module driver properties 

     
Critical Configuration - critical properties the installer protected with this 
privilege 

     
Area Name - area display names 

     Control Program Name - equipment display names 

     
Alarm Configuration - enabling/disabling alarms and editing alarm 
messages, actions, categories, and templates 

     Status Display Tables - tables available under Status 

     Maintenance Tables - tables available under Maintenance 

     User Config Tables - tables available under User Config 

     Service Config Tables - tables available under Service Config 

     Setpoint Tables - tables available under Setpoint 

     Time Schedule data Tables - tables available under Time Schedule 

 

 

 

 

 
 

General tab 

1 Click , then select System Options > General tab. 

2 Enter information on this page as needed. 

3 Click OK or Apply.  
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You can edit or use the following fields and buttons. 

 Field Notes 

System Statistics • Numbers of controllers allowed and present in system 

• Number of trend sources and samples in the database 

• Estimated time to import/export clipping 

Logs For troubleshooting, download a zip file that contains a log of system 
activity. Logs are available for a maximum of 4 weeks.  

Management Tool Select Management Tool (page 32) button to access the following:   

• Download weekly system logs  

• View or change system name and IP addresses    

• Port Configuration 

• Backup and Restore, Compress Trend Storage  

• Reset to Factory Defaults 

• Upgrade System Version 

• Reboot 

• NTP Configuration 

Time Time Format 
• 12-hour clock (Example:  4:34 pm) 
• 24-hour clock (Example:  16:34) 

• Daylight Saving Time is automatically controlled. To update Daylight 
Saving begin and end dates, go to System Options > Daylight Saving. 

• Enable time synchonization of controllers daily at - Automatically 
synchronizes the time on all equipment to the time on the i-Vu® web 
server, adjusting for different time zones and Daylight Saving Time. We 
recommend that you enable this field. 

CAUTIONS   

○ To prevent time sync problems when the transition to and from 
Daylight Saving Time occurs, set the time sync to occur at least 1 
hour after the last controller in the system is adjusted for DST. For 
example, your i-Vu® and part of your system is in the Eastern 
Standard Time zone, but you also have controllers in the Pacific 
Time zone. Your server is adjusted for DST at 2:00 a.m. Eastern 
Standard Time, but the controllers in the Pacific Time zone are 
not adjusted until 3 hours later. So you would set the time sync to 
occur daily at 6:00 a.m. or later. 

○ Make sure that your i-Vu®’s time and time zone setting are 
correct.  

• Time Sync –  Sends a time broadcast to synchronize all controllers in 
the system with the i-Vu® web server's time. 

Alarms Select the checkbox to enable Alarm Notification functionality. See Alarm 
Popup (page 86) alarm action. 

Trends NOTE  Configurable for i-Vu® Plus only. i-Vu® Standard is 7 days. 
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 Field Notes 

Import/Export Source Files Use to import or export source files in a .zip file that can be imported or 
exported to/from another i-Vu® or Field Assistant system. Source files 
include: 
• Control programs (.equipment files only) 
• Drivers 
• Graphics (.view files only) 
• Touchscreen files 
• BACview® files 
• Report design files for Equipment Values or Trend Sample reports 
NOTE  If import detects a difference between a database file and an import 
file with the same name, import does not overwrite the database file. A 
message lists any file differences so that you can resolve them. 

See Commissioning equipment using Field Assistant (page 143). 

Download You can increase download speed by checking Optimize download for 
Open PIC controllers. The full source files are not downloaded into the PIC 
controllers when this is checked.  

You can increase download speed by unchecking Include graphics in Open 
programmable controller download. If you are not changing the graphics, 
you may not want to include them in every download in order to save time. 

Clippings • Navigation tree items including attached control programs, graphics, 
drivers, and screen files 

• Trend datal 

• Reports 

• Alarm categories 

• Schedules and schedule group membership (including the entire 
schedule group and schedules, if it does not exist in the target system) 

• Alarm actions 

NOTE  A clipping containing CCN controllers does not include the CCN 
tables. When importing a clipping containing CCN devices, you must re-
scan the table. 

 

 

 
 

Management Tool 

You can access Management Tool by either: 

• Clicking  and selecting System Options > General tab > Management Tool button   

• Launching your browser and typing your system name followed by :8080.  For ex.: http://ivu:8080/  

NOTE The Management Tool is password-protected and can only be accessed by a user with Installer role. 
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System Status  

i-Vu is running at: This is used to troubleshoot server or LAN communications.  

Click the Stop Server button to stop the i-Vu® web server. When stopped, the button 
changes to Start Server. Do NOT close the Management Tool before restarting the server. 
Click to restart.  

Weekly system logs: • System - used for troubleshooting (same as logs available from System Options > 
General (page 30) tab). Logs are available for a maximum of 4 weeks.   

• Kernel - operating system logs  

Addressing 
 CAUTION  If you change the name or the IP address of your system, record the 

numbers in a secure place.  

• Name - Controls the name used to access your system from the Internet. Do not use 
special characters or spaces. 

• Obtain an IP address automatically - Uncheck this to manually assign addresses for 
the following: 

○ i-Vu Address 

○ Subnet Mask 

○ Default Gateway 

○ DNS Address - IP address of the Domain Name Server 

○ Domain - Host name of the domain (i.e. carrier.utc.com) 

○ USB Network Type - Read-only field shows either CCN or BACnet types. 

○ USB Network Address - IP address of the internal BACnet router or the internal 
CCN Gateway  

i-Vu Port Configuration Changing these values forces a web server restart. 

Default values: HTTP: 80   HTTPS: 443 

Operation Status Message showing progress of background operations, such as backup and restore. 

Manage Server Data • PC Backup -  Saves the entire database zipped into one file to your computer.  

• PC Restore - Replaces the current server data with a backup from your computer. 

• USB Backup -  Saves the entire database zipped into one file onto a USB inserted 
into the i-Vu® web server.  

• USB Restore - Replaces the current server data with a backup from your USB 
inserted into the i-Vu® web server. 

• Compress System - Creates more storage space for trend data. 

• Factory Defaults - Deletes all server data and resets the device to the original factory 
default values. 

NOTE  Executing this option does not delete configuration data under the Addressing 
and i-Vu Port Configuration sections of the Management Tool.  

Machine Maintenance • Management Version - Apply .update file from here. 

• Reboot - System restart 
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Configuring NTP 

Network Time Protocol (NTP) is a networking protocol for clock synchronization. You can designate an NTP source 
that sends the correct time to the i-Vu® web server, ensuring constant accurate time. You can enter 2 static 
addresses (DNS name or IP) of NTP servers or use the default addresses provided by the i-Vu® application. If you 
do not enable NTP, the i-Vu® system clock must be monitored and updated regularly in the System Options menu 
> General tab.  

You can configure DHCP servers to supply IP addresses of NTP servers to the i-Vu® web server. If you have 
checked Obtain an IP address automatically and Enable Time Synchronization, the i-Vu® web server tries to 
obtain an NTP server address from the DHCP server on site. If it cannot find one, the i-Vu® web server uses the 
User Assigned NTP addresses, if any, in the User Assigned fields. 

 CAUTION Contact your Network Administrator for guidance in entering these settings.  

You can access NTP from a local server, a remote server, or a website. To set up NTP: 

1 Verify that Enable time synchronization from an NTP server is checked. 

2 System Assigned NTP Server Address - To use this read-only field, make sure you have checked Obtain an IP 
address automatically to allow your system to search for an address for the NTP server and display a primary 
and alternate address. 

3 User Assigned NTP Server Address - You can use the default website addresses if your system allows it. 
Firewalls may prevent successful access to the default websites. Your Network Administrator can provide 
alternate addresses for a local server, a remote server, or a website. 

 

 
 

Security tab 

To adjust security settings, 

1 Click , then select System Options > Security tab. 

2 Enter information as needed. See table below. 

3 Click OK or Apply.  

 

Field Notes 

Return operators to previous 
locations when server reconnects. 

Returns operators to current navigation tree locations when the 
server reconnects. 

 

Log off operators after _:_ (HH:MM) 
of inactivity 

The system automatically logs off an operator who has had no 
activity in the system for the time period specified. 

This is a default setting for the system. The Installer or 
Administrator can change this setting for an individual operator on 
the Operators (page 26) tab. 

Lock out operators after  __ minutes 
after __ failed login attempts 

Set the time that a user will be locked out of the system after the 
failed number of login attempts has been reached.  

NOTE  Restarting the i-Vu® application removes lockouts. 

Clear Lockouts  Remove lockouts for all users. 
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Field Notes 

Use advanced password policy You can place specific requirements on passwords to increase 
security. See Advanced password policy (page 35). 

Permissions  

Permissions When control programs, views, touchscreen, and BACview® files 
are created by an original equipment manufacturer (OEM), they 
cannot be used in the i-Vu® system without the creator's 
permission. However, the creator can produce a key for a system 
with a different license that will grant permission to the key's 
recipient. 

If you receive a key, put it in a convenient location on your 
computer. To activate a key, click Add, then browse to the key.  

To delete a key from your system, select the key in the table, then 
click Delete. 

Red text in the table indicates the key has a problem such as it 
does not apply or has expired. See the Notes column for an 
explanation. 

 

 
 

Advanced password policy 

You can set up a i-Vu® password policy to meet your security needs.  

1 On the System Options tree, select the Security tab. 

2 Enter information in the fields described below.   

 

Field Notes 

Use advanced password policy Enable this field to put restrictions on passwords. 

An operator’s login name and password must be different when this 
policy is enabled. 

After you change the password policy, any operator whose password 
doesn't meet the new requirements will not be locked out of the system, 
but will be prompted to create a new password. 

Passwords must contain You can specify how many characters and which of the following types of 
characters a password must contain: 
• Numbers 
• Special characters—any keyboard character that is not a number or 

letter. 
• Letters—uppercase, lowercase, or both. 

Cannot be changed more than once 
every __ days. 

Enter a number to limit how often users can change their passwords. 
When set to 0, users can change them as often as they want. 

May not be reused until __ different 
passwords are used. 

Enter a number between 1 and 20. Enter 0 to reuse passwords without a 
delay. 
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Field Notes 

Expire after __ days Enable to set the number of days an operator can use his password 
before the system requires him to change it. Enter a number between 1 
and 999. 

Force expiration Click this button to force every user's password to expire. Each user will 
be prompted to change their password when they next attempt to log in 
to the i-Vu® interface. 

  

 
 

Update tab 

Select the Update tab to install .update files (patches, service packs, drivers, language packs, graphics libraries, 
and help updates). 

Click  next to Applied Updates and Current Libraries to view all currently applied updates and .SAL files currently 
and verify if the i-Vu® application has the latest updates or library files. 

i-Vu® Library 

The i-Vu® application is equipped with a complete library. There are occasionally library (.sal file) updates, which 
contain the following files: 

• graphic (.view) 

• control program (.equipment) 

• driver (.driver) 

• BACview (.bacview) 

• Touchscreen (.touch) 

 

Notes: 

• Get the latest updates from your Carrier representative. 

• The library update only changes default graphics. If you have edited your graphic in ViewBuilder, it is not 
updated. 

• Keep copies of the latest libraries in a safe place. In the event of a system restore, any updated .sal files 
must be reapplied. 

• The last digits in the sal library name are the release date of the library. 

 

Step 1: Update library  

1 Save the updated library (.sal file) to your computer. 

2 Click , then select System Options > Update tab. 

NOTE  Expand Current Libraries (.sal) to see the current SAL libraries and their revision. Compare them to 
what you downloaded from the Carrier support website to determine if any of them have been updated. 

3 Click  and browse to the updated .sal file that you have saved on your computer, select the 
file, and click Open. 
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4 Click Continue. 

5 When process is complete, the message appears File added successfully. 

6 Click Close. 

NOTE  These changes are not applied to the controllers until you have updated routers and controllers. 

Follow these steps to implement the new equipment library: 

Step 2: Update the files for the routers 
1 Select the router that you wish to update in the navigation tree. 

2 Right-click and select Driver Properties.  

3 Select Properties page > Update tab.  

4 If the database contains 2 or more routers, you must check Change for all control programs of this type in 
the Controller section. 

5 Click Update. A message appears Changes the driver and screen file to use the current library version. 
Continue?  

NOTE  If more than one router exists, the additional routers are listed below the Update button. 

6 Click OK.  

7 Click Accept. 

Step 3: Update the files for Open controllers  
1 Double-click the controller in the navigation tree or right-click and select Configure .   

2 If you have multiple controllers of the same type, enable Change for all control programs of this type?. 

3 Click Update under Controller. A message appears Changes the control program, view, driver and screen file 
to use the current library version. Continue?  

4 Click OK. When the message Updated to the library version xx. appears, click Close. 

5 Repeat steps 1 - 4 for any additional types of controllers. 

6 Click Close again. 

 

Step 4: Update the files for CCN controllers 

1 In the navigation tree, select the CCN device manager associated with the controllers that are to be updated. 

2 Select Devices > CCN Discovery tab and re-scan any controllers that need to be updated.  

3 Select the i-Vu® and in the list. 

4 Check Rescan Controllers Selected Below for Configuration Changes and click Start Scan. 

 

Step 5: Apply the update to the routers and controllers 

1 Select the site level in the navigation tree and then select the Downloads page. 

2 If you wish to apply the new SAL file to your entire system, you can use this page to compare to your 
navigation tree and verify that you have selected all of your routers and controllers for download. 

NOTE  Only the CCN Gateway and device managers require download, so the CCN controllers/equipment will 
not be listed. 
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3 A network's controllers download in the order shown. To change the order, select a controller(s), then drag 
and drop or click Move to Top or Move to Bottom. 
EXCEPTION  If a controller's router requires a download, it will download first regardless of its position on the 
Download page.Click the Start button. 

NOTES 

○ Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers.  

○ Up to 5 routers can download simultaneously. 

4 See To download from the Downloads page (page 146) in Help for more details. 

 

 

 
 

Daylight Saving tab 

On this tab, you can adjust the Daylight Saving Time settings. 

Click Update to automatically set the table's Begin and End dates for the next 10 years based on the system's 
timezone. This marks all controllers for a Parameters download. 

If the updated dates are incorrect 
If you clicked Update but the dates are incorrect, your system's Java timezone data may be out-of-date. Do the 
following: 

1 Go to the Oracle Java SE Download site (http://java.sun.com/javase/downloads). 

2 Download the JDK DST Timezone Update Tool (tzupdater-version.zip). 

3 In the i-Vu® interface, click , then select System Options > Daylight Saving and then click Import. 

4 Browse to the tzupdater.zip file, select it, then click Open. 

5 Click Continue. 

6 Restart the i-Vu® application. 

7 On the System Options > Daylight Saving tab, click Update. 

 

  

 
 

Add-ons tab 

This feature is available only in the i-Vu® Plus application.  

The Add-ons tab allows you to use plug-ins that integrate with your system, such as Tenant Override Billing or the 
Weather. 

To install an add-on 
1 Save the add-on's file (.addon or .war) to your computer.  

2 Click , then select System Options > Add-ons tab, and browse to the file. 

http://java.sun.com/javase/downloads
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3 Click Install Add-on. After a few seconds, the add-on will appear in the Installed table, and will be enabled. 
The table below gives a description of each column. 
  

Column Notes 

Name The add-on's name. 

Path To open the add-on in a web browser, append this path to your i-Vu® 
system's address. 

For example, to start Tenant Billing, type 
http://<system_name>/override, or  
http://<system_IP_address>/override  

Version The version is shown if the author provided the information in the add-on. 

Status If this column shows: 
○ Running, you can open the add-on in a web browser. 
○ Disabled, click Enable to run the add-on. 
○ Startup error, select the table row to see an explanation 

of the error under Details. 
  

1 Select an add-on in the Installed table to disable or enable it, or to see the following Details. 
  

Add-on  
main page 

Click the main page link to open the add-on, if the author provided a main 
page. 

Description A description of the add-on, if the author provided one 

Vendor Name The add-on's author 

Public Data Directory This public directory contains data generated by the add-on. This data is 
visible in a web browser. 

Private Data Directory This private directory contains information such as configuration data. 

  

To back up the add-on's private and public data directories 
NOTE  This procedure will not back up data stored in an external database.  

1 Select the add-on in the table. 

2 Click Save Data. 

3 Click OK. 

4 Click Save. 

5 Select the location where you want to save the data, then click Save. 
  

To update an add-on 
NOTE  Add-ons for i-Vu® v6.0 and later systems have a different folder structure than previous versions. 

1 Select the add-on in the table. 

2 Click Remove Add-on and Keep Data  

3 Follow the procedure above to install the new version of the add-on.  
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To uninstall an add-on 
1 Select the add-on in the table. 

2 Click Remove Add-on and Data. 
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You can view and adjust equipment operation from the following pages: 
  

Devices pages 

Select the system level on the navigation tree to 
view the Devices page, where you can: 

• Upload source files or just parameters 

• Download source files, schedules, parameters, 
or BBMD tables 

• Check status and error messages 

• View model, IP address, drivers, device ID 

• Edit device names  

 

Graphics pages (page 42) 

You can view and adjust your essential building 
controls on most Graphics pages. 

Equipment drawings show the current status of 
mechanical equipment. 

Adjust setpoints (page 58) on a Graphics page. 

To upload a graphic from ViewBuilder, double-click 
the controller in the navigation tree or right-click and 
select Configure. 

 
Logic pages (page 48) 

Logic pages show the control program for a piece of 
equipment. Use the sequence of control and yellow 
status values on the Logic pages for troubleshooting 
your mechanical equipment. 
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Properties pages (page 46) 

You can monitor and control point sources. 

1 Select the equipment in the navigation tree. 

2 Click Properties page > Control Program tab. 

3 Expand the plus sign next to the desired table. 

 

 
Properties/Microblock popups  

Click a property or point to open the microblock 
popup to view and change details, including forcing 
or locking values. 

 
 
 

Graphics pages 

You can view and adjust your system from Graphics pages, which include navigation maps, floor plans, and 
equipment. 

 
Some typical controls that may appear on a graphics page are: 

• Button or switch to turn equipment on or off 

• Input field to set a property value 

• Drop-down list to select a state 

• Interactive zone sensor to override an unoccupied schedule 

• Setpoint graph to adjust setpoints 
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• Trend graph to view trend information 

• Link to jump to another i-Vu® page or to the Internet  
  

NOTES 

• Right-click a value, then select Details to view and change properties in the microblock pop-up.   

• Right-click a value, then select Global Modify (page 50) to view and change the property in other control 
programs.   

• A yellow dashed box around a value indicates the value is locked or forced.  

• If a graphic does not fit in the action pane, right-click it and select Scale to Fit to make it fit the action pane. 
Select Scale to Fit again to return the graphic to its original size. 
  

 

 
 

To attach a graphic in the i-Vu® interface 

1 On the navigation tree, right-click the item that you want to attach a graphic to, then select Configure. 

2 Equipment graphic only:  If the system has other control programs of this type, select which control programs 
you want to change.  

 
NOTES   

○ If the control program is in an IP router, the second option will change the graphic for all control 
programs of this type only on the IP network. 

○ If the control program is on the network below an IP router, the second option will not change the graphic 
for the router's control programs of this type. 

3 Do one of the following: 
  

If the graphic is...  

In the Views Available list a.  Select the graphic, then click Attach. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 
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NOTES   

• Select a graphic in the Attached list to edit the following information for the graphic: 
• Display Name–The name that appears in the Graphics button drop-down list 
• Category–The name of the category that multiple graphics may be sorted into in the Graphics button 

drop-down list 
NOTE  Changes to Display Name or Category apply only in the i-Vu® interface and are not retained if you 
export source files (page 144). 

• Reference Name–The name that is used to create links to the graphic in ViewBuilder 
• Default View–Sets the selected graphic as the default view if the tree item has multiple graphics. The 

default graphic is bolded in the Attached list. 
Included in download–Equipment graphics only. Select to have the .view file included in an All Content 
download so that it can be uploaded by Field Assistant. The graphic will have  beside it in the 
Attached list. Requires 4.x or later drivers.  
  

• You can click Delete Unused at the bottom of the Views section to delete all unattached graphic files from 
your system. 

 

 
 

To edit a graphic from the i-Vu® application in ViewBuilder 

1 In the i-Vu® interface, double-click the controller in the navigation tree or right-click and select Configure. 

2 Select appropriate options. 

3 Click Edit Existing button under Views. 

4 Click Save and place the file in an appropriate folder. 

5 Open ViewBuilder. 

6 Select File > Open.  Browse to your saved graphic and click to open. 

7 Edit and save with a new name - the original system name is locked and cannot be used for an edited 
graphic.  

NOTE  Names are case sensitive and should not have spaces and/or special characters. 
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To control equipment using an interactive zone sensor 

An equipment graphic may include an interactive zone sensor that provides you with the following control.  

 

If the sensor is a...      You can... 

ZS  

 
  

  
• Click  to raise the setpoint or  to lower the setpoint.  

• Click    to override the schedule and put the zone in an occupied state. 
To cancel an override, continue clicking  until the display shows 0. 

• See that the zone is in an occupied state when the green LED is lit. 

 

SPT Standard, Plus, or Pro  

 

  
• Click the WARMER or COOLER button to adjust the setpoint.  

• Click the MANUAL button to override the schedule and put the zone in an 
occupied state. 

• Click the INFO button to cycle through the following information: 

• Outside air temperature, if enabled in the control program 

• Override time remaining 

• Heating setpoint 

• Cooling setpoint 

• See the Occupied/Unoccupied state in the display. 
  

SPT Pro-Plus  

 

  
• Click the WARMER or COOLER button to adjust the setpoint.  

• Click the MANUAL button to override the schedule and put the zone in an 
occupied state. 

• Click the INFO button to cycle through information such as: 

• Outside air temperature 

• Override time remaining 

• Heating setpoint 

• Cooling setpoint 

• Click the FAN button to adjust the fan speed. 

• Click the MODE button to perform customer-specific functions. 

• See the Occupied/Unoccupied state in the display. 
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Properties pages 

Properties pages are automatically generated from control programs. Properties pages show the status of a piece 
of equipment and the points/properties currently stored in it. See Checkout input and output, alarms, trends, and 
network points (page 136) for details. 

Use Properties pages to: 

• View the status of a piece of equipment.  See Colors and status in the i-Vu® interface (page 23).  

• View or change the equipment point/properties currently stored in the controller. 

• Commission equipment (page 136) 

• Set up Linkage. 

Refer to your individual controller's Installation and Start-up Guide for detailed explanations of the 
points/properties. 

 

 

 
 

To view or edit properties on a Properties page 

1 Select a controller on the navigation tree, click Properties, and then select the appropriate tab. 

NOTE  You must resolve any condition described in red text at the top of the page before a Properties page 
can obtain current information from its controller. 

2 Click  to show property details. 

 
 

3 Do one of the following to change a property: 

○ Select or clear a checkbox 

○ Select an item on a drop-down list 

○ Change text in a text field 

4 Click Accept. 
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NOTES  

• Click the bold, underlined point name to open the editable microblock pop-up 

• Right-click a value, then select Details to view and change properties in the microblock pop-up. 

• Right-click a value, then select Global Modify (page 50) to view and change the property in other control 
programs. 

• Use Search/Replace on the Network Points tab to replace a term in the point address with another address. 

•  For the legend of status colors, see Colors and status in the i-Vu® interface (page 23).  

• A yellow dashed box around a value indicates the value is locked or forced. 
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Logic pages 

The Logic page shows a custom control program for a programmable controller. The live data (yellow text) is 
updated every few seconds and when you click the Logic button. The control program uses exact property values 
for its calculations, but values are rounded to 2 decimal places when displayed on the Logic page. 

 TIP  Click anywhere on the Logic page, then use your keyboard's Page Up, Page Down, and arrow keys to scroll 
through the page. 

NOTE  If you find an unexpected value on a Properties page or a Logic page, you can use the Logic page to 
troubleshoot. 

 

 
 

To view a Logic page 

1 Select a custom control program on the navigation tree. 

2 Click Logic. 

3 Click a microblock to view its details. 

 

 
 

To locate a microblock, section, or label 

1 Right-click the Logic page, then select Jump To. 

2 Do one of the following: 

○ On the Microblock or Section tab, select an item to have it located and highlighted. 

○ On the Label tab, select a label to display a reduced logic page outlined in yellow that shows all 
instances of the label. A red box indicates an output label; a yellow box indicates an input label. Click a 
red or yellow box to jump to that label in the full-size logic page. 
 
NOTE  You can also click a label on the full-size logic page to display the reduced logic page.  

 

 
 

To change properties, alarms, or trends 

1 Click a microblock on the equipment’s Logic page. 

2 In the microblock pop-up, click the Properties, Alarms, or Trends button. 

3 Change properties, alarms, or trends for that microblock in the same way that you would make changes on a 
regular Properties (page 46), Alarms (page 90), or Trends (page 100) page. 

4 Click Accept. 
  

NOTE  Right-click a value, then select Global Modify (page 50) to view and change the property in other control 
programs. 
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Using a Logic page to troubleshoot 

The i-Vu® application monitors your system and provides feedback. If you get unexpected feedback, you can use a 
Logic page as a troubleshooting tool. On the Logic page, work your way backward (right to left) through the 
sequence in the control program to discover what caused the problem. See Microblock Reference (page 1) to 
understand what each microblock in the sequence is doing. 
  

Unexpected feedback Possible cause 

Space temperature reads 
excessively high or low 

• The sensor has a short (or open) circuit. Verify wires are properly 
connected at the sensor and controller. 

• A sensor is missing or configured incorrectly. Open the sensor or input 
microblock from the Logic page to verify its configuration. 

Equipment displays an unexpected 
color - effective setpoints are 
different than the programmed 
setpoints 

NOTE  Equipment operates using effective setpoints. Open the Setpoint 
microblock from the Logic page and check the following: 

• Hysteresis 

• Demand Level 

• Optimal Start 

• Timed Local Override (TLO) 

• Setpoint Adjust 

Gaps in trend data on trend graph Usually gaps result if network communication was disrupted or a point was 
temporarily disabled. 

If the gap is not the result of interrupted communication, send reports 
more frequently. From the Logic page, open the trend microblock that 
displayed the gap in data, then decrease the notification threshold so that 
it is approximately 40% of the buffer size (allocated memory size) for that 
microblock. 

The i-Vu® application is not 
receiving alarms from a BACnet 
alarm microblock 

Locate the microblock on the Logic page. If the color square on the 
microblock is black, the alarm is disabled. To enable it: 

1 Click the microblock.  

2 In the microblock pop-up, click the Alarms button.  

3 On the Enable/Disable tab, select Potential alarm source. 

The equipment is on when I expect 
it to be off, or off when I expect it to 
be on 

Use the Logic page to determine whether the program is sending an 
unexpected signal and why, or if the problem is with the physical 
equipment. For example, the On-Off-Auto (OOA) switch on the controller for 
that equipment may be locked in the On (Hand) position. 

Sensor value on the Properties 
page does not match the reading 
from handheld sensor 

Calibrate the sensor.  

On the Logic page, check to see if the output point is locked on. 
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Changing multiple microblock properties 

Two i-Vu® features, Global Modify and Global Copy, allow you to view and change multiple microblock properties 
at the same time. 

 CAUTION  Global Modify and Global Copy are convenient for making widespread changes in your system. 
But, because they do not take into account the operation of individual equipment, your changes could produce 
undesired results in your equipment or system operation. Use with caution because these features do not have an 
Undo function. 

 TIP  Click  to copy a microblock's reference path to the clipboard so you can paste it into another field or 
application. 

 

 
 

To use Global Modify 

Use the Global Modify feature to: 

• View a microblock’s full path, control program name, and the privileges required to change its properties. 

• View or change a single property in several control programs at one time. 

• View errors on Graphics and Properties pages. 
  

1 Browse to any page that displays the property you want to view or change. 

2 Do one of the following to open Global Modify: 

○ Alt+click the property. 

○ Right-click the property and select Global Modify. 

3 Make changes to the Control Program field, if needed. 

NOTES 

○ Use wildcards in the Control Program field to broaden the search. 
For example: 

vav* matches vav, vav1, vavx, vav12345 

vav*z matches vavz, vav1z, vavxz, vav12345z 

vav*1*2 matches vav12, vavabc1xyz2 

vav?? matches vav11, vav12, vavzz, but does not match vav, vav1, vav123 

* matches any control program 

○ Click Show Advanced to view the location, value, and privileges associated with this property. 
  



 Working with equipment in the interface 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 51 

 

 
  

4 Select the tree item that you want to search under for every occurrence of that microblock in other control 
programs. 

5 Click Find All. 

6 Select the properties in the list that you want to change. 

7 Do one of the following: 

a) Type a New Value to the right of each selected item. 

b) Select Enable All, type a new value in b, then click Set All To. 
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c) Select Enable All, type a new value in c, then click Change All By. 

 
 

8 Click Apply Changes. 

NOTE  To modify several properties in multiple control programs at the same time, use Global Copy. 

 
 

To use Global Copy 

Use Global Copy to copy any or all of the following from one control program to other equipment using the same 
control program: 
• Embedded trend graph settings 
• Custom trend graphs 
• Custom reports 
• Other editable properties to other pieces of equipment using the same control program. 

  
1 On the navigation tree, right-click the piece of equipment that has the properties you want to copy, then 

select Copy Control Program Properties. 

2 Click OK when you see This will copy this control programs properties to other control programs of the same 
type. Continue?. This opens the next screen and does not lock in any changes. 

3 In the Global Copy dialog box, select the items that you want to copy. 

4 Select the area on the tree containing similar control programs that you may want to copy these properties to, 
then click Search. 

All instances at that level and below are listed in the expanded lower window. 

5 Check or uncheck items as needed. 

6 Do one of the following: 

○ Check Skip bad values to copy all values except a bad value (it cannot be copied because you do not 
have the necessary privilege, the property to be copied is undefined, etc.).  

○ Uncheck this field to prevent any values from being copied if a bad value is found. 

7 Click Apply Changes, then close the Global Copy dialog box.  
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Checking controller status 

On the i-Vu® navigation tree, you can select a router, site, or the system, and then click the Devices button to: 

• View the status of controllers (page 53) 

• View controller information such as address, model, driver, and .view files included in download 

• Download or upload to resolve a mismatch (page 56) 

• Troubleshoot network communication (page 164) 

• Download or upload files for Field Assistant (page 143) 

  

NOTES 
• Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers. 
• Click Hold to stop pending  downloads or uploads. Active downloads  or uploads  cannot be stopped. 
• Icons in the Tasks column indicate the following: 

  

 Active—The i-Vu® application is downloading to the controller. 

 Active—The i-Vu® application is uploading from the controller. 

 Pending—You initiated the download, and the controller is waiting for its turn to download. 

 Failed—The download failed. See If a controller fails to download (page 147). 

 On Hold—Indicates you clicked Hold to stop a pending  download. 

  
• Click  in the upper left-hand corner to view a log of activity on the Devices page in the current session. 

Copy to Clipboard lets you copy the text to paste it into another application. 
  

 

 
 

Status messages 

On the i-Vu® navigation tree, you can select a router, site, or the system, and select the Devices page to view the 
status of controllers. The Status column shows a description of the controller's current state. Hold your cursor over 
that description to see hover text with a more detailed description. 

If multiple conditions exist, the i-Vu® interface displays the message with the highest priority. 

The table below shows all possible messages. The message color indicates the following: 

Black—In process 
Red—An error occurred 
Blue—Requires action from the user 

 

 

 

 

 

 

 



Working with equipment in the interface 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 54 

 

i-Vu® Open routers/controllers 

Status column message Hover text message  Notes 

   

Black messages:   

Downloading The controller is downloading, 
communications may be disabled 

 

Uploading The controller is uploading, 
communications may be disabled 

 

Pending This controller is waiting to be processed.  

Processing Clipping Clipping operation in progress. Do not 
make changes during this operation, as 
they may corrupt your system. 

 

   

Red messages:   

Communications Error Cannot communicate with this controller.  

Connection Disabled The connection for this controller has been 
disabled. 

Occurs if someone stopped the 
connection.  

Connection Error The connection for this controller failed to 
start. 

Occurs if the connection is misconstrues 
or failed to start. 

Controller offline The controller is offline. This only appears for equipment 
controlling slave devices that it is 
unable to communicate with. 

Download Failed (Message depends on the cause of the 
failure.) 

 

Download Not Permitted This controller is not permitted to 
download. 

 

Error  An unknown error has occurred.  

Missing Files Upload failed. Server is missing the source 
files. 

 

Not Uploadable  This controller is not configured for 
content upload. 

Occurs if you attempt to upload a 
controller with a pre-4.x driver. 

Out of Service This controller is out of service.  

Unsupported Controller This controller does not support content 
upload. 

 

Upload Not Permitted This controller is not permitted to upload.  

USB Unplugged Cannot communicate with the controller 
because the USB cable is unplugged. 

Applies only to the i-Vu® Standard and 
Plus applications. 
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Status column message Hover text message  Notes 

Blue messages:   

Controller Replaced This controller has been replaced by 
another controller of the same type in the 
field. 

4.x driver only 

Download All Content Please download all content to the 
controller. 

 

Download Parameters To download parameters, highlight row 
and select Parameters from the Download 
Action menu and click Download. 

 

Download Schedule To download schedules, highlight row and 
select Schedules from the Download 
Action menu and click Download. 

 

Driver Parameter 
Mismatch 

Driver parameter differences detected. 
Upload parameters from the controller or 
download parameters to the controller. 

 

Network Ready for 
Upload 

To upload this network, select the router in 
the tree and Find Devices. 

 

Parameter Mismatch Control program parameter differences 
detected. Upload parameters from the 
controller or download parameters to the 
controller. 

 

Program Mismatch Content differences detected. Upload all 
content from the controller or download all 
content to the controller. 

4.x driver only 

Unprogrammed 
Controller 

Applies only to a programmable controller 
that does not have any control programs in 
it.  

To add control programs, click Add 
Control Program. 

Upload All Content Please upload all content from the 
controller. 

 

   

General messages:   

 This controller is ok.  

Cancelled  The last operation on this controller was 
cancelled 

 

 

CCN controllers/equipment 

Status column message Hover text message  Notes 

<blank> This is a known control program from a 
previous discovery, but communications 
with it has not been attempted since the 
user logged in. 

 

 Successful rescan.  
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Downloading Downloading changes. Communications 
will resume shortly. 

 

New Control Program A new controller was found at the scanned 
address and added to the system. 

 

New Version Applied This controller's program or views have 
been updated with a newer version. 

 

   

Red messages:   

Communications Error Cannot communicate with this controller.  

Download Failed <The message is specific to the failure.>  

USB Unplugged Cannot  communicate with the controller 
because the USB cable is unplugged. 

Applies only to the i-Vu® Standard and 
Plus applications. 

   

Blue messages   

Classification Mismatch The controller at this address was 
previously a Bridge routing to other 
controllers. 

 

Download All Content Please download all content to the 
controller. 

 

   

Model Mismatch The controller at this address is the wrong 
model. 

 

Rescan Required A configuration change was made to this 
control program therefore a rescan is 
required to get the correct graphic and 
control logic components. 

 

 

 
 

Handling parameter mismatches 

A parameter mismatch occurs when a value in a controller does not match the value in the system database. This 
can be a driver or control program value.  

To find mismatches in your system 
You can find mismatches in the following places: 

• The Devices page > Manage tab > Status column will show Parameter Mismatch. 

• The Properties page for a controller, driver, control program, or point will show one of the following red 
messages at the top of the page stating: 

Control Program parameter differences detected. 
Driver parameter differences detected. 
Parameter download required. 
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The value that has a discrepancy will appear with a purple box around it. Hover your cursor over the field to 
see: 

  

or 

 
○ Go to Reports > Equipment > Parameter Mismatch, and then click Run to get a report of any existing 

mismatches in your system. 

   
NOTE  The Downloads page > Tasks column will show Resolve Parameters for any mismatches that your 
system discovered in the 3 places listed above. 
  

To resolve a mismatch 
1 Go to one of the following:  

• Devices page - Click the Parameter Mismatch link 
• Properties page that shows one of the red messages above 

  
2 Click one of the following: 

○ Resolve to let the i-Vu® application download changes made in the i-Vu® interface or upload changes 
made in the controller. Click the Details button to see what the discrepancy is and whether Resolve will 
download or upload parameters. See NOTE below. 

 
○ Upload to upload the parameters from the controller to the i-Vu® application 

○ Download to download the parameters from the i-Vu® application to the controller 

  
NOTE  On the Devices page with Show Control Programs unchecked, if a controller has simultaneous 
mismatches in the driver and control program, clicking Details will show that a control program mismatch 
exists but it will only show details for the driver mismatch. You must go to the control program in the tree to 
see details of that mismatch. However, clicking Resolve will resolve both mismatches. 
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Managing setpoints 

The Setpoint graphic shown on a standard equipment graphic indicates the base setpoint values (Occupied 
High/Low, Unoccupied High/Low). The i-Vu® application reads these values back periodically, typically within 10 
seconds. The timing can vary based on network traffic, the number of controllers in the database, and several 
other variables. Setpoints that are changed in the field via another user interface are displayed in the i-Vu® 
interface as soon as they are detected.  

You can, at any time, change the setpoints from i-Vu® graphics by using the slider or by entering numeric values 
directly. Updated setpoints are transmitted to the controller when you Accept the changes. Setpoints can also be 
changed on the Properties page > Control Program tab > Space Temperature and Setpoints. or Configuration > 
Setpoints. 

NOTE  Power and Standard operators may only edit Occupied/Unoccupied and Heating/Cooling setpoints. They 
cannot edit Demand levels or more detailed setpoint parameters.    

The various color bars indicate adherence to or deviation from the setpoint. You can change the current default 
settings for setpoint deviation. Select a color band on the setpoint graph to see the current setpoints in the 
Heating and Cooling fields. The values in this graphic are Fahrenheit. See setpoint descriptions below. 

NOTE  This graphic is an example only. Your setpoints may differ. 

 
 

Color  Condition 

 Green Temperature is within the Occupied Low and High Setpoint 

 Grey Temperature is within the Unoccupied Low and High Setpoint 

 Light Blue Temperature is less than 2°F below the Occupied Low 
Setpoint  

 Dark Blue Temperature is more than 2°F below the effective Low 
Setpoint but less than 4°F below the effective Low Setpoint 

 

 Yellow Temperature is less than 2°F above  the effective High 
Setpoint 

 Orange Temperature is more than 2°F above the effective High 
Setpoint but less than 4°F  above the effective  High Setpoint 
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Color  Condition 

 Red Temperature is more than 4°F above or below the effective 
setpoints   

 

 

 
 

 
 

Adjust setpoints 

• Programmed setpoints are set and changed by operators.  

• Effective setpoints reflect the impact of other system conditions on the programmed setpoints, such as 
setpoint adjustments, and hysteresis. Effective setpoints control the equipment.  
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To change programmed setpoints: 

1 Navigate to a setpoint control in one of the following places: 

○ Properties page > Control Program tab > Configuration > Setpoints 

○ The setpoint microblock pop-up on a Logic page 

○ A Graphics page (Click a setpoint trend graph control to access the editable setpoint bar.) 

2 Make changes on a programmed setpoint bar by either:  

○ Clicking and dragging the segment or the gap between segments  

○ Typing new values in the Heating and Cooling fields 

3 Click Accept. 

 
 

Demand Control 

Demand Control is a cost-saving strategy that saves energy while maintaining comfort in the following ways: 

• Controlling energy use to avoid peak demand, ratchet, or time of use utility charges 

• Maintaining ventilation at relaxed setpoints rather than shutting down equipment (as with load shedding or 
duty cycling) 

Before you can use Demand Control effectively, you must: 

• Obtain details regarding past energy usage and peak demand, ratchet, and time of use charges from your 
energy provider. 

• Understand the demand profiles of the zones you are controlling. 

Demand Control can be customized at the zone level. For example, you may relax the setpoints in some zones, 
like break rooms and closets, by a few degrees, but you may not want to relax setpoints in computer rooms at all. 

  

 
 To define Demand Control properties 

1 On the navigation tree, select the electric meter. 

2 Select Properties > Control Program and expand the Demand Level Parameters section. 

3 Type the Start and End time to define the time period that you want demand control to be in effect for this 
zone. 

4 Type kilowatts per hour (kW/hr) in the Level columns to define the amount of power that the demand must 
exceed before the i-Vu® system calls for a higher demand level. 
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NOTE  Levels are defined in the electric meter control program in the Snap application. You can test the Demand 
Levels by locking the meter to a value. 

In the example below, during Period 4, defined as 12:00 (noon) to 16:00 (4:00 p.m.), if the demand exceeds 800 
kW/hr, the i-Vu® system will use Demand Level 1 setpoints. If the demand exceeds 1000 kW/hr, the i-Vu® 
system will use Demand Level 2 level setpoints and so on. 

 
 

 
 
 

Configuring Optimal Start 

Enable and configure Optimal Start on the  Properties page > Control Program tab > Configuration > Setpoints. 
Your control program could be configured for Optimal Start or for both Optimal Start and Optimal Start Type.  

NOTES 

• The Optimal Start options depend on the revision date of the control program in your controller. 

• Optimal Start is automatically disabled when Properties > Control Program > Maintenance > Occupancy > 
BAS On/Off is set to either Unoccupied or Occupied.  

 

 
 

Optimal Start 

Optimal Start adjusts the effective setpoints to achieve the occupied setpoints by the time scheduled occupancy 
begins.The Optimal Start recovery period may begin as early as 4 hours prior to occupancy. The algorithm works by 
moving the unoccupied setpoints toward the occupied setpoints. The rate at which the setpoints move is based on 
the outside air temperature, design temperatures, and capacities. 

The following conditions must be true for optimal start to operate: 

• On the Properties page > Control Program tab > Configuration > Setpoints > Optimal Start, the Default 
Value must be set greater than 0 and less than or equal to 4 (0.00 disables Optimal Start). 

• The system is unoccupied 

NOTE  If the Open controller does not have a valid outside air temperature, then a constant of 65° F is used. This 
value is not adjustable. 
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The actual equation that the controller uses to calculate Optimal Start is nonlinear. An approximation of the result 
is shown below. 

 
 
To change Optimal Start settings: 

1 In the navigation tree, select the equipment that you want to change. 

2 Select Properties page > Control Program tab >  Configuration > Setpoints. 

 

 
 

Optimal Start Type 

If you have Optimal Start Type, you must choose from the following: 

• None 

• Temperature Compensated Optimal Start 

• Learned Adaptive Optimal Start 

 
To select the method used to change from unoccupied to occupied setpoints: 

1 In the navigation tree, select the equipment that you want to change. 

2 Click Properties page > Control Program tab >  Configuration > Setpoints. 

3 Select option from the Optimal Start Type drop-down list. 

4 See below to make further adjustments. 

 
None – The unit will not start to control to the occupied setpoints until the unit goes into an occupied mode. 
Setpoints do not ramp, but change immediately from unoccupied to occupied values. When you select None, you 
must set all Learning Adaptive Optimal Start transition factors, identified by their themographic color, to 0. These 
are located directly above the Effective Set Points graph.   

Temperature Compensated – The unit changes to occupied setpoints at some time prior to the occupied time, not 
to exceed the hours you set for Optimal Start. The start time is determined by the current error between space 
temperature and the appropriate heating or cooling setpoint. At that time, the setpoints do not ramp, but change 
immediately from unoccupied to occupied values. When selecting Temperature Compensated, you must set all 
Learning Adaptive Optimal Start transition factors, identified by their thermographic color to 0. These are located 
directly above the Effective Set Points graph.  
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When selecting Temp Compensated, you can adjust the following: 

• Heat Start K factor (min/deg) – If Optimal Start Type is Temp Compensated, this is the time in minutes per 
degree that the equipment starts before the occupied period when the space temperature is below the 
occupied heating setpoint (including any setpoint offset).  

• Cool Start K factor (min/deg) – If Optimal Start Type is Temp Compensated, this is the time in minutes per 
degree that the equipment starts before the occupied period when the space temperature is above the 
occupied cooling setpoint (including any setpoint offset).  

NOTE  The default value for the above is 15.00 and the range is 0 to 99.  

 

Learning Adaptive Optimal Start – This function gradually adjusts the unoccupied setpoints over a specified 
period of time to achieve the occupied setpoint by the time scheduled occupancy begins. This learning adaptive 
algorithm uses the learned heating capacity and learned cooling capacity values to calculate the effective 
setpoints prior to the occupied start time. The algorithm calculates a learned cooling and heating capacity during 
the previous unoccupied time. Set the Learning Adaptive Optimal Start recovery period from 1 to 4 hours in 
Optimal Start. When the Learning Adaptive Optimal Start routine runs, adjustments are based on the color that is 
achieved when occupancy begins. Adjustment amounts are defined in the thermographic color fields located 
directly above the Effective Setpoints graph under Setpoints. 

EXAMPLE  The heating capacity for a zone is 5° per hour (default). When the zone becomes occupied, the zone 
temperature is 1° below the occupied setpoint, indicating a need for additional heat. Because the zone 
temperature was low by 1°, the learned heating capacity is decreased by the value entered in the LtBlue 
thermographic color field (0.0600 default). As a result, the learned heating capacity is adjusted to 4.94° for the 
next optimal start period. Since the algorithm has calculated that the equipment has less capacity to bring the 
temperature to setpoint within the configured recovery period, the setpoint adjustment  begins sooner in the next 
unoccupied period. 

To change the adjustment values in the Learning Adaptive Optimal Start routine: 

1 In the navigation tree, select the equipment that you want to change. 

2 Click Properties page > Control Program tab > Configuration > Setpoints. 

3 Adjust the color fields between the Zone Setpoints graph and the the Effective Setpoints graph. 

  
When you determine that no further start time optimization is required, you can disable Heating and Cooling 
Capacity adjustments by setting the color field values to 0.0. 
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You can reset the learned heating and cooling capacities by entering a value into either the Heating Capacity or 
Cooling Capacity, located beneath the Zone Setpoints graph.   

 

 CAUTION  When using Learning Adaptive Optimal Start, be sure that all equipment is properly maintained so 
that your system does not “learn” to compensate for dirty filters or loose fan belts. 

 

 
 

Reports 

Use i-Vu® reports to monitor and troubleshoot your system. In the i-Vu® interface, you can: 
• View preconfigured reports 
• Create custom reports 
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See the table below for a list of all reports. 
  

 

The Reports button drop-list varies depending on what you 
selected in the navigation tree and if you have created any 
custom reports at or above the selected location.  

A report shows data for the selected item and all of its 
children. 

 

This preconfigured report... allows you to... 

  
Schedules 

 

Schedule Instances Find every schedule with its location that is entered at and below a selected tree 
item. This report can help you discover newly added and conflicting schedules. 

Effective Schedules View all equipment that may be scheduled and the net result of all schedules in 
effect for a selected date and time. 

  
Commissioning 

 

Test & Balance View the damper calibration parameters.  

Run this report after performing Test and Balance to upload all calibrations and 
resolve parameter mismatches.  

• Running the report at the equipment level of the navigation tree uploads to 
that location 

• Running the report at the system or router level will upload to all equipment 
that contain one or more airflow microblocks.  

CAUTION! After performing Test and Balance, you must run the Test and Balance 
report to upload the values from the controller to the i-Vu® application. You will 
lose all your calibrations if you download to the controller before running this 
report. 

Equipment Checkout View the information on the Equipment Checkout tab of the equipment's 
Properties page during commissioning. Also, find equipment that has not been 
fully commissioned. 

 Alarms 
 

 

Alarms View, sort, and filter the information on the Alarms View (page 81) tab. 

Alarm Sources Create a summary of potential alarm sources as configured on the Alarms > 
Enable/Disable (page 90) tab. 

Alarm Actions Create a summary of the information configured on the Alarms > Actions (page 
85) tab. 
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This preconfigured report... allows you to... 

  

 

 
Equipment 

 

Point List View the details of all points. Verify that all points have been checked out during 
commissioning. Also, create custom lists for other contractors. For example, 
create a list of BACnet IDs. 

Locked Values Find all locked points and locked values. 

NOTE  Locks in the Airflow microblock are not reported. 

Network IO Verify the programming and status of all network points—especially useful for 
commissioning controllers used for third-party integration. 

Trend Usage Creates a summary of the information configured on the Trends > 
Enable/Disable (page 100) tab. 

Parameter Mismatch Discover where your system has parameter mismatches that need to be 
resolved. 

  
Security 

  

Location Audit Log View chronological lists of changes, the operators that made them, and the 
reasons for the changes. This report includes changes such as property edits, 
downloads, driver changes, and view changes.  

Select the Options tab to choose whether to show the changes made by All 
Operators, System, Installer, or specific operators. You can show administration, 
system, and schedule group changes. 

System Audit Log View chronological lists of system-wide changes, the operators that made them, 
and the reasons for the changes. This report includes changes such as any 
change made on the  tree, login/logout, and scheduled processes like deleting 
expired trends. 

Select the Options tab to choose whether to show the changes made by All 
Operators, System, Installer, or specific operators. 

  
Network 

 

Equipment Status Display the thermographic color, status, and prime variable of each control 
program. 

Controller Status Discover network communication problems (shown as purple squares on the 
report) that need troubleshooting. The report also shows boot and driver version, 
download information, and if controller has 4.x or later driver, the report shows 
the serial number and Local Access port status.  
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This custom report... allows you to... 

Equipment Summary View the following information for equipment at or below the location where the 
report was created: 

• Color 

• Active alarm 

• Locked values 

• Current value of selected points 

• Combined schedule 

See To create an Equipment Summary report (page 68). 

Equipment Values Compare point information. See To create an Equipment Values report (page 
69). 

Trend Samples View trend values for a particular time frame. See To create an Trend Samples 
report (page 71). 

 

NOTE  The Send E-mail alarm action (page 89) can run any i-Vu® report and attach it to the email. The report can 
be a PDF, HTML, XLS, or CSV file. 

 
 

To run a report 

1 Select an item on the navigation tree. 

NOTE  A report shows data for the selected tree item and all its children. 

2 Click the Reports button drop-down arrow, then select a report. 

3 On the Options tab, define the layout and content of the report. 

NOTES   

○ Changing the size and orientation of the printed page also changes the report layout on the View tab. 

○ To create a CSV (Comma Separated Values) file after you run the report, select Support CSV text format. 
See To create a PDF, Excel spreadsheet, or CSV file (page 67). 

○ The current operator's report options are saved so that when that operator logs in again, the same 
options are used. 

4 Click Run. 

5 Click PDF if you want to print the report. 

 
 

To create a PDF, XLS, or CSV file 

PREREQUISITE FOR CSV  You must enable Support CSV text format on the Reports > Options tab before you run 
the report. 

1 Run a report.  

2 Click PDF, XLS, or CSV.  

NOTE To create a CSV file when using Safari, see instructions below. 

3 For XLS or CSV, click Open to view the file or Save to save it. 
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To create a CSV file when using Safari  
1 Run a report.  

2 Click CSV. A pop-up displays the results. 

3 Select File > Save As. 

4 In the Format field, select Page Source. 

5 Add the .csv extension to the file name. 

6 Select the save location in the Where field. 

7 Click Save. 

8 Close the popup. 

 
NOTE  If you need a digitally signed PDF to comply with 21 CFR Part 11, open the PDF in a program that supports 
digital signing such as the Adobe® Acrobat® application, then sign the PDF. The i-Vu® application does not 
support digital signing because 21 CFR Part 11 requires that the signature be added manually, not through an 
automated process. 

 
 

To create an Equipment Summary report 

An Equipment Summary report can provide the following information for equipment at or below the location 
where the report is created. 
• Color 
• Active alarm 
• Locked values 
• Current value of selected points 
• Combined schedule 

  
To create an Equipment Summary report: 

1 On the navigation tree, select the location where you want to view the report. 

2 Click the Reports button drop-down arrow, then select New Report. 

3 Select Equipment Summary. 

4 Type a name for the report. 

5 Click Create. 

6 Define the Title, Page Size and orientation, and the Maximum number of rows. 

7 Select or clear the Optional Sections checkboxes as needed. 

8 Optional:  Select Include only specific control programs at or below this location, then type the names of the 
control programs. 

9 Select Available Points that you want to include in the report. Use Ctrl+click, Shift+click, or both to select 
multiple items. 

10 Click Add. 

11 Click Accept. 

12 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button drop-down 
arrow, select the report, then click Run. 
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To create an Equipment Values report 

An Equipment Values report allows you to compare point information. 

To create an Equipment Values report: 

1 On the navigation tree, select the location where you want to view the report. 

2 Click the Reports button drop-down arrow, then select New Report. 

3 Select Equipment Values. 

4 Type a name for the report. 

5 Click Create. 

6 Click  next to Rows. 

7 On the selection tree, select the pieces of equipment you want to view in the report. (Use Ctrl+click, 
Shift+click, or both to select multiple items.) Then click Add. 

8 Optional: Select the Highlight alternate rows checkbox to make the report easier to analyze. 

9 Click Next or   next to Columns. 

10 Verify or change the report Title, Page units of measure for defining column widths, and Outer border 
characteristics. 

11 Select a column in the report preview.  

NOTE The selected column is light blue. 

12 Under Column Header, define how you want the column header to look. 

13 Under Column Data, define the data you want in the column and how you want it to look. See table below. 

NOTE  Select General from the Format drop-down list unless you want to define the number of places to the 
right of the decimal point for the displayed value. 

14 Optional:  Use the Add, Delete, and arrow buttons below the report preview to manipulate the columns. 

15 Optional:  Click  next to Page to change the page size and orientation. 

NOTE  Changing the size and orientation of the printed page also changes the report layout on the View tab.  

16 Click Accept. 

17 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button drop-down 
arrow, select the report, then click Run. 
  

Type of Column Data 

Point Displays point data in the column. 

 Display Select the property to show in this column. 

 Data is named 
differently in some 
control programs 

Select this checkbox if similar points have different names in 
different control programs. Then add each of the names to the 
Name to use list. 

For example, if a point is named Zone Temp in one control 
program and Zone Temperature in different control program, add 
both names to the list. 

 Point to use Select the name of the point to show in the column.  
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Type of Column Data 

Trend Sample Display Select First, Minimum, Maximum, or Last recorded trend value. 

 Data is named 
differently in some 
control programs 

Select this checkbox if similar points have different names in 
different control programs. Then add each of the names to the 
Name to use list. 

For example, if a point is named Zone Temp in one control 
program and Zone Temperature in different control program, add 
both names to the list. 

 Trend to use Select the name of the point to show in the column. 

 Set Click to have all columns in the report use the same time range. 

 Time Range Select the time range to run the report for. 

Trend Calculation Display Select the type of calculation to show in the column, Average or 
Total. 

 Data is named 
differently in some 
control programs 

Select this checkbox if similar points have different names in 
different control programs. Then add each of the names to the 
Name to use list. 

For example, if a point is named Zone Temp in one control 
program and Zone Temperature in different control program, add 
both names to the list. 

 Trend to use Select the name of the point to show in the column. 

 Set Click to have all columns in the report use the same time range. 

 Time Range Select the time range to run the report for. 

Control Program Display Select Color, Display Name, Display Path, Notes, Prime Variable, or 
Reference Name to show in the column. 

Expression Data is named 
differently in some 
control programs 

Select this checkbox if similar points have different names in 
different control programs. Then add each of the names to the 
Name to use list. 

For example, if a point is named Zone Temp in one control 
program and Zone Temperature in different control program, add 
both names to the list. 

 Expression Type the path relative to the current control program. The path 
must return a string value. See Defining i-Vu® paths (page 172) 
for more information on paths. 

To display the Notes on an equipment's Properties page, type 
.notations in this field. 
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To create a Trend Samples report 

A Trend Samples report provides trend values for a particular time frame. 

To create a Trend Samples report: 

1 On the navigation tree, select the location where you want to view the report. 

2 Select the Reports button drop-down arrow, then select New Report. 

3 Select Trend Samples. 

4 Type a name for the report. 

5 Click Create. 

6 Select a Time Range from the drop-down list, then refine that option by selecting an option from the drop-
down list(s) to the right. 

7 Define the trend data. 

NOTES   

○ Calculate values for missing samples calculates a value based on the 2 closest values to the time 
interval. 

○ Find the closest sample displays the value closest to the time interval selected.  

8 Optional:  Select the Highlight alternate rows checkbox to make the report easier to analyze. 

9 Click Next or  next to Columns. 

10 Verify or change the report Title, Page units of measure for defining column widths, and Outer border 
characteristics. 

11 Select a column in the report preview.  

NOTE  The selected column is light purple. 

12 Under Column Header, define how you want the column header to look. 

13 Under Column Data, select the source of the trend data and how you want the data to look. 

NOTE  Select General from the Format drop-down list unless you want to define the number of places to the 
right of the decimal point for the displayed value. 

14 Optional:  Use the Add, Delete, and arrow buttons below the report preview to manipulate the columns. 

15 Optional:  Click  next to Page to change the page size and orientation. 

NOTE  Changing the size and orientation of the printed page also changes the report layout on the View tab.  

16 Click Accept. 

17 Click Run. 

NOTE  To run this report later, go to the location where the report was created. Click the Reports button drop-down 
arrow, select the report, then click Run. 
 

To edit or delete a custom report 

1 Select the item on the navigation tree where the report was created.  

2 Click the Reports button drop-down arrow, then select the report you want to edit or delete. 

3 Do one of the following: 

○ Edit the report, then click Accept. 

○ Click the Delete Report button, then click OK.  
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To save a custom report's design 

You can save the design of an Equipment Values report or a Trend Samples report for reuse in another location. 
Or, you can create a library of different report designs to pull from as needed. 

To save a report's design 
1 Create the Equipment Values (page 69) or Trend Samples (page 71) report. 

2 On the Reports > Design tab, click the Save Report Design button.  

NOTE  The .reportdesign file includes the report name. If you save multiple report designs in your system, 
each of those reports must have a unique name. 

To use the report design at a different location in the system 
1 Select the location in the navigation tree. 

2 Select Reports > New Report. 

3 In step 1, select Report design, then select the report name in the drop-down list. 

4 In step 2, type a report Name. 

5 In step 3, click Create. 
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Schedules 

Using schedules, your equipment can maintain one set of setpoints during occupied periods to provide 
comfort, and it can maintain a different set of setpoints during unoccupied periods to reduce energy 
consumption. Schedules are an i-Vu® system's most effective cost-saving strategy. 

In the User view, you can apply a schedule to a single tree item or to a group of tree items. 

 

When you apply a schedule to a tree item, the schedule affects equipment 
at and below the area or equipment where the schedule was added. 

 

When you apply a schedule to a schedule group, the schedule affects all 
pieces of equipment in the group. 

For example, a school board meets every third Tuesday of the month and 
uses the lobby, main conference room, break room, and restrooms. You 
can create a schedule group to control these different areas with a single 
schedule. 

  
NOTES   

• When multiple schedules affect a tree item, the net result is the Effective schedule (page 77). 

• Do not include preheating or precooling time in your schedules. Optimal Start (page 61), another cost-
saving strategy, automatically calculates and controls precise preheating and precooling routines.   
  

 

 
 

To view schedules 

1 Select a navigation tree item (site, area, or equipment). 

2 Click Schedules > View tab. 

3 Optional:  Click a white Effective bar to view all the schedules that contribute to the resulting schedule. If 
the item has multiple schedules, the schedule closest to the Effective bar has the highest priority. You 
set a schedule's priority when you create the schedule. 
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NOTES   

• When multiple schedules affect a single area or controller, the i-Vu® application sorts the schedules by 
priority - the higher the priority, the closer the schedule is to the bar. You set a schedule's priority when 
you add a schedule. 

• You can also view schedules on the following detailed, printable schedule reports. These reports are 
accessible from the Schedules page > Reports tab or from the Reports button drop-down menu. 

 

This report... allows you to... 

Schedule Instances Find every schedule with its location that is entered at and below a selected tree 
item. This report can help you discover newly added and conflicting schedules. 

Effective Schedules View all equipment that may be scheduled and the net result of all schedules in 
effect for a selected date and time. See Effective schedules (page 77). 

 

 
 

To print schedules 

1 Select a navigation tree item and click the Reports . 

2 Click Schedules > Schedule Instances or Effective Schedules. 

3 Click Run, then click PDF. 

 

This report... allows you to... 

Schedule Instances Find every schedule with its location that is entered at and below a selected tree 
item. This report can help you discover newly added and conflicting schedules. 

Effective Schedules View all equipment that may be scheduled and the net result of all schedules in 
effect for a selected date and time. 

 

 
 

To apply a schedule to equipment 

Schedules in the i-Vu® application are typically based on zone occupancy.  

1 In the User navigation tree, select the area or equipment you want to schedule .   

NOTES 

○ To schedule all equipment in a specified area, select the area you want. 

○ You can schedule individual controllers from the Installer view, but you must be in the User view to 
schedule areas and routers 

2 Click Schedules, then Configure tab. 

3 Click Add. 
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4 Select a Priority. A schedule's priority determines whether affected zones will use occupied or 
unoccupied setpoints. 
  

Select... For... 

Normal A typical occupied period 

Holiday An unoccupied period that overrides a Normal schedule 

Override An occupied period that overrides a Holiday schedule 

 

5 Select a Type. See table below. 

6 Type a schedule name in the Description field (50 characters maximum). 

7 Enter desired values in the fields below Description. 

8 On the graph, change a time segment's Start and End times by doing one of the following: 

○ Click the segment, then type the times in the Start and End fields. 

○ Click and drag either end of the segment or the entire segment.  

9 Optional:  Click Add Time Period to add one or more segments to the schedule. Or, select a segment and 
click Delete Time Period to delete that segment. 

10 Click Accept. 

  

Select this Type... To use the schedule... 

Weekly Every week on the specified days 

Date On a single, specified date 

Date Range Between 2 specified dates 

Date List On multiple, specified dates 

Wildcard According to a repeating pattern (For example, the second 
Tuesday of every month) 

Continuous Continuously between specified times on 2 separate dates 

Dated Weekly Weekly between a start date and an end date (For example, 
the summer break in the school year) 

 

NOTES   

• To automatically download all schedules that you create or change, click  > System Options > My 
Settings and, under Preferences, select Automatically download schedules on each change. If you want 
to manually download schedules, clear the Automatically download... field and then see Downloading 
system changes to controllers (page 145). 

• When you apply a schedule to an item on the navigation tree, the schedule affects that item and all 
children of that item. If you do not want an item to be affected by schedules from a higher level, select 
Ignore Schedules above this level on the Schedules > Configure tab. 
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To apply a schedule to a group of items 

You must create a group, then add members (areas, equipment, or other groups) to the group before you can 
apply a schedule to it. 

1 On the User navigation tree, select Scheduling Groups. 

Optional:  If you have created folders to organize your groups, select the appropriate folder. See "To 
organize groups using folders" below. 

2 Click Add Group. 

3 Type a name for the new schedule group in the Name field. 

4 Optional:  Change the default Reference name. A group's reference name must be unique throughout 
the system. 

5 Click Accept. 

6 Click Add Members to Group. 

7 On the Members page, select the areas, equipment, or other groups that you want to add to the group 
from the tree on the right. Use Ctrl+click, Shift+click, or both to select multiple items. 

8 Click Add. 

 TIP  Use the Raise and Lower buttons to reorder items in the Members list. Changing the order is for 
your viewing convenience and does not affect the system. 

9 Click Accept. 

10 You will see the question Execute download now?. Click OK. 

11 Click the Schedules button, then Configure. 

12 Add a schedule to the group. See To apply a schedule to equipment (page 74). 

  
To organize groups using folders 
You can create folders and sort your groups into them to organize the Schedule Groups tree. For example, a 
large school system that has a group for each school may want to create an Elementary School folder, a 
Middle School folder, and a High School folder, and put the appropriate groups in each folder. 

To create folders and add groups to them: 

1 On the User tree, select Scheduling Groups. 

2 Click Add Folder. 

3 Type a name for the new folder in the Name field. 

4 Optional:  Change the default Reference name. 

5 Click Accept. 

6 Repeat steps 1–4 for each folder that you want to add. 

7 Do one of the following to add a group to a folder: 

○ If you have already created the group, drag and drop it into the appropriate folder in the tree on the 
Scheduling Groups page, then click Accept. 

○ Select the folder in the tree on the Scheduling Groups page, then click Add Group to add a new 
group inside the folder. 

  
NOTE  You can also add a folder to a folder, or drag and drop a folder into another folder. 
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To edit or delete a schedule 

1 Do one of the following: 

○ On the navigation tree, select the tree item where the schedule was defined, then select Schedules 
> Configure tab. 

○ In the User tree, click Scheduling Groups, then select the group that has the schedule you want to 
edit or delete. 

2 Select the schedule you want to edit or delete. 

3 Edit the fields you want to change or click Delete. 

4 Click Accept. 

NOTE  Expired dated schedules are automatically deleted from the database at 3:30 AM every day. But 
expired schedules remain in the controller until the next time schedules are downloaded to the controller.  

 

 
 

Effective schedules 

The effective schedule that you see on the Schedules > View tab can be the result of multiple overlapping 
schedules. 
  

 
  

The following schedule features can influence an item's effective schedule. 

  

 Feature Description 

  
Hierarchy 

  
A schedule applied to an item on the i-Vu® tree affects that item and all of its children. A child item's 
combined schedule could be the result of multiple schedules applied at different levels above it. To 
change a child item's combined schedule: 

• Add a schedule at the child that overrides the current schedule. See the Priority feature below.  

• Set the child to ignore the parent schedules. To do this, select the child item on the tree, then go 
to Schedules > Configure. Select the schedule, then click Ignore Schedules above this level. You 
can then add a different schedule for the child. 

Any schedule change that you make to an item affects it and all of its children.  
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 Feature Description 

Priority You must assign one of the following priorities to every schedule. 
  

Use... For... 

Normal  A typical occupied period 

Holiday An unoccupied period that overrides a Normal schedule 

Override An occupied period that overrides a Holiday time 

 
EXAMPLE  For a school, you define: 

• A Normal schedule that has it occupied every Monday–Friday, 6 am–5 pm 

• A Holiday (unoccupied) schedule for the week of Spring Break 

• An Override schedule on the first day of Spring Break from 9 am–1 pm for the cafeteria only 
where a teacher's meeting will be held. 

Type You must assign one of the following types to every schedule.* 

Weekly 
Date 
Date Range 
Date List 

Wildcard 
Continuous 
Dated Weekly 

See To apply a schedule to equipment (page 74) for a description of each type. 

EXAMPLE  For a school, you define the following 3 schedules: 

• Full calendar year:  Normal, Weekly, Monday–Friday, 6am–5pm 

• Summer months:  Holiday, Continuous, 12am June 1st –11:59pm August 31st 

• Work days in summer months:  Override, Dated Weekly, Monday–Thursday, 9am–2pm 

  

Using the Priority and Type options, you can often accomplish the combined schedule you need in several 
different ways. For example, the combined schedule resulting from the 3 schedules described above for Type 
could also be accomplished with the following schedules: 

School year:  Normal, Dated Weekly, Monday–Friday, September 1st–May 31st, 6am–5pm 

Summer months:  Normal, Dated Weekly, Monday–Thursday, June 1st–August 31st, 9am–2pm 
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i-Vu® CCN schedules 

There are 2 types of CCN schedules: 
• 1 – 64 are local schedules that reside within the equipment   

• 65 – 99 are network or global schedules, which are sent over a CCN network and received by controllers 
that contain network schedules  

The i-Vu® application supports both local and global schedules.  

Most CCN equipment is shipped with the default schedule of 64. See exceptions below.  

Equipment i-Vu®'s default 
schedule number 

Comfort Controller/UC/Expansion Controllers 0 

Any controllers using a custom equipment file (*.equip) 
created with EquipmentBuilder 

0 

Gen III VVT, 48/50EJ (Conquest), FSM, CSM  1 
All PICs 64 

 CAUTION!  Confirm the actual schedule numbers that are used in the controller, as they may have been 
changed from their programmed default settings. 

In order to use i-Vu® schedules, the i-Vu® schedule number must match the CCN schedule number at the 
controller. This can be set in the i-Vu® interface by selecting the equipment in the navigation tree and clicking 
Schedules > CCN tab. It is also accessible at the area or site level. 

NOTE  To reduce start-up labor on a retrofit project, existing network schedules can be used by the i-Vu® 
application. However, switching to local schedules allows for schedule retention after a power failure and 
local schedule maintenance tables.  

If a controller uses a different schedule number, complete the following steps.  
CAUTION!  Failure to follow these steps may result in unexpected equipment operation. 

1 On the navigation tree, select the controller. 

2 Click the Schedules page, then CCN tab. 

3 Adjust the following fields: 

• Schedule number - enter the CCN schedule number in use at the controller.  

• Override time (optional) - enter the number of minutes of the desired override and verify that the 
controller override time is greater than or equal to this number 

• Override group - enter the number of the group, if you have established one  
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Alarms 

A message is sent from an alarm source to i-Vu® to notify you that certain conditions exist, such as a piece of 
equipment that has stopped running or a temperature that is too high. When i-Vu® receives an alarm, it 
displays information about the alarm on the Alarms page. i-Vu® can also perform alarm actions (page 85) to 
inform personnel of the condition. An alarm source can also send a return-to-normal message when the alarm 
condition returns to its normal state. 

 
Alarm sources and the alarms they generate are assigned to categories, such as HVAC Critical or HVAC 
Maintenance, to help you work with related alarms.  

The application engineer usually sets up alarm sources in the Snap application. In the i-Vu® interface, you 
can: 

• View, troubleshoot, acknowledge, and delete alarms  (page 81) 

• Set up the alarm actions that the i-Vu® application performs (page 85) 

• Edit alarm sources that were set up in the Snap application or set up new alarm sources to generate 
alarms (page 90) 

NOTE  In addition to the alarms that you set up, i-Vu® has built-in system and equipment alarms.  
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Viewing, acknowledging, and deleting alarms 

The i-Vu® Alarms page displays alarms as they are received. If desired, an operator can set options on  
> System Options > My Settings tab to have the i-Vu® application play an audio file when an alarm is 
received. 

An alarm's setup may require that it be acknowledged and/or the alarm condition returned to normal. The 
alarm, its return to normal, and any other alarms related to the incident are referred to as an alarm incident 
group. The i-Vu® application closes an alarm incident group when all of the following have occurred: 
• You acknowledge the alarm (if required) 
• The i-Vu® application receives a return-to-normal (if required) 
• The i-Vu® application performs all alarm actions defined for the group 
You should delete alarms from your system as they are closed because large quantities of stored alarms can 
reduce the efficiency of your system. 

NOTE  The Installer view does not display all alarms on the system or site level, only on the router and 
controller level. Go to the User view or click the system-wide alarms button to see all of the alarms in the 
system.  

The color of the system-wide alarms button signifies one of the following conditions: 

•   Red  - Critical alarms need to be acknowledged. 

•   Yellow - Non-critical alarms need to be acknowledged. 

•  Grey - No alarms need to be acknowledged. 
You must acknowledge alarms that have been set up to require acknowledgement. Right-click alarm message 
to print. To save alarm information before deleting, select Alarms > Reports tab > Alarms > click Run button. 

 

 
 

To view alarms in the i-Vu® interface 

• Click  at the top of the page to see all alarms in the system.  

or 

• Click the Alarms button and then select an item on the navigation tree to see all alarms at and below 
that level.  
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NOTES   

• Alarms generated by the i-Vu® application appear at the system level. 

• Alarms generated by controllers appear at the system level in the User view. 

• An alarm's details include a path to the alarm source. Each section of the path is a link to that location. 
For example, in the path West TEMP LO at Router 41/Sunshine Corp, TEMP LO links to the microblock's 
Properties page, and Sunshine Corp links to the Sunshine Corp West Wing graphic, TEMP-LO links to the 
equipment graphic.  
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To control which alarms you see 
   

Use these tools... To control the Alarms list 

 

Click the arrow buttons to display other alarms. 

 
  

Type a date and time or click  to select a date. Then 
click Go to show up to 50 alarms since that date/time. 

When finished, click  to display the 50 newest alarms 

or  to display the oldest 50 alarms. 
  

 

Date–Sorts list by date/time the alarms were generated 
with the most recent at the top. 
To Do–Shows only alarms that require one or more actions 
before they are closed. 
Incident Group–Sorts alarms by incident. For example, an 
alarm and its return-to-normal form an incident group. 
Brackets indicate a group. 

 
  

 
  

Select the alarm categories that you want to see in the 
alarms list. Use Ctrl+click, Shift+click, or both to select 
multiple categories, or check Show all categories. 
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To acknowledge alarms 
You must acknowledge alarms that have been set up to require acknowledgment. An alarm shows if it needs 
to be acknowledged. 

 
  

The table in the upper left corner of the page shows how many alarms need acknowledgment at the current 
location (Here) and in the entire system (Total). This table also shows how many alarms need a return-to-
normal and how many are closed.  

 
  

To acknowledge an alarm 
1 On the Alarms page > View tab, select the checkbox of an alarm that shows Acknowledge. 

2 Click the Acknowledge button. 
  

To acknowledge all alarms in the alarms database for selected categories 
1 On the Alarms page > View tab in the left-hand column, select the categories whose alarms you want to 

acknowledge.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox. 

2 Click Advanced. 

3 Click Acknowledge All. 

 TIP  Acknowledging many alarms simultaneously can take a long time. Acknowledge alarms as they occur 
to avoid long waits.  

 

 
 

To delete alarms 
You should delete alarms from your system as they are closed because large quantities of stored alarms can 
reduce the efficiency of your system. To save alarm information before deleting, select Alarms > Reports tab 
> Alarms, then click the Run button. 
  

To delete an alarm 
1 On the Alarms page > View tab, select an alarm's checkbox. 

2 Click Delete under Manage List. 
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To delete all alarms in the alarms database for selected categories 
1 On the Alarms page > View tab, click Filter View at the bottom of the page. 

2 Select the categories whose alarms you want to delete.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox. 

3 Click Advanced. 

4 Click Delete All. 
  

To delete all closed alarm incident groups in the alarms database 
An incident group is all alarms related to a particular incident. For example, an alarm and its return-to-normal 
form an alarm incident group. An incident group is considered closed when all alarms in the group are closed. 

1 On the Alarms page > View tab, click Filter View at the bottom of the page. 

2 Select the categories whose alarms you want to delete.  

NOTE  Use Ctrl+click, Shift+click, or both to select multiple categories, or select the Select All checkbox. 

3 Click Advanced. 

4 Click Delete Closed Incidents. 
  

NOTE  An alarm source may be set up to generate an alarm and a return-to-normal. If an alarm occurs but the 
i-Vu® application never receives the return-to-normal, you can select the alarm and then click Force Normal 
so that the alarm can be closed. Force Normal has no effect on the alarm condition that generated the alarm. 

 

 
 

To receive audible notification of alarms 
You can set up the i-Vu® application to play an audio file on your workstation when it receives a critical or 
non-critical alarm.  

1 Click , then select System Options > My Settings. 

2 Under Preferences, select Non-critical alarms or Critical alarms to be notified of them.  

 

 
 

Setting up alarm actions 

Alarm Action - An action that the i-Vu® application performs to notify personnel of an alarm or to record 
information about the alarm. You can assign alarm actions to an alarm source, a category of alarm sources, 
alarm sources from a certain location, or a combination of these criteria.  

To assign alarm actions to alarm sources: 
Although you can assign an alarm action to an individual alarm source, you typically assign an action to 
multiple alarm sources at the area or equipment level. The alarm action applies to all instances of the alarm 
sources at the selected location and below. Click an action’s Edit button to make any changes. 
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To assign an alarm action to alarm sources: 

1 On the navigation tree, select the area or equipment, containing the alarm sources. 

2 Click Alarms > Actions tab and follow the 3 steps on the screen. 

NOTE  Use Ctrl+click, Shift+click, or both to select multiple items.  

3 Click Add. 

4 Set up the alarm action by editing the fields on the alarm action page. See the appropriate alarm action 
below for field descriptions. 

5 Click OK. 

 

 
 

Alarm Popup 
The Alarm Popup alarm action pops up a message on any computer with a Windows operating system that is 
running the i-Vu® Alarm Notification Client application. 
  

Field Notes 

To Operator 
To Group 

Select individual operators or operator groups who should receive alarm notification. 

Generate alarm if delivery 
fails 

Select this checkbox to generate a System Info alarm if the popup recipient is not 
currently running the Alarm Notification Client application. 

Message text Use punctuation, spaces, or returns after the entries to format the text. 
To add live data to the text, select field codes (page 94) from the Append Field Code list. 

Append Field Code Add field codes (page 94) to the message text if desired.  

Perform Action By default, the i-Vu® application performs an alarm action when the alarm source 
generates an alarm and when it returns to normal. Under Perform Action, you can 
choose to run the alarm action only when the alarm source generates an alarm or 
when it returns to normal. 

 

Using the Alarm Notification Client application 
The Alarm Notification Client application must be running on each client computer (Windows only) that should 
receive popup notifications. Keep the application minimized to the right side of the Windows task bar. The 
window will pop up with a message when an alarm occurs. 

NOTE  To use the i-Vu® Alarm Notification Client application across a firewall, you must open UDP port 
47806. 

Select an alarm message, then click  to open i-Vu® displaying the piece of equipment that generated the 
alarm. A grayed out alarm indicates that it was acknowledged in the i-Vu® interface. 

If the Alarm Notification Client is set up to play a continuous alarm sound, you can silence an alarm by 
clicking Silence!, by pressing Ctrl+S, or by acknowledging the alarm in the i-Vu® interface. 
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Button Notes 

 Opens the i-Vu® interface displaying the equipment that generated the alarm. 

 
Copies the selected alarm information to the clipboard. 

 
Removes the alarm information from the alarm popup list. Removing items from this list has no 
effect on the alarms list in the i-Vu® interface. 

 View information about the server connection. 

 
On this tab... You define... 

 Server Connection The i-Vu® web server and port, and the i-Vu® operator name and password 

 Browse To The i-Vu® page that you want to see first when browsing to the equipment 

 Notification 
Sounds 

• If you want to hear a sound when an alarm occurs 

• Which sound you want to hear for each type of alarm.  
NOTE  A Connection Failure occurs when the Alarm Notification Client 
loses communication with the i-Vu® application.  

• Whether you want the sound to continue until silenced 

NOTE  If multiple types of alarms occur simultaneously, the application plays 
the sound of the most critical alarm (Connection Failure first, then Critical, 
then Normal). 

 

To set up the i-Vu® application to support Alarm Popup clients 

1 Click , then select System Options > General tab, and then select Enable support for Alarm 
Notification Clients to connect to this server. 

2 Leave Restrict to IP Address field blank. 

3 Use the default port.  

4 Click Accept. 

NOTE  If the Alarm Notification Client application is not on the local network and will access i-Vu® alarms 
through a NAT router, your Network Administrator must port forward the TCP port you defined in step 3 above. 
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To install the Alarm Notification Client application 
Follow the steps below on each client computer that should receive alarm popups. 

PREREQUISITE  You must enable Alarm Popup support in System Options > General tab. See above topic. 

Click , then select System Options > General tab, and then check Enable support for Alarm Notification 
Clients to connect to this server. 

1 Install software from your Tech Tools DVD. 

2 Click Alarm Popup Application. 

3 Click Run, then follow the on-screen instructions to install the Alarm Notification Client application. After 
you click Done, the application starts automatically.  

NOTE  To locate your applicable IP address, look in the Management Tool. 

4 In the Settings dialog box, enter appropriate values. You can also click  to open this box. See the table 
above for a description of each setting.  

NOTE  You can lock the Settings so that a user cannot edit them. See To lock a client's Settings feature 
below. 

5 Click OK. 

6 Minimize the Alarm Notification Client window. 
  

To lock a client's Settings feature 

To prevent a user from editing the Settings  :  

1 Right-click Alarm Notification Client in the Windows Start menu. 

2 Select Properties.  

3 On the Shortcut tab, type -lockconfig at the end of the Target path. 

 
 

 

 
 



 Using schedules, alarms, trends, and reports  
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 89 

 

Send E-mail 
The Send E-mail alarm action sends a message to one or more e-mail accounts. The alarm action can also 
run a report and attach it to the e-mail as a PDF, HTML, or XLS file. 
     

Field Notes 

To Type the address(es) that you want to send the alarm to. To enter multiple addresses, 
type a space or press Enter after each address. 

From Enter a valid address if required by your mailserver. 

Mail Host The mailserver's address. This can be an IP address or a system name, such as 
mail.mycompany.com. 

Mail Host Port Change this field if using a port other than the default port 25. 

Mail Host Security Options Select the type of security the mailserver uses. 

• Cleartext – Uses the SMTP protocol to send as clear text over TCP/IP 

• Secure SSL – Uses SSL, a communication protocol that provides data encryption 

• Secure TLS – Uses TLS, but does not begin encryption until the i-Vu® application 
issues STARTTLS command 

Specify Mail User For Mail 
Host Authentication 

Select if your mailserver requires a username and password. 

Send mail as MIME 
attachment 

Select if your mailserver allows only MIME attachments. 

Message Text Use punctuation, spaces, or returns after the entries to format the text. 
To add live data to the text, select field codes (page 94) from the Append Field Code 
list. 

Attach Report Select to attach a report to the e-mail, then select the Report and the Format. The 
attached report will include the date and time. For example, Alarm Sources 2012 Jan 
01 1230. 

NOTE  The Report Name field shows a custom report only if it was created at the 
current system level. 

Run as shows the name and login name of the operator creating the alarm action. The 
report will be run using the privileges and report options of this operator. 

 TIP  You may want to create a new operator with limited privileges for this 
purpose. 
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Field Notes 

Perform Action By default, the i-Vu® application performs an alarm action when the alarm source 
generates an alarm and when it returns to normal. Under Perform Action, you can 
choose to run the alarm action: 

• Only when the alarm source generates an alarm or when it returns to normal. 

• After a specified amount of time if the alarm has not been acknowledged or has 
not returned to normal. Use this option for alarm escalation.  

• If the alarm occurs during the occupied hours defined for a schedule group or run 
if the alarm occurs during the unoccupied hours defined for a schedule group.  
EXAMPLE  To have one alarm action performed during work hours and a different 
alarm action performed after work hours: 

1. Create a schedule group (page 76), but do not assign members to it.  

2. Create a schedule for the group. Set the occupied hours to be the same as 
the work hours. 

3. Create the alarm action that is to be performed during work hours. Under 
Perform Action, select If schedule group <your new group> is Occupied. 

4. Create the alarm action that is to be performed after work hours. Under 
Perform Action, select If schedule group <your new group> is Unoccupied. 

 

  
NOTE  You should not assign this alarm action to frequently-occurring alarms as this may cause problems on 
your network or the Internet. 

 

 
 

Setting up an alarm source in the i-Vu® interface 

In the i-Vu® interface you can: 

• Edit an alarm source’s settings or set up a new alarm source to generate alarms. 

• Select Properties page > Alarm Sources tab to set up all alarms associated with a particular piece of 
equipment 

• Simulate an alarm to test its setup. 

 

  
 

To set up, edit, or disable alarm sources 

To set up, edit, or disable a single alarm source 
1 On the navigation tree, select the control program. 

2 Click Alarms, then select the Enable/Disable tab. 

3 Make changes to the fields as needed. The fields can vary for different types of alarm sources. See table 
below. 

4 Click Accept. 
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 TIP  To set up all the alarms for a piece of equipment at once, click Properties, then select Alarm 
Sources. 
  

Field Notes 

Potential alarm source Check to enable the alarm source to generate alarms. Uncheck to disable the alarm 
source. 

Alarm enabled Check to have the alarm source generate an alarm when the specified conditions 
occur.   

• For a binary input, enter the conditions for generating an alarm. 

• For an analog input, type the low and high limits that, when exceeded, will 
generate an alarm.  
 

Deadband  The amount inside the normal range by which an alarm condition must 
return before a return-to-normal notification is generated. 

EXAMPLE 

 
NOTE  If the Status checkbox is selected, the alarm condition currently exists. 

Return to Normal Check to have the alarm source generate a return-to-normal when the alarm 
condition returns to a normal state. 

Alarm requires 
acknowledgement 

Check to have the i-Vu® application require that an operator acknowledge the 
alarm. 

Return requires 
acknowledgement 

Check to have the i-Vu® application require that an operator acknowledge the 
return-to-normal. 

Classified as critical This property determines the color of the system-wide alarm button when the alarm 
comes in. 

 = Critical       = Non-critical 

Event State The current state of the alarm source can be: 
• Normal—value is normal 
• Off normal—the value is not normal (binary only) 
• Fault—the alarm source microblock may be misconfigured 
• High Limit—the value exceeds the normal range (analog only) 
• Low Limit—the value is below the normal range (analog only) 

BACnet 
Configuration: 
  

Dial on alarm 

 N/A  
 

Notification Class Do not change this field. 
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To set up, edit, or disable multiple alarm sources simultaneously 
1 On the navigation tree, select the area, equipment, or controller containing the alarm sources.  

2 Click Alarms, then select the Enable/Disable tab. 

3 In step 1, select the categories that contain the alarm sources. 

NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or select the Select 
All checkbox. 

4 In step 2, select the alarm sources. 

5 Make appropriate changes in step 3. 

6 Click Accept. 

NOTE  Click View Selected Sources to view or change settings for each alarm. 

 

 
 

To view all instances of an alarm source 
To find all instances of an alarm source at and below a selected area: 

1 On the navigation tree, select an area. 

2 Click Alarms and select the Actions, Enable/Disable, or Category tab. 

3 Select an alarm source from the list in step 2. 

4 Click View Selected Sources. 

NOTE  You may be able to change settings that relate to the tab you selected. 

 

 
 

To simulate an alarm 
To test the setup of an alarm source and its alarm actions (page 85), you can simulate an alarm or its return-
to-normal. 

1 On the navigation tree, select the alarm source whose alarm you want to simulate. 

2 Click Properties > Alarm Sources tab. 

3 Click on an alarm point that is labeled as (BALM) or (CALM) and is enabled as a Potential Alarm Source 
(fifth column from the left). 

4 In the dialog box that opens, select Alarms and then the Enable/Disable tab. 

5 Check Enable next to Alarm or Return to Normal. 

6 Click Simulate next to Alarm or Return to Normal. 
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7 Click Accept. 

 
 

8 Select the controller on the navigation tree, then select the Alarms > View tab to see the alarm. 

 

 
 

Alarm categories 
Alarm categories sort related alarm sources and their alarms into groups such as HVAC Critical and Access 
Control General. Alarm categories let you: 

• View, acknowledge, or delete selected categories of alarms (page 81) received by the i-Vu® application 

• Assign alarm actions (page 85) to selected categories of alarm sources  

• Set up alarm sources (page 90) in selected categories 

You can change the category assignment in the i-Vu® application.  

To assign alarm sources to a different category  
1 On the navigation tree, select the area, equipment, or controller containing the alarm sources. 

2 Click Alarms, then select the Category tab. 

3 In step 1, select the category that currently contains the alarm sources. 

NOTE  In step 1 and step 2, Ctrl+click, Shift+click, or both to select multiple items, or check Select All. 

4 In step 2, select the alarm sources whose category you want to change. 

5 In step 3, select a category from the drop-down list, then click Change. 

6 Click Accept. 
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Edit alarm messages 

To edit the message for an alarm source 
1 On the navigation tree, select the controller. 

2 Select Properties > Alarm Sources tab and double-click the underlined name of point to open the 
microblock popup. 

3 In the dialog, select Alarms > Messages tab. 

NOTE   Sample Alarm Message and Sample Return Message show the messages as they are currently 
defined. 

4 Enter the edited message you want to appear in the field for Alarm or Return. You can add live data to 
the text by selecting field codes (page 94) from the Append Field Code list. 

5 Click Accept. 
  

 

 
 

Using field codes 

Use field codes to insert live data into:  

• The message on an alarm action  

• Text displayed on the Alarms page > View tab 

• Alarm information archived to a text file when an alarm is deleted 

You can customize the setup of each of these items by appending field codes. For example, to have the 
message in an alarm action include the device that generated the alarm, append the Device field code to the 
action's message.  

 

 
 

Formatting field codes 
You can type a formatting command after a field code to format the field code in one of the following 3 ways:  

• Format a number field code (Example: ##.##)  

• Format a date/time field code (Example: MM/dd/yyyy hh:mm:ss)  

• Left, right, or center align a field code and set the field width 

A formatting command must have the following syntax: 

 
Use the table below to determine the format_type and style for a formatting command. 

 

  format_type   style 
Example 
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To format a 
number 

N  The actual formatting, such 
as ##.##. The basic format 
uses the pound sign (#) to 
represent a number. For 
more information, search 
the Internet for "customizing 
number formats with java". 

To always truncate a setpoint 
value to two digits to the right of 
the decimal, the field code is: 
$setpoint_value%N:##.##$ 
For example, 78.9935 becomes 
78.99. 

To format 
date/time 

D  The actual formatting, such 
as MM/dd/yyyy hh:mm:ss. 
For more information, 
search the Internet for 
"customizing date time 
formats with java".  

To show the date and time when 
an alarm is generated in a format 
like 03/15/2004 10:50:43, the 
field code is: 
$generation_time%D:MM/dd/yyyy 
hh:mm:ss$  

To set alignment 
and field width  

L for left align 
R for right align 
C for center align  

Indicate the field width by 
number of characters. 

To left align the name of the 
device that generated the alarm 
and set the field width to 15 
characters, the field code is: 
$device%L:15$ 

 

Using multiple formatting commands  
You can type multiple formatting commands for a field code. For example, you can format a number and then 
set the alignment and field width. The syntax for multiple formatting commands is:  

$fieldcode%format_type1:style%format_type2:style$  

EXAMPLE  To format the alarm date and time, center it and set the field at 20 characters, the field code is: 
$generation_time%D:MM/dd/yyyy hh:mm:ss%C:20$  

NOTE You must enter the date/time or number formatting command before the alignment/field width 
command. 

 

 
 

Field Codes 
  

Field Code Name Field Code Description 

Acknowledge 
Operator 

$acknowledge_operator$  The operator who acknowledged the alarm.  
EXAMPLE  John Doe 

Acknowledge Time  $acknowledge_time$  The time when the operator acknowledged the alarm.   
EXAMPLE  Nov 12, 2012 6:46:31 PM 

Alarm Category  $alarm_category$  The alarm category that the alarm is assigned to.  
EXAMPLE  HVAC Critical 

Alarm Priority  $alarm_priority$ The priority number associated with the alarm's priority 
(Off-Normal, Fault, or Normal) on the controller's Driver > 
Notification Class page. 

Alarm Type  $alarm_type$  The alarm type of the alarm source.  
EXAMPLE  CHANGE OF STATE 
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Field Code Name Field Code Description 

Character $c$ A single ASCII character. Often used for form feeds and 
other printer escape sequences. 
EXAMPLE  $C:65$ displays A 

Command Value $command_value$  The commanded value from the alarm source. Valid only 
for alarm type COMMAND FAILURE.     
EXAMPLE  3 

Control Program $equipment$  The display name of the equipment where the alarm 
came from.   
EXAMPLE  Chiller 

Controller $device$  The display name of the device where the alarm came 
from.   
EXAMPLE  UPC Open 

Dead Band  $deadband$  The deadband value from the alarm source. Valid only for 
alarm type OUT-OF-RANGE. 
EXAMPLE  5 

Deletion Operator  $deletion_operator$  The operator who deleted the alarm.   
EXAMPLE  John Doe 

Deletion Time  $deletion_time$  The time the alarm was deleted.   
EXAMPLE  Nov 12, 2012 6:46:31 PM 

Error Limit  $error_limit$  The error limit, from the alarm source. Valid only for alarm 
type FLOATING LIMIT.   
EXAMPLE  90 

Event Values $event_values$ Returns a string of alarm values associated with the 
alarm.    

Exceeded Limit  $exceeded_limit$  The exceeded limit value from the alarm source. Valid only 
for alarm type OUT-OF-RANGE.   
EXAMPLE  90 

Exceeding Value  $exceeding_value$  The exceeding value from the alarm source. Valid only for 
alarm type OUT-OF-RANGE.   
EXAMPLE  91 

Fault  $fault$  The status of the fault condition from the alarm source.   
EXAMPLE  True or false 

Field Message  $field_message$  Text generated in the alarm by the controller.   

Feedback Value $feedback_value$  The feedback value from the alarm source. Valid only for 
alarm type COMMAND FAILURE.   
EXAMPLE  10 

From State  $from_state$  The previous state of the alarm source.   
EXAMPLES  NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, 
LOW LIMIT 

Generation 
Operator 

$generation_operator$  The operator who forced the alarm to return to normal.   
EXAMPLE  John Doe 

Generation Time  $generation_time$  The time in the controller when the alarm was generated.   
EXAMPLE  Nov 12, 2012 6:35:18 PM 

In Alarm  $in_alarm$  The in alarm status from the alarm source.   
EXAMPLE  True or false 
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Field Code Name Field Code Description 

Incident Closed 
Time 

$incident_closed_time$  The time the alarm's entire incident group closed.  
EXAMPLE  Nov 12, 2012 6:46:31 PM 

Location Path  $location_path$  Displays the path display names from root to source.  
EXAMPLE  Building B / Basement / VAV AHU B / 
SSP_STOP 

Long Message  $long_message$ The formatted alarm long text displayed by double-clicking 
the alarm on the Alarms page.     

Message Details $message_details$ The message details displayed on the Alarms page View 
tab.    

Message Prefix $message_prefix$ The message prefix displayed on the Alarms page View 
tab.    

Message Text $message_text$ The message text displayed on the Alarms page View tab. 
   

New State  $new_state$  The status of new state from the alarm source. Valid only 
for alarm type CHANGE OF STATE. 
EXAMPLE  Alarm, Fault 

New Value  $new_value$ The new value from the alarm source. Valid only for alarm 
type CHANGE OF VALUE.   
EXAMPLE  70 

Notification Class $notification_class$ The notification class assigned denotes how the received 
alarm was generated. For example, if set to 1, the alarm 
would typically be sent to i-Vu® by Carrier controllers.    

Object ID  $object_ID$  Object ID of the alarm source.   
EXAMPLE  5:26 

Out of Service  $out_of_service$  The status of 'out of service' from the alarm source.   
EXAMPLE  True or false 

Overridden  $overridden$  The status of 'overridden' from the alarm source.   
EXAMPLE  True or false 

Program ID  $program_id$  The address of the control program that generated the 
alarm. 

BACnet program address format: 
device ID, program number  
EXAMPLE  2423101,1 

Receive Time $receive_time$  The time at the workstation when the alarm was received.   
EXAMPLE  Nov 12, 2012 6:46:31 PM 

Recipient Device 
ID  

$device_id$ The device ID of the device where the alarm came from.  
EXAMPLE  8:2423101 

Reference Path  $reference_path$  Path to alarm source. Available in all alarm actions.  
EXAMPLE  #e_b_vav_ahu_b/ssp_stop 

Reference Value  $reference_value$  The 'reference value' from the alarm source. Valid only for 
alarm type FLOATING LIMIT.   
EXAMPLE  83 
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Field Code Name Field Code Description 

Referenced 
Bitstring 

$referenced_bitstring$  The value of the 'referenced bitstring' value from the 
alarm source. Valid only for alarm type CHANGE OF 
BITSTRING.   
EXAMPLE  1011011101101 

RTN Time $RTN_time$  The time when the alarm returned to normal.  
EXAMPLE  Nov 12, 2012 6:46:31 PM 

Setpoint Value $setpoint_value$  The 'setpoint value' from the alarm source. Valid only for 
alarm type FLOATING LIMIT.   
EXAMPLE  72 

Short Message $short_message$  The formatted alarm short text.     

Site  $site$  The display name of the site the alarm came from.   
EXAMPLE  Kennesaw 

Source  $source$ The display name of the alarm source microblock that 
generated the alarm.   
EXAMPLE  SAT_HI 

Source description  $source:description$  The Description field of the alarm source microblock that 
generated the alarm.  
EXAMPLE  High Cooling Supply Air Temp 

Source Path $source:<path>$  Substitute <path> with the path to the value your want to 
display. See Defining i-Vu® paths (page 172). 

Example to add text value: 
$source:~equipment.display-name$ 

NOTE  You can use Global Modify (page 50) to get the 
path. 

System Directory  $system_dir$  i-Vu® Pro only: 

The system folder name.   
EXAMPLE  c:\<i-Vu_Pro_>x.x\webroot\ world_corporation 

To State $to_state$ The current state of the alarm source.  
EXAMPLES  NORMAL, FAULT, OFF NORMAL, HIGH LIMIT, 
LOW LIMIT 
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Trends 

The i-Vu® system can read and store equipment status values over time and then display this information in 
a trend graph to help you monitor the equipment’s operation.  

 
You can collect trend data for any point value in the i-Vu® system. The controller reads point values at 
intervals that you define and then stores that data in the controller for up to 7 days . A controller has limited 
memory for storing trend data, so you can set up historical trending to archive the trend data from the 
controller to the database.  

A trend graph can display data from the controller and the database, or it can display only data stored in the 
database. 

When the storage capacity of your system is running low from too much historical trend data, you will receive 
an error message. To create more storage space, go to the Management Tool (page 32) and click Compress 
System. 

After you set up the desired points for trend data collection (page 100), you can:  
• View built-in trend graphs that show a single point (page 101) 
• Create custom trend graphs with multiple points (page 102)  
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To collect trend data for a point 

Before you can see a point's trend graph, you must enable trending for that point and then define how you 
want the controller to collect the point's data. This can be done in Snap or you can do it in the i-Vu® interface 
using the instructions below. 

NOTE  I/O microblocks have trending capability built-in, and you enable trend logging in the I/O microblock. 
Any other microblock value must have a trend microblock attached in the control program, and you enable 
trend logging of the value in the trend microblock.  
  

To set up a point's trending in the i-Vu® interface: 

1 On the navigation tree, select the equipment that has the point you want to trend. 

2 Click the Trends button drop-down arrow, select Disabled Points, then select the point. 

3 Click the Enable/Disable tab, then select Enable Trend Log to have the controller collect trend data. 

4 Enter information in the appropriate fields. See table below. 

5 Click Accept. 

 TIP  You can set up all trends for a piece of equipment at once on the Trend Sources tab of the 
equipment's Properties page. 

  

Field Notes 

Sample every _:_:_ (hh:mm)  Records the point’s value at this interval. 

NOTES  

• Set this field to one minute or greater. 

• This setting should be longer than the CCN bus poll interval. To 
determine the poll interval: 

1.  In the Installer tree, right-click the device polling the CCN 
     controller, and then select Driver Properties. 
2.  Go to Protocols > CCN. 
3.  Scroll down to the Program Status heading. 
4.  In the first row of the table, subtract the third column  
     value from the fourth column value to get the poll interval. 

Sample on COV 
(change of value) 

This method records the point’s value only when the value changes by at 
least the amount you enter in the COV Increment field. 

NOTE  Use this method for a binary point or for an analog point that has 
infrequent changes in value. 

Enable Trend Historian  Archives trend data to the system database. 

Store Trends Now Writes all trend data in the controller to the system database without having 
to enable trend historian. 
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Field Notes 

 Keep trends for _ days Enter a number between 1 and 62 in this field to override the default number 
of days that trends for this point are stored. The trend storage default settings 
are:  

• 62 days of override trends stored to accommodate Tenant Override 
Billing (available for i-Vu Plus only) 

• 7 days of all other system trends stored  

NOTE  Saving more than 62 days will affect system performance and could 
result in alarm messages instructing you to compress trend storage in the 
Management Tool (page 32). You can also create more space by using the 
next option Delete trend samples. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet 
object. Although the Object Name field can be edited, it is not recommended. 
The Notification Class is set to 1 to receive alarms generated by Carrier 
controllers. 

  
NOTE  Run a Trend Usage report (page 64) to view trend data. 

 

 
 

Viewing a built-in, single-point trend graph 

1 On the navigation tree, select the equipment whose trend you want to view. 

2 Click the Trends button drop-down arrow, select Enabled Points, and then select the graph you want to 
view. 

3 Select the View tab. See Using trend graphs (page 104). 

  
NOTE  On the Configure tab, you can: 
• Enable/disable the grid. 
• Set the time range for the X axis. For example, enter 7 days to see the data for the last week. 
• Turn off autoscaling so that you can define a range for the Y-axis 
• Type a Y-axis label that will appear on the right side of the graph. 
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Creating a custom trend graph 

When creating a custom trend graph, you can select up to 16 points. If you select more than 4 points or 
points with different units, the i-Vu® application splits the data into subgraphs. Each subgraph can show a 
maximum of 4 points with similar units.  

 
  
NOTE  You must enable trending for points that you want to include in the custom trend graph. See To collect 
trend data for a point (page 100). 

 
 

To create a custom trend graph 
1 On the navigation tree, select the area or equipment where you want to see the graph. 

2 Click the Trends button drop-down arrow, then select New Trend Graph. 

NOTE  If the Trends button does not have a drop-down arrow, the New Trend Graph page is already 
displayed. 

3 In the tree on the New Trend Graph page, use Ctrl+click or Shift+click to select the points (16 maximum) 
that you want to see on a graph.  

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 
100). 

4 Click Save. 

5 Type a Name for the graph that will appear at the top of the graph and in the Trends button drop-down 
list. 

6 Click OK.  

7 Select: 

○ The View tab to see the custom trend graph. See Using trend graphs (page 104). 

○ The Configure tab to edit the trend graph. See To edit a custom trend graph (page 103). 
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To edit a custom trend graph 
1 On the navigation tree, select the area or equipment where you created the graph. 

2 Select the Trends > Configure tab. On this page, you can: 
• Change the name of the custom trend graph 
• Enable/disable the grid 
• Set the time range for the X axis 
• Edit a subgraph's Y-axis label that will appear on the right side of the graph 
• Turn off autoscaling so that you can define a range for the Y-axis 
• Add/delete subgraphs (see instructions below) 
• Add/delete points (see instructions below) 
• Change a point's name on the graph 
• Change a binary point's active/inactive text on the graph 
• Click Delete Trend Graph to delete the entire custom trend graph 

  

To add a subgraph to a custom trend graph 
1 Click Add below the Subgraphs list. 

2 Type a Y-axis label. 

3 Click Add below the Points list. 

4 Select a point in the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 
100). 

5 Repeat steps 3 and 4 to add up to 4 points to the subgraph. 

6 Click Accept. 

NOTE  To delete a subgraph, select it in the Subgraphs list, click Delete below the list, and then click Accept. 
  

To add a point to a subgraph 
1 Select the subgraph in the Subgraphs list. 

2 Click Add below the Points list. 

3 Select a point from the Data source tree. 

NOTE  The tree shows only points that have trending enabled. See To collect trend data for a point (page 
100). 

4 Click Accept. 

NOTE  To delete a point, select the appropriate subgraph, select the point, click Delete below the Points list, 
and then click Accept. 
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Using trend graphs 

 
  

 NOTES   

• A gray triangle at the top of a graph indicates a note from the system. Hover your cursor on the triangle to 
see which of the following occurred: 

○ Equipment received a time synchronization from its network router or from the i-Vu® application.  

○ Trend Historian has been enabled or disabled.  

○ Trend Log has been enabled or disabled. 

○ The trend object ID of a third-party trend source has been changed. For information only, you do not 
need to do anything. 

• Click  at the top of the i-Vu® page to print the graph. You may need to set your printer's orientation 
to Landscape. 

• Toolbar options are also accessible by right-clicking a trend graph. 

• You can check Display gap in graph line for missing data on an individual trend graph page, or you can 
go to the System Settings (or System Options) > General tab (page 30) to set this for all future trend 
graphs. 
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To view trend data in a spreadsheet program 
You can save trend data as csv data that you can open in a spreadsheet program such as Microsoft® Excel®. 

1 On the Trends > View tab, select  > Save as CSV data. 

2 Save the data (.zip file) wherever you want. The .zip file contains the following: 
• A .csv file for each trend source (point). The filenames match the point names. 
• A Combined folder containing a file with the combined data for all of the graph's trend sources. 

3 Open the .csv file in a spreadsheet program. 

  
NOTES 

• You will need to convert the data in the spreadsheet's Time column to a readable date/time format. 

• If you use Microsoft® Excel® on a Mac and the converted date shows the wrong year, do the following: 

1. In Excel, go to File > Options > Advanced. 

2. Scroll down to the section When calculating this workbook, and then uncheck Use 1904 date 
system. 
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Setting up i-Vu® Open devices in the i-Vu® application 

From the system level in the navigation tree, select Devices page > Manage tab to:   

• Search the network to populate the system with Open routers and controllers (page 106) 

• Upload control programs, drivers, graphics, and touch files (page 106) 

• Build, edit, and arrange the navigation tree for the User view (page 148) 

• Perform downloads to individual or multi-selected controllers (page 145)  
 

Find and upload i-Vu® Open routers and controllers 

1 Select the system level in the navigation tree.  

2 On the Devices page > Manage tab, click Find Devices to discover your routers. 

3 Once routers are found, select one router at a time in the left-hand navigation tree and click Find Devices 
again.  

4 Once controllers are found, you must upload content to the routers and controllers. Select one or more 
devices in the list on the Manage tab and click Upload All Content to upload drivers, graphics, touch 
files, and control programs to the i-Vu® application. Use Ctrl+click, Shift+click, or both to select multiple 
items. 

NOTE  If Show Control Programs is checked, all control programs are listed. If you have multiple control 
programs in one controller, you will see every control program in the list. If it is not checked, the list only 
shows the individual controllers and their model. The same information is uploaded, this option just 
controls what you see on the Manage tab and you can toggle back and forth.  

5 Click OK when you see the message This will upload all content for the controller. Are you sure you want 
to do this?. When complete, a check mark under Status indicates a successful upload.  

NOTES 

○  If an error message appears, click on the message to view an explanation. 

○ Uploading can be time consuming, especially for multiple controllers. You may want to create the 
navigation tree for the User view while waiting. See Create navigation tree. (page 148) 

○ The MAC address shows to the left of the controller name in the Installer navigation tree only. 
Programmable controllers show multiple equipment listings with the same MAC address, based on 
control programs downloaded from EquipmentBuilder or Snap. 

○ To view the driver names after uploading, select the Advanced tab or right-click the controller in the 
navigation tree and select Driver Properties or Module Status. 

  TIPS  

• Click the i symbol   in the upper left corner to display the status of the latest operation. 

• Status messages are color coded as follows: 

○ Red - reports an error 

○ Blue - requires action 

○ Green - indicates an upload or download is in process 
 

Setting up devices in the i-Vu® application 
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Change network and device addressing 

The i-Vu® application automatically assigns a BACnet Network IP number and the Device ID for the 
application. Do not change these addresses unless absolutely necessary!   

NOTE  If you have more than 99 routers, you must set your own addresses. 

To change an address: 

1 Select the system level in the navigation tree and select the Devices page > Advanced tab.  

You can change the addressing in these fields:  

System level: 

○ BACnet/IP network  - default is 1600 (The maximum number allowed is 65,534) 

NOTE  Typically, you should not need to change this. 

○ Server Device Id - address of the i-Vu® web server (default is 169999) 

○ Communications Time-out (in milliseconds)  - increase this value only if downloads to controllers or 
routers fail with communication time-out errors.  

○ Communication Retries (default is 3) 

 
 

Router level: (Select the router in the navigation tree and select Devices page > Advanced tab.) 

○ Router to MS/TP network  

○ Device Identifier  

 

USB Network  

○ Baud Rate - recommended rate is 76,800 

○ Router to Network 

 

2 Click Accept.  

 

 
 

Working with control programs for programmable controllers 

 The following are programmable controllers: 

• AppController 

• MPC Open XP 

• UC Open XP 
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• UC Open 

• i-Vu® Open Link 

• Carrier® ChillerVu™ 

• i-Vu® Link (programmable in the i-Vu® Plus application only) 

• i-Vu® CCN Router (programmable in the i-Vu® Plus application only) 

 

In the navigation tree, you can double-click the controller, or right-click and select Configure, then select one 
of the following options: 

• Edit Exisiting - Downloads files to your computer for programmable controllers to edit in Snap or 
EquipmentBuilder  

• Add New - Obtains files for the i-Vu® application to add to a controller or to replace an existing control 
program 

• Update - Changes the control program, view, driver, and screen files to use the current library version. 
See Update the equipment library (page 157) for complete instructions 

• Delete Unused - Deletes unused control programs  

 

You can use EquipmentBuilder or Snap to create your control programs (.equipment files). 

• EquipmentBuilder can also produce a graphic (.view file), BACview®  file, touchscreen file, and a 
sequence of operation, based on the equipment options you select.   

• If using Snap, you must create your graphics separately in ViewBuilder. See Snap Help for detailed 
instructions on creating a custom control program. 

After creating your control program, load it into i-Vu® and download it into the controller. See Add or delete a 
custom control program to a controller and to i-Vu® (page 111).  

 

 
 

Reload, create, or edit a control program in EquipmentBuilder or Snap 

If the control program has already been uploaded to the i-Vu® application and loaded into the programmable 
controller, you must save it to your computer to be able to edit it in EquipmentBuilder or Snap.  

To reload a control program 
In the navigation tree, right-click the controller and select Reload Control Program. Reloading updates all 
instances of a control program throughout the system and marks the controller(s) for an All Content 
download. 

To create your control program in EquipmentBuilder 
1 Start EquipmentBuilder. (Windows Start > All Programs > i-Vu Tools x.x) 

2 Click Create Equipment and then click Next. 

3 Select the .sal library from the Library: drop-down list.   

4 Select the equipment type from the list and click Next. 

5 In the Equipment Name field, edit the name, if desired. 

NOTE  Your name must not exceed 21 characters. 
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6 Select options on the Summary tab and, if applicable, edit setpoints on the Sequence tab. 

NOTE  The Points and Sequence tabs change based on your choices on the Summary tab. 

7 Click Next. 

8 Check the files you wish to generate from the list. 

9 Check to select saving your control program files to a folder of your choice or a folder linked to a system. 

10 Click Next. 

 

To save the control program you want to edit 

1 Double-click the programmable controller in the navigation tree, or right-click and select Configure.  

2 Select the control program you want to edit in the Control Program drop-down list. 

3 Click Edit Existing in the Control Programs box. A new dialog window appears. 

4 Save the file to a location of your choice. 

5 Click Close. 

 

To edit the control program in EquipmentBuilder or Snap. 

1 Click Windows Start < All Programs > i-Vu Tools x.x > EquipmentBuilder or Snap. 

2 In EquipmentBuilder, click Open Equipment or, in Snap, select File > Open. 

3 Open the .equipment file that you saved and edit it. 

4 Save your revised control program with a different name. 

5 Open the i-Vu® application. 

6 Double-click the programmable controller in the navigation tree, or right-click and select Configure 

7 Click Add New in the Control Programs box. A new dialog window appears. 

8 Browse to your edited control program and click Continue. When message appears File added 
successfully, click Close. 

9 Click Close again. 

NOTE  If you change a control program in the Snap application and it does not display correctly in the i-Vu® 
interface, Ctrl+right-click the i-Vu® action pane, and then select Refresh. 

 

Apply these changes to the controllers 
1 Select the router in the navigation tree. 

2 On the Devices page > Manage tab, select any controllers with a File Mismatch error message. 
(CTRL+click or Shift-click to multi-select.) 

3 Right-click and select Download All Content. You now have the updated control programs, graphics, 
drivers, and screen files in your routers and controllers. 
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To change the control program for all controllers of one type when adding new controllers 
1 Select the Devices page > Manage tab 

2 To upload one or more controller's graphics, screen files, and control programs, select one or more 
controller (Shift-click or enable Select all) and click the Upload button. 

 

To change the control program for all controllers of one type when updating the current library 
See Update the equipment library (page 157). 

NOTE  If you change a control program and it does not display correctly in the i-Vu® interface, Ctrl+right-click 
the i-Vu® action pane, and then select Refresh. 

 

 

 
 

Change a control program or graphic 

1 Double-click the equipment/control program in the navigation tree, or right-click and select Configure. 

NOTE  You must have uploaded all content to the controller for this option to be available. 

2 Change the Display Name if desired.  

3 If the database contains 2 or more of the same control programs, you can check Change for all control 
programs of this type in the Control Program section. 

 
NOTES   

○ If you are changing an IP router's control program, the second option will change all control 
programs of this type only on the IP network. 

○ If you are changing a control program on the network below an IP router, the second option will not 
change control programs of this type in the router. 

4 To add or change the control program, do the following: 

 

If the control program is...  

In the Control Program drop-down list a) Select the control program that you generated in 
EquipmentBuilder or Snap. 

b) Click Accept. 
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If the control program is...  

Not in the Control Program drop-down list c) Click Add New. 

d) Browse to select the control program. 

e) Click Open. 

f) Click Continue. 

g) Click Close. 

h) Click Accept. 

 

5 To add a control program to the controller, in addition to those already present, see Add a new custom 
control program to a programmable controller (page 111). 

6 To add a graphic to the list , do one of the following: 

  

If the graphic is...  

In the Views Available list a.  Select the graphic, then click Attach. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

 
 

Add or delete a custom control program 

To save time when testing custom control programs, you can use Debug Mode (page 172) in the i-Vu® 
interface.  for one controller at a time. 

  CAUTION  Never leave your i-Vu® system without unchecking DEBUG MODE first and and then 
downloading all content. The source files are not in the controller until you complete both steps.  

To add a new control program to a programmable controller 
1 Select the router in the navigation tree. 

2 Select Devices > Manage tab. 

3 Select the controller in the list on the page. 

4 If you are adding a new control program, click the Add Control Program  button. A 
dialog window appears. 

5 Enter a name for your control program in Display Name and select your controller in the Controller drop-
down list. 

NOTES 
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○ If you already have the maximum number of control programs for a controller, it will not appear in 
the list.  

○ Optional:  You can change the control program's Reference Name if needed. 

6 Do one of the following: 
  

If the control program is...  

In the Control Program drop-down list Select the control program. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the control program. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

 

7 To upload a graphic, click Add New under Views and browse to your .view file. 

8 Click Continue. When message appears File added successfully, click Close. 

9 Click Close again. 

10 Right-click on the programmable controller in the controller list and select Check Status from the list. The 
status of the controller should say File Mismatch. 

11 Click the Download All Content (page 145) button.  

 

NOTE  If you need to edit the Object Instance, right-click the control program in the navigation tree and then 
select Configure. Click  next to the field for additional information. 

 

To delete a single control program in a programmable controller 
1 Select the router in the navigation tree. 

2 Right-click the the desired controller/control program in the list on the Devices page > Manage tab and 
click Delete Selected from the list.  

3 The message appears Do you wish to remove a controller and all its descendants? Click OK. 

IMPORTANT!  The process is not finished until you complete the following steps. 

4 Highlight the programmable controller in the controller list again, and select Check Status. The status of 
the controller should say File Mismatch. 

5 Click File Mismatch and click the Download button. This deletes the files from the controller. 

 

 

 

To delete all control programs in a programmable controller 
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1 Select the router in the navigation tree. 

2 Right-click the desired controller/control program in the list on the Devices page > Manage tab and 
select Delete Programs. Click OK when the following message appears This will delete all programs in 
this controller. Are you sure? 

IMPORTANT!  The process is not finished until you complete the following steps. 

3 Highlight the programmable controller in the controller list again, and select Check Status. The status of 
the controller should say File Mismatch. 

4 Click File Mismatch and click the Download button. This deletes the files from the controller. 

 
 

To edit a control program on a i-Vu® client 

On a i-Vu® client, you can get a copy of a control program from the server, edit it, then put it back on the 
server. 

To get the control program 
1 In the navigation tree, right-click the equipment, then select Configure. 

2 In the Control Programs section, click Edit Existing. 

3 Click Save. 

4 Browse to the folder you want to put the file in. 

5 Click Save. 

6 Click Close. 

7 Click Close again. 
  

To put the edited control program back on the server 
1 In the navigation tree, right-click the equipment, then select Configure. 

2 In the Control Programs section, click Add New. 

3 Browse to select the control program. 

4 Click Open. 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 
 

Setting up CCN devices in the i-Vu® application 

Connect to the Gateway on the Devices > CCN Setup tab. 

Select the Gateway in the navigation tree > Devices > CCN Discovery tab to: 

• Scan the network to populate the system with CCN device managers and controllers (page 114) 

• Download control programs, drivers, graphics and BACview files (page 114) 

• Build, edit, and arrange the navigation tree for the User view (page 148) 

• Perform downloads to individual or multi-selected controllers (page 145)  
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NOTE  You must use Network Service Tool to change addresses. 

 
 

To find and download CCN devices 

If you are using: 

• A Carrier® ChillerVu™ as a CCN device, follow all of the steps on this page  

• An i-Vu® CCN Router or i-Vu® Link, start with Connect to a CCN system 

 

Connect to a Carrier® ChillerVu™ 

1 In the navigation tree, from the system level, go to the Devices page > Manage tab.   

2 Click Find Devices. 

3 Select the Carrier® ChillerVu™ in the list on the Manage tab and click Upload All Content.  

4 You must set the Carrier® ChillerVu™ to be the Gateway or Bridge.  

a) Right-click the router, select Driver Properties.  

b) Expand Protocols and select CCN.  

c) Select the correct baud from drop-down list.  

d) If it is the Gateway, select CCN Gateway for Device Type. If it is a Bridge, select CCN Bridge. 

e) Fill in Element number. 

5 Continue with the steps below.  

 

Connect to a CCN system 

1 In the i-Vu® interface, select the system in the navigation tree. 

2 On the Devices page > CCN Setup tab, enter your CCN Gateway IP address and click Connect to 
Gateway.  

NOTE  If the server has more than 1 NIC, type the IP address the server will use to connect to controllers. 

3 After connecting to the Gateway, select it in the navigation tree.  

4 On the Devices page > CCN Discovery tab, verify that Discover Tables is checked.  

NOTE  The scanning time for discovering tables increases based on the number of devices. You may 
choose to discover tables at a later time for a faster scan. 

5 Enter the Bus and Element ranges that encompass all your devices.  

NOTE  Depending on your number of devices, it could be faster to scan several small ranges.   

6 Click Start Scan. When the process is complete, a message appears showing the number of control 
programs found.  

NOTES 

○ If the scan does not begin, wait a minute and try again. There may be a delay when first starting the 
system. 

○ If an error message appears, click on the message to view an explanation. 

7 Click Download CCN to download the control programs, drivers, and parameters. 

NOTE  This process can be time consuming. While waiting, you may want to create the navigation tree for 
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the User view. See Create navigation tree. (page 148) 

8 If you have programmable controllers and want to add a .equipment file made in EquipmentBuilder or 
Snap, see Assign and download a custom equipment file (page 115).  

 

 

TIPS  

•  indicates you need to download the device by clicking Download CCN. 

• Click  to view a log of activity on the Devices page in the current session. Copy to Clipboard lets you 
copy the text to paste it into another application. 

• Status messages are color coded as follows: 

○ Red - reports an error 

○ Blue - requires action 

○ Green - indicates an upload or download is in process 

 
 

To assign and download a custom CCN equipment file 

To add a custom control program to the list of available programs: 

1 In the i-Vu® navigation tree, right-click the controller you want to associate the equipment or control 
program with. 

2 Either double-click the controller in the navigation tree, or right-click and select Configure in the list. 

3 Enter the Display Name. 

4 To add a control program to the list of possible .equipment files in i-Vu®, do one of the following: 

 

If the control program is...  

In the Control Program drop-down list a.  Select the control program that you generated in 
EquipmentBuilder or Snap. 

b.  Click Accept. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the equipment file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

 

 

 

5 To add a graphic, do one of the following: 
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If the graphic is...  

In the Views Available list a.  Select the graphic, then click Attach. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

6 When finished, select the Gateway in the navigation tree and select the Devices page. 

7 Click Download CCN to finalize your changes. 

 

For additional pieces of equipment controlled by your Universal Controller/Comfort Controller 
(expansion controllers)  
1 In the navigation tree, select the device manager that the controller is associated with. 

2 Select the Devices page and click Add Control Program. 

3 Enter the Display Name. 

4 Select the controller or Gateway that you want to associate the new equipment with. If you select CCN 
Controller, enter the Bus and Element number of the controller.    

5 Do one of the following: 

 

If the control program is...  

In the Control Program drop-down list a.  Select the control program that you generated in 
EquipmentBuilder. 

b.  Click Accept. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

6 Add a graphic or, if finished, select the Gateway in the navigation tree and, on the Devices page, click 
Download CCN to finalize your changes. 

 

7 To add a graphic, do one of the following: 
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If the graphic is...  

In the Views Available list a.  Select the graphic. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

8 When finished, select the Gateway in the navigation tree and, on the Devices page, click Download CCN 
to finalize your changes. 

 

 
 

To view an equipment's CCN tables 

1 In the navigation tree, select the equipment. 

2 Click  next to the equipment to expand it.  

3 Select the table you want to view. 

 

 
 

Working with Universal and Comfort Controllers (CCN) 

Universal Controllers (UC) and Comfort Controllers (CC) are assigned a generic equipment and view file, which 
have setpoint control, but no additional pre-mapped I/O. To generate additional I/O points for graphic display, 
you must use EquipmentBuilder to create custom equipment files that support your application. These files 
map the CCN variables to i-Vu® BACnet points. 

In EquipmentBuilder, you can create CCN Values Only, Read Integration, or Link Integration custom 
equipment for UC/CC's that are tailored for your specific application. 

EquipmentBuilder can also create some stand-alone applications for Consumable Reports for: 

• Energy Meters 

• Non-linear flow meters 

• Energy (BTU) consumption 

• Equipment Runtime 

NOTE  You can add these options to CCN Values Only and Link Integration custom equipment and require 
mapping just the points to be monitored. 

Once the equipment files and the view file are added to a device in the i-Vu® interface (page 115), you can 
assign these points to custom graphic elements created in ViewBuilder.  

 

Because CC’s will likely control multiple pieces of HVAC equipment, expansion controllers associated with 
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CC’s must be added to the i-Vu® Devices page (select the Gateway in the navigation tree.) You can control 
separate setpoints and schedules for multiple physical equipments from a single CC. The expansion 
controllers support the additional equipment and view files required for these systems. 

 

 
 

Create custom equipment files in EquipmentBuilder for UC/CC's that link only to CNN points 
You create an equipment file in EquipmentBuilder for the UC/CC, which maps the I/O points required for one 
or more applications. Once you have created the files, you can associate the linked I/O points with 
ViewBuilder graphics.  

NOTE  To have a Prime Variable, (a temperature displayed in a color oval when the UC/CC is shown in a site 
or area equipment list), you must select the Schedule and Setpoint option when creating the equipment file.  

 

1 Start EquipmentBuilder. (Windows Start > All Programs > i-Vu_Tools_x.x) 

2 Click Create Equipment. 

3 Select i-Vu EquipmentBuilder SAL from the Library drop-down list. 

4 Select equipment type: Custom Equipment > CCN Values Only. 

5 Click Next. 

6 In Equipment Name, type a name for the custom equipment (i.e., Hot Water system). 

7 Enable English or Metric units. 

8 Select options from the drop-down lists. 

9 Select Schedule and Setpoint in the first drop-down list to use the setpoint slidebar graphic in the i-Vu® 
interface and to have a Prime Variable (a temperature displayed in a color oval when the UC/CC is 
shown in a site or area equipment list).  

10 Click Next. 

11 Choose the type of element, quantity, and click  . 

Add Elements to your application  
NOTE   Elements are a collection of input/output points that perform a specific operation. The 
input/output point that is reading or writing to the UC/CC is called a CCN point.  

The available Elements that you can add to your custom equipment in EquipmentBuilder are: 

 

Point type Used for 

Read CCN Point Reading an analog or binary value from the UC/CC 

Carrier Text Point Reading a text string from the UC/CC 

Analog - Setpoint Write  Reading and writing individual variables 

Demand Limit Load to Shed !/O points for Demand Limiting 
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1 As you add Elements, enter the requested information for the CCN points: 

○ Display Text - the description of the point as it appears in the i-Vu® interface (i.e., Pump status) 

○ Reference Base - the name of the point used when linking the point to a graphic element. All points 
have a unique identifier (i.e.,input_pumpstat, trendPumpstat) 

○ Input Address - enter the CCN path to link to this point. In the i-Vu® interface, all CCN tables have a 
Copy Path symbol  at the far right of the display. Clicking on this symbol places a copy of the 
path on the clipboard. In EquipmentBuilder, paste the path into the Input Address field, using Ctrl+v. 

2 When you are finished adding Elements for your application, click Next. 

3 Type a new Equipment Name, if desired. 

4 In Save Location, browse to a location where you would like to save the new custom equipment. 

5 Click Save. 

 

Custom graphic 
Use ViewBuilder to edit the graphic. 

 

 
 

Map to Point procedures for the UC/CC 
I/O Points that are included in a custom equipment file are automatically mapped to their associated CCN 
points once the file is downloaded in the i-Vu® application. The following procedure is not required for those 
points.  

This procedure is necessary to map associated points with the Setpoint Support option:   

1 In the navigation tree, select the UC/CC and click + to expand tables. 

2 Click + next to the table headings (Setpoint, Status Display, Maintenance, etc.) to see additional tables.  

3 Select the table you want. 

4 Click the drop-down list under Map to Point in the far right column and select the variable to be mapped.  

NOTE  Not Mapped erases any previously selected information. 

5 Click Accept. The Map to Point entry changes to the mapped point's description. 

 

 

 
 

Create custom equipment files for UC/CC's that link to TPI points 
You create an equipment file In EquipmentBuilder for the UC/CC, which maps the I/O points required for one 
or more applications. In this type of equipment, you can link CCN to TPI points in a UC/CC.  Once you have 
created the files, you can associate the linked I/O points with ViewBuilder graphics.  

NOTE  To have a Prime Variable, (a temperature displayed in a color oval when the UC/CC is shown in a site 
or area equipment list), that comes from a TPI point, you must select the Link to Third Party to Prime Variable 
option when creating the equipment file. You must not select he Schedule and Setpoint option for this 
equipment.  

 

 



Setting up devices in the i-Vu® application  
 

 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 120 

 

1 Start EquipmentBuilder. (Windows Start > All Programs > i-Vu Tools x.x) 

2 Click Create Equipment. 

3 Select i-Vu ApplicationBuilder. 

4 Select equipment type: Custom Equipment > CCN Link Integration. 

5 Click Next. 

6 In Equipment Name, type a name for the custom equipment (i.e., Hot Water system). 

7 Select options from the drop down menus. 

8 Click Next. 

9 Choose the type of element, quantity and click the  . 

Add Elements to your application  
NOTE   Elements are a collection of input/output points that perform a specific operation. The 
input/output point that is reading or writing to the UC/CC is called a CCN point.  

The available Elements that you can add to your custom equipment in EquipmentBuilder are: 

 

Point type Used for 

Read CCN Point Reading an analog or binary value from the UC/CC 
 

Read Integration Point Reading an analog or binary value from a TPI 
 

Carrier Text Point Read a text string from the UC/CC 
 

Analog - Setpoint Write Reading and writing individual variables 
 

Analog - Link CCN to Integration Writes CCN variables to TPI 
 

Analog – Link Integration to CCN Writes TPI variables to CCN 
 

Analog – Link CCN Passive to Integration Writes CCN variables to TPI 
 

Analog – Link Integration to CCN Passive Writes TPI variables to CCN 
 

Analog – BACnet Value to CCN Writes BACnet variable to CCN 
 

Analog - CCN to Integration Setpoint Write 

 
Writes CCN to TPI setpoint 

Analog - Manual TPI output/setpoint 

 
Manual control from UI to TPI/CCN 

Demand Limit Load to Shed 

 
I/O points for Demand Limiting 

Binary – Link CCN to Integration Writes CCN variables to TPI 
 

Binary – Link Integration to CCN Writes TPI variables to CCN 
 

Binary – Link CCN Passive to Integration Writes CCN variables to TPI 
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Point type Used for 

Binary – Link Integration to CCN Passive Writes TPI variables to CCN 
 

Binary – Link BACnet Value to CCN Writes BACnet variable to CCN 
 

Binary - Manual Control 

 
Manual Control from UI to TPI/CCN 

Binary - Time Manual Control 

 
Delay on Make Control 

 

1 As you add Elements, enter the requested information for the CCN or TPI points: 

○ Display Text - the description of the point as it appears in the i-Vu® interface (i.e., Pump status) 

○ Reference Base - the name of the point which is used when linking the point to a graphic element. 
All points have a unique identifier (i.e.,input_pumpstat, trendPumpstat) 

○ Input Address - enter the CCN path to link to this point. In the i-Vu® interface, all CCN tables will 
have a Copy Path symbol  at the far right of the display. Click on this symbol to place a copy of 
the path on the clipboard. In EquipmentBuilder, paste the path into the Input Address field, using 
Ctrl+v. 

2 When you are finished adding Elements for your application, click Next. 

3 Type a new Equipment Name, if desired. 

4 In Save Location - browse to a location where you would like to save the new custom equipment. 

5 Click Save. 

Custom graphic 
Use ViewBuilder to edit the graphic. 

 

 
 

Create stand-alone applications 
In EquipmentBuilder,  you can create some pre-engineered, stand-alone equipment applications with a view 
for Consumable Reports for Energy Meters (electric, gas, water, steam, generic), non-linear flow meters, 
energy (BTU) consumption, and equipment runtime.   

These options can be added to CCN Values Only and Link Integration custom equipments. Mapping the 
points allows monitoring.   

NOTES  

• 1 meter and 1 Runtime may be added to equipment. 

• There is an application for a CCN Vertical Pack unit. This is a CC with special software and BEST++. While 
this controller can be discovered in the i-Vu® application in CCN Setup as a Vertical Pack, none of the 
possible selected options can be auto-discovered, so only a base view is generated. This application 
allows your to generate a correct equipment and view file, based on the selected options. 
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Working with Terminal System Managers 

A Terminal System Manager (TSM) that is scanned into the system is assigned an auto-generated equipment 
that represents Group 1 in the TSM. Group 1 is the default group which can control the setpoints and 
occupancy for all of the existing zones, or up to 16 specifically selected zones. This equipment is pre-mapped 
and requires no further action. 

All other Groups or Zone equipment must be added as expansion equipments. You must use 
EquipmentBuilder to create the necessary additional Group or Zone equipment files. These files map the CCN 
variables to i-Vu® BACnet points and replace the default equipment in the expansion equipments that have 
been added for the additional Groups or Zones. 

Once the equipment files are created and uploaded to the i-Vu® application, these points can be assigned to 
custom graphic elements, which you create in ViewBuilder. 

Expansion equipment associated with a TSM must be added to the i-Vu® application on the Devices page to 
support additional Groups and Zones. You must create separate equipment and view files in 
EquipmentBuilder for each expansion equipment.  

Important points when setting up your TSM in the i-Vu® application  

• You must add each group or zone as a new equipment.  

• TSM’s can only be on Bus 0. 

• Only the Gateway can be Bus 0. 

• The Gateway can support 140 devices and 200 equipments 

• A fully utilized TSM (12 Groups/64 Zones) takes 76 equipment files. 

NOTE  If you have 2 TSM’s with 8 Groups and 37 Zones in each, it takes 45 equipment files for each 
TSM, or a total of 90 equipment files from a possible 200. This allows another 110 equipments for every 
other controller on Bus 0. 

 

 
 

Create custom equipment files in EquipmentBuilder for Terminal System Managers (TSM) 
EquipmentBuilder creates .equipment and .view files for the TSM temperature zones and control groups. The 
.equipment file contains points that you finish formatting in the i-Vu® interface after uploading. 

You specify the air source(s) that the TSM communicates with by configuring its Linkage function. A system 
can consist either of 1 TSM communicating with 1 to 4 air sources, or 1 to 4 TSM's communicating with a 
single air source. 

 

1 Start EquipmentBuilder. (Windows Start > All Programs > i-Vu_Tools_x.x) 

2 Click Create Equipment. 

3 Select your equipment type:  

○ TSM II Plus Group 

○ TSM II Plus Zone 

○ TSM II Group 

○ TSM II Zone 

4 Click Next. 

5 In Equipment Name, type a name for the custom equipment (i.e., Hot Water system).  

6 Enable English or Metric units. 
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7 Click Next. 

8 Check the files that you want to generate. 

9 Browse to the desired location to store your files and click Open. 

10 Click Next. 

11 Click Save. 

12 Click Exit to close or Start Over to create another equipment file. 

 

Custom graphic 
Use ViewBuilder to edit the graphic or make a custom graphic. 

 

 
 

Assign and download a TSM equipment file in the i-Vu® application 
When you scan equipment in the i-Vu® application, each TSM is assigned Group 1. You must: 

• Add a new separate equipment for each additional zone and group that you want a graphic for 

• Create the .equipment file for each in EquipmentBuilder 

• Upload the .equipment and .view file for the new equipment that was added in the i-Vu® application   

The group or zone that you create in EquipmentBuilder contains setpoint support, schedules, and a Group or 
Zone's points configuration. The CCN path information is automatically configured, however, it is incomplete 
and you must use a Search and Replace function to exchange the generic Groups or Zones for your specific 
Group or Zone number.  

To upload an equipment file to a TSM Group or Zone that is already present in the i-Vu® 
application 
1 Either double-click the controller in the navigation tree, or right-click and select Configure in the list. 

2 Enter the Display Name. 

3 To add a control program to the list of possible .equipment files in i-Vu®, do one of the following: 

 

If the control program is...  

In the Control Program drop-down list a.  Select the control program that you generated in 
EquipmentBuilder or Snap. 

b.  Click Accept. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the equipment file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 
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4 To add a graphic, do one of the following: 

  

If the graphic is...  

In the Views Available list a.  Select the graphic, then click Attach. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

5 When finished, select the Gateway in the navigation tree and select the Devices page. 

6 Click Download CCN to finalize your changes. 

 

To add expansion equipment for additional groups and zones controlled by your TSM 
(expansion controllers) 
1 In the navigation tree, select the device manager that the controller is associated with. 

2 Select the Devices page and click Add Control Program. 

3 Enter the Display Name. 

4 Select the controller or Gateway that you want to associate the new equipment with. If you select CCN 
Controller, enter the Bus and Element number of the controller.    

5 Do one of the following: 

 

If the control program is...  

In the Control Program drop-down list a.  Select the control program that you generated in 
EquipmentBuilder. 

b.  Click Accept. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

6 Add a graphic or, if finished, select the Gateway in the navigation tree and, on the Devices page, click 
Download CCN to finalize your changes. 

7 To add a graphic, do one of the following: 
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If the graphic is...  

In the Views Available list a.  Select the graphic. 

b.  Click Accept. 

Not in the Views Available list a.  Click Add New. 

b.  Browse to select the view file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 

 

8 When finished, select the Gateway in the navigation tree and, on the Devices page, click Download CCN 
to finalize your changes. 

 

 
 

Configure the path to the source of the point for TSM Groups and Zones 
A generic list of points is created in the i-Vu® application when the TSM Group or Zone is scanned into the 
system or when you upload the .equipment file.  

You must initially revise the address of the path for every point!  

1 Select the TSM Group or Zone in the navigation tree, then click Properties > Network Points tab. 

2 To substitute the correct Group or Zone number where the double X (XX) is in each path, click the 
Search/Replace button under the Address column. 

3 Enter "XX" in the Search field and enter the appropriate Zone or Group number in the Replace field. This 
updates all of the paths for that Zone or Group. 

 

IMPORTANT! 

TSM Zone 1 requires an extra step because 1 point has a slightly different name than in Zones 2 thru 64. The 
setpoint offset point in Zone 1 is inadvertently named STPOFF, while it is named SPTOFF in the remaining 
Zones. 

This causes an error because the point is incorrectly mapped in the template for Zone 1, even though it is 
correctly mapped for Zones 2 through 64. 

You must change SPTOFF to STPOFF for this one zone! 

Example:  

CCN://LINK/TZDSP01/SPTOFFST must be changed to CCN://LINK/TZDSP01/STPOFFST. 
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Integrating third-party data into the i-Vu® system 

This feature not available in the i-Vu® Standard application. 

You can integrate third-party devices into a i-Vu® system if the following are true: 
• The third-party devices are physically connected on the i-Vu® system’s network 
• You have a Carrier controller that supports third-party integration 
• You have the correct Carrier driver for the third-party protocol 
• You have enabled a port for a third-party protocol on the Carrier controller’s driver page 

  
To read from or write to a third-party device, you need the following information from the third-party vendor: 
• Protocol 
• Third-party device’s network address 
• Memory location of the object in the device you want to read from or write to 
If you are integrating with BACnet devices, you can use the i-Vu® BACnet Discovery (page 126) feature to 
gather this information. 
  

Before you begin a third-party integration, study the Carrier controller’s Installation and Start-up Guides and 
the third-party protocol’s Integration Guide. Both are available on the Carrier website 
(http://www.hvacpartners.com). 
  

The following Carrier routers let you integrate the allowed number of third-party points into your i-Vu® system: 

This router... 

i-Vu Link   

i-Vu Open Link 

Carrier® ChillerVu™ 

Allows this number of non-BACnet third-party points... 

500  

500 

1000 

   
NOTE  The point allowance of a router that provides third-party points applies to only itself. For example, if you 
purchase an i-Vu® Open Link and download control programs that use 125 third-party Network I/O points, 
you cannot apply the unused 125 points to a different router.   

 
 

To discover third party BACnet networks, devices, and objects 

The i-Vu® BACnet Discovery feature locates all accessible BACnet networks, BACnet devices, and BACnet 
objects (including devices in your i-Vu® system) on a BACnet network. The information gathered in this 
process is typically used to integrate third-party BACnet devices and their BACnet objects into the i-Vu® 
system. 

 

To use BACnet Discovery: 

1 Select the system level in the navigation tree and then the Devices page > Advanced tab.  

2 Click the BACnet Discovery Start button to discover BACnet sites for the system. An item called 
Discovered Networks appears in the tree. After all sites are found, close the status dialog box. 

3 To discover BACnet networks, select Discovered Networks, then click Go. A list of all BACnet networks 
appears in the navigation tree. After all networks are found, close the status dialog box. 

 TIP  Run a commstat manual command to determine which device routes to each network. The 
BACnet Bind Show Network section of the Commstat window shows the IP address of the router to each 
network.   

http://www.hvacpartners.com/
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4 To discover BACnet devices on a network, select a network in the navigation tree, then click Go. After all 
devices are found, close the status dialog box. Click  beside an item to expand the list of devices.  

5 To discover BACnet objects on a device, select the device on the navigation tree, then click Go. After all 
objects are found, close the status dialog box. A list of all BACnet objects in this device appears on the 
navigation tree.  

 TIP  Make sure you are discovering objects in the correct device. It may take some time to discover 
objects in devices with more than 100 objects. 

6 Optional:  Do the following to export the BACnet information so that it can be used in the Snap 
application: 

a) On the navigation tree, select a discovered network with devices or a single device. 

b) Click Export. 

c) Name and save the .discovery file in any folder. 

 

NOTES 

• Some third-party BACnet devices may not be discovered because they do not support the BACnet 
methods required for auto discovery. 

• If the discovery process returns ambiguous information, such as multiple points with similar names, 
contact the third-party manufacturer's representative for clarification. 

• Device configuration or network load can prevent the i-Vu® interface from showing all BACnet devices. If 
you do not see a BACnet device that you expect to see, check the system's BBMD configurations. If the 
configurations are correct, try the discovery process again. 

 

 
 

To determine the number of non-BACnet third-party points used in a system 

In SiteBuilder, right-click the system level on the Geographic tree, then select Run Global Point Count. 

 TIP  Select Run Local Point Count below the system level to count third-party points at and below the 
selected item.  
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SiteBuilder displays the addresses that require licensing, but does not show the location of the point. 
  

 
 

 
 

To determine the number of third-party points used in a controller 

In the SiteBuilder application 
Right-click the controller on the Network tree, then select Run Point Count. 
  

In the i-Vu® application 
1 On the navigation tree, right-click the controller.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                  

2 Select Driver Properties > Properties page > Settings tab, and then scroll to the bottom of the page. 

3 Number of integration points requested and Number of integration points active show how many non-
BACnet third-party Network I/O microblocks the controller is using. These two counts will differ if you 
exceed the product's integration point limits. For example, if your control program includes 27 Modbus 
points, your Integration points requested will be 27 and your Integration points active will be 25.   
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To configure LonWorks points using the LonWorks Integration Tool 

1 Log in to the i-Vu® application. 

2 Double-click the third party controller in the navigation tree. A dialog window appears. 

3 Click Export.erl under Integration Points. 

4 Click Save. 

5 Browse to a location on your computer to save the file. (The file will have a .erl extension.) 

6 Start the LonWorks Integration Tool (Lonworks_Integration_Tool.jar).  

7 Click  to start the wizard 

8 Follow the wizard's instructions to create your LonWorks addresses. 

9 Click  to save the file to your PC. (The file will be saved with a .erl extension.) 

10 Return to i-Vu®.  

11 In the navigation tree, double-click the i-Vu® to open the Configure dialog box. 

12 Navigate to Integration Points at the bottom of the screen and click Import .erl. 

13 Browse to the .erl file that you saved in the LonWorks Integration Tool. 

14 Click Open and then Continue to upload the file. 

15 Click Close. The LonWorks addresses are now set. 
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Configuring your system 

Work with controllers, set up Linkage, and perform Test and Balance 

Refer to your individual controller's Installation and Start-up Guide for detailed explanations and procedures 
on configuration, sequence of operation, and Linkage. 

 

 
 

i-Vu® connection options and requirements 

You can use any of the following common network configurations (see below for details): 

• Option 1 - Connect directly from a computer to the i-Vu® web server 

• Option 2 - Connect to the Intranet for internal network access only 

• Option 3 - Connect to the Internet through the Intranet for both internal and external access 

• Option 4 - Connect to the Internet through a dedicated broadband account 

 

Option 1 - Connect directly from a computer to the i-Vu® web server 

 
Requirements: 

• Windows-based computer with supported web browser and available Ethernet port 

• LAN Cable (either straight or crossover) 

Email Options - None 
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Option 2 - Connect to a LAN for internal network access only 

 
Requirements: 

• Windows-based computer with supported web browser and Ethernet port 

• Access to Ethernet LAN 

• For i-Vu® Standard and Plus systems, you need a (DHCP or static) IP address for each of the following: 

○ One IP address for the i-Vu® web server (required) 

○ One IP address for the i-Vu® web server's internal router (optional) 

○ One IP address for each external i-Vu® router (if applicable) 

Email Options - Email can be sent from a local or an Internet mail server if network policies allow this. 

 

Option 3 - Connect to the Internet through an Intranet for both internal and external access 
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Requirements: 

• Windows-based computer with supported web browser and Ethernet port 

• Access to Ethernet LAN 

• For i-Vu® Standard and Plus systems, you need a (DHCP or static) IP address for each of the following: 

○ One IP address for the i-Vu® web server (required) 

○ One IP address for the i-Vu® web server's internal router (optional) 

○ One IP address for each external i-Vu® router (if applicable) 

• Internet IP address provided by the site’s IT personnel 

• Open firewall port for HTTP/HTTPS traffic to the i-Vu® web server's IP address (default is port 80/443 
respectively) 

Email Options - Email can be sent from both Internet and Intranet mail servers. To send email off of the LAN, 
the DNS and domain field must be properly configured in the i-Vu® web server. 

 

Option 4 - Connect to the Internet through a dedicated broadband account 

 

 
• Window-based computer with supported web browser and Ethernet port 

• Broadband Internet connection (internet IP address provided by the Internet Service Provider) 

• IP router (w/Integrated Switch if computer or external i-Vu® routers will be used) 

• For i-Vu® Standard and Plus systems, you need a (DHCP or static) IP address for each of the following: 

○ One IP address for the i-Vu® web server (required) 

○ One IP address for the i-Vu® web server's internal router (optional) 

○ One IP address for each external i-Vu® router (if applicable) 

• Open firewall port for HTTP/HTTPS traffic to the i-Vu® web server's IP address (default is port 80/443 
respectively) 

Email Options - Email can be sent from a local or an Internet mail server if network policies allow this. 
 



 Setting up devices in the i-Vu® application  
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 133 

 

Network security 

Your i-Vu® building automation system's controllers and server should be as secure as possible. However, 
achieving this security can be challenging because of the complexities of networks, firewalls, and virtual 
private networks (VPN's).  

While the i-Vu® server was designed to be secure, BACnet is an open protocol that can pose risks for the 
controllers. The most secure system is one that is completely isolated from the Internet, but that is not always 
possible. The v6-02 or later drivers for Carrier controllers with Ethernet capability have a BACnet firewall 
feature that allows you to restrict communication with the controller to all private IP addresses and/or to a 
whitelist of IP addresses that you define. To set this up, go to the navigation tree > right-click the router > 
Driver Properties > Bacnet Firewall. Follow the instructions in the interface. 

For information on secure network configurations, options, and best practices, see the following documents 
on the Carrier support website. 

• Security Best Practices  

• Security Letter 

  

 

 
 

Using a Modstat to troubleshoot your system 

A Modstat (Module Status) provides information about a controller and verifies proper network 
communication with the controller. 

 

 
 

To obtain a Modstat 
You can get a controller's ModStat in the following places: 

• Open controller—In the i-Vu® application 

• XT controller—In the i-Vu® application or the controller's Local Access web pages 
  

In the i-Vu® application 
Use one of the following methods:  

• Right-click a controller on the navigation tree, then select Module Status. 

• Select a controller on the navigation tree. On the Properties page, click Module Status. 
  

In the controller's Local Access web pages (XT controller only) 
1 Use an Ethernet cable to connect your computer to the controller's Local Access port.  

2 Open a web browser on the computer. The Local Access web pages should automatically display showing 
the Modstat. 

NOTE  To use Local Access, your web browser's Home page cannot be set to GoogleTM. 
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Modstat field descriptions 
NOTE  Modstats vary for different types of controllers. The list below describes all information that could 
appear on any Modstat. If a description differs between different generations of controllers, the generation is 
noted. 
  

Field Description 

Date/Time Date and time the Modstat was run 

CM The controller's rotary switch address (MAC address) 

Device Instance A unique address assigned to the controller 

Driver built When the driver was built 

Downloaded by When and where the last download was performed 

Application Software Version The name of the first control program that is downloaded 

Flash Archive Status Shows the validity, date, and time of the most recent archive of 
parameters and status to the controller's permanent flash memory. 
The archive takes place once a day. 

# PRGs initialized 
# PRGs running 

The number of control programs that were downloaded vs. the 
number that are running. If these numbers are not the same, the 
controller has a problem such as lack of memory. 

Firmware sections in flash 
memory 

The name, version, and date of the driver 

Reset Counters: Open controller: The number of times each of the following events 
have occurred since the last time the controller was formatted. 

XT controller: The number of times each of the following events have 
occurred since the last time the controller was commanded to clear 
the reset counters. 
See NOTE below this table. 

         Power failures Interruption of incoming power 

         Brownouts Low-level incoming power 

         Commanded boots Includes commands issued from the i-Vu® interface such as the zap 
manual command, plus commands issued during a memory 
download. 

         System errors Error in the controller's firmware or hardware 

         Watchdog timeouts Watchdog is firmware that monitors the firmware for normal 
operation. If watchdog detects a problem, it restarts the firmware. 

         S/W Watchdog 
         timeouts 

Watchdog is firmware that monitors the application firmware for 
normal operation. If the watchdog firmware detects a problem, it 
restarts the application firmware. 

         H/W Watchdog 
         timeouts 

H/W Watchdog will restart the controller if it detects a severe problem 
with the controller's operating system 

System status Gives the current status of the controller's operation.  

Network status Gives the current status of the controller's networks. 
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Field Description 

System error message history Open controller: High-severity errors since the last memory download 
or format. Shows the first 5 and last 5 messages. 

XT controller: High-severity errors since the last memory download. 
Shows the most recent 5 messages and oldest 5 messages. 
See NOTE below this table. 

Warning message history Open controller: Low-severity errors and warning messages since the 
last memory download or format. Shows the first 5 and last 5 
messages. 

XT controller: Low-severity errors and warning messages since the last 
memory download. Shows the most recent 5 messages and oldest 5 
messages. 
See NOTE below this table. 

Information message history Open controller: Information-only messages since the last memory 
download or format. Shows the first 5 and last 5 messages. 

XT controller: Information-only messages since the last memory 
download. Shows the most recent 5 messages and oldest 5 
messages. 
See NOTE below this table. 

Manifest revision Firmware revision 

Installed bundles Components of the firmware 

ARC156 reconfigurations during 
the last hour 

An ARCNET network normally reconfigures itself when a controller is 
added to or taken off the network. The Total field indicates the 
number of reconfigurations in the last hour. Initiated by this node 
indicates the number of reconfigurations caused by this controller, 
the controller with the next lower rotary switch address, or any 
controller located between these two controllers. An excessive 
number in these fields indicates a problem with the network.  

BACnet comm errors in the last 7 
days 

BACnet communication errors usually indicating dropped packets 
caused by high traffic on network. 

Core (or Main) and Base board 
hardware 

Gives the following information about the controller's boards: 
• Type and board numbers that are used internally by Carrier. 
• The manufacture date and serial number. 
• Open controller only: The core board's RAM and Flash memory. 

RAM is used for driver and control program executables. 
Flash memory is used for firmware and file storage. See Flash 
storage size below. 

Largest free heap space Size of the largest piece of unused dynamic memory 

Database size Open controller: Size of the controller's memory designated for 
running programs. Database memory is used for control program 
parameters, status and history; trends, schedules, and alarms; and 
driver parameters, status and history. 

XT controller: Size of the controller's memory. 

Flash storage size The size of the flash memory that is not used by the firmware. This 
memory is used for file storage and archiving. 

 Archive storage size The amount of flash memory remaining for archival after files are 
downloaded. 
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Field Description 

 File storage size The size of all files (control programs, graphics, driver, etc.) 
downloaded to the controller. How much information is in these files 
depends on whether the controller's Download source files option is 
selected in i-Vu®. 

Raw physical switches The readings used to test the DIP or rotary switches 

Network Information Open controller: The various network addresses for a controller 
installed on an Ethernet. The Current and Assigned  addresses will be 
the same unless: 
• The Assigned addresses were changed in PuTTY. 
• The controller's DHCP/Assigned DIP switch was moved to the 

DHCP position after the Assigned addresses were defined. 
• The Enable IP configuration changeover on the BACnet Router 

Properties page is being implemented. 
•  
XT controller: The various network addresses for the controller. The 
Current and Assigned  addresses will be the same unless the Enable 
IP configuration changeover on the BACnet Router Properties page is 
being implemented. 

Route Information BACnet networks that a router is currently routing traffic to. The list 
changes as BACnet routers are added or removed from the system. 

Ethernet statistics Diagnostic counters directly related to the ethernet communications 
hardware. 

  

NOTE  XT controller only—If you want to clear the Reset counters and the three message history fields, click 
the Clear Counts/Logs button on the controller's Properties page in the i-Vu® application or in the XT 
controller's Local Access pages. 

 
 

Commissioning equipment 

Follow the process below to commission system equipment. 

 
 

Step 1:  Check out point setup 
1 On the i-Vu® navigation tree, select the piece of equipment you want to check out. 

2 Click Properties. 

3 View and change properties on the I/O Points, Alarm Sources, Trend Sources, Network Points, BACnet 
Objects, and Rnet Points tabs. See "Property descriptions" below. 

4 After completing the equipment checkout, click the Checkout tab. 

5 Select Checked Out. This field is for your reference only. 

6 Optional: Type notes. 

○ Notes typed in this field appear in the Equipment Checkout report and can also be changed from 
the Properties page Notes field for this piece of equipment. 

○ Notes remain in this field until an operator deletes them. 

7 Optional: Click the Reports drop-down arrow button, then select and run each of the following reports to 
verify your work: 
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○ Equipment > Point List 

○ Alarms > Alarm Sources 

○ Equipment > Trend Usage 

○ Equipment > Network IO 

  

 TIP  You can export the calibrated data so that you can import it into another control program. See 
Optional: Import/export calibration data (page 142). 

  

Property descriptions 

I/O Points 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a fault condition where the point may be misconfigured. 
EXAMPLE  No input/output number or a nonexistent input/output number. 

Type Type of Input or Output point.  

Value The point's present value. 

Offset Allows for fine calibration of the present value of an analog point. 

Polarity Determines the point’s binary normal polarity in the control program. 
NOTE  Polarity is not the hardware normally open/normally closed position. 

Locked Select the checkbox to lock the present value at the value you specify. 

Exp:Num Expander numbers and input or output numbers associated with where the physical point 
wires, such as a sensor wire, are physically connected to a controller. 

I/O Type Selects the bank of physical inputs or outputs on the controller. 

Sensor Selects how the physical input is mapped to the engineering units. 

Min/Max is used with the sensor type of linear to scale the input to engineering units. 
NOTE  This field is ignored for sensor types other than linear. 

 EXAMPLE: AI linear sensor type 
min 
max 

  
-10 
50 

  

  when input reads 100% 
50% 
0% 

the value is 50 
20 
-10 

Actuator Selects how the present value in engineering units is mapped to the physical output.  

Min/Max is used with the actuator type of linear to scale the output from engineering 
units. 
NOTE  This field is ignored for actuator types other than linear. 

 EXAMPLE: AO linear sensor type 
min 
max 

  
-10 
50 

  

  when input reads 50 
20 
-10 

the output is 100% 
50% 
0% 
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Resolution Amount by which the present value will change.  
EXAMPLE  If a physical input changes by 1, but the resolution is set at 2, then the present 
value remains the same. If the input changes by 2, the present value will then change by 
2. 

Checked Out 

Checkout Notes 

These fields are for your reference only. 

 

Alarm Sources 
Name Click the name to display the microblock pop-up. 

Type Type of point that is an alarm source.  

Alarm Shows Alarm in red if a current alarm exists.  

Network Visible Select to allow the microblock to be seen by the i-Vu® application and third-party BACnet 
controllers on the network. 

Potential alarm 
source 

Select to enable the microblock to generate alarms. 

Alarm Enabled Alarm—Select to generate an alarm when conditions exceed the limits set in the Condition 
column. 
Return—Select to generate a return-to-normal message when the alarm condition returns 
to a normal state.  
Fault—Select to have an alarm generated if the alarm source is not configured correctly. 
For example, a misconfigured channel number produces a no sensor fault. 

Requires ack Alarm—Select to require that the alarm be acknowledged. 
Return—Select to require that the return-to-normal message be acknowledged. 

Critical Select if the alarm is critical. 

Category You can change the alarm category assigned to the microblock. 

Condition An alarm will be generated if conditions exceed the low or high limits set.  

Deadband: 
The amount inside the normal range by which an alarm condition must return before a 
return-to-normal notification is generated. 

EXAMPLE 

 
Delay Delay time in seconds for notification after an alarm is generated. 
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Trend Sources 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a fault condition where the point may be misconfigured. 
EXAMPLE  No input/output number or a nonexistent input/output number. 

Type The type of point being trended.  

Sample Interval The interval or COV (Change of Value) increment that triggers the trend sample. 

COV Increment  

The increment, or interval, that triggers the trend sample on Change of Value 

 

Network Points 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a condition where the point may be misconfigured. 

Type Type of network point. 

Value The point's present value.  
EXAMPLE  For a Maximum point type, Value is the maximum value of all the target BACnet 
object properties the point is communicating with. 

Locked Select the checkbox to lock the present value at the value you specify. 

Default Value The value that the control program will use as the point’s value when communication with 
the target defined in the Address column is lost or communication is disabled. 

Com Enabled Select to enable this point’s network communications. Disable this property for 
troubleshooting. 

NOTE  Select All in the column header to quickly enable all points in the control program. 

COV Enable Select to make: 

• A digital network output point write a value to the target defined in the Address 
column only when the value changes. 

• An analog network output point write a value only when the value changes by the 
specified increment. 

Refresh Time 
(mm:ss) 

The time interval at which the network point writes or retrieves the value to or from the 
target. For network output points, this time is used when COV is not enabled or when COV 
is enabled but fails. 

NOTE  If COV fails and the Refresh Time is zero, the value is sent once per second. 

Address The address of the target BACnet object property or third-party value that the point 
communicates with. 

NOTE  Click Search/Replace at the top of the Address column to have the i-Vu® 
application replace all instances of specific text in the addresses with different text. This is 
especially useful when copying a control program to use for multiple third-party devices. 

Error The error code and error if the point cannot communicate with the target. 

Present Value Current value of the target defined in the Address column. 
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Checked Out 

Checkout Notes 

These fields are for your reference only. 

 
Notes typed in this field appear in the Equipment Points List Report. 

 

BACnet Objects 
Name Click the name to display the microblock pop-up. 

NOTE  A red name indicates a condition where the point may be misconfigured. 

Reference 
name 

A unique identifier that allows the point to be referenced for used for graphics, source tree 
rules, or network links.  

Type The BACnet object type.  

Present Value The object's current value. 

Locked Check to lock the third-party object to a specific value.  

Device A device alias. See "To reuse a control program" in Device Alias (page 224). 

Object Name An alpha-numeric string that is unique within the third-party device. 

Object ID A combination of the object type and a unique instance number. The object ID must be 
unique within the device. 

Address The address of the third-party object that the microblock references. 

Network Visible Allows other BACnet equipment to read or change the microblock's present value. Must be 
enabled for this microblock to generate alarms. 

 

Rnet Points 
This tab shows varying information for the different point types. Below are all possible properties that may 
appear on this tab and a list of the applicable points. The following list is arranged alphabetically. 

 

Combination 
Algorithm 

(Analog Sensed Values) 
The method used to combine the ZS sensors' values to determine the microblock's 
output value. 

Default Value (Analog Parameters, Binary Parameters, Multi-State Parameters) 
The value the control program uses until a user changes the value in the system 
interface. 

Display 
Resolution 

(Analog Sensed Values, Analog Statuses, Analog Parameters) 
Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 (example: 
74.5). 

Edit Increment (Analog Parameters) 
The amount that you want each press of the sensor's  or  button to change the 
microblock's value. 

Editable (Analog Parameters, Binary Parameters) 
When enabled, the microblock's value is editable on the ZS sensor. 
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Lock Present 
Value to 

(Binary Parameters) 
Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Maximum (Analog Parameters) 
The highest amount that this value can be changed to on the ZS sensor or in the i-Vu® 
interface. 

Menu 
Configuration 

(All points) 
Shows which sensor screens display the value. 

Minimum (Analog Parameters) 
The lowest amount that this value can be changed to on the ZS sensor or in the i-Vu® 
interface. 

Minimum off 
time 

(Binary Parameters) 
The minimum period (seconds) that the microblock sends an off signal to the controller, 
regardless of the input signal to the microblock. 

Minimum on 
time 

(Binary Parameters) 
The minimum period (seconds) that the microblock sends an on signal to the controller, 
regardless of the input signal to the microblock. 

Object Id (All points) 
A combination of the object type and a unique instance number. 

Object Name (All points) 
A unique alphanumeric string that defines the BACnet object. Although the Object Name 
field can be edited, it is not recommended. 

Reference name (All points) 
A unique identifier that allows the point to be referenced for used for graphics, source 
tree rules, or network links.  

Rnet Tag (All points) 
Defines what type of information this value represents and determines how the sensor 
will display the value. For example, for the Rnet Tag Fan Status, the sensor automatically 

displays  on the Home screen when the microblock is active.   

Show on sensors (Analog Sensed Values) 
Defines whether the ZS sensors are to display their individual sensed values, or the value 
determined by the Combination Algorithm. 

Type (All points) 
Type of Input or Output point.  

Value (All points) 
The point's present value. 

Protocol Mapping 
If a control program was built with Protocol Mapping information in Snap, this tab will appear showing third-
party protocol configuration information. 

 
 

Step 2:  Check controller communication 
1 On the navigation tree, select the network that the controller is on. 

2 On the Devices page, view the status of all controllers on that network. 
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 TIPS   

• Navigate to a network or router further down in the tree to show its controllers on the Devices page. 

• In the Reports button drop-down list, select Network > Equipment Status, then click Run to see the 
status of all controllers below the selected tree item. 

 

 
 

Step 3:  Check equipment operation 
Refer to the sequences of operation in the system specifications to verify that the equipment operates in 
each operational mode (for example, occupied and unoccupied) as specified. 

 TIP  If needed, you can import calibration data that you exported from another control program. See 
Optional: Import/export calibration data (page 142). 

 
 

Step 4:  Check the commissioned status 
1 In the i-Vu® interface, select the system. 

2 Click the Reports drop-down arrow button, then select Commissioning > Equipment Checkout. 

3 Run the report. 

 
 

Optional: Import/export calibration data 
You can export I/O point calibration data from a control program and import it into the same control program 
or another control program with the same I/O point configuration. 

To export calibration data 
1 On the i-Vu® navigation tree, select the control program whose data you want to export. 

2 Scroll to the bottom of the Properties page I/O Points tab, and then click Export. The file <control 
program name>_<ref name>.xml is saved in your browser's Downloads folder. 
  

To import calibration data 
NOTE  We recommend that you export existing data as a backup before you import new data. 

1 On the i-Vu® navigation tree, select the control program that you want to import the data into. 

2 Scroll to the bottom of the Properties page I/O Points tab, and then click Import. 

3 Browse to the file you want to import. 

4 Click Continue. A side-by-side comparison of existing data and the new import data will appear. Red text 
indicates one of the following errors: 
• Duplicate data—Existing data has duplicate I/O numbers so that import cannot determine its match. 
• I/O type mismatch—I/O Type in existing data does not match I/O Type in import data. 
• Missing import data—Existing data has a point that import data does not have. 
• Missing system data—Import data has a point that existing data does not have. 

5 Click OK to complete the import. Existing data that does not show an error will be overwritten by the 
imported data. 
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Adjust airflow configuration for VAV or VVT controllers 
To enter airflow parameters for a VAV Zone, VVT Zone or VVT Bypass controller, right-click on the controller in 
the navigation tree and select Airflow Config in the menu.  

For more information, see the following microblock details. 

• VAV Zone - Airflow Control (page 96)  

• VVT Zone - PD Airflow Control (page 108) 

• VVT Bypass - BACnet Bypass Control (page 115) 

 

 

 
 

Commissioning equipment using Field Assistant 

PREREQUISITES  Your controllers have v4.x or later drivers. 
  

To start up and commission a piece of equipment or a controller, you can run Field Assistant on: 

• A laptop connected to a controller's or sensor's Local Access port.  

• A laptop or computer connected to an IP network if your controllers are communicating on the network.  

See Field Assistant Help for information on using Field Assistant. 

 

 
 

Providing source files to Field Assistant 
Field Assistant requires a controller's source files. Source files include: 
• Control programs (.equipment) 
• Drivers (.driver) 
• Graphics (.view) 
• Touchscreen files (.touch) 
• BACview® files (.bacview) 

  
To provide Field Assistant with source files, do one of the following: 

• Download source files from the i-Vu® application (page 144) to the controller so that they can be 
uploaded in Field Assistant.  
NOTES 

○ All Open PIC's arrive from the factory containing all their source files. They will no longer have the 
source files if they have been optimized for download in the i-Vu® application and then 
downloaded.   

○ To make sure the controller has the source files in it, verify that in the System Options > General tab 
> Download section that Optimize download for Open PIC controllers is unchecked (the default) 
before downloading from the i-Vu® application. 

• Export the source files from the i-Vu® application (page 144) to a zip file so that they can be imported in 
Field Assistant. This option exports all source files for all controllers in the system.  

 TIP  If you download source files to a controller, you may still want to export files from the i-Vu® 
application. Importing the files in Field Assistant reduces the time required to upload the controllers. 
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If the technician using Field Assistant changes or adds source files, he can get the new source files back to 
the i-Vu® application by doing one of the following: 

• Download the source files to the controller in Field Assistant so that you can upload the files in the i-Vu® 
application (page 145). 

• Export the source files from Field Assistant to a zip file so that you can import the files in the i-Vu® 
application (page 144).  
This option exports the source files for all controllers in the system to the zip file. 
  

See Field Assistant Help for instructions on uploading, downloading, importing, or exporting source files in 
Field Assistant. 

 

 
 

To download source files from the i-Vu® application 

1 Click , then select System Options > General tab > Download section and verify that Optimize 
download for Open PIC controllers is unchecked (the default setting). 

2 Select the site level or a router on the navigation tree. 

3  On the Devices page, select the controller that you want to download. 

NOTE  Shift+click or Ctrl+click to select multiple  controllers to download. 

4 Select All Content in the Download drop-down list, then click the Download button. 

NOTE  If a programmable controller does not have enough memory for the files, the download will fail and an 
error message displays. You must remove or edit the control programs.  

 

 
 

To export source files from the i-Vu® application 
Export the source files from the i-Vu® application (page 144) to a zip file so that they can be imported in Field 
Assistant. This option exports all source files for all controllers in the system.  

1 Click , then select System Options > General tab > Source Files section and click the Export 
button.  

2 Save to your desired location. 

 

 
 

To import source files in the i-Vu® application 

1 Click , then select System Options > General tab > Source Files section and click the Import 
button.  

2 Browse to the *sourcefiles.zip file. 

3 Click Continue. 

4 Click Close. 

NOTE  If the import detects a difference between a database file and an import file with the same name, 
import does not overwrite the database file. A message lists any file differences so that you can resolve them. 
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To upload source files in the i-Vu® application 
1 Select a router in the navigation tree. 

2 On the Devices page, select the controller whose files you want to upload. 

NOTE  Shift+click or Ctrl+click to select multiple controllers to upload. 

3 Select All Content in the Upload drop-down list, then click the Upload button. 

 

 
 

Downloading to controllers 

If you make any of the following changes, you must download the new data from the i-Vu® application to the 
affected controllers.  
  

In the i-Vu® interface • Change or reload a control program 
• Change or reload a driver 
• Change a schedule 

NOTE  A schedule change automatically downloads unless you uncheck Automatically 
Download Schedules on each change on the My Settings page. 

• Change a screen file 

  
The i-Vu® application automatically marks the affected controllers as requiring a download. You can 
download these controllers from the Properties page (page 147) for the controller, the equipment, or a 
microblock.  

When the i-Vu® application marks a controller for download, it determines what information needs to be 
downloaded based on the type of information that changed. See Download Options (page 146). 
  

By default, Full Source files are downloaded to Open PIC controllers because Optimize download for Open 
PIC controllers is unchecked in the System Options (or System Settings) > General tab > Download section. 
If you have multiple sites, you can adjust this for each site individually. Check this option if you do not want 
Full Source downloaded. 

 CAUTION  If you want this option checked and purposely had it checked in your previous system, it is 
automatically unchecked after upgrading and you must check it again. 

NOTES   

• A property change in the i-Vu® interface is automatically downloaded to the controller. If the download 
fails, the controller is added to the Downloads page with the reason for the failure.  

• To see who downloaded a controller last, go to the navigation tree, select the controller, then do one of 
the following: 

○ Select Properties > Control Program > and click the underlined Controller: name  (Controller 1, 
Controller 2...) at the top left. This opens the Controller Information page, where you click the 
Module Status button. 

○ Select Reports > Network > Controller Status and then click Run. 

○ Right-click the controller in the tree and select Module Status.  
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Download Options 
When the i-Vu® application marks a controller for download, it determines what information needs to be 
downloaded based on the type of information that changed. Below are the options that can be downloaded. 

 

 This option... Downloads... 

All Content •  Only the executable portion of the driver and control programs 
•  The names of all .equipment, .touch, .bacview, and .driver source files 
•  The names of any .view files that are marked to be included in a  
    download 
•  Parameters 
•  Schedules 

NOTE  An All Content download also: 
•  Synchronizes the controller's time to the i-Vu® web server. 
•  Overwrites trends in the controller. 
•  Restarts the controller. 

Only Schedules All schedules that are not set for automatic download 

Only Parameters All editable properties 

Only BBMDs BBMD tables (.bdt file) that you have updated but have not yet written to the controller 

 

NOTES   

• An All Content download clears trend, history, and alarm data from the affected controllers. At the 
beginning of the download process, trends that have the Trend Historian enabled are saved to the 
system database. 

• If Field Assistant will be used with your system, you can choose to have the All Content option download 
the full source files instead of only their names. See Commissioning equipment using Field Assistant 
(page 143). 

 

 
 

To download from the Downloads page 
The Downloads page shows any controllers that the i-Vu® application marked for download. But if needed, 
you can add other controllers to the list.  
  

To download: 

1 On the navigation tree, select an item to download controllers at and below that item. 

2 Click Downloads.  

3 Click  to the left of a Location to see controllers that require a download. 

4 Optional:  To add controllers to the list: 

a) Click Add. 

b) Select the controller(s). 
NOTE  Use Ctrl+click or Shift+click to select multiple controllers. 

c) Select a Download Option (page 146). 

d) Click Add, then click Close. 
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5 Select the controllers that you want to download.  

NOTES   

○ Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers. 

○ A network's controllers download in the order shown. To change the order, select a controller(s), 
then drag and drop or click Move to Top or Move to Bottom. 
EXCEPTION  If a controller's router requires a download, it will download first regardless of its 
position on the Download page. 

6 Click Start.  
   

NOTES 

• Click Hold to stop pending  downloads. Active downloads  cannot be stopped. 
• Up to 5 routers can download simultaneously. 
• A controller is removed from the list when its download is complete. 
• Icons in the Tasks column indicate the following: 

  

 Active—The i-Vu® application is downloading to the controller. 

 Pending—You initiated the download, and the controller is waiting for its turn to download. 

 Failed—The download failed. See If a controller fails to download (page 147). 

 On Hold—Indicates either of the following: 

•  The controller requires a download 
•  You clicked Hold to stop a pending  download. 

  
• Click  in the upper left-hand corner to view a log of download activity in the current session. Copy to 

Clipboard lets you copy the text to paste it into another application. 
• To remove an item from the download list, right-click the item, then select Remove selected tasks. 
 

 
 

To download from a Properties page 
If a controller requires a download, a red download message and a Download button appear at the top of the 
Properties page for the controller, the equipment, or a microblock. Click the button to start the download. 

Downloading from the Properties page downloads All Content to the controller. 

 

 
 

If a controller fails to download 

A controller that fails to download appears on the Downloads page with this icon .  

1 Review the reason for the failure: 

○ Hold your cursor over the failed task to see hover text giving the reason.  

○ Click  in the upper left-hand corner of the page to see information on all failed downloads. Copy 
to Clipboard lets you copy the text to paste it into another application. 

2 Correct the problem that caused the failure. 

3 Select the controller on the Downloads page, then click Start. 
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Create navigation tree for the User view 

The navigation tree is a hierarchical representation of the areas or locations at your site and the mechanical 
equipment in your system.  

1 Use the Arrange User View window in the Installer view to add, delete, rename, or move items in your 
tree. You can also select a system or controller in the tree and right-click to configure change it.   

 
2 Right-click on your system name at the top of the tree in the Arrange User View window and select Add 

Area (or click  in the toolbar above the navigation tree). Type in the name of an area, location, or 
building that contains mechanical equipment.  

3 Repeat the above until all required areas have been added to the navigation tree. The following is an 
example: 

 
4  To move one or more controllers to a specific area, select the icon in the User tree, (use Ctrl+click, 

Shift+click, or both to select multiple controllers) and: 

○ Use the Move Up or Move Down arrows in the toolbar 

○ Use Move Up or Move Down arrows in right-click menu 

○ Drag and drop 

  

NOTES  

• A user with the Administrator role can change the display name in the User view by selecting the item in 
the navigation tree and double-clicking, or right-clicking and selecting Configure. The Installer must make 
all other changes. 

• In the Installer view, click and drag the tab at the top of Arrange User View to adjust the height of the 
window. 
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You can monitor and control your equipment from: 
• The Open controller's Properties (page 46) pages  
• The CCN controller's Properties (page 46) pages and the tables that are available when you expand the 

categories under the controller in the navigation tree   
• The equipment graphic (page 42) (if applicable) 
 

 
 

To lock a BACnet point or value 

You can lock certain editable parameters to a specified setting from the Properties page or microblock popup.  

1 Select the Lock checkbox. 

2 Type the value you want to send to the controller. 

3 Click Accept. 

NOTE  Locked values are indicated by a dashed yellow line on graphics. 

  

On Properties page > Control Program tab, click  to locate the point you wish to lock. 
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On the microblock popup: 

1. Click on the underlined Name or Reference Name of the point on any of the Properties tabs to open 
the microblock popup.  

2. Click Properties page > Details tab to lock a value. 

 
 

 

 
 

To force a CCN point value 

You can force certain editable point values to a specified setting from: 

• Equipment tables - click  next to the equipment to expand tables 

• A graphic - hold down Ctrl and, using your mouse, click on the point value on the graphic. A microblock 
popup appears. 

• Properties pages 

Forced values are indicated by a dashed yellow line on graphics. 

  

1 Select the Force checkbox. 

2 Type the value you want to send to the device. 

3 Click Accept or Apply. 
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You can make the following changes to a driver in the i-Vu® interface.  

• Change or upgrade a driver. See topic below. 

• Reload a driver if it becomes corrupt (for example, a driver page is missing). On the i-Vu® navigation tree, 
right-click the controller or driver, then select Reload Driver. Reloading updates all instances of the driver 
throughout the system and marks the controller(s) for an All Content download. Changes you made on 
the driver pages in i-Vu® remain in effect.  

After you make these changes, you must Download All Content (page 145) to the affected controller(s). 

 

 
 

To view or change a driver 

To view the driver 

• In the Installer view, select the router in the navigation tree and select Devices > Advanced tab. 

• From Installer or User view, right-click the controller in the navigation tree and select Driver Properties. 

 

To change a driver 

1 From Installer or User view, right-click the controller in the navigation tree and select Driver Properties. 

2 Select the Properties page, Update tab. 

3 In the Controller section,  if other controllers in the system use this driver, select which controllers you 
want to change.  

 
4 Do one of the following: 

  

If the driver is...  

In the Driver Version drop-down list a.  Select the driver. 

b.  Click Accept. 

Not in the Driver Version drop-down list a.  Click Add. 

b.  Browse to select the driver. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

f.  Click Close again. 
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5 You can continue and also change the screen file, or, if finished, Download All Content (page 145) to the 
controller. 

6 See Update the equipment library (page 157) for details on implementing a new library version of drivers 
and screen files. 

  CAUTION  Selecting the Delete Unused button permanently removes the files from the database. 

 

To change a screen file 

1 If other controllers in the system use this screen file, select which controllers you want to change.  

2 Do one of the following: 

 

If the Screen file is...  

In the Screen file drop-down list a.  Select the screen file. 

b.  Click Accept. 

Not in the Screen file drop-down list a.  Click Add. 

b.  Browse to select the screen file. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Accept.. 

   

3 Download All Content (page 145) to the controller. 
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To use a touchscreen device or BACview® to view or edit a controller's property values, you must download a 
screen file (.touch, .bacview, .S37, or.kpd) to the controller. The screen file is typically downloaded with the 
initial download to the controller, but you can select a different file in the i-Vu® interface. 

 

 
 

To select a different screen file 

1 On the i-Vu® navigation tree, right-click the controller, then select Driver Properties > Update tab. 

2 If other controllers in the system use the current screen file, select which controllers you want to change.  

 
3 Do one of the following: 

  

If the screen file is...  

In the Screen file drop-down list i) Select the file.  

j) Click Accept. 

Not in the Screen file drop-down list k) Click Add. 

l) Browse to select the screen file. 

m) Click Open. 

n) Click Continue. 

o) Click Close. 

p) Click Close again. 

   

4 Download All Content (page 145) to the controller. 
  

NOTE  You can click Delete Unused in the Screen File section to delete all unused screen files. 

 

 

 

 
 

To edit a screen file on an i-Vu® client 

On an i-Vu® client, you can get a copy of a screen file from the server, edit it, then put it back on the server. 
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To get the screen file  
1 On the i-Vu® navigation tree, right-click the controller that uses the screen file, then select Driver 

Properties > Update tab. 

2 Under Screen File, click Edit. 

3 Click Save as. 

4 Browse to the folder you want to put the file in. 

5 Click Save. 

6 Click Close. 
  

To put the edited file back on the server 
1 On the i-Vu® navigation tree, right-click the controller that uses the screen file, then select Driver 

Properties > Update tab. 

2 Under Screen File, click Add. 

3 Browse to select the file. 

4 Click Open. 

5 Click Continue. 

6 Click Close. 

7 Click Close again. 

 
 



 System Management  
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 155 

 

Although the i-Vu® application is a reliable front-end, you must perform periodic backups of the i-Vu® 
database to ensure a quick recovery in case of failure. To make sure that your controllers have the latest 
version of software you must install periodic library upgrades. The sections below describe how to backup and 
restore the i-Vu® database and how to install the library updates. 

 

 
 

Backup data from Management Tool 

Access the Management Tool using one of the following methods: 

• Click , then select System Options > General tab > Management Tool.  

• Launch your browser and type your system name followed by :8080. For ex.: http://ivu:8080/. 

 

Use either of the following methods to backup your data: 

Backup data to your computer 

1 Click PC Backup under Manage Server Data to save the entire database zipped into one file to your 
computer. 

2 Click OK when you see the message The system will be stopped and restarted. Do you wish to proceed? 
Watch Operation Status to see the progress. 

3 Click the message Save/Download Backup File to Your Local Hard drive when it appears.  

4 Click Save when asked Do you want to open or save this file? 

5 Save this system.backup.tgz file to a convenient location on your computer.  

CAUTION! Do not alter the name of this file! 

6 Exit from Management Tool. 

 

Backup data to a USB drive 

1 Plug your USB drive into any available USB port on your i-Vu® web server. 

NOTE  Do not use the i-Vu® Restore USB drive!   

2 You must reboot in order for the web server to find the USB drive. Click Reboot under Machine 
Maintenance in the Management Tool.  

3 Click OK. 

4 When reboot is complete, click USB Backup under Manage Server Data. 

5 Click OK when you see the message The system will be stopped and restarted. Do you wish to proceed?  

6 When Operation Status says No Background Operations Currently Active, remove USB drive from the i-
Vu® web server.  

7 Exit from Management Tool. 
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Restore data from backup 

1 Click PC Restore or USB Restore under Manage Server Data in the Management Tool. 

○ PC Restore - Browse to your backup file and click Perform Restore. 

○ USB Restore - Place your backup USB drive in any port on thei-Vu® web server. Select the backup 
file and click Perform Restore. 

2 Restore is complete when Operation Status displays No Background Operations Currently Active.  

3 If you wish to change the name of your i-Vu® system from the default ivu, enter the new name in the 
Name field under Addressing. The restore process does not automatically reinstate your previous name. 

 

Restore factory defaults 

Restoring factory defaults deletes your existing data and restores your system to factory defaults. This restore 
process is quicker than using the Restore CD or Restore USB drive.  

1 Access the Management Tool in System Options > General tab > Management Tool or via your browser 
by typing your system name followed by :8080.  

For ex.: http://ivu:8080. 

2 Click Factory Defaults. This deletes all server data and resets the device to the original factory default 
values. 

3 NOTE  Executing this option will not delete configuration data under the Addressing and i-Vu Port 
Configuration sections of the Management Tool.  

4 Begin setting up your system. 
 

Restore i-Vu® system 

From i-Vu® Restore USB drive: 

  CAUTION!  Placing the Restore USB drive in the i-Vu® web server USB port reformats your system and 
restores it to factory defaults. Library updates are lost and you must reapply them. 

 

1 Insert the Restore USB drive into any i-Vu® web server USB port. 

2 Shut down 

○ i-Vu® web server - Shut down  the web server by pushing the On/Off button on the top. 

○ Older i-Vu® web server - Shut down the web server by holding down the On/Off button for several 
seconds. Then wait for the blue lights to go out before restarting. 

3 Press the On/Off button again to restart. The restore process starts automatically and takes several 
minutes. The web server shuts off when finished.   

NOTE  Do not turn the power off during reformatting!  

4 Wait another minute or two before accessing the new system using a browser. 
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The following applies only to the older i-Vu® web server model 

From i-Vu® Restore CD: 

  CAUTION!  Placing the Restore CD in the i-Vu® disk drive reformats your system and restores it to 
factory defaults. Library updates are lost and you must reapply them. 

 

1 Remove the i-Vu® web server from the network by disconnecting the LAN cable. 

2 Insert the i-Vu® Restore CD into the i-Vu® web server CD drive.  

3 Shut down the i-Vu® web server by pushing the On/Off button once.  Wait for the blue light to turn off 
(could take as long as 2 minutes). 

4 Press the On/Off button again to restart the web server. The installation begins automatically. 

5 The Restore CD ejects when the installation is complete. This process takes several minutes. 

NOTE  Do not power off during the installation.     

6 Wait another minute or two before accessing the new system using Internet Explorer.  

 

 

 
 

Update the equipment library 

The i-Vu® SAL files update youri-Vu® controllers. The SAL libraries contain control programs, graphics, 
drivers, screen files, and other important controller data.  

Carrier periodically provides updates, which include enhancements and bug fixes. 

NOTES 

• The library update only changes default graphics. If you have edited your graphic in ViewBuilder, it is not 
updated. 

• The last digits in the SAL library name are the release date of the library. 

• All of the SAL files will not necessarily have the same <date> revision. 

• To ensure that your installation is running the latest software, we recommend that you check Control 
Systems Support  http://www.hvacpartners.com/ for updates. Download the latest SAL files and apply 
them to all new installations. 

• If you are changing to an older SAL file than the current one being used, a warning asks you if you are 
sure you want to apply an older version. 

NOTE  Keep copies of the latest libraries in a safe place. In the event of a system restore, the updated .sal file 
must be reapplied. 

 

To check current SAL library version 

1 Login to the i-Vu® application. 

2  Click , then select System Options > Update tab. 

3 Click Current Libraries (.sal) to view the current SAL libraries and their revision date. 

  

http://www.hvacpartners.com/
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Step 1: Update library  

1 Save the updated library (.sal file) to your computer. 

2 Click , then select System Options > Update tab. 

NOTE  Expand Current Libraries (.sal) to see the current SAL libraries and their revision. Compare them 
to what you downloaded from the Carrier support website to determine if any of them have been 
updated. 

3 Click  and browse to the updated .sal file that you have saved on your computer, select 
the file, and click Open. 

4 Click Continue. 

5 When process is complete, the message appears File added successfully. 

6 Click Close. 

NOTE  These changes are not applied to the controllers until you have updated routers and controllers. 

 

Follow these steps to implement the new equipment library: 
Step 2: Update the files for the routers 

1 Select the router that you wish to update in the navigation tree. 

2 Right-click and select Driver Properties.  

3 Select Properties page > Update tab.  

4 If the database contains 2 or more routers, you must check Change for all control programs of this type 
in the Controller section. 

5 Click Update. A message appears Changes the driver and screen file to use the current library version. 
Continue?  

NOTE  If more than one router exists, the additional routers are listed below the Update button. 

6 Click OK.  

7 Click Accept. 

 

Step 3: Update the files for the controllers  

1 Double-click the controller in the navigation tree or right-click and select Configure .   

2 If you have multiple controllers of the same type, enable Change for all control programs of this type?. 

3 Click Update under Controller. A message appears Changes the control program, view, driver and screen 
file to use the current library version. Continue?  

4 Click OK. When the message Updated to the library version xx. appears, click Close. 

5 Repeat steps 1 - 4 for any additional types of controllers. 

6 Click Close again. 

 

Step 4: Update the files for CCN controllers 

1 In the navigation tree, select the CCN device manager associated with the controllers that are to be 
updated. 

2 Select Devices > CCN Discovery and re-scan any controllers that need to be updated by checking Rescan 
Controllers Selected Below for Configuration Changes and clicking Start Scan. 
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Step 5: Apply the update to the routers and controllers 

1 Select the site level in the navigation tree and then select the Downloads page. 

2 If you wish to apply the new SAL file to your entire system, you can use this page to compare to your 
navigation tree and verify that you have selected all of your routers and controllers for download. 

NOTE  Only the CCN Gateway and device managers require download, so the CCN controllers/equipment 
will not be listed. 

3 A network's controllers download in the order shown. To change the order, select a controller(s), then 
drag and drop or click Move to Top or Move to Bottom. 
EXCEPTION  If a controller's router requires a download, it will download first regardless of its position on 
the Downloads page. Click the Start button. 

NOTES 

○ Use Ctrl+click, Shift+click, or the Select All checkbox to select multiple controllers.  

○ See To download from the Downloads page (page 146) in Help for more details. 

 

 
 

Synchronize to system time 

To update all routers and controllers to the system time: 

1 Click , then select System Options > General tab. 

2 Click  to immediately synchronize all controllers. 

3 To adjust the time when controllers are automatically synchronized each day, click Enable time 
synchronization of controllers daily at and fill in time. 
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Troubleshooting and communications 

 

 

 
 

Troubleshooting BACnet bindings 

Every controller has a Device Binding Table that contains all Device IDs that the controller communicates with 
and the network address of each device. This typically includes the Device ID of the BACnet Alarm Recipient.  

If the i-Vu® application is not receiving alarms/trends or if the a point's value is incorrect, you can view this 
table to see where the controller is looking for its data. 

1 On the i-Vu® navigation tree, select the router that has incorrect or missing data. 

2 On the Properties page, click Show Bindings. 
 

 

 
 

Communicating using PuTTY 

You can connect a computer to a controller's Local Access port and then use PuTTY, a free open source 
terminal emulation program, to: 

• Set the baud rate for ports S1 on the i-Vu® Open Router or i-Vu® Open Link 

• Set controller properties, such as IP address and network information 

• Retrieve a Modstat (page 133) 

NOTE  Use Network Service Tool V to set the CCN baud rate and configure IP settings for an i-Vu® CCN 
Router, i-Vu® Link, or Carrier® ChillerVu™. 

PREREQUISITES 

• A computer with a USB port 

• A USB Link cable   
NOTE  The USB Link driver is installed with an i-Vu® v5 or later system. But if needed, you can get the 
latest driver from http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx. 
Install the driver before you connect the USB Link to your computer. 

   

 CAUTION   If multiple controllers share power but polarity was not maintained when they were wired, the 
difference between the controller's ground and the computer's AC power ground could damage the USB Link 
and the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the 
USB Link. Purchase a USB isolator online from a third-party manufacturer. 
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1 Download and install PuTTY from the PuTTY website 
(http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html). 

2 Connect the laptop to the local access port of the controller, ZS sensor, or an SPT sensor using the USB 
Link cable(s). 
  

 
  
NOTE  If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link 
cable into the isolator. 

3 To change a router's IP address, subnet mask, or default gateway, set its IP Address DIP switch to 
Assigned. 

4 Start PuTTY. 

5 Under Category > Connection, select Serial. 

6 Under Options controlling local serial lines, enter the following settings: 
  

Field Value 

Serial line to connect to Replace X with the computer's port number that the USB Link Kit cable is 
connected to.  

NOTE  To find the port number, select Start > Control Panel > System > 
Device Manager > Ports (Com & LPT). The COM port number is beside 
Silicon Labs CP210x USB to UART Bridge.  
 

 
Speed (baud) 115200 

Data Bits 8 

Stop Bits 1 

Parity None 

Flow Control None 

    

http://www.chiark.greenend.org.uk/%7Esgtatham/putty/download.html
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7 Click Open. A window similar to the one below appears. 

 
 

8 Do one of the following: 

○ To change a property value: 
a.  Type the number of the property, then press Enter. 
b.  Type the new value, then press Enter. 

○ To take an action, type number of the action, then press Enter. 

9 If you changed a value, type 1, then press Enter to restart the controller. 

10 Close PuTTY. 

 

 
 

Communicating using HyperTerminal 

You can connect a computer to a controller's Local Access port and then use HyperTerminal, an application 
installed with Windows XP and older operating systems, to: 

• Set the baud rate for ports S1 or S2 on the i-Vu® Open Router or i-Vu® Open Link 

• Set controller properties, such as IP address and network information 

• Retrieve a Modstat (page 133) 

NOTE  Use Network Service Tool V to set the CCN baud rate and configure IP settings for an i-Vu® CCN Router 
or i-Vu® Link, or Carrier® ChillerVu™. 

  

PREREQUISITES 

• A computer with a USB port 

• A USB Link cable   
NOTE  The USB Link driver is installed with an i-Vu® v5 or later system. But if needed, you can get the 
latest driver from http://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx. 
Install the driver before you connect the USB Link to your computer. 
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 CAUTION   If multiple controllers share power but polarity was not maintained when they were wired, the 
difference between the controller's ground and the computer's AC power ground could damage the USB Link 
and the controller. If you are not sure of the wiring polarity, use a USB isolator between the computer and the 
USB Link. Purchase a USB isolator online from a third-party manufacturer. 

  

1 Connect the computer to the local access port of the controller, ZS sensor, or an SPT sensor using the 
USB Link cable(s). 
  

 
 

NOTE  If using a USB isolator, plug the isolator into your computer's USB port, and then plug the USB Link 
cable into the isolator. 

  

2 Verify that the baud rate is set to 115,200. 

3 To change a router's IP address, subnet mask, or default gateway, set its IP Address DIP switch to 
Assigned. 

4 Start Windows HyperTerminal located under Start > Programs > Accessories > Communications. 

5 NOTE  This option is not available in Windows v7 or later. You can download it from the Internet. 

6 Select an icon for this connection file, then click OK. 

7 In the Connect to dialog box, set the Connect using field to ComX, where X is the number of the 
computer's Com port that the USB Link cable is connected to, then click OK. 

8 In the Com Properties dialog box, set the Port Settings for your local access port, then click OK. 

Port Setting Value  

Bits per second 

 

i-Vu® Open Link 
i-Vu® Open Router 
i-Vu® Link 
i-Vu® CCN Router 
Carrier® ChillerVu™ 

115200  

  

Data Bits 8  

Parity None  

Stop Bits 1  

Flow Control None  
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1 From the main HyperTerminal screen, press Enter to view a router configuration screen like the one 
below.  

 
 

2 Do one of the following: 

○ To change a property value: 
a.  Type the number of the property, then press Enter. 
b.  Type the new value, then press Enter. 

○ To take an action, type number of the action, then press Enter. 

3 If you changed a value, type 1, then press Enter to restart the controller. 

4 Close HyperTerminal. 
 

Troubleshooting networks 

If a controller is not communicating, click the router on the i-Vu® navigation tree, then click Devices. This 
page shows the communication status of all controllers on the network. If all controllers on the network are 
not communicating, you have a network problem. Begin moving up the  tree, checking communication status 
at each level to determine the starting point of the communications problems. 

 

 
 

Manual commands 

To run a manual command:  

1 Click  and then select Manual Command. 

2 Type the manual command in the dialog box, then click OK. 

 TIP   Ctrl+Shift+M also opens the dialog box. 
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You must have the Installer or Admin role to access the manual commands dialog box. Some commands are 
restricted to the Installer role only. 
  

Command Description 

addon Opens a dialog box where you can upload, start, stop, or remove an add-on 
program such as Tenant Override Billing. 

bacnet showindex Displays all files (file name, size, date) downloaded to the selected 
controller. 

bbmd commands: You must have the Installer Role to run bbmd commands. 

   bbmd read <IP address> Reads the BBMD table of the controller at the given IP address. 

For example, to display the BBMD table in the BACnet device router at IP 
address 154.16.12.101, type:  
       bbmd read 154.16.12.101 

 bbmd update <network  
        number> 

Selects BBMDs on the specified network and marks them for download. If 
no network is entered at the end of the command, all networks in the 
system are scanned.  

For example, if the network number is 888, type: 
       bbmd update 888 

   bbmd view <network  
       number> 

Views the list of BBMDs that have been selected for the network number 
at the end of the command. Assumes the update has been run. 

For example: 
       bbmd view 888 

 bbmd write <table file> <IP  
        address>  

Writes the BBMD table into the controller at the given IP address. See To 
set up BBMDs through the i-Vu® interface. 

For example, to write the BBMD table in dallasbbmd.bdt into the BACnet 
device router at IP address 154.16.12.101, type: 
       bbmd write dallasbbmd.bdt 154.16.12.101 

   bbmd clear <IP address> Clears the BBMD for the specified controller. 

For example: 
       bbmd clear 154.16.12.101 

 bbmd dump <network>  
       <file> 

Writes to a file the BBMD from the specified controller. 

For example: 
       bbmd dump 888 dallasbbmd.bdt 

checkurls 1 Finds all network point exp: expressions for the selected item on the 
navigation tree. 

2 Converts the exp: expressions to bacnet:// equivalent expressions that 
the controllers use. 

3 Compares the equivalent bacnet:// expressions to the bacnet:// 
expressions currently downloaded in the controllers. 

4 Displays any mismatches. 

checkurls -p Does the same as checkurls, then adds any mismatches to the download 
queue as parameter downloads. 

checkurls -v Does the same as checkurls, but displays the exp: and bacnet:// 
expressions for all network points that were checked. 
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Command Description 

commstat Gives a complete set of diagnostic information for all defined connections 
as well as information regarding all modems in the system. 

copy Displays a global copy utility that allows you to selectively copy trend 
graphs, custom reports and all editable properties from the selected 
equipment to other equipment in the system with the same control 
program. See To use Global Copy (page 52). 

download commands: Each of these commands performs an immediate download to a controller 
for the selected control program, device, or driver. 

   download m Downloads all content, including parameters, schedules, and BBMDs (if 
applicable). 

   download p Downloads parameters only. 

   download s Downloads schedules only. 

go commands:  

  go <refname or path> Goes to the point in the system that is referenced. 

For example: 
       go #oa_conditions 
or 
       go vav_1/m28 

go ~network Takes you to the network the selected object’s controller is associated to. 

go -logicpopup <refname> Goes to the microblock pop-up for the microblock that is referenced. You 
must run this command from the microblock’s equipment on the 
navigation tree. 

For example: 
      go -logicpopup rs 

go <device ID>/<object  
        ID> 

Goes to a device and object on the navigation tree. 

For example: 
      go 300550/AI:3 

 go <object ID> Goes to an object for the current device on the navigation tree. 

For example, if a module alarm reports a control program Locked I/O 
Alarm and references an error in program 11, click the link to go to the 
device, then go to the object by typing: 
      go PRG:11 

localhost Shows the IP address of the i-Vu® web server 

logoffuser Logs off a user (without warning the user). 

Type a whoson manual command to view the IDs of logged in operators, 
then type logoffuser x, where x is the user's ID. 

markdownload commands: These commands place the controller for the selected tree item on the list 
to download at a later time. The download list can be viewed at the System 
level on the Downloads page. 
 

markdownload Marks for an All Content download, that includes parameters, schedules, 
and BBMDs (if applicable). 
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Command Description 

markdownload p Marks for a Parameters download. 
 

markdownload s Marks for a Schedules download. 
 

memory Shows the amount of server memory allocated for the i-Vu® application 
and the amount being used.  

memory -free Releases unused server memory, then shows the i-Vu® memory usage 
before and after the release. 

modstat commands: These commands display a Modstat (page 133) report. 

NOTE  It is not necessary to download a controller before running a Modstat 
on it. Binding takes place when you run the modstat. 

   modstat Displays status of the controller at the current location, including: 

• Hardware components of the device 

• Software components of the device 

• Error conditions that may exist in the device 

• Date and time the device is using 

   modstat 8:<device instance  
        number> 

Displays status for a specific controller in the IP network using the 
controller’s ID. Your location in the system does not have to be the 
controller you are querying. 

For example: 
       modstat 8:489202 

   modstat mac:<network  
   number>,<media type>: 
   <mac address> 

Displays a Modstat for a specific controller in the system using the 
controller’s MAC address. Network number is the number of the network 
this controller is on; media type is the type of network the controller is on; 
MAC address can be either the controller address or the IP address and 
depends on the controller’s media type.  

Media types allowed are: 

• bacnet/ip  or  b 

• ms/tp       or  m 

• ethernet   or  e 

For example: 
       modstat mac:48161,arcnet:2 
                   or 
       modstat mac:888,bacnet/ip: 172.16.101.119 

notify Sends a message to all operators currently logged in to the system. For 
example, "The server is going to shut down in 5 minutes. Please log off." To 
run this command, type:   notify <your message>. The message 
must use only alphanumeric characters. You must have the Installer role 
to run this command. 

paramupload Uploads parameters (editable properties) to the i-Vu® application from the 
equipment or driver at the current location and below. If you want to 
upload editable properties for all equipment under a particular router, 
navigate to the router or the network on the navigation tree. You must 
have the Installer role to run this command. 
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Command Description 

ping Ping to verify communication between IP devices. You cannot ping devices 
on non-IP networks. To run this command type: ping <hostname> 
where <hostname> is the IP address or device name. 

For example: 
       ping 192.168.168.1 
(will ping the IP address 4 times)                 

rebootserver Restarts the i-Vu® application. You must log back in to the i-Vu® interface 
if you want to continue. You must have the Admin or Installer role to run 
this command. 

rebuild Rebuilds a Properties page. Use if you make changes to control program 
property text in the Snap application. 

reload Reloads a control program. Use if you make changes to control program in 
the Snap application. Reloading updates all instances of the control 
program throughout the system and marks the controller(s) for download. 
The i-Vu® application determines the type of download based on what 
changed in the control program. You must have the Installer role to run 
this command. 

restartmodule Restarts the current controller. You must have the Installer role to run this 
command. 

revert Resets the selected driver or control program to its default values. 

setdefault Sets the current page as the default view for the selected action button 
and the selected tree location. You must have the Installer role to run this 
command. 

shutdown Shuts down the i-Vu Server application. This stops communication 
between the server and the client, but does not close any open i-Vu® 
pages. You must have the Admin or Installer role (System Shutdown 
privilege) to run this command. 

storetrends Uploads trend data from the controller(s) to the database for all equipment 
at and below the selected item on the navigation tree. This command 
stores trend data for points that have Trend Historian enabled. 

timesync Synchronizes the time on all controllers at the current location and below 
to the time on the server. Run this command only from a location on the 
navigation tree. You must have the Installer role to run this command. 

NOTE  For CNN networks, executing a timesync on a controller sends the 
timesync to its Gateway, and all the controllers under that Gateway. 

whereami Displays the full path for the current location and gives the display and 
reference names of the action button, category, instance and tab. If the 
selected tree location differs from the location shown in the action pane 
(for example, a point trend page), whereami returns information on both 
locations. 

Use this command when you create links in ViewBuilder. 

whoson Shows the list of users currently logged in to the i-Vu® system, the IP 
addresses from where they are logged on, what kind of interface they are 
using (for example, lvl5 for a web browser on a computer), and how long it 
has been since they have actively interfaced with the i-Vu® system. 

zap Restarts the current controller. You must have the Installer role to run this 
command. 
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Using WAP devices with the i-Vu® system 

The i-Vu® system supports Wireless Application Protocol (WAP), a communications protocol that allows you to 
access your system through a WAP-enabled phone. The i-Vu® application supports WAP-enabled browsers on 
2G and 3G devices on the Sprint PCS network and Pocket Internet Explorer on devices running Windows 
Mobile for Pocket PC 2003 or later. 

Using a WAP device, you can access the Internet and remotely manage certain aspects of your system. Only 
English alphanumeric characters are supported.  

NOTES   

• Navigation buttons and how the information is presented varies among WAP devices.  

• To use WAP through a secure port, you must use a certificate from a trusted Certificate Authority (CA). 
Ask your phone company which Certificate Authorities they support. See "To set up TLS using a self-
signed certificate" in i-Vu® Help. 

 
 

Supported i-Vu® features 

The WAP interface supports the following i-Vu® features. You can: 
• Access the navigation tree. 
• View and manage Alarms for the current location. 
• Receive an e-mail alarm message. 
• View and edit abbreviated Properties pages for areas and equipment. 
• View and edit abbreviated Properties pages for microblocks. 
  
You cannot: 
• View and edit items under the System Options tree. 
• View and manage Schedules. 
• Configure and view Reports. 
• View Graphics pages. 
• Send manual commands. 
 
 

To dial up a i-Vu® system using WAP 

Dialing up a i-Vu® system using a WAP device differs from dialing a telephone number. Each service has a 
slightly different method. The following method for connecting to i-Vu Server using WAP is similar to the Sprint 
PCS Wireless mobile phone process. 

1 Turn on the WAP device. 

2 Select Wireless Web. 

3 Select Launch Browser. 

4 Select Menu. 

You can also select i-Vu bookmark if one has been saved. 

5 Select Goto. 
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6 Tap in the i-Vu® IP address; for example, 192.168.168.1. 

NOTE  If you do not see the i-Vu® login, tap in the IP address again and do the following: 
  

If your WAP device supports... ...append these characters to the end of the 
address. 

WML browsers.  
Applies to most older (pre 3G) WAP devices. 

?t=w 

XHTMLMP browsers. 
Applies to most newer (3G) WAP devices. 

?t=xmp 

XHTML browsers.  
A text only interface for PC's or PDA's. 

?t=X 

EXAMPLE  192.168.168.1?t=xmp 

7 Log in to your i-Vu® system: 

○ Tap in your i-Vu® username, then select OK 

○ Tap in your i-Vu® password, then select Login. 

 

 
 

To navigate the system 

Navigating through the WAP interface is the same as navigating through the i-Vu® navigation tree—the WAP 
screen is similar to the i-Vu® navigation pane. 

 

 
The i-Vu® application automatically generates default WAP interface pages.  

After you log in, the first screen shows the system level. The name at the top of the screen is the name of the 
current level. To navigate deeper into the system, select an item by either pressing its number on the keypad 
or by scrolling through the list and then selecting OK. To navigate to other areas of the system, see below. 
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Select  Action 

1... 
 Navigate up one level. 

Menu Navigation    Return to the navigation tree (area and equipment level only). 

 Alarms List the alarms at the current level (area and equipment level only). 

 Properties Show properties at the point level 
and show properties at the area and equipment levels if custom pages 
have been attached. 

 Back Return to the previous page. 

 Go to Root Return to the top of the navigation tree. 

 Logout Log out of the i-Vu® application. 

 
 

To view and edit Alarms 

1 Navigate to the area you want to view alarms for. 

2 Select Menu. 

3 Select Alarms to view all alarms at this area. 

4 Select an alarm, then click OK to view or edit its details. 

5 Select Actions to view a list of actions for the alarm. 

6 Select the action to be done, then select OK. 

 

Select Action 

1  List List all alarms at the current area or equipment level. 

2  Navigation Return to the navigation tree. 

3  Ack All Acknowledge all alarms at the current level. 

4  Del All Closed Delete all closed alarms at the current level. 

5  Del All Delete all alarms at the current level. 

 
 

To view and edit equipment properties 

NOTE  If your i-Vu® system requires reasons for changes to equipment, you cannot edit equipment properties 
using WAP. 

1 Navigate to a point or BACnet object to view. 

2 Edit any properties in brackets. 

NOTE  You may need to scroll down the screen to view them all. 
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For example, from the BACnet analog input point level, you can view the following: 
  

Select Action 

Value Present value for that point. 

Lock Locked override status for that point; True locks the present value to the At value. 

At Locked override value. 

Alarm Alarm state for that point. 

 

 
 

Using DEBUG MODE 

Debug Mode saves considerable time when troubleshooting custom control programs for programmable 
controllers. Typical operating mode in the i-Vu® application always downloads full source, which is time-
consuming. While operating in Debug Mode, full source is kept in the database and is not downloaded to the 
controller.  

  CAUTION  Never leave your i-Vu® system without unchecking DEBUG MODE first and and then 
downloading all content. The source files are not in the controller until you complete both steps.   

To use DEBUG MODE 

1 Select the custom control program in the navigation tree and either double-click it or right-click and 
select Configure.  

2 Check DEBUG MODE. 

3 Download the new or edited control program. See Add or delete a custom control program (page 111) 
and Change a control program or graphic (page 110). 

4 Before logging out or switching to a different controller, select the control program in the navigation tree 
and either double-click it or right-click and select Configure.  

5 Uncheck DEBUG MODE. 

6 Download All Content from the Downloads page, Devices page > Manage tab, or any page that has a 
Download button.  

 

 
 

Defining i-Vu® paths 

A path tells the i-Vu® application the route through the system hierarchy to an item in the system. For 
example, a path tells the i-Vu® application where to find a microblock property value to display on a graphic 
or where to jump to when the operator clicks a link on a graphic.  

In ViewBuilder, you use paths in:  
• Controls 
• Links 
• Conditional expressions 
In i-Vu®, you use paths in :  
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• The source field code (page 94) in alarm actions and messages 
• An Equipment Values report (page 69) 
• The go manual command (page 164) 
• i-Vu® Pro only: Autopilot 
 
You can do one of the following to get the path: 
• In ViewBuilder, let ViewBuilder write the path. 
• In the i-Vu® interface, determine the path yourself (page 174). 
A path consists of the reference name of each tree item included in the path, separated by a forward slash 
(/). For example, first_floor/zone_1/rs. 

A path can be absolute (page 173) or relative (page 173). 

i-Vu® paths are based on parent-child hierarchy.  

 

 
 

Absolute path 

An absolute path begins at a specific point in the system hierarchy and is followed by the children below it 
down to the object or property of interest. An absolute path can begin with either of the following: 

• A global reference name—a reference name that is unique within the entire system and begins with a # 
sign. 
EXAMPLE If OA Conditions has a global reference name of #oa_conditions, the absolute path to OA 
Conditions is simply #oa_conditions. The absolute path to any child of OA Conditions, such as OA 
Temperature, begins with #oa_conditions. For example, #oa_conditions/oa_temp. 

• The top of the i-Vu® tree. 

 

 
 

Relative path 

A relative path is useful for items such as graphics or alarm messages that you will reuse in multiple i-Vu® 
locations because the path is relative to the item that contains the path. 
  

A relative path going down the tree 
A relative path going down the tree begins with the reference name of the item below the location where the 
path is used. Examples using the system shown above:  
• To display the Lobby’s zone temperature on the Lobby’s graphic, the path is rs.  
• To display the Lobby’s zone temperature on the Atlanta-R&D Facility graphic, the path is 

first_floor/zone_1/rs. 
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A relative path going up the tree 
A relative path going up the tree begins with a ~ followed by one of the options below: 
  

 Use... To go... Examples using the system shown above 

~parent Up one level 1 To put a link on the Lobby graphic that goes to the First 
Floor graphic, the path is ~parent.  

2 To put a link on the Lobby graphic that goes to the 
Atlanta R&D Facility (up 2 levels), the path is 
~parent/~parent. 

3 To display the Lobby’s zone temperature on the Boiler 
graphic, the path is ~parent/~parent/ 
first_floor/zone_1/rs/present_value. 

~equipment To the microblock's control 
program 

To display the Lobby zone temperature in a High Temp 
alarm message, the path is ~equipment/rs/present_value. 

~device From a control program to its 
device 

To show the device name on an equipment graphic, use 
~device.display-name. 

 

 
 

Determining a path or microblock property 

A path tells the i-Vu® application the route through the system hierarchy to an item in the system. Paths are 
used in graphics, links, alarm messages, alarm actions, network microblock address, and other items. 

To get the path to an area, equipment, or microblock 
In the i-Vu® interface, right-click the item on the tree, then select Copy Path. Paste the path where you need 
it. 
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To get the path to a microblock property value 
1 In the i-Vu® interface, right-click the value, then select Global Modify. 

2 Click Show Advanced to see the full path to the property value. 

 

 
 

 
 

Supported i-Vu® features 

The WAP interface supports the following i-Vu® features. You can: 
• Access the navigation tree. 
• View and manage Alarms for the current location. 
• Receive an e-mail alarm message. 
• View and edit abbreviated Properties pages for areas and equipment. 
• View and edit abbreviated Properties pages for microblocks. 
  
You cannot: 
• View and edit items under the System Options tree. 
• View and manage Schedules. 
• Configure and view Reports. 
• View Graphics pages. 
• Send manual commands.
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icroblock families 

  The list below includes all microblock families, however, you may not see all of them. What information you 
see depends on your license, the application you are using, or the control program type. 

  

Family Description 

Carrier (page 2) Carrier microblocks allow the i-Vu® application to communicate directly with CCN 
devices. 

I/O Pts (page 31) Input and Output Points microblocks communicate values between a control program 
and a controller's physical inputs and outputs. Input values are read from sensors 
connected to the controller's physical inputs. Output values are sent from the controller's 
physical outputs to control components on the controlled equipment.  

The Airflow and Zone Sensor microblocks belong to this family. 

Network I/O (page 
122) 

Network Input and Output microblocks pass information between points on the network. 
A network input microblock reads the value of a network-visible BACnet® property on the 
network or of an equivalent value from another supported protocol. A network output 
microblock writes a value to a point on the network. 

Display (page 171) & 
Display2 (page 211) 

Display microblocks communicate directly with BACnet® objects, and can be used to 
integrate BACnet devices into a i-Vu® system. They can be referenced on graphics, 
allowing any vendor's BACnet equipment to be integrated into the system's interface. 

Sys In (page 226) System Input microblocks receive heat and cool requests, as well as other system 
information, editable properties, or constants used as input values to a control program.  

Sys Out (page 255) System Output microblocks contain control program output values, such as heat and 
cool requests or other status information. You can make these values network-visible to 
other BACnet devices. 

Log (page 271) Log microblocks record system values, such as trends, alarms, and runtime values. 

Control (page 287) Control microblocks output signals that are used for control and scheduling purposes. 
Many of these microblocks generate colors, which are used to communicate control 
program or zone color status. 

Convert (page 326) Convert microblocks take information from other microblocks, change the data in some 
way, then output the changed data. 

Limit (page 357) Limit microblocks test their input values against some limit, then output either the 
original signal or the limit value. 

Relay (page 366) Relay microblocks act as software relays to determine how and when an input signal 
should be modified before it is sent from the microblock or the control program. 

Logic (page 383) Logic microblocks perform logical operations on their inputs. Often these microblocks 
determine the conditions that trigger equipment starts, stops, or alarms. 

Math 1 (page 392) Math 1 microblocks perform simple mathematical operations on their inputs.  

Microblock reference 
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Math 2 (page 405) Math 2 microblocks perform advanced and trigonometric mathematical operations on 
their inputs.  

Misc (page 414) Miscellaneous microblocks include: 
• DO/DI Proof 
• Up/Down Counter 
• Text 
• Version 
• Sunrise/Sunset 
• OCL (Operator's Control Language) 

  

 

 
 

Carrier microblocks 

The following Carrier microblocks allow the i-Vu® application to communicate directly with CCN devices. 
  

 Carrier Controller (page 3) 

A CCN Controller microblock does the following: 

• Establishes and verifies communication with a CCN device in the CCN network. 

• Contains the CCN device address so that all CCN points in the control program 
can link to it. 

• Determines the refresh time for these related CCN points. Write points use 
standard network microblocks that have individual refresh timers.  

 Carrier Binary Value (page 4) 

The Carrier Binary Value microblock can monitor and force (restrict) a binary value in 
a Carrier device. 

 Carrier Analog Value (page 7) 

The Carrier Analog Value microblock can monitor and force (constrain or restrict) an 
analog value in a Carrier device. 

 Carrier Binary Point (page 9) 

The Carrier Binary Point microblock reads the binary (on or off) value of a physical 
input on the controller and makes this value available to be read by other BACnet 
devices on the network. The value appears to other BACnet devices as the Present 
Value property of a BACnet Binary Input Object. 

 Carrier Analog Point (page 15) 

The Carrier Analog Point microblock reads the analog (continuous) value of a physical 
input on the controller. Then converts the raw data from the sensor to the 
appropriate range for its unit of measurement (like mA, degrees Fahrenheit, or psi). 

 BACnet CCN Alarm (page 20) 

The BACnet CCN Alarm microblock monitors CCN alarms and passes them from the 
Carrier device to the i-Vu® Alarms page or third-party BACnet front end. 
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 Carrier Schedule (page 23) 

The Carrier Schedule microblock writes a weekly schedule to the CCN Controller. 

 Zone Setpoint for Integration (page 26) 

This microblock determines a zone's heating and cooling setpoints for both occupied 
and unoccupied periods. 

 Carrier Text Display (page 29) 

This microblock allows you to place descriptive text on the Properties page from a CCN 
point. 

 

 

 
 

CCN Controller 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol 
    

What it does A CCN Controller microblock does the following: 

• Establishes and verifies communication with a CCN device in the CCN network. 

• Contains the CCN device address so that all CCN points in the control program 
can link to it. 

• Determines the refresh time for these related CCN points. Write points use 
standard network microblocks that have individual refresh timers.  

 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Refresh Time The interval at which all CCN points in the program read their target values from the 
CCN device. 

Bus The number of the CCN network. (0-239) 

Element A unique number assigned to each device on a CCN network (1-239). 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 

Comm error limit The number of communication failures to allow before a CCN device is considered 
offline and the microblock's COMM output goes OFF. 

Refresh controller info Select to initiate a read of the CCN device so that device information such as model 
number, serial number, etc. can be obtained. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Carrier Binary Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol    



 Microblock reference
  

 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 5 

 

What it does 
 

 

The Carrier Binary Value microblock can monitor and force (restrict) a binary value in 
a Carrier device. 

A Carrier Binary Value microblock: 

• Is not visible to the network 

• Does not contain a BACnet object 

• Cannot be an alarm source 

• Cannot be trended 

See the Carrier Binary Point microblock if you need these features. 

This microblock's poll rate is set in the related CCN Device microblock. 

  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Com Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 
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Path Use the information below to format a valid path for the microblock you are using to 
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric 
characters. Check Editable if you want the path to be editable in the i-Vu® interface.  

Path format:    
CCN://LINK/<table name>/<point name><:instance#><@force level> 
  

LINK represents the CCN device defined in the CCN Controller microblock. 
  

<table name> - Use one of the following: 

Definition table name:Data table name 
Example:  CCN://LINK/MYTABLE:MYDATA1 

Definition table name:Instance number 
Example:  CCN://LINK/MYTABLE:1 

Data table name 
Example:  CCN://LINK/MYDATA1 

Where: 
• Definition table name is the name of the POC table that describes the data 

structure of the child tables.  
• Data table name is the name of the table instance that contains the variable or 

field being referenced. 
• Instance# is the table instance number  

  
<point name> 
Example:  CCN://LINK/.../HEATSP 
  

<:instance#> (Optional) - Use the instance number of the point name if the table has 
more than one point with the same name. 
  

<@force level> (Optional) - The force level being written to (a value 1–15) 
Example:  CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4 

 
You can edit the address/path of a CCN point in one of the following places in the i-
Vu® interface: 
• The Details tab of a Point Properties dialog box 
• The Address column on the Properties > Network Points page 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Editable Check to make this microblock's value editable in the i-Vu® interface. 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 
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Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Carrier Analog Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol    

What it does 
 

 

The Carrier Analog Value microblock can monitor and force (constrain or restrict) an 
analog value in a Carrier device. 

A Carrier Analog Value microblock: 

• Is not visible to the network 

• Does not contain a BACnet object 

• Cannot be an alarm source 

• Cannot be trended 

See the Carrier Analog Point microblock if you need these features. 

This microblock's refresh rate is set in the related Carrier Device microblock. 

 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Comm Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  
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Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Path Use the information below to format a valid path for the microblock you are using to 
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric 
characters. Check Editable if you want the path to be editable in the i-Vu® interface.  

Path format:    
CCN://LINK/<table name>/<point name><:instance#><@force level> 
  

LINK represents the CCN device defined in the CCN Controller microblock. 
  

<table name> - Use one of the following: 

Definition table name:Data table name 
Example:  CCN://LINK/MYTABLE:MYDATA1 

Definition table name:Instance number 
Example:  CCN://LINK/MYTABLE:1 

Data table name 
Example:  CCN://LINK/MYDATA1 

Where: 
• Definition table name is the name of the POC table that describes the data 

structure of the child tables.  
• Data table name is the name of the table instance that contains the variable or 

field being referenced. 
• Instance# is the table instance number  

  
<point name> 
Example:  CCN://LINK/.../HEATSP 
  

<:instance#> (Optional) - Use the instance number of the point name if the table has 
more than one point with the same name. 
  

<@force level> (Optional) - The force level being written to (a value 1–15) 
Example:  CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4 

 
You can edit the address/path of a CCN point in one of the following places in the i-
Vu® interface: 
• The Details tab of a Point Properties dialog box 
• The Address column on the Properties > Network Points page 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Editable Check to make this microblock's value editable in the i-Vu® interface. 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Carrier Binary Point 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol    

What it does 
 

 

The Carrier Binary Point microblock: 

• Can monitor and force (constrain or restrict) a variable in a Carrier device 

• Is visible to the BACnet network 

• Contains a BACnet binary value object 

• Contains a BACnet trend log object 

• Can be an alarm source 

• Can be trended 

• Uses the out-of-service BACnet requirements 

• Can be used in a graphic to force a variable 

This microblock's refresh rate is set in the related Carrier Device microblock. 

The Carrier Binary Point microblock reads the binary (on or off) value of a physical 
input on the controller and makes this value available to be read by other BACnet 
devices on the network. The value appears to other BACnet devices as the Present 
Value property of a BACnet Binary Input Object. You can assign a name to each input, 
which appears on the face of the microblock and is used as the name of the BACnet 
object.  
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Com Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Writable Check to allow BACnet commands to write to present value. 

Force Level The force level being written to (1-15). 

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Description (optional) A BACnet-visible microblock description. 
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Path Use the information below to format a valid path for the microblock you are using to 
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric 
characters. Check Editable if you want the path to be editable in the i-Vu® interface.  

Path format:    
CCN://LINK/<table name>/<point name><:instance#><@force level> 
  

LINK represents the CCN device defined in the CCN Controller microblock. 
  

<table name> - Use one of the following: 

Definition table name:Data table name 
Example:  CCN://LINK/MYTABLE:MYDATA1 

Definition table name:Instance number 
Example:  CCN://LINK/MYTABLE:1 

Data table name 
Example:  CCN://LINK/MYDATA1 

Where: 
• Definition table name is the name of the POC table that describes the data 

structure of the child tables.  
• Data table name is the name of the table instance that contains the variable or 

field being referenced. 
• Instance# is the table instance number  

  
<point name> 
Example:  CCN://LINK/.../HEATSP 
  

<:instance#> (Optional) - Use the instance number of the point name if the table has 
more than one point with the same name. 
  

<@force level> (Optional) - The force level being written to (a value 1–15) 
Example:  CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4 

 
You can edit the address/path of a CCN point in one of the following places in the i-
Vu® interface: 
• The Details tab of a Point Properties dialog box 
• The Address column on the Properties > Network Points page 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Editable Check to make this microblock's value editable in the i-Vu® interface. 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Show Property Page Text   Check to show this microblock's value on the equipment's Properties page. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

History 
Change of State Time The date and time the most recent change of state occurred.  

Change of State Count The number of times the point has changed states. Click Reset to set Change of 
State Count to 0. 

Time of State Count Reset The date and time the change of state count was set to zero. 

Elapsed Active Time The amount of time the point has been in the "on" state. Click Reset to set Elapsed 
Active Time to 0. 

Time of Active Time Reset The date and time the elapsed active time was set to zero. 

 

 
 

Trends 
  

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

NOTE  Set this field in Snap to one minute or greater. After the control program is 
running in a live system, if needed you can adjust this setting in the live system based 
on the characteristics of the CCN bus and its polling interval. See "To collect trend 
data for a point" in i-Vu help, or see the CCN Integration Guide. 

Sample on COV 
(change of Value) 

Records the microblock’s present value only when the value changes. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset on the Properties page in a i-Vu® or Field Assistant system to delete all 
samples currently stored in the controller. 
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Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Alarm 
 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm Enabled? Check to send a message when this microblock indicates an alarm condition. 

Alarm State Select the checkbox to have an alarm condition exist when the microblock's present 
value is on (true). 

Clear the checkbox to have an alarm condition exist when the microblock's present 
value is off (false). 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Return Enabled Check to send a message when an alarm condition has returned to normal. 

Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 
non-existent sensor. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

BACnet Configuration 
Dial on alarm Select to have this alarm immediately delivered through a modem connection. 

Notification Class Defines how alarm notifications shall be prioritized in their handling according to TO-
OFFNORMAL, TO-FAULT, and TO-NORMAL alarms; whether these categories of alarms 
require acknowledgement (nearly always by a human operator); and what destination 
devices or processes should receive notifications.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Carrier Analog Point 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol    

What it does 
 

 

The Carrier Analog Point microblock: 

• Can monitor and force (constrain or restrict) a variable in a Carrier device 

• Is visible to the BACnet network 

• Contains a BACnet analog value object 

• Contains a BACnet trend log object 

• Can be an alarm source 

• Can be trended 

• Uses the out-of-service BACnet requirements 

• Can be used in a graphic to force a variable 

This microblock's poll rate is set in the related Carrier Device microblock. 

The Carrier Analog Point microblock reads the analog (continuous) value of a physical 
input on the controller. Then converts the raw data from the sensor to the 
appropriate range for its unit of measurement (like mA, degrees Fahrenheit, or psi). 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Com Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Writable Check to allow BACnet commands to write to present value. 

Force Level The force level being written to (1-15). 
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Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Description (optional) A BACnet-visible microblock description. 

Path Use the information below to format a valid path for the microblock you are using to 
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric 
characters. Check Editable if you want the path to be editable in the i-Vu® interface.  

Path format:    
CCN://LINK/<table name>/<point name><:instance#><@force level> 
  

LINK represents the CCN device defined in the CCN Controller microblock. 
  

<table name> - Use one of the following: 

Definition table name:Data table name 
Example:  CCN://LINK/MYTABLE:MYDATA1 

Definition table name:Instance number 
Example:  CCN://LINK/MYTABLE:1 

Data table name 
Example:  CCN://LINK/MYDATA1 

Where: 
• Definition table name is the name of the POC table that describes the data 

structure of the child tables.  
• Data table name is the name of the table instance that contains the variable or 

field being referenced. 
• Instance# is the table instance number  

  
<point name> 
Example:  CCN://LINK/.../HEATSP 
  

<:instance#> (Optional) - Use the instance number of the point name if the table has 
more than one point with the same name. 
  

<@force level> (Optional) - The force level being written to (a value 1–15) 
Example:  CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4 

 
You can edit the address/path of a CCN point in one of the following places in the i-
Vu® interface: 
• The Details tab of a Point Properties dialog box 
• The Address column on the Properties > Network Points page 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Editable Check to make this microblock's value editable in the i-Vu® interface. 

Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

NOTE  Set this field in Snap to one minute or greater. After the control program is 
running in a live system, if needed you can adjust this setting in the live system based 
on the characteristics of the CCN bus and its polling interval. See "To collect trend 
data for a point" in i-Vu help, or see the CCN Integration Guide. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 
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Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 
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Alarm 
 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 
Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Return Enabled Check to send a message when an alarm condition has returned to normal. 

Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 
non-existent sensor. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 
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Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

BACnet CCN Alarm 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol 
   

What it does The BACnet CCN Alarm microblock monitors CCN alarms and passes them from the 
Carrier device to the i-Vu® Alarms page or third-party BACnet front end. 

The Alarm ID string is used to match an incoming CCN alarm to this microblock. In 
most cases, this is the CCN variable name. This microblock monitors all CCN alarms, 
and sends an alarm event to the i-Vu® application when a CCN alarm is received that 
matches the Alarm ID.  

Also, you can define a BACnet CCN Alarm microblock with Accept all Alarms checked to 
act as a catchall for alarms that do not match other Alarm microblock match strings. 
When the i-Vu® application receives an alarm, it searches all BACnet CCN Alarm 
microblocks for matching Alarm ID's. If no match is found the alarm is processed by 
the BACnet CCN Alarm microblock that has Accept all Alarms checked. 

Two alarms will be generated: one from the BACnet CCN Alarm microblock that 
includes the original CCN alarm text, and another from the related "Point" microblock 
because the Present_Value (updated via the received alarm message) may trigger an 
alarm intrinsic to the AV or BV object in the "Point" microblock. If this behavior is 
undesirable, the Event_Enable flags in the corresponding "Point" microblock should 
be set to FALSE to inhibit the intrinsic alarm from the "Point" microblock. 

This microblock will have a digital output wire that transitions to “on” when the alarm 
is active. If Accept all Alarms is checked – then the output will toggle on then go back 
off. RTN messages are posted as a separate event. If that is desired another 
microblock with the “specific” text should be added. Then, the output will stay active 
until an RTN of that type of alarm is received. 

The parameters for this microblock will be similar to the alarm parameters in any 
Carrier microblock that can be an alarm source, and the user will be able to enable 
and disable this alarm. When disabled, the microblock will still reflect the alarm 
status of the CCN device that sourced the alarm, but an event will not be sent to the i-
Vu® application. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Network Visible Check to make the microblock's output visible to third-party equipment.  

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Description NOTE  To use this field, the device's driver must be equal to or greater then 3.04.xxx. 
You cannot edit this field during run time. 

Use the text portion of the CCN alarm message generated by the Carrier PIC device.  

Enter the following text match="T051%x" 

T051%x respresents the CCN alarm code generated by the CCN equipment. See 
Carrier's Controls and Troubleshooting Guide for specific alarm codes. 

Controller Do not change this path from the default CCN://LINK. If altered, the alarms will not 
be forwarded. 

Alarm ID A variable name/point name of the Carrier CCN point you wish to monitor for an 
alarm. 

Active/Inactive Text The i-Vu® interface displays the Active Text when an alarm occurs, and the Inactive 
Text when the alarm status is normal.  

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Alarm 
 

Accept All Alarms Acts as a catchall for alarms that do not match pre-defined Alarm ID strings. When an 
alarm arrives, it will first search all BACnet CCN Alarm microblocks for matching Alarm 
ID's, if no match is found, the alarm will be processed by the BACnet CCN Alarm 
microblock with Accept all Alarms. 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm Enabled? Check to send a message when this microblock indicates an alarm condition. 

Alarm State Select the checkbox to have an alarm condition exist when the microblock's present 
value is on (true). 

Clear the checkbox to have an alarm condition exist when the microblock's present 
value is off (false). 

Return Enable Check to send a message when an alarm condition has returned to normal. 

Fault Enable Check to send a message when a fault condition occurs, such as a misconfigured or 
non-existent sensor. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Carrier Schedule 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

 

Microblock family Carrier microblocks (page 2) 

Icon and symbol 
   

What it does 
 

 

The Carrier Schedule microblock writes a weekly schedule to the CCN Controller.  

The Carrier Schedule microblock provides the CCN controller with an occupancy 
schedule. The CCN occupancy schedule is generated from a BACnet schedule 
originating in the i-Vu® application or a BACnet BMS. The CCN controller must use 
the same occupancy SCHEDULE NUMBER as this microblock's Write to global schedule 
number_____property (default=1). This ensures the schedule from this microblock is 
written to the correct schedule in the CCN controller.  

The Schedule Number range is 1-99. 

The Carrier Schedule microblock can write to the local schedule (schedule # 1 – 64) 
of a CCN controller or to a controller configured to receive a CCN Global schedule 
(schedule # 65 – 99). It will not write a schedule to a CCN controller that is 
broadcasting a global schedule. 

The microblock has three outputs:  
• The first (top) outputs On or Off to indicate the occupancy state of the microblock. 
• The second outputs how much time remains in the current state. 
• The third outputs On or Off to indicate if an override is in effect. This output could 

be used to feed a trend microblock.  
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Schedule Category The category of the schedule that will run the controlled equipment. Select 
Occupancy unless you have defined a custom schedule category in the Snap and i-
Vu® applications. 

Schedule number • 1 – 64 are local schedules that reside within the equipment. 

• 65 – 99 are network or global schedules, which are sent over a CCN network and 
received by controllers that contain network schedules. 

Group schedule 
overrides? 

Allows an override from a single controller to override all controllers within it's Group 
number. 

Configuration 
Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

Timed override minutes Minutes the microblock adds to the zone's occupied time for each press of the zone's 
local override button or switch. 

Second press cancels 
override 

Select to have a second press of a zone sensor's override button cancel the override. 
If not selected, a second press will increase the override by the amount of time 
defined in the Timed override minutes field. 

CCN Schedule Number The CCN device must be configured for a schedule number between 1 and 99 
inclusive. 

Show scheduling limits: 
 

The default limits for the Occupancy schedule category.  

NOTES 

• A schedule download will fail if you exceed these limits when creating schedules. 

• Changing these properties erases the schedule information in the controller, 
requiring you to download schedules again. 

• If you use Global Modify to change these limits, the affected devices will not be 
automatically marked for schedule download. 

     Weekly       Schedules - 
Max      Transitions Per  
     Day 

The number of transitions a weekly schedule allows in a 24-hour period. The default 
is 6, which creates 5 schedule segments. 

     Max Exception  
     Schedules 

The number of non-weekly schedules allowed in a controller. The default is 30. The 
system reserves 7 of these schedules - one for each day of the week. 
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     Max Transitions  
     Per Day 

The number of transitions a non-weekly schedule allows in a 24-hour period. The 
default is 6, which creates 5 schedule segments. 

Property Page Text 
Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the controller. 

 

 
 

Alarms 
 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide alarm 
button when the alarm comes in. 

Alarm 
Alarm Enable Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before the 
microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 
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Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that contains 
the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Zone Setpoint for Integration 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol 

     

What it does 
 

 

This microblock determines a zone's heating and cooling setpoints for both occupied 
and unoccupied periods. 

You can determine a zone's setpoints for both occupied and unoccupied periods; 
however, because of factors such as local overrides, demand level, or optimal start 
routines, the zone's effective setpoints may be calculated differently by the 
microblock.  

NOTE  The Zone Setpoint for Integration microblock is only supported in the UPC 
Open. 
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Inputs and outputs 

Input 
OCC Binary input - indicates whether or not the zone is currently occupied 

ZONE Analog input - current zone temperature 

HT Analog input - Effective heating setpoint from the linkage provider 

CL Analog input - Effective cooling setpoint from the linkage provider 

Output 
CO Analog output - preset cooling occupied setpoint 

CU Analog output - preset cooling unoccupied setpoint 

HO Analog output - preset heating occupied setpoint 

HU Analog output - preset heating unoccupied setpoint 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Setpoints 
Color Change Hysteresis The Color Change Hysteresis is represented by the Hyst setting on the Properties page. 

When returning to normal, it is the number of degrees required to exceed the setpoint 
before the microblock's color changes. An appropriate hysteresis prevents equipment 
from "chattering" when the temperature is very close to and oscillating around the 
setpoint. 

The desired occupied and unoccupied zone setpoints (degrees) and the value of each 
occupied color band (degrees).  

A color band's value determines the threshold at which the microblock changes the 
zone thermographic color as the zone temperature departs from setpoint.  

You can use the free cooling light green color band to enable economizer operation. If 
you are not using this feature, type 0 for this band's value.  

EXAMPLE 

 
 

Editing Privilege  Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 
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Carrier Text Display 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Carrier microblocks (page 2) 

Icon and symbol      

What it does This microblock allows you to place descriptive text on the Properties page from a CCN 
point. 

 

 
 

Properties 
 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 
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Path Use the information below to format a valid path for the microblock you are using to 
read or write to the CCN point. Each item in the path is limited to 8 alpha-numeric 
characters. Check Editable if you want the path to be editable in the i-Vu® interface.  

Path format:    
CCN://LINK/<table name>/<point name><:instance#><@force level> 
  

LINK represents the CCN device defined in the CCN Controller microblock. 
  

<table name> - Use one of the following: 

Definition table name:Data table name 
Example:  CCN://LINK/MYTABLE:MYDATA1 

Definition table name:Instance number 
Example:  CCN://LINK/MYTABLE:1 

Data table name 
Example:  CCN://LINK/MYDATA1 

Where: 
• Definition table name is the name of the POC table that describes the data 

structure of the child tables.  
• Data table name is the name of the table instance that contains the variable or 

field being referenced. 
• Instance# is the table instance number  

  
<point name> 
Example:  CCN://LINK/.../HEATSP 
  

<:instance#> (Optional) - Use the instance number of the point name if the table has 
more than one point with the same name. 
  

<@force level> (Optional) - The force level being written to (a value 1–15) 
Example:  CCN://LINK/HOLIDAYS:HOLIDAY1/HEATSP@4 

 
You can edit the address/path of a CCN point in one of the following places in the i-
Vu® interface: 
• The Details tab of a Point Properties dialog box 
• The Address column on the Properties > Network Points page 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Show Property Page Text  Check to show this microblock's value on the equipment's Properties page. 
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Input and Output Points microblocks 

Input and Output Points microblocks communicate values between a control program and a controller's physical 
inputs and outputs. Input values are read from sensors connected to the controller's physical inputs. Output 
values are sent from the controller's physical outputs to control components on the controlled equipment.  

The Airflow and Zone Sensor microblocks belong to this family. 

 Inputs 

 BACnet Analog Input (page 32) 

Reads the analog (continuous) value of a physical input on the controller. Converts the raw data 
from the sensor to the appropriate range for its unit of measurement (such as mA, degrees 
Fahrenheit, or psi). 

 BACnet Binary Input (page 38) 

Reads the binary (on or off) value of a physical input on the controller. 

 Timed Local Override (page 43) 

Reads a local override input signal from a user-adjustable switch or button in the zone. Converts the 
signal, then outputs a remaining time value. 

 Pulse to Analog Input (page 49) 

Counts pulses from a binary (on or off) input over a specified period of time. Every minute, 
calculates and outputs the average number of pulses received over the specified time. 

Outputs 

 BACnet Analog Output (page 54) 

Sends an analog (continuous) value from the control program to a physical analog output on the 
controller. 

 BACnet Binary Output (page 60) 

Sends a binary (on or off) value from the control program to a physical digital (on or off) output on 
the controller. 

 Floating Motor (page 64) 

Works with a bi-directional motor actuator triggered by two digital signals, such as clockwise and 
counterclockwise or damper open and damper closed. Converts a percent open value from the 
control program to on and off signals to two physical digital outputs on the controller. 

 Pulse-Width Output (page 70) 

Converts a percent value from the control program to a digital on or off signal that varies in duration 
based on minimum and maximum values you define. 

Zone (Airflow and Sensors) 

 U Line Airflow Control (page 77) 

This microblock cannot be used for Carrier controllers. 

 LogiStat Zone Sensor (page 77) 

This microblock cannot be used for Carrier controllers. 
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 RS Zone Sensor (page 77) 

Sends information to and receives values from a variety of sensor configurations. Works with a 
schedule and setpoint microblock to maintain zone temperature at setpoint. 

 RS Zone Sensor with Fan Control (page 85) 

Sends information to and receives values from a variety of sensor configurations. Works with a 
schedule and setpoint microblock to maintain zone temperature at setpoint. Enables the sensor's 
fan control and mode functionality. 

 Airflow Control (page 96) 

Maintains VAV zone airflow at setpoint. Its inputs, outputs, and properties interface with a 
controller's built-in airflow control algorithm. The algorithm ensures that zone airflow stays above the 
specified minimum for zone indoor air quality standards.  

Enables VAV testing and balancing through your system interface or through the stand-alone Airflow 
Test and Balance Utility.  

 BACnet Pressure Dependent Control (page 108) 

Calculates and maintains the desired damper position in a pressure dependent zone.  Controls AUX 
reheat operation and fan operation in a fan powered box.  

Its inputs, outputs, and properties interface with the control algorithms built into other controllers. 
The algorithm ensures that zone airflow stays above the specified minimum for zone indoor air 
quality standards.  

Enables testing and balancing through the i-Vu® interface or through a stand-alone utility. Controls 
the damper and other key zone operations, such as the fan (FAN) and auxiliary heat (AUX HEAT), 
during commissioning. 

 BACnet Bypass Control (page 115) 

Controls the bypass damper based on the commanded position input wire. Converts the pressure 
sensor count to pressure and output this value to the DUCT SP wire. Allows for the configuration of 
the duct static pressure setpoint and the maximum static pressure setpoint during LAT override. 

Enables testing and balancing through the i-Vu® interface. Calibrates the airflow sensor readings at 
design setpoint and zero calibration of sensor when AHU fan is off. Calibrates full open and closed 
damper positions. 

 

 
 

BACnet Analog Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Reads the analog (continuous) value of a physical input on the controller. Converts 
the raw data from the sensor to the appropriate range for its unit of measurement 
(such as mA, degrees Fahrenheit, or psi). 
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How it works 
The Input Type, Sensor Type, Scaling Range (linear sensor types only) and Input Resolution together determine 
how the microblock converts raw sensor data into the microblock's output value. 

For non-linear sensor types, you can set up a custom translation table that has sensor input values (kOhms or 
volts) and their equivalent output values. You set up these tables in your i-Vu® or Field Assistant system on a 
driver's Custom Translation Tables Properties page. 

Linear sensor types use the slope-intercept formula for a line (y=mx+b). 

EXAMPLE  For a 0-20 mA input type using a Linear w/offset scaling method (4-20 mA) and a scaling range of 20 
to 420 gpm, a sensor reading of 8 mA produces a microblock output value of 120 gpm. 
 

x = mA
20

420

-80

y = gpm

204

m =
420 gpm - 20 gpm

20 mA - 4 mA
= 25

gpm

mA

b (y-intercept)
calculated by control module

y = mx + b

y =   25  8 mA   - 80 gpm = 120 gpm
gpm

mA

8

120

 
 

The Input Resolution determines the final microblock output. The driver rounds the microblock's present value 
according to the resolution and prevents it from fluctuating too rapidly. 

EXAMPLE  If the calculated present value is 13.789 and you set the Resolution to 0.1, the control program uses 
13.8 for any calculations downstream from the microblock. The output remains at 13.8 until the calculated 
present value rises to 13.9 or falls to 13.7. 

 

 
 

Limitations 
Inputs are limited to a controller's supported input types. See the controller's documentation for more information. 
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Configuration example 
For a 4–20 mA flow meter designed for operation between 20 and 420 gpm that is wired to input 3 on a 
controller's expander 4: 

 
NOTE  An input resolution of 1 causes the microblock to output gpm in whole numbers. 

See the controller's documentation for more information on assigning inputs and outputs to points. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical input this microblock 

reads. Type 0 for a physical input on a controller without an expander. 

Input Number The number of the physical input the microblock reads. 

Input Type The type of equipment wired to the input number that the microblock reads. 

Universal Input - Provides backwards compatibility with drivers earlier than 
v2.02.022. With later versions, this selection displays a ? value in the i-Vu® or Field 
Assistant system. 

Calibration 
Input Resolution The increment by which the microblock updates the value on its output wire in a i-

Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

Sensor Type  
(Scaling Method) 

The scaling method the controller uses to convert the raw sensor data to the 
appropriate range for the input's engineering units. 

Scaling Range 
Minimum 

Applies to linear Sensor Types only. The value associated with the minimum sensor 
signal to the controller's physical input. 

EXAMPLE  For a 4-20 mA sensor that reads from 20 to 420 gpm, type 20 so that 
when the input reads 4 mA, the microblock outputs a value of 20. 

Scaling Range 
Maximum 

Applies to linear Sensor Types only. The value associated with the maximum sensor 
signal to the controller's physical input. 

EXAMPLE  For a 4-20 mA sensor that reads from 20 to 420 gpm, type 420 so that 
when the input reads 20 mA, the microblock outputs a value of 420. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 
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Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 
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Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 38 

 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 
 

BACnet Binary Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Reads the binary (on or off) value of a physical input on the controller.  
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How it works 
The Input Type, Active Text, Inactive Text, and Polarity together determine how the microblock converts raw 
sensor data into the microblock's output value. 

The Input Type tells the microblock whether to expect a sensor that closes and opens an unpowered set of 
contacts to produce an on or off signal (dry contact) or a sensor that provides an on or off electrical signal up to 
10 Vdc (binary input).  

Then, based on the signal and Polarity, the microblock converts the sensor's signal to a true or false value and 
displays the Active Text or Inactive Text. 

 

Polarity Signal Output 

Normal 

 

on (true) Active Text 

off (false) Inactive Text 

 

 
 

Limitations 
Inputs are limited to a controller's supported input types. See the controller's documentation for more information. 

 

 
 

Configuration example 
For a normally closed status relay indicating whether a fan is on or off wired to input 3 on a controller's expander 
4: 

 
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical input this microblock 

reads. Type 0 for a physical input on a controller without an expander. 

Input Number The number of the physical input the microblock reads. 

Input Type The type of equipment wired to the input number that the microblock reads.  

Use the following guidelines for choosing the Input Type:  

• Binary Input - Configures the microblock to read a set of contacts which 
close/open for an on/off signal. 

NOTE  We recommend using Binary Input. 

• Dry Contact - Same as Binary Input. 

• H-O-A Status Feedback - Reads status of HOA switches. 

Do not use: 

• Universal Input - Not supported.  

• Pneumatic Input - Not supported.  

• Special - Reserved for Carrier Engineering Dept.  

• Counter Input - Not supported. Use the Pulse to Analog Input microblock 
instead. 

System Setup 
Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Polarity Normal - The microblock's output is on when the signal to the microblock is on, and 
is off when the signal to the microblock is off. 

reversed - The microblock's output value is off when the signal to the microblock is 
on, and is on when the signal to the microblock is off. 
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BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled? Check to send a message when this microblock indicates an alarm condition. 

Alarm State Active - An alarm condition exists when the microblock's present value is on (true). 

Inactive - An alarm condition exists when the microblock's present value is off (false). 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 
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Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of Value) 

Records the microblock’s present value only when the value changes. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset on the Properties page in a i-Vu® or Field Assistant system to delete all 
samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 
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Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Timed Local Override 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Reads a local override input signal from a user-adjustable switch or button in the 
zone. Converts the signal, then outputs a remaining time value. 

This value can be used by a time clock microblock (page 287) to indicate a change in 
occupancy status.  

 

 
 

How it works 
Each time the user presses the button or switch that is assigned to this input, the input senses a binary signal. 
The microblock converts this binary input signal, or pulse, into a time output (minutes) using one of 3 methods 
you choose and set up. 
  

Method Description 

Pulse Input Pulses counted x Each pulse = Present Value 

Present Value accumulates up to Maximum Value. 

You can define a reset signal for the user in the Cancel override if input closed for > 
___ seconds field. 
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Fixed Width Input Pulse sensed x Each pulse = Present Value 

No accumulation with multiple pulses.  

No reset signal. 

Mechanical Input Override enabled by a constant-signal device such as a wind-up timer. 

Signal sensed x Input closed = Present Value 

 

 
 

Limitations 
Maximum Value cannot exceed 546 minutes. 

 

 
 

Configuration example 

 
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical input this microblock 

reads. Type 0 for a physical input on a controller without an expander. 

Input Number The number of the physical input the microblock reads. 

Input Type The type of equipment wired to the input number that the microblock reads. 

Universal Input - Provides backwards compatibility with drivers earlier than 
v2.02.022. With later versions, this selection displays a ? value in the i-Vu® or Field 
Assistant system. 

Override Type and Setup 
Pulse Input, 
Mechanical Input, 
or Fixed Width Input 

Select the method the microblock uses to convert the controller's binary input signal 
into a time value (minutes). See "How it works" in this microblock's help. 

Each pulse Minutes the microblock adds to the zone's occupied time for each press of the zone's 
local override button or switch. 

Cancel override if input 
closed for > ___ seconds 

Seconds the user must press the local override button to cancel timed local override 
and return the zone to the unoccupied mode. 

Input Closed Minutes the microblock adds to the zone's occupied time for each press of the zone's 
local override button or switch. 

Maximum Value Maximum value (up to 546 minutes) the microblock outputs regardless of additional 
pulses from the controller's input. 
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Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Out Of Service Minimum 
Pres Value 
Minimum Value 

If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True 
and then he writes a value lower than this value to the microblock's Present_Value, 
the controller returns a Property, Value_Out_Of_Range error.  

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 47 

 

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 
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BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Pulse to Analog Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Counts pulses from a binary (on or off) input over a specified period of time. Every 
minute, calculates and outputs the average number of pulses received over the 
specified time. 

 

 
 

How it works 
Many meters measure flow rates and output pulses, where each pulse represents a quantity of the flowing 
medium. For example, a pulse might equal a quantity of water (gallons/pulse), gas (cubic feet/pulse), or electricity 
(kWh/pulse). Your meter determines your Gain, or the quantity that each pulse represents. For example, a flow 
meter that measures 15 gallons/pulse has a Gain of 15. This microblock calculates and outputs the flow rate 
from the pulses using the following formula: 

 
EXAMPLE 

During a Pulse Window of 30 minutes the microblock counts 90 pulses. Each pulse represents 15 gallons (Gain = 
15).  The microblock calculates and outputs a flow rate of 45 gallons/minute. 

 
 

 
 

Limitations 
Some controllers do not support pulse counting or do not support pulse counting on all inputs. Most controllers 
that support pulse counting cannot count more than 4 pulses per second. See the controller's documentation for 
more information. 
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Configuration and programming example 
For an electric meter connected to input 3 on a controller's expander 1 that reads 10 kWh/pulse: 

 
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical input this microblock 

reads. Type 0 for a physical input on a controller without an expander. 

Input Number The number of the physical input the microblock reads. 

Input Type Select Counter Input. 

Calibration 
Gain The quantity that each meter pulse represents.  

EXAMPLE  For a flow meter that measures 15 gallons/pulse, type 15. 

Pulse Window The period (minutes) over which the microblock averages the flow rate. The 
microblock uses a sliding window. 

Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Out Of Service Minimum 
Pres Value 
Minimum Value 

If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True 
and then he writes a value lower than this value to the microblock's Present_Value, 
the controller returns a Property, Value_Out_Of_Range error.  
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Out Of Service  
Max Pres Value 
Maximum Value 

If a third-party vendor sets the microblock's BACnet Out_Of_Service property to True, 
and then he writes a value higher than this value to the microblock's Present_Value, 
the controller returns a Property, Value_Out_Of_Range error.  

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 
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Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 
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Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

BACnet Analog Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Sends an analog (continuous) value from the control program to a physical analog 
output on the controller. 
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How it works 
The Output Type, Actuator Type, Minimum Value, Maximum Value, and Resolution together determine how the 
microblock converts its input value into the controller's output signal to the controlled equipment. 

The Output Type tells the microblock what type of physical output it is connected to on the controller. The Actuator 
Type tells the controller how to convert the signal from the controlled equipment into engineering units. The 
Minimum Value and Maximum Value define the scale the microblock uses to convert the input signal from linear 
Actuator Types into the controller's output signal. 

The microblock truncates the input value using the Resolution before performing any scaling calculations.   

EXAMPLE  If the wire input value is 50.073 and you set the Resolution to 0.1, the microblock uses 50.0 for any 
scaling calculations. 

Linear sensor types use the slope-intercept formula for a line (y=mx+b).  

EXAMPLE  For a microblock that uses a 0–100% open signal from a PID microblock to control a 2–10 Vdc 
actuator, set the Minimum Value to 0 and the Maximum Value to 100.  Then a 50% signal from the PID to the 
microblock produces a 6 Vdc output signal. 

 

Control
module 
output
x = Vdc

-25

y = PID output (%)

102

m =
100% - 0%

10 Vdc - 2 Vdc
= 12.5

b (y-intercept)
calculated by control module

y = mx + b

x =  (50% + 25%) = 6 Vdc

6

50

100

  0

Maximum
value:

Minimum
value:

x =       (y - b)
1
m

%
Vdc

1

12.5

%
Vdc

 
 

 
 

Limitations 
Outputs are limited to a controller's supported output types. See the controller's documentation for more 
information. 
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Configuration example 
For a 0–100% signal to a 2–10 Vdc damper actuator connected to analog output 2 on a controller's expander 3: 

 
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical output this microblock 

sends a signal to. Type 0 for a physical output on a controller without an expander. 

Output Number The number of the physical output that the microblock sends a signal to. 

Output Type The physical output type of the output number that the microblock sends a signal to. 

Output Configuration and Calibration 
Minimum Value The microblock value associated with the minimum signal the controlled equipment 

expects. 

EXAMPLE  For a 2-10 Vdc actuator controlled by a 0-100% PID signal, type 0 so that 
when the PID signal to the microblock is 0, the controller sends a 2 Vdc signal to the 
actuator. 

Maximum Value The microblock value associated with the maximum signal the controlled equipment 
expects. 

EXAMPLE  For a 2-10 Vdc actuator controlled by a 0-100% PID signal, type 100 so 
that when the PID signal to the microblock is 100, the controller sends a 10 Vdc 
signal to the actuator. 

Resolution The increment by which the microblock updates it's input value for use in 
calculations.  

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the system uses and displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system uses and displays 2 digits to the right of the decimal 
• 1 or greater, the system uses and displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the system uses and displays 8.4, 8.6, 8.8, ... 
• .03, the system uses and displays 5.09, 5.12, 5.15, ... 
• 10, the system uses and displays 30, 40, 50, ... 

Actuator Type The signal the controlled equipment connected to the output number expects. See 
the controller's documentation for more information on assigning inputs and outputs 
to points. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 
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Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 
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Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 
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In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

BACnet Binary Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Sends a binary (on or off) value from the control program to a physical digital (on or 
off) output on the controller. 

 

 
 

How it works 
The Output Type, Minimum off time, Minimum on time, and Polarity together determine how the microblock 
converts its input value into the controller's output signal to the controlled equipment. 

The Output Type tells the microblock what type of physical output it is connected to on the controller. Based on 
the microblock's value and its Polarity, the controller converts the microblock's input value into an on or off signal 
to the controlled equipment. Graphics or properties pages connected to the microblock display the microblock's 
Active Text or Inactive Text. 

 

Polarity Value Output 

Normal 

 

true (on) Active Text 

false (off) Inactive Text 
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Reversed 

 

true (off) Inactive Text 

false (on) Active Text 

 
The Minimum off time and Minimum on time protect the controlled equipment by determining the minimum 
amount of time the microblock sends each signal to the controller, regardless of the microblock's input value. 

 

 
 

Limitations 
Binary outputs are limited to a controller's supported power, current, or pressure rating. Some controllers allow 
you to configure binary outputs as normally open or normally closed. Non-configurable binary outputs are normally 
open. See the controller's documentation for more information. 

 

 
 

Configuration example 
For an output sending a signal to a relay wired to binary output 2 on a controller's expander 3: 

 
 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical output this microblock 

sends a signal to. Type 0 for a physical output on a controller without an expander. 

Output Number The number of the physical output that the microblock sends a signal to. 

Output Type The physical output type of the output number that the microblock sends a signal to. 

Setup 
Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Polarity Normal - The microblock's output is on when the signal to the microblock is on, and is 
off when the signal to the microblock is off. 

reversed - The microblock's output value is off when the signal to the microblock is 
on, and is on when the signal to the microblock is off. 

Minimum off time The minimum period (seconds) that the microblock sends an off signal to the 
controller, regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock sends an on signal to the 
controller, regardless of the input signal to the microblock. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Trends 
  

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of Value) 

Records the microblock’s present value only when the value changes. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset on the Properties page in a i-Vu® or Field Assistant system to delete all 
samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 
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Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Floating Motor 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol    

What it does Works with a bi-directional motor actuator triggered by two digital signals, such as 
clockwise and counterclockwise or damper open and damper closed. Converts a 
percent open value from the control program to on and off signals to two physical 
digital outputs on the controller. 

 
 

How it works 
The microblock's output controls two digital signals that together provide 3 commands to a floating motor 
actuator: 

• Don't move (both digital outputs are off) 

• Open (one digital output is on) 

• Close (the other digital output is on) 

The direction the actuator turns to open or close the damper or valve depends on the actuator wiring. 

Floating motor actuators are specified by the time required for the actuator to move from full closed to full open. 
Type this time (minutes:seconds) in the Full travel time is field. 

During each calculation, the microblock uses the following formula to determine how long it should send a signal 
and to which output. The motor moves for the duration of the controller's digital signal.  

|(Current % value - Previous % value)| x Full travel time is = Signal length 

• If Current % value > Previous % value, send signal to Open output. 

• If Current % value < Previous % value, send signal to Close output. 
  

EXAMPLE 
Full travel time = 100 seconds 
Current % value = 60% 
Previous % value = 80% 
Output = |(60% – 80%)| x 100 seconds = 20 seconds 
Since 60 < 80, the control program sends a 20-second signal to the controller's Close digital output. 

The microblock tracks the actuator's current position based on the history of its movement since its last 
calibration. 
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If the microblock's calculated signal time to any output is less than the Min Pulse Width, the controller does not 
activate the motor. 

When the microblock's value is either 0% or 100%, the microblock sends an additional signal for the Full travel 
time is duration to ensure that the damper or valve is fully open or fully closed. 

 

 
 

Limitations 
This microblock will not send a signal shorter than 1 second. To control the actuator's position to within 1% 
accuracy, you must use an actuator with a travel time of at least 100 seconds. For example, if your actuator has a 
20-second travel time, it can only be adjusted in increments of 5% (1 second/20 seconds = .05 or 5%). 

If the Full travel time is inaccurate, the actuator's calculated position will also be inaccurate. Over time, multiple 
adjustments can cause the error to increase and to affect the equipment's ability to efficiently achieve the desired 
setpoint. 

 

 
 

Configuration example 
For a 0–100% open signal to a 120-second floating motor actuator with the following configuration: 

• Open output wired to input 3 on the controller's expander 1 

• Close output wired to input 4 on the controller's expander 1 

 
In this example, the controller turns off the signal to the appropriate output after the actuator reaches its fully 
open or fully closed position because Maintain contact closure if current position = 0% or 100% is not checked. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration - Open 
Expander The address of the expander (1 to 6) that has the physical output this microblock 

sends a signal to. Type 0 for a physical output on a controller without an expander. 

Output Number The number of the physical output that the microblock sends a signal to. 

Output Type The physical output type of the output number that the microblock sends a signal to. 

Hardware Configuration - Close 
Expander The address of the expander (1 to 6) that has the physical output this microblock 

sends a signal to. Type 0 for a physical output on a controller without an expander. 

Output Number The number of the physical output that the microblock sends a signal to. 

Output Type The physical output type of the output number that the microblock sends a signal to. 

Output Configuration and Calibration 
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Maximum Value The microblock value associated with a full open signal. 

EXAMPLE  For an actuator controlled by a 0 to 100% PID signal, type 100 so that 
when the PID signal to the microblock is 100, the controller sends a full open signal 
to the actuator. 

Minimum Value The microblock value associated with a full closed signal. 

EXAMPLE  For an actuator controlled by a 0 to 100% PID signal, type 0 so that 
when the PID signal to the microblock is 0, the controller sends a full closed signal to 
the actuator. 

Resolution The increment by which the microblock updates it's input value for use in 
calculations.  

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the system uses and displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system uses and displays 2 digits to the right of the decimal 
• 1 or greater, the system uses and displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the system uses and displays 8.4, 8.6, 8.8, ... 
• .03, the system uses and displays 5.09, 5.12, 5.15, ... 
• 10, the system uses and displays 30, 40, 50, ... 

Full travel time is The period (hours:minutes:seconds) the actuator takes to travel from its fully open to 
its fully closed position. Maximum travel time is 54 minutes. 

Min Pulse Width The minimum period (hours:minutes:seconds) the motor should be activated each 
time it moves. Adjust after startup based on system performance. 

Maintain contact closure 
if current position = 0% 
or 100% 

Check to keep the signal to the motor on after the actuator reaches its fully open or 
fully closed position.  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 
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Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 
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In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Tips and tricks 
For accurate control, make sure that the Full travel time is value is as accurate as possible.  

The microblock tracks the actuator's current position based on the history of its movement since its last 
calibration. To prevent compounding error over time, recalibrate the Floating Motor microblock by periodically 
(nightly) setting the value to 0% or 100%. When the microblock's value is either 0% or 100%, the microblock 
recalibrates by sending an additional signal for the Full travel time is duration to ensure that the damper or valve 
is fully open or fully closed. 

 

 
 

Pulse-Width Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol     

What it does Converts a percent value from the control program to a digital on or off signal that 
varies in duration based on minimum and maximum values you define. 

Can control an actuator that requires a pulse-width signal, a hot wax valve, or a pulse-
width transducer.  
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How it works 
The Minimum Value, Maximum Value, Resolution, Pulse Duration, and Pulse Refresh Time values together 
determine how the microblock converts its input value into the controller's output signal to the controlled 
equipment. 

Obtain the maximum pulse duration (full open to full closed stroke time) and minimum pulse duration (pulse 
duration that indicates full open or full closed) from the controlled equipment's manufacturer's specifications. 

EXAMPLE  For a valve actuator with a 15-second stroke time (full open to full closed), a minimum pulse duration 
of 1 second, a minimum pulse refresh time of 20 seconds, and that is controlled by a 0% to 100% PID signal: 
  

 
  

Pulse Duration varies linearly between 1 second and 1+14=15 seconds as the microblock input value varies from 
0% (Minimum Value) to 100% (Maximum Value). 

 
 

If the microblock input value does not change the microblock resends the pulse duration calculated based on the 
current input value after the Maximum Pulse Refresh Time. 

An unchanging 50% PID output results in an 8-second pulse every 25 seconds. An unchanging 0% PID output 
results in a 1-second pulse every 25 seconds. As the PID output changes, the pulse duration will change no more 
frequently than every 20 seconds. 
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If the microblock input value changes by more than the Resolution, the microblock completes the current pulse, 
then recalculates and changes the pulse duration after the Minimum Pulse Refresh Time. 

If the microblock input value changes after the Minimum Pulse Refresh Time but before the Maximum Pulse 
Refresh Time, the microblock immediately sends a new pulse and resets the refresh times. 

The Minimum Pulse Refresh Time must be at least as long as the maximum pulse duration (Minimum + 
Additional % x __) or the complete pulse will not be sent. 

The Maximum Pulse Refresh Time must be longer than the Minimum Pulse Refresh Time.  

 

 
 

Limitations 
The microblock cannot output a minimum Pulse Duration smaller than 0.1 seconds. 

The Minimum Pulse Refresh Time must be at least as long as the maximum pulse duration (Minimum + 
Additional % x __) or the complete pulse will not be sent. 

The Maximum Pulse Refresh Time must be longer than the Minimum Pulse Refresh Time. 

Do not use pulse width modulated outputs with PWM-Stage Sequencer transducers. Control of the stages is 
limited by the timing within the pulse width modulated output, and use of this microblock could harm the 
controlled equipment.  

Hot wax valve actuators can be difficult to control. Paraffin (wax) expands when heated by the pulse-width signal. 
The wax continues to expand for a time after the signal has stopped. After the signal stops, the wax will eventually 
contract. If the pulse-width signal begins again, the wax may continue to contract for a time after the signal starts. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Hardware Configuration 
Expander The address of the expander (1 to 6) that has the physical output this microblock 

sends a signal to. Type 0 for a physical output on a controller without an expander. 

Output Number The number of the physical output that the microblock sends a signal to. 

Output Type The physical output type of the output number that the microblock sends a signal to. 

Output Configuration and Calibration 
Maximum Value 
 

The microblock value associated with the maximum pulse duration (Minimum + 
Additional % x __). 

EXAMPLE  For an actuator controlled by a 0-100% PID signal, type 100 so that 
when the PID signal to the microblock is 100, the controller sends the maximum 
pulse duration to the actuator. 

Minimum Value The microblock value associated with the 0% Pulse duration. 

EXAMPLE  For an actuator controlled by a 0-100% PID signal, type 0 so that when 
the PID signal to the microblock is 0, the controller sends the minimum pulse 
duration to the actuator. 
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Resolution The increment by which the microblock updates it's input value for use in 
calculations.  

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the system uses and displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system uses and displays 2 digits to the right of the decimal 
• 1 or greater, the system uses and displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the system uses and displays 8.4, 8.6, 8.8, ... 
• .03, the system uses and displays 5.09, 5.12, 5.15, ... 
• 10, the system uses and displays 30, 40, 50, ... 

Pulse Duration  
Minimum 

(0.1 seconds or greater) The pulse duration the microblock outputs for a microblock 
input value equal to the Minimum Value. 

Pulse Duration Additional 
% x ___ 

As the microblock's input varies from the Minimum Value to the Maximum Value, this 
value determines how much additional time will be added to the microblock's 
Minimum Pulse duration.  

Pulse Refresh Time 
Minimum 

How long the microblock must wait before sending a new pulse duration output for a 
changing input signal. Must be at least as long as the maximum pulse duration 
(Minimum + Additional % x __). 

Pulse Refresh Time 
Maximum 

How long the microblock waits before resending an existing pulse duration output for 
an unchanging input signal. Must be longer than the Minimum Pulse Refresh Time. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 
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BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

U-Line Airflow Control 

This microblock cannot be used for Carrier controllers. 

 

 
 

LogiStat Zone Sensor 

This microblock cannot be used for Carrier controllers. 

 

 
 

RS Zone Sensor 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol 

    

What it does Sends information to and receives values from a variety of sensor configurations. 
Works with a schedule and setpoint microblock to maintain zone temperature at 
setpoint. 

Can be connected to a controller's Rnet port. See the Carrier Sensor Installation 
Guide for supported Rnet configurations. 
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How it works 
Some features of this microblock do not apply to all supported sensors. However, the type of sensor connected to 
the controller can be changed without changing the control program.  

When connected to each sensor, the microblock's output and input values behave as follows: 

 
Output/Input 
value 

SPT Standard Rnet that includes an SPT Plus Rnet that includes an  
SPT Pro  

ZONE Current zone temperature (degrees). Units (Fahrenheit or Celsius) are determined at design 
time by the control program's Metric option.  

Calculated (Average, Maximum, or Minimum) from all communicating sensors* based on 
Zone Temp Method field selection. 

  The SPT Pro displays the ZONE 
output value. 

SP ADJ  0 Setpoint adjustment (degrees) from sensor. 

OVRDE 0 Value (minutes) of timed local override from sensor. 

OAT (optional) not used not used As the user presses the INFO 
button, the sensor cycles its display 
through the OAT input value (if 
used), the HTSP input value, and 
the CLSP input value, then returns 
to the ZONE output value. 

HTSP not used not used 

CLSP not used not used 

OCC not used True (on) when the zone is occupied. Not true (off) when the zone is 
unoccupied. Connect to a time clock microblock (page 287) or to 
other logic that indicates the zone's occupancy status. 

   The SPT Pro displays Occupied 
when the OCC input is true (on) or 
the TLO is enabled.  

ALARM (optional) not used not used If true (on), the SPT Pro displays an 
alarm bell icon. 

* This microblock's i-Vu® Properties page shows which sensors are communicating. 

Setpoint adjust 
The user can adjust zone setpoints from the zone sensor by no more than the Max adjust = ± number of degrees 
in either direction from the setpoint.  

EXAMPLE  If the cooling setpoint = 74ºF, the heating setpoint = 70ºF, and Max adjust = ± 2.0, the user can raise 
the setpoints to a maximum of 76ºF and 72ºF or lower them to a minimum of 72ºF and 68ºF. 

If you check Reset setpoint adjust to zero when unoccupied, the microblock resets the SP ADJ output to 0 when 
the OCC input changes to false (off), and it remains at 0 when the OCC input changes again to true (on) or when 
the zone enters a timed local override condition. 

Timed local override 
Each time the user presses the zone sensor's local override or MANUAL ON button, the sensor sends a pulse 
signal to the controller. The microblock converts this binary signal into a time output (minutes) using the following 
formula: 

Time output (minutes) = # of pulses x Each pulse (minutes) 

The time output accumulates up to the microblock's Maximum Accumulation value, which cannot exceed 546 
minutes (09:06:00 hh:mm:ss) regardless of additional pulses from the controller's input. 
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Inputs and outputs 

Inputs 
HTSP 
Heating Setpoint 

Heating setpoint (degrees). Connect to a setpoint microblock's HT output or to other 
logic that indicates the zone's heating setpoint. 

CLSP 
Cooling Setpoint 

Cooling setpoint (degrees). Connect to a setpoint microblock's CL output or to other 
logic that indicates the zone's cooling setpoint. 

OCC 
Occupied 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 
Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

Optional Inputs 
Select the appropriate checkbox on the Snap Optional Inputs tab to enable these microblock inputs. 

OAT 
Outside Air Temp 

Check for an analog OAT wire input. A sensor with a display shows this value when a 
user cycles through the INFO button options. 

ALARM Select for a binary (digital) ALARM input.  When the input is true (on) an SPT Pro 
displays an alarm bell icon. 

Outputs 
ZONE 
Zone Temp 

Current zone temperature (degrees). 

SP ADJ 
Setpoint Adjust 

Setpoint adjustment (degrees) indicated by zone sensor. Connect to a setpoint 
microblock's HADJ and CADJ inputs. 

OVRDE 
Override Time 

Reads a pulse signal from a local override input, then converts the signal to a 
remaining time value (minutes). This value can be used by a time clock microblock 
with TLO (page 287) to indicate a change in occupancy status.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Zone Temp to Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Zone Temp Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Min Present Value 
Max Present Value 

The temperature range of the sensor. These fields are for information only. 

Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

Setpoint Adjustment 
Max adjust = ± The maximum amount (degrees) by which the user can adjust the zone's setpoints 

from a zone sensor. 

Reset setpoint adjust to 
zero when unoccupied 

Check to set any setpoint adjustment to 0 each time the OCC input changes to false 
(off). SP ADJ remains at 0 when the OCC input changes to true (on) or when the zone 
enters a timed local override condition.  

Uncheck to use adjusted setpoints during unoccupied periods. 

Timed Local Override 
These properties apply to the timed local override BACnet Analog Value object embedded in the RS Zone Sensor 
microblock. You can think of this object as a microblock within a microblock. 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Description (optional) A BACnet-visible microblock description. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 
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Increment Minutes the microblock adds to the zone's occupied time for each press of the zone's 
local override button or switch. 

Maximum Duration Maximum value (up to 546 minutes) the microblock outputs regardless of additional 
pulses from the controller's input. 

Allow Continuous SPT and SPT Plus only. If enabled, a user can press the sensor's local override button 
until the Maximum Accumulation value is reached, then press one more time to 
have a continuous override until the next occupied period or until the user cancels 
the override. 

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

Sensor Array 
Sensor calculation 
method 

For Rnets with more than one sensor. Based on your selection, the microblock's 
ZONE output shows the Average, Maximum, or Minimum of up to 5 Rnet zone 
sensors. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's 

present value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If 
subscription succeeds, the ANI receives a value from this microblock only when 
this microblock's present value changes by at least the COV Increment. If 
subscription fails, the ANI reads this microblock's value at intervals specified in 
the ANI's Refresh Time field. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 
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BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Programming example 

 
  

Critical applications 

 
If the SPT sensor is used in a critical application, this logic will detect if the sensor is disconnected (<45.1°F) or is 
shorted (>98°F). The Sensor Fail label can be used to cause the control program to go into an appropriate failure 
mode if the sensor fails. 

 

 

 

 

 
 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 85 

 

Detecting SPT sensor communication failure 
Applies to the following controllers: 
VVT Zone, VVT Bypass, RTU-Open, WSHP, UC, and UC XP 
  

To verify that the SPT Zone Sensor microblock is receiving a valid value from at least one sensor on a controller's 
Rnet, you can add a Binary Input to the controller's control program with the following logic. The input turns on if 
the sensor(s) stop communicating. 

 
  

Set these Binary Input properties to the following values: 

Expander: 
Input Number: 
Input Type: 

100 
100 
Special 

 

 

 

 
 

RS Zone Sensor with Fan Control 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol 
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What it does Sends information to and receives values from a variety of sensor configurations. 
Works with a schedule and setpoint microblock to maintain zone temperature at 
setpoint. Enables the sensor's fan control and mode functionality. 

Can be connected to a controller's Rnet port. See the Carrier Sensor Installation 
Guide for supported Rnet configurations. 

 
 

How it works 
Some features of this microblock do not apply to all supported zone sensors. However, the type of zone sensor 
connected to the controller can be changed without changing the control program, so you should develop your 
control program to take advantage of all available features. The controller automatically detects the type of zone 
sensor and sets point addresses for a basic LogiStat Basic's or LogiStat Plus' OVRDE, ZONE, and SP ADJ inputs 
when you turn on the controller. 

When connected to each sensor, the microblock's output and input values behave as follows: 
  

Output/ 
Input value 

SPT Standard Rnet that includes 
an SPT Plus 

Rnet that includes 
an  
SPT Pro 

Rnet that includes an 
SPT Pro Plus 

ZONE Current zone temperature (degrees). Units (Fahrenheit or Celsius) are determined at design time 
by the control program's Metric option. 

Calculated (Average, Maximum, or Minimum) from all communicating sensors* based on Zone 
Temp Method field selection.  

  NOTE  The SPT Pro and SPT Pro Plus display the 
temperature of their sensor, not the calculated min, max, or 
average temperature. 

SP ADJ  0 Setpoint adjustment (degrees) from sensor. 

OVRDE 0 Value (minutes) of timed local override from sensor. 

FAN not used not used  not used If the input is true (on), the SPT Pro Plus 
displays a fan icon. As the user presses 
the FAN button on the sensor, the 
output value cycles through the Order of 
Speeds (limited by Number of speeds) 
set on the microblock's Fan Speed 
Adjust tab. 

MODE not used not used not used As the user presses the MODE button 
on the SPT Pro Plus, the output value 
and sensor display cycle through the 
Modes Available settings from the 
microblock's Mode/Sensor Display tab. 

OAT 
(optional) 

not used not used As the user presses the SPT Pro's or SPT Pro Plus' INFO 
button, the sensor cycles its display through all available 
and enabled input values (other than OCC, FAN, and 
ALARM), then returns to the ZONE output value. 

NOTE  If you select the Disable info button on the 
Mode/Sensor Display tab, the SPT Pro Plus' display cycles 
through the OVRDE input value, the HTSP input value, and 
the CLSP input value, then returns to the ZONE output value 
as the user presses the sensor's INFO button. 

HTSP not used not used 

CLSP not used not used 

AI1, AI2, 
BI1, BI2 
(optional) 

not used not used not used If input and INFO button are enabled, 
values are included in SPT Pro Plus' 
INFO button display cycle. 
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Output/ 
Input value 

SPT Standard Rnet that includes 
an SPT Plus 

Rnet that includes 
an  
SPT Pro 

Rnet that includes an 
SPT Pro Plus 

OCC not used True (on) when the zone is occupied. Not true (off) when the zone is 
unoccupied. Connect to a time clock microblock (page 287) or to other logic 
that indicates the zone's occupancy status. 

   The SPT Pro or SPT Pro Plus displays Occupied when the 
OCC input is true (on).  

ALARM 
(optional) 

not used not used If true (on), the SPT Pro or SPT Pro Plus displays an alarm 
bell icon. 

* This microblock's Properties page shows which sensors are communicating. 

Setpoint adjust 
The user can adjust zone setpoints from the zone sensor by no more than the Max adjust = ± number of degrees 
in either direction from the setpoint.  

EXAMPLE  If the cooling setpoint = 74ºF, the heating setpoint = 70ºF, and Max adjust = ± 2.0, the user can raise 
the setpoints to a maximum of 76ºF and 72ºF or lower them to a minimum of 72ºF and 68ºF. 

If you check Reset setpoint adjust to zero when unoccupied, the microblock resets the SP ADJ output to 0 when 
the OCC input changes to false (off), and it remains at 0 when the OCC input changes again to true (on) or when 
the zone enters a timed local override condition. 

Timed local override 
Each time the user presses the zone sensor's local override or MANUAL ON button, the sensor sends a pulse 
signal to the controller. The microblock converts this binary signal into a time output (minutes) using the following 
formula: 

Time output (minutes) = # of pulses x Each pulse (minutes) 

The time output accumulates up to the microblock's Maximum Accumulation value, which cannot exceed 546 
minutes (09:06:00 hh:mm:ss) regardless of additional pulses from the controller's input. 

 

 
 

Inputs and outputs 

Inputs 
HTSP 
Heating Setpoint 

Heating setpoint (degrees). Connect to a setpoint microblock's HT output or to other 
logic that indicates the zone's heating setpoint. 

CLSP 
Cooling Setpoint 

Cooling setpoint (degrees). Connect to a setpoint microblock's CL output or to other 
logic that indicates the zone's cooling setpoint. 

OCC 
Occupied 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 
Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

FAN If the input is true (on), the SPT Pro Plus displays a fan icon.  
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Optional Inputs 
Check the appropriate checkbox on the Snap Optional Inputs tab to enable these microblock inputs. 

OAT 
Outside Air Temp 

Check for an analog OAT wire input. A sensor with a display shows this value when a 
user cycles through the INFO button options. 

ALARM Check for a binary (digital) ALARM input.  When the input is true (on) an SPT Pro or 
SPT Pro Plus sensor displays an alarm bell icon. 

AI1, AI2 
Aux Analog Input 1 
Aux Analog Input 2 

Select for an analog value to be displayed (with a small 1 or 2 indicating the input) 
with the selected units as the user cycles through the sensor's INFO button display. If 
the value exceeds 199 or -199, the sensor displays OF, indicating a display overflow 
condition. 

NOTE  The Disable info button checkbox on the Mode/Sensor Display tab must be 
unchecked for the user to see these values. 

BI1, BI2 
Aux Binary Input 1 
Aux Binary Input 2 

Select for a binary (digital) value to be displayed (with a small 1 or 2 indicating the 
input) as the user cycles through the sensor's INFO button display. The sensor 
displays ON when the value is true (on) or OF when the value is false (off). 

NOTE  The Disable info button checkbox on the Mode/Sensor Display tab must be 
unchecked for the user to see these values. 

Outputs 
ZONE 
Zone Temp 

Current zone temperature (degrees). 

SP ADJ 
Setpoint Adjust 

Setpoint adjustment (degrees) indicated by zone sensor. Connect to a setpoint 
microblock's HADJ and CADJ inputs. 

OVRDE 
Override Time 

Reads a pulse signal from a local override input, then converts the signal to a 
remaining time value (minutes). This value can be used by a time clock microblock 
with TLO (page 287) to indicate a change in occupancy status.  
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FAN As the user presses the FAN button on the sensor, the output value cycles through 
the Order of Speeds (limited by Number of speeds) set on the microblock's Fan 
Speed Adjust tab. Connect to any override or safety logic, then to a fan status or 
enable point. 

 

0 1 2 0 1 2
AU LO HI AU LO HI

Large text on RSPro-F
Fan output wire value

AU M AU M
0 1 0 1

0 1 2 1 0
AU LO HI LO AU

0 1 0 1
AU M AU M

0 1 2 3 0 1 2 3
AU LO M HI AU LO M HI

0 1 2 3 4 0 1 2 3 4
AU LO M M HI AU LO M M HI

0 1 2 3 2 1 0
AU LO M HI M LO AU

0 1 2 3 4 3 2 1 0
AU LO M M HI M M LO AU

0,1,2,3,4,0,1,2,3,44

Num of 
Speeds Order of Speeds

0,1,2,3,4,3,2,1,0,14

0,1,2,3,4,0,1,2,3,43

0,1,2,3,4,3,2,1,0,13

0,1,2,3,4,0,1,2,3,42

0,1,2,3,4,3,2,1,0,12

0,1,2,3,4,0,1,2,3,41

0,1,2,3,4,3,2,1,0,11

Result:

0
AU
0

AU
0,1,2,3,4,0,1,2,3,40

0,1,2,3,4,3,2,1,0,10
 

MODE As the user presses the MODE button on the SPT Pro Plus, the output value and 
sensor display cycle through the Modes Available settings from the microblock's 
Mode/Sensor Display tab. You can use this analog value to enable different control 
sequences based on the user's MODE selection. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Zone Temp to 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Zone Temp Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Min Present Value 
Max Present Value 

The temperature range of the sensor. These fields are for information only. 

Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

Setpoint Adjustment 
Max adjust = ± The maximum amount (degrees) by which the user can adjust the zone's setpoints 

from a zone sensor. 

Reset setpoint adjust to 
zero when unoccupied 

Check to set any setpoint adjustment to 0 each time the OCC input changes to false 
(off). SP ADJ remains at 0 when the OCC input changes to true (on) or when the zone 
enters a timed local override condition.  

Uncheck to use adjusted setpoints during unoccupied periods. 
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Timed Local Override 
These properties apply to the timed local override BACnet Analog Value object embedded in the RS Zone Sensor 
with Fan Control microblock. You can think of this object as a microblock within a microblock. 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Description (optional) A BACnet-visible microblock description. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Increment Minutes the microblock adds to the zone's occupied time for each press of the zone's 
local override button or switch. 

Maximum Duration Maximum value (up to 546 minutes) the microblock outputs regardless of additional 
pulses from the controller's input. 

Allow Continuous 
 

SPT Pro and SPT Pro Plus only. If enabled, a user can press the sensor's local 
override button until the Maximum Accumulation value is reached, then press one 
more time to have a continuous override until the next occupied period or until the 
user cancels the override. 

TLO Operating 
Sequence 

Determines the order of timed local override modes the user can cycle through using 
the sensor's Manual On or override button. 

Pulse Acc - Each time the user presses the sensor's Manual On or override button, 
add the value in the Each Pulse = field to the override time up to the Max accum. 
value. The next time the user presses the button, go to the next specified mode of 
operation. 

Continuous On - When the user presses the sensor's Manual On or override button, 
set the zone to run continuously (24 hours per day) in the occupied mode. 

Cancel - Returns the zone to automatic control. 

Maintain continuous 
through power fail 

If the zone is in a continuously occupied mode, checking this option returns the zone 
to continuous operation when power is restored.  If this option is not checked, the 
zone returns to automatic control when power is restored. 

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign  SiteBuilder assigns a BACnet Object ID when you attach the control 
program to a controller. 

Use specific value  (0 to 3999999) Assign a number that is unique within the 
controller. 

Sensor Array 
Sensor calculation 
method 

For Rnets with more than one sensor. Based on your selection, the microblock's 
ZONE output shows the Average, Maximum, or Minimum of up to 5 Rnet zone 
sensors. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Fan Speed Adjust 
 
Number of speeds Determines the number of speeds that a user can cycle through using the sensor's 

FAN button. The microblock outputs the speed value on its FAN output wire. See 
"Inputs and outputs" in this microblock's help. Type 0 to disable the FAN button. 

Order of speeds Determines the order of the speeds (limited by Number of speeds) that a user will 
cycle through using the sensor's FAN button. The microblock outputs the speed value 
on its FAN output wire. See "Inputs and outputs" in this microblock's help. 

Only Allow Auto on 
Unoccupied 

Check this option to set the FAN output to 0 (Auto) when the OCC input is false (off). 
The FAN output remains at zero until adjusted from the sensor during an occupied 
period. 

 

 
 

Mode/Sensor Display 
 
Modes Available The number of modes in addition to automatic control that you want the sensor to 

cycle through and output on the MODE output wire as the user presses its MODE 
button. Type 0 to disable mode selection.  

Maintain Mode Through 
Power Failure 

Check this option to return the MODE output value to the user's last MODE selection 
at the sensor after a power failure. 

Uncheck to return MODE output value to 0 (automatic control) after a power failure.  

Reset Mode to ___ 
During Unoccupied 

Check this option to use the entered value as the MODE output value when the OCC 
input changes to false (off). 

Uncheck to set the MODE output value to the user's last MODE selection at the 
sensor regardless of the OCC input value.   

Modes 1–4 
Heat/Cool Heating - The sensor displays Heating when the user selects this mode. 

Cooling - The sensor displays Cooling when the user selects this mode. 

None - The sensor does not display Heating or Cooling when the user selects this 
mode. 

Occupied/ Unoccupied Occupied - The sensor displays Occupied when the user selects this mode. 

Unoccupied - The sensor displays Unoccupied when the user selects this mode. 

None - The sensor does not display Occupied or Unoccupied when the user selects 
this mode. 
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Large Text Select the large text characters you want the sensor to display when the user selects 
this mode.  

Sensor Display 
Disable info button Select to limit the sensor's INFO button display cycle to the OVRDE input value, the 

HTSP input value, and the CLSP input value before returning the display to the ZONE 
output value.  

Clear to allow the user to press the sensor's INFO button to cycle through all available 
and enabled input values other than OCC, FAN, and ALARM before returning the 
display to the ZONE output value. 

Disable idle display Select to display a blank screen when the user is not pressing the sensor's MANUAL 
ON button to set override time or the WARMER or COOLER buttons to change 
setpoints.  

Clear to display the ZONE output value and any configured input values when the 
user is not interacting with the sensor.  

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 
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Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 
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Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Airflow Control 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol 

   

What it does Maintains VAV zone airflow at setpoint. 

Its inputs, outputs, and properties interface with a controller's built-in airflow control 
algorithm. The algorithm ensures that zone airflow stays above the specified minimum 
for zone indoor air quality standards.  

This microblock is used in factory applications for zone control. 

Enables VAV testing and balancing through your system interface or through the 
stand-alone Airflow Test and Balance Utility. This microblock allows the Airflow Test 
and Balance Utility to control the VAV damper and other key zone operations, such as 
the fan (FAN) and auxiliary heat (AUX HEAT), during commissioning and flow sensor 
calibration. For more information on testing and balancing, see your system's Help or 
the Airflow Test and Balance Utility help. 

 

 
 

How it works 
A patented algorithm provides fast response while minimizing overshoot and damper movements, leading to 
longer actuator life. The algorithm measures the damper curve slope (change in airflow / damper movement) with 
each damper movement and uses that information to predict the movement required for the next flow adjustment 
or setpoint change.  

The algorithm dynamically calculates the deadband around the flow control setpoint based on the current slope.  
If the damper requires less than a 1-second movement to bring the measured flow to its setpoint, the damper 
does not move. This dynamic deadband provides accuracy at low flow settings while maintaining stability 
throughout the damper range. 

The algorithm provides additional stability by averaging flow sensor readings over a 10-second period and reacting 
to average, rather than instantaneous readings, and by requiring at least a 5% change in flow setpoint to initiate a 
damper movement.   

If measured flow falls below the Occupied Min Airflow while the zone is occupied, the algorithm sends a 1-second 
open signal to the dampers to ensure that zone airflow stays above the specified minimum for zone indoor air 
quality standards.  

The algorithm calculates the flow setpoint based on the microblock's current operational mode. 
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Cooling Mode 
If HEAT MODE is... and the zone is... the flow setpoint is... 

Off 

 

occupied Occupied Min Airflow +  
Cooling % x (Cooling Max Airflow - Occupied Min Airflow) 

not occupied Unoccupied Min Airflow +  
Cooling % x (Cooling Max Airflow - Unoccupied Min Airflow) 

 
NOTE  If the Cooling % input is 100%, the flow setpoint is the Cooling Max Airflow.  The damper will be at the 
position required to maintain the flow at this setpoint, which may not be 100% open. 
 

Heating Mode 
For a VAV air handling unit that provides heat, check Use supply air for heating when Heat Mode is ON and 
connect a reverse-acting controller to the Heating % input.  
 

If HEAT MODE is... and the zone is... the flow setpoint is... 

On 

 

occupied Occupied Min Airflow +  
Heating % x (Heating Max Airflow - Occupied Min Airflow) 

not occupied Unoccupied Min Airflow +  
Heating % x (Heating Max Airflow - Unoccupied Min Airflow) 

 

For VAV boxes with reheat coils that require a certain amount of airflow from the air handling unit to operate safely 
and effectively, use the Aux Heat Min Airflow to specify the minimum airflow across the coils.  
 

If AUX HEAT is... and the zone is... the flow setpoint is... 

On 

 

occupied The largest of  

Heating Max Airflow x Heating % (if HEAT MODE is on) 
or 
Auxiliary Heat Min Airflow 
or  
Occupied Min Airflow 

not occupied The largest of  

Heating Max Airflow x Heating % (if HEAT MODE is on) 
or 
Auxiliary Heat Min Airflow 
or 
Unoccupied Min Airflow 

 
 

Limitations 
This microblock is designed for comfort VAV flow control applications. Used in other applications, some properties 
may not apply and features intended to extend actuator life, such as the 5% threshold on setpoint adjustments, 
may not be compatible. 
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If the Carrier controller has an integrated flow sensor, it is a velocity sensor, not a velocity pressure sensor. This 
can be confusing to technicians who have only worked with velocity pressure sensors. Velocity sensors do not 
have a K-factor. Flow varies linearly with the sensor reading, not with the square root of the sensor reading, 
resulting in more precise readings than velocity pressure sensors at low flows. You calibrate the combined flow 
sensor and VAV box pitot tube array by entering measured flow values in a table.   

This microblock provides exceptional control of VAV boxes, but it cannot compensate for mechanical problems 
such as duct restrictions, damper actuator slippage, an oversized VAV box, or a damper motor that is too fast to 
provide accurate control. 

Although this microblock applies to various controllers, some sensor and damper configurations apply only to 
controllers with an integrated flow sensor and damper actuator. 

 

 
 

Inputs and outputs 

Inputs 
Occupied True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 

Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

Heat Mode True (on) when the AHU is in a heating mode. Not true (off) if the AHU provides 
cooling only or is in a cooling mode. 

Cooling % Cooling called for (%). Connect to a direct-acting controller such as the Zone 
Controller (page 327) microblock's CLG% output. 

Heating % Heating called for (%). Connect to a reverse-acting controller such as the Zone 
Controller (page 327) microblock's HTG% output. 

Fan Fan start/stop signal. Usually passed directly to the Fan output, unless controlled by 
the Airflow Test and Balance Utility for testing, balancing, and flow sensor calibration. 

Aux Heat 
Auxiliary Heat 

Signal to control the VAV box's auxiliary heat. Usually passed directly to the Aux Heat 
output, unless controlled by the Airflow Test and Balance Utility for testing, balancing, 
and flow sensor calibration. 

Outputs 
Fan Fan start/stop signal. Usually passed directly from the Fan input, unless controlled by 

the Airflow Test and Balance Utility for testing, balancing, and flow sensor calibration. 

Aux Heat 
Auxiliary Heat 

Signal to control the VAV box's auxiliary heat. Usually passed directly from the Aux 
Heat input, unless controlled by the Airflow Test and Balance Utility for testing, 
balancing, and flow sensor calibration. 

Actual Flow 
Flow 

Measured airflow (units defined by Flow Measurement Units). 

Flow Setpt 
Flow Setpoint 

Airflow setpoint (units defined by Flow Measurement Units) calculated by the airflow 
control algorithm. 

Damper Pos 
Damper Position 

(0–100%). For External damper types, connect to the analog output or floating motor 
output that controls the damper actuator.  
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock... 
...fan 
...auxiliary heat 
...Flow Setpoint 
...Damper Position 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Flow Measurement 
Units 

The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. For display and 
documentation purposes only. Set to the airflow unit of measurement used during 
system calibration. 

Hardware Configuration 
Primary Use For a typical single-duct VAV system, select Cooling.  

For a dual-duct system, use 1 Airflow Control microblock for each duct. Select Cooling 
in the microblock that controls the primary cooling duct. Select Heating in the 
microblock that controls the heating or ventilating duct. 

Sensor Select the airflow sensor type used by your equipment.  

Damper Select the damper type used by your equipment.  

Damper Motor Travel 
Time 

The time (seconds) the damper motor takes to travel from its fully open to its fully 
closed position. 

Direction: CW = Close - Turn the damper motor clockwise to close the damper. 

Open - Turn the damper motor clockwise to open the damper. 

NOTE  Applies to integrated actuators only. 
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Design Properties 
Cooling Max Airflow The maximum zone airflow specified for the cooling mode (HEAT MODE input is off). 

Heating Max Airflow The maximum zone airflow specified for a heating or warm-up mode (HEAT MODE 
input is on). Typically used if the air handling unit supplies warm air to heat the zone. 

Occupied Min Airflow The minimum airflow specified for ventilation when the zone is occupied. Applies in 
heating and cooling modes. Usually based on health and safety criteria such as 
ASHRAE Standard 62-1. 

Unoccupied Min Airflow The minimum airflow specified for ventilation when the zone is unoccupied (usually 
0). 

Auxiliary Heat Min 
Airflow 

The minimum airflow specified to ensure adequate airflow over a VAV box's auxiliary 
heating coil. Applies when the AUX HEAT input is greater than zero. Type 0 if the 
VAV box does not have an auxiliary heating coil or if the box contains a fan that 
ensures sufficient flow across the coil. 

Use supply air for 
heating when Heat 
Mode is ON 

Check to control the VAV damper with the Heating % input when the air handling unit 
supplies warm air to the VAV box.  
Uncheck to provide the appropriate occupied or unoccupied minimum zone airflow 
during the warm-up period. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet configuration 
Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 

 
 

Flow input properties 
These properties apply to the flow input BACnet object embedded in the Airflow Control microblock. You can think 
of this object as a microblock within a microblock. 
  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Description (optional) A BACnet-visible microblock description. 
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Input Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

Lock Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Trend 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 
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Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   
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Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Programming example 
This simple VAV application with no fan and no auxiliary heat compares the zone temperature to the supply air 
temperature from the air handling unit (AHU) to determine whether the AHU is in a heating mode.  This airflow 
microblock is configured for a controller with an integrated actuator, so the microblock controls the actuator 
directly and no additional output points are needed for control.  

 
 

 
 

Tips and tricks 

Cooling-only VAV boxes 
Uncheck Use supply air for heating when Heat Mode is ON. The microblock will maintain the applicable minimum 
flow. 

Dual-duct VAV boxes 
Use 2 Airflow Control microblocks.  In the microblock that controls the cooling damper, lock the HEAT MODE off 
and set Primary Use to Cooling. In the microblock that controls the heating damper, lock the HEAT MODE on and 
set Primary Use to Heating. Examples of dual duct applications can be found in EquipmentBuilder. 

Industrial process ventilation or off-hours skeleton crews 
You can use the Unoccupied Min Airflow to provide a different minimum flow during unoccupied periods for 
industrial process ventilation, for skeleton staffs, or for other reasons. 

Deadhead protection 
To prevent deadheading the fan (running the fan with the outlet blocked), some VAV systems require a minimum 
number of open dampers before the fan starts. Typically, when a building is unoccupied and the AHU fan is off, 
VAV dampers are closed. To provide deadhead protection, set Unoccupied Min Airflow to a non-zero value in the 
VAV boxes you want to leave open.  When the system is unoccupied and the fan is turned off, these VAV boxes will 
open their dampers fully in an attempt to maintain the Unoccupied Min Airflow setpoint. 

Smoke control - unbounded inputs 
Cooling % and Heating % are not limited to 0–100%. A PID microblock or Zone Controller microblock output stays 
within the 0–100% range, but for special circumstances like smoke control you can switch these inputs to other 
signals.  For example, to force the dampers fully open, switch HEAT MODE to an off signal and switch Cooling % to 
a value such as 500%. This forces the damper to open fully trying to reach an unrealistically high flow setpoint. 
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Pressure-dependent control 
To control a pressure-dependent VAV box (a box with no flow pickup or flow measurement, where the damper 
moves from 0% to 100% open proportionally with the zone temperature), check Lock Damper Position to on the 
microblock's Properties page and use a BACnet Analog Network Output (page 146) microblock to write the 
desired damper position to the Airflow Control microblock's Damper Lock property.  See BACnet object property 
addresses (page 105) below. You can connect a Zone Controller (page 327) microblock's CLG% output to the 
Network Output microblock's input, and use a Constant Low Limit (page 361) microblock to impose a minimum 
damper position. 

BACnet properties 
The Airflow microblock is a proprietary BACnet object. If you make this object Network Visible, you can address a 
BACnet Analog Network Input (page 124) or BACnet Analog Network Output (page 146) microblock to access 
many of its configuration and control properties in other control programs. See BACnet object property addresses 
(page 105) below. 

 

 
 

BACnet object property addresses 
The Airflow Control microblock is a proprietary BACnet object (object type 768). The format for a BACnet address is 
bacnet://device/object/property@priority.  

See To format a BACnet address (page 458) for BACnet address syntax options and information. 
  

EXAMPLE  To set up a microblock to read the Cooling Output (%) from the first Airflow Control microblock in the 
same controller, use the following address: 

bacnet://this/768:1/4114 

In the above address, 768:1 indicates the first instance of an Airflow Control microblock in the controller. If writing 
to a dual-duct application with two Airflow Control microblocks, the address in the second microblock would have 
768:2. 
  

NOTE These properties are only available with a v2-03-009 or newer driver. 

 

BACnet 
property 
identifier # 

BACnet property 
identifier 

Description Read/ 
Write 

4096 Max Occ Cooling Flow Real - units determined by flow AI. r/w 

4097 Max Occ Heating Flow Real - units determined by flow AI. r/w 

4098 Min Occupied Flow Real - units determined by flow AI. r/w 

4099 Min Unoccupied Flow Real - units determined by flow AI. r/w 

4100 Min Aux Heat Flow Real - units determined by flow AI. 
Minimum airflow to maintain while aux heat is active. 

r/w 

4101 Flow at 1 inch WC Real - units determined by flow AI. 
VAV manufacturer-provided data used for baseline 
control. 

r/w 

4102 Flow Calibration Real - units determined by flow AI. 
Array of 4 measured flow calibration properties. 

r/w 
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BACnet 
property 
identifier # 

BACnet property 
identifier 

Description Read/ 
Write 

4103 Sensor Calibration Real - units determined by flow AI. 
Array of 4 raw sensor calibration properties. 

r/w 

4104 Aux Heat Lock Real - lock value (%) for AUX HEAT 
output wire. 

r/w 

4105 Damper Lock Real - lock value (% open) for VAV damper. r/w 

4106 Flow Setpoint Lock Real - lock value, units determined by flow AI. r/w 

4107 Auto-Zero Boolean - indicates completion of auto-zero. r/w 

4108 Test and Balance Mode Enumeration of states of damper control while test 
and balance is performed. 

r/w 

4109 Parent Program Device ID Device ID of device containing air source object. r 

4110 Parent Program ID Program AI of program containing air source object. r 

4111 Air Source Object ID Air source BACnet object ID. r/w 

4112 Occupied Mode Boolean - true if occupied. r 

4113 Heat Mode Boolean - true if AHU in heating mode. r 

4114 Cooling Output Real - percentage cooling demand. r 

4115 Heating Output Real - percentage heating demand. r 

4116 Auxiliary Heat Output Real - percentage of aux heat demand. r 

4117 Damper Output Real - damper position (% open). r 

4118 Actual Flow Real - units determined by flow AI. r 

4119 Flow Setpoint Real - units determined by flow AI. r 

4120 Air Flow Object ID BACnet Object ID of embedded flow AI object. r 

4121 Obsolete. Use 4141.   

4122 Loop config  Cooling or Heating (Primary Use). r/w 

4123 Sensor Config Sensor configuration—Internal, ZASF, or External. r 

4124 Damper Config Damper configuration—Internal, ZASF, or External. r 

4125 Raw sensor reading Real - raw sensor value, % of scale of 
0-1.0" WC. 

r 

4126 Raw sensor setpoint Real - raw sensor Setpt, % of scale of 
0-1.0"WC. 

r 

4127 Moves Today Number of damper moves, current day. r 

4128 Moves Yesterday Number of damper moves yesterday. r 

4129 Fan Lock Fan lock value—on or off. r/w 

4130 Fan Output Status of fan pass-through wire. r 

4131 Status Flags BACnet status flags. r 

4132 Test and Balance Tech 
Name 

Name of test and balance technician. r/w 
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BACnet 
property 
identifier # 

BACnet property 
identifier 

Description Read/ 
Write 

4133 Test and Balance Org 
Name 

Name of test and balance company. r/w 

4134 Last Test and Balance 
Date 

Date of last test and balance activity through stand-
alone Airflow Test and Balance Utility. 

r/w 

4135 Display Name Copy of Display Name provided by microblock. r/w 

4136 Owning Program ID Object ID for program containing this instance. r 

4137 Override Flags Unsigned - Status flags of property overrides in effect. r 

4138 Max Occ Cooling Flow 
Override 

Real - volatile override for Max Occ Cooling Flow 
(4096). 

r/w 

4139 Min Occ Flow Override Real - volatile override for Min Occ Flow (4098). r/w 

4140 Pars Stamp BACnet DateTime - volatile, used to detect writes by 
external test and balance software. 

r/w 

4141 Lock Flags Binary lock bits whether to apply locks. Include one of 
the following index numbers in the address field: 

4141(4) Holds the damper in its current position. 

4141(5) Locks the fan to the Fan Lock State property 
value. 

4141(6) Locks the damper to the Damper Position 
Lock Value property. 

4141(7) Locks the aux heat to the Aux Heat 
Percentage Lock Value property. 

4141(8) Locks the flow setpoint to the Flow Setpoint 
Lock Value property. 

NOTE  4141(0) creates a "Write access denied" error 
message. 

For example, bacnet://this/768:1/4141(4) 

r/w 
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Pressure Dependent Airflow Control 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol 

   
What it does 

 

 

Calculates and maintains the desired damper position in a pressure dependent zone.  
Controls AUX reheat operation and fan operation in a fan powered box.  

Its inputs, outputs, and properties interface with the control algorithms built into other 
controllers. The algorithm ensures that zone airflow stays above the specified minimum 
for zone indoor air quality standards.  

Enables testing and balancing through the i-Vu® interface or through a stand-alone 
utility. Controls the damper and other key zone operations, such as the fan (FAN) and 
auxiliary heat (AUX HEAT), during commissioning. 

 
 

How it works 
The algorithm calculates the desired damper position (setpoint) based on the microblock’s current operational 
mode (TERMINAL MODE), zone temperature requirements, air source mode (AHU MODE) and TERMINAL TYPE. 
When in heating or cooling mode, the calculated damper position is a function of the COOLING % or HEATING % 
input to the microblock. Using the configured values for minimum and maximum damper positions as 0% and 
100% respectively, the actual calculated damper setpoint is scaled to the range determined by the configured min 
and max damper positions based on the following formula. 

Damper Setpoint = ((% Damper Request) * (Max. Damper Position – Min. Damper Position)) + Min. Damper 
Position. 

For instance, for a configured min damper = 0% and a max damper = 100%, in a cooling mode, a COOLING % 
input value of 50% (damper request) would result in a calculated damper setpoint of 50%. For a configured min 
damper = 10% and max damper = 80%, a COOLING % input of 50% (damper request) would result in a calculated 
damper position of 45%. 

NOTE  When the VAV HEATING input = Yes, the damper setpoint calculation uses the Heating % value as the % 
Damper Request. When the VAV HEATING input = No, the damper setpoint calculation uses the AUXHEAT % value 
as the % Damper Request. 
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Once the desired damper position is calculated, the microblock’s DAMPER POS output is used to position the 
damper accordingly. The damper sends position feedback information to the microblock to provide accurate 
movement of the damper to its calculated setpoint. 

The following table shows the damper setpoint and heat enable/disable state for all associated AHU MODES, 
TERMINAL MODES, and zone temperature requirements for each terminal type: 
 

Air Source 
(AHU) Mode 

Temperature 
Control  
Requirement 

Terminal 
Type 

Aux 
Heat 

Terminal 
Mode 

Damper Control  
(Damper Setpoint used) 

Heat  
Control 

Fan 
Control 

Off 

 
None All N/A Off Hold Damper Position (N/A) Disable Disable 
Cooling All N/A Off Hold Damper Position (N/A) Disable Disable 
Heating Single Duct N/A Off Hold Damper Position (N/A) Disable Disable 

Series or 
Parallel Fan 

No Off Hold Damper Position (N/A) Disable Disable 

Series Fan Yes Heat Hold Damper Position (N/A) Enable  Enable 
Parallel Fan Yes Heat Close Damper (Heat) Enable  Enable 

Cooling, 
FreeCool 

 

None Single Duct N/A Cool Cool minimum Disable Disable 
Series Fan N/A Cool Cool minimum Disable Enable 

Parallel Fan  N/A Cool Cool minimum Disable Disable 
Cooling Single Duct N/A Cool Modulate Damper Position  

between Min and Max (Cool) 
Disable Disable 

Series Fan N/A Cool Modulate Damper Position  
between Min and Max (Cool) 

Disable Enable 

Parallel Fan  N/A Cool Modulate Damper Position  
between Min and Max (Cool) 

Disable Disable 

Heating Single Duct, 
Parallel Fan 

No Heat Minimum Damper Position (Cool) Disable Disable 

Series Fan No Heat Minimum Damper Position (Cool) Disable Enable 
Single Duct Yes ReHeat Reheat Damper Position Enable Disable 
Series or 
Parallel Fan 

Yes Heat Minimum Damper Position (Cool) Enable Enable 

Vent 

 
None 

 
Single Duct or 
Parallel Fan 

N/A Vent Vent Position Disable Disable 

Series Fan N/A Vent Vent Position Disable Enable 
Heat, 
Warmup 

None Single Duct, 
Parallel Fan 

N/A Heat Minimum Damper Position (Heat) Disable Disable 

Series Fan N/A Heat Minimum Damper Position (Heat) Disable Enable 

Cooling Single Duct, 
Parallel Fan 

N/A Heat Minimum Damper Position (Heat) Disable Disable 

Series Fan N/A Heat Minimum Damper Position (Heat) Disable Enable 
Heating Single Duct No Heat Modulate Damper Position  

between Min and Max (Heat) 
Disable Disable 

Single Duct Yes Heat Modulate Damper Position  
between Min and Max (Heat) 

Enable Disable 

Series or 
Parallel Fan 

No Heat Modulate Damper Position  
between Min and Max (Heat) 

Disable Enable 

Series or 
Parallel Fan 

Yes Heat Modulate Damper Position  
between Min and Max (Heat) 

Enable Enable 

Pressure None Single Duct, 
Parallel Fan 

N/A Pressurize Maximum Damper Position (Cool) Disable Disable 

Series Fan N/A Pressurize Maximum Damper Position (Cool) Disable Enable 
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Cooling Single Duct, 
Parallel Fan 

N/A Pressurize Maximum Damper Position (Cool) Disable Disable 

Series Fan N/A Pressurize Maximum Damper Position (Cool) Disable Enable 
Heating Single Duct, 

Parallel Fan 
No Pressurize Maximum Damper Position (Cool) Disable Disable 

Series Fan No Pressurize Maximum Damper Position (Cool) Disable Enable 
Single Duct, 
Parallel Fan 

Yes Pressurize Maximum Damper Position (Cool) Enable Disable 

Series Fan Yes Pressurize Maximum Damper Position (Cool) Enable Enable 
Evac All All N/A Evac Close Damper Disable Disable 

 

 
 

Inputs and outputs 

Inputs 
Cooling % Cooling called for (%). Connect to a direct-acting controller such as the Zone Controller 

microblock's CLG% output. 

Heating % Heating called for (%). Connect to a reverse-acting controller such as the Zone Controller 
microblock's HTG% output. 

RH % Cooling for Dehumidification called for (%). The microblock compares this value to the COOLING 
% and IAQ % inputs and selects the greatest value. 

IAQ % Airflow for IAQ called for (%). The microblock compares this value to the COOLING % and RH % 
inputs and selects the greatest value. 

AHU Mode Analog value that represents the current mode of the air source. 

Terminal Type Analog value that represents the type of terminal control used by the microblock: single duct, 
series fan, or parallel fan terminal. 

Heat Type Analog value that represents the type of Aux Heat used by the microblock: two position, 
modulating, staged electric, ducted or non-ducted. 

VAV Heating Binary value. When VAV HEATING = YES, the heating damper position is a function of the 
HEATING % input. When VAV HEATING = NO, the heating damper position is a function of the 
AUXHEAT (%) input. 

Fan Fan start/stop signal. Usually passed directly to the Fan output, unless controlled by the Airflow 
Test and Balance Utility for testing and balancing.  

Aux Heat 
Auxiliary Heat 

Required Auxiliary Heat %. Usually passed directly to the Aux Heat output, unless controlled by 
the Airflow Test and Balance Utility for testing and balancing. 

Outputs 
Fan Fan start/stop signal. Usually passed directly from the Fan input, unless controlled by the 

Airflow Test and Balance Utility for testing and balancing. 
Aux Heat 
Auxiliary Heat 

Signal to turn on the box's auxiliary heat. Usually passed directly from the Aux Heat input, 
unless controlled by the Airflow Test and Balance Utility for testing, and balancing. 
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Terminal Mode Analog value that represents the current mode of the air terminal: 

1 Off 

2 Heat 

3 Warmup 

4 Vent 

5 N/A 

6 Cool 

7 Dehumidification 

8 Reheat 

9 Pressure 

10 Evac 

11 N/A 

12 Zone IAQ 

13 Zone Test and Balance 

Airflow Mode Analog value that represents the current control state of the damper: Max cooling, Min 
heating, etc. This is maintenance data that can be used by the Test and Balance software. 

Heat Enable Binary value that represents the current commanded state of the Aux Heat control. 

Damper Pos 
Damper Position 

(0–100%). Analog value that represents the current commanded position (setpoint) of the 
damper. For External damper types, connect to the analog output or floating motor output that 
controls the damper actuator. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Flow Measurement Units The unit of measurement of the microblock's flow value.  

This will be displayed on the Test and Balance utility and i-Vu® and Field Assistant 
Test and Balance section on the microblock pop-up Details tab.  

Hardware Configuration 
Damper Motor Travel Time The time (seconds) the damper motor takes to travel from its fully open to its fully 

closed position. 

Direction: CW = Close - Turn the damper motor clockwise to close the damper. 

Open - Turn the damper motor clockwise to open the damper. 

NOTE  Applies to integrated actuators only. 

Damper Positions 
Cooling Min  The minimum specified damper position for the cooling mode (HEAT MODE input is 

off). 

Cooling Max  The maximum specified damper position for the cooling mode (HEAT MODE input is 
off). 

Reheat Min  The minimum damper position specified to ensure adequate airflow over a box's 
auxiliary heating coil. Applies when the AUX HEAT input is greater than zero. Type 0 if 
the box does not have an auxiliary heating coil or if the box contains a fan that 
ensures sufficient flow across the coil. 

Heating Min  The minimum specified damper position for the heating or warm-up mode (HEAT 
MODE input is on). 

Heating Max  The maximum damper position specified for a heating or warm-up mode (HEAT MODE 
input is on). Typically used if the air handling unit supplies warm air to heat the zone. 

Vent Position The specified damper position when the air terminal is in Vent mode. 

Property Page Text 
Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet Configuration 
Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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BACnet  
Reference Name Use the default reference name unless you want a more descriptive name for 

graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Tips and tricks 

BACnet properties 
The Pressure Dependent Airflow microblock is a proprietary BACnet object. If you make this object Network Visible, 
you can address a BACnet Analog Network Input or BACnet Analog Network Output microblock to access many of 
its configuration and control properties in other control programs. See BACnet object property addresses below. 

 

 
 

BACnet object property addresses 
The Pressure Dependent Airflow Control microblock is a proprietary BACnet object (object type 769). The format 
for a BACnet address is bacnet://device/object/property@priority.  

EXAMPLE  To set up a microblock to read the Cooling Output (%) from the first Airflow Control microblock in the 
same controller, use the following address. 

 bacnet://this/769:1/4512 

In the above address, 769:1 indicates the first instance of a Pressure Dependent Airflow Control microblock in the 
controller. 
   

BACnet 
property 
identifier # 

BACnet property identifier Description Read/ 
Write 

4501 PD_MIN_COOL_POSITION Configured Min Cool Damper Position %. R/W 
4502 PD_MAX_COOL_POSITION Configured Max cool Damper Position %. R/W 
4503 PD_MIN_REHEAT_POSITION Configured Min Reheat Damper Position %. R/W 
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4504 PD_MIN_HEAT_POSITION Configured Min Heat Damper Position %. R/W 
4505 PD_MAX_HEAT_POSITION Configured Max Heat Damper Position %. R/W 
4506 PD_VENT_POSITION Configured Vent Damper Position %. R/W 
4507 PD_REHEAT_LOCK Reheat Lock value %. R/W 
4508 PD_DAMPE_LOCK Damper Lock value % R/W 
4509 PD_AUTO_ZERO Indicates completion of Auto Zero for Damper 

calibration. 
R/W 

4510 PD_TAB_MODE Current mode of the Test and Balance program. R/W 
4156 APPLICATION INSTANCE The Linkage application instance used in  

this microblock. 
R/W 

4511 PD_USE-SUPPLY_AIR Use VAV Heating R 
4512 PD_COOLING Cooling % required. R 
4513 PD_HEATING Heating % required. R 
4514 PD_REHEAT Reheat % required. R 
4515 PD_DAMPER Damper % required. R 
4516 PD_RH RH % required. R 
4517 PD_IAQ IAQ % required. R 
4518 PD_AHU_MODE Current AHU Mode. R 
4519 PD_TERMINAL_TYPE Terminal Type. R 
4520 PD_HEAT_TYPE Heat Type. R 
4521 PD_TERMINAL_MODE Current Terminal Mode. R 
4522 PD_AIR_FLOW_MODE Current PD Airflow Mode. R 
4523 PD_HEAT_ENABLE Heat Enable commanded state - on, off. R 
4525 PD_LOCK_FLAGS Binary lock bits whether to apply locks. Include one of 

the following index numbers in the address field:  

• 4530(4) Holds the damper in its current 
position.  

• 4530(5) Locks the fan to the Fan Lock 
State property value.  

• 4530(6) Locks the damper to the Damper 
Position Lock Value property.  

• 4530(7) Locks the aux heat to the Aux 
Heat Percentage Lock Value property. 

• 4530(8) Locks the flow setpoint to the flow 
Setpoint Lock Value property.  

NOTE  4530(0) creates a "Write access denied" 
error message. For example, 
bacnet://this/769:1/4530(4) 

R/W 

4527 PD_DAMP_CONFIG Damper config - internal, external, stroke time, 
direction. 

R 

4528 PD_MOVES_TODAY Number of damper movements today. R 
4529 PD_MOVES_YESTERDAY Number of damper  movements yesterday. R 
4530 PD_FAN_LOCK Fan lock value - on or off. R/W 
4531 PD_FAN_OUTPT Fan output status. R 
4532 PD_PROP_STAT_FLAG BACnet status flags. R 
4533 PD_TAB_TECH_NAME Test and Balance technician name. R/W 
4534 PD_TAB_ORG_NAME Test and Balance Company name. R/W 
4535 PD_LAST_TAB_DATE Last Test and Balance Date. R/W 
4536 PD_DISPLAY_NAME Microblock Display Name. R/W 
4537 PD_OWN_PRG_OBJ_ID Object ID for program containing this instance. R 
4538 PD_OVR_FLAGS Unsigned - Status flags of property overrides in effect. R 
4539 PD_MIN_COOL_POSITION_OVR Real - Volatile override for Min Cool Position. R/W 
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4540 PD_MAX_COOL_POSITION_OVR Real - Volatile override for Max Cool Position. R/W 
4541 PD_MIN_REHEAT_POSITION_OVR Real - Volatile override for Min Reheat Position. R/W 
4542 PD_MIN_HEAT_POSITION_OVR Real - Volatile override for Min Heat Position. R/W 
4543 PD_MAX_HEAT_POSITION_OVR Real - Volatile override for Max Heat Position. R/W 

4544 PD_VENT_POSITION_OVR Real - Volatile override for Vent Position. R/W 
4545 PD_TAB__PARS_SEAL BACnet DateTime - volatile - used to detect writes by 

external test and balance software. 
R/W 

4546 PD_LOCK_FLAGS_BOOL Boolean array of lock flags for damper, fan and aux 
heat. 

R 

4547 PD_PROP_STAT_FLAGS_BOOL Boolean array of BACnet status flags. R 
4548 PD_BPD_VERSION Microblock version number. R 

 

 
 

BACnet Bypass Control 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family I/O Point microblocks (page 31) 

Icon and symbol 

    

What it does 

 

 

Controls the bypass damper based on the commanded position input wire. Converts 
the pressure sensor count to pressure and output this value to the DUCT SP wire. 
Allows for the configuration of the duct static pressure setpoint and the maximum 
static pressure setpoint during LAT override. 

Enables testing and balancing through the i-Vu® interface. Calibrates the airflow 
sensor readings at design setpoint and zero calibration of sensor when AHU fan is off. 
Calibrates full open and closed damper positions. 

Applies to the following controllers: 
VVT Bypass 

 

 

 
 

How it works 
The microblock adds the airflow sensor output with any required zero offset and slope adjustment and converts it 
to a useable static pressure reading. This value is place on the DUCT SP output wire to be used by the control 
program for static pressure control. 

The bypass damper is controlled by the COMMANDED POS input and the internal damper position feedback signal, 
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no error control is used at this level. The output is calculated using integral control and is active until the damper 
position equals the COMMANDED POS. 

The Bypass microblock provides the control program with the working static pressure setpoint, this is normally the 
configured base static pressure setpoint. When LAT override is in effect, the microblock calculates the working 
static pressure setpoint based on a linear value between the configured base setpoint and the configured 
maximum LAT setpoint. This allows for increased static pressure when the LAT (Leaving Air Temperature) of the 
AHU exceeds a configurable limit.   

Test and Balance 
The microblock allows for direct calibration of the sensor at the configured duct static setpoint. When the Static 
Pressure Setpoint button is selected, the microblock checks for LAT override, if active, no sensor calibration will be 
performed. With no LAT override (LAT OVRRIDE=0%), the CAL ACTIVE output goes true (yes) and the control 
program controls to the configured duct static pressure setpoint.  

THE DAMPER MOVE input wire will equal 0 when the setpoint is reached and the damper has stopped moving.  The 
bypass controller is now at the configured setpoint and actual pressure readings obtained from the air balancer 
may be entered.  The current sensor reading is calibrated to this new value and the offset value is retained for 
future pressure sensor count conversions. 

When the Auto Zero button is selected, the microblock ensures the air source fan is off, reads the current raw 
count and determines a zero offset to be used in future sensor count conversions. If AHU MODE equals any 
number other than “1”, no zero calibration takes place. 

The Damper Full Open and Damper Full Close buttons force the damper to the fully opened or closed position. The 
damper position feedback values for these positions are stored and used by the damper control routine. 

Normal control is suspended until the Automatic Control button is activated, or until one hour of inactivity has 
passed, at which time the Test and Balance mode will automatically be terminated.  

 

 
 

Inputs and outputs 

Inputs 
COMMANDED POS The current desired position (%) of the bypass damper. 
LAT OVRRIDE The current calculated value (%) between the configured (base) static pressure 

setpoint and the maximum configured LAT override setpoint required to satisfy LAT 
limits.  

AHU MODE A Multi-state variable that indicates the current mode of the associated Air Handling 
Unit. The AHU Modes are as follows: 

1 Off 

2 Warmup 

3 Heat 

4 Cool 

5 Freecool 

6 Pressure 

7 Evac 

8 Vent 
DAMPER MOVE A binary value that indicates whether the damper has achieved the commanded 

position (0), or if it is still moving (1). 
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Outputs 
DUCT SP The current duct static pressure (in H2O). 

WSP SETPNT Working Static Pressure setpoint (in H2O). This is the static pressure setpoint that 
the bypass is controlling to, and includes any LAT override that might be in effect.  

DAMPER POS Current position of the bypass damper (% open to bypass). 
SP SETPNT The configured (base) duct static pressure setpoint. 

MAX LAT SP The configured maximum LAT duct static pressure setpoint. This is the maximum duct 
static pressure that will be used during LAT override. 

CAL ACTIVE A binary value that indicates if the airflow sensor static pressure reading is being 
calibrated (yes/no) in the Test & Balance screen. NOTE  LAT OVERRIDE must be 0% 
before the Cal Active output goes to “yes”. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The BACnet engineering unit of measurement of the microblock's present value. 

Hardware Configuration 
Direction: CW = Close - Turn the damper motor clockwise to close the damper. 

Open - Turn the damper motor clockwise to open the damper. 

NOTE  Applies to integrated actuators only. 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 118 

 

Design Properties 
Static Pressure Setpoint The desired duct static pressure (base) setpoint. 

LAT Pressure Setpoint The maximum duct static pressure setpoint that will be used during LAT override. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet configuration 
Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the controller. 

 

 
 

Static Pressure Input Properties 
  

Display Name The microblock label used in the interface. You can use any characters (including 
spaces) in this field, except for the " character. 

Description (optional) A BACnet-visible microblock description. 

Resolution The increment by which the microblock updates the value on its output wire. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Trends 
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 
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Sample every ___ 
(hh:mm:ss) 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset in the i-Vu® interface to delete all samples currently stored in the 
controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trnds for 
___days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

 

 
 

Alarms 
  

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 
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Alarms 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains below the Low 
Limit value for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm Text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledgment 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enable Check to send a message when an alarm condition has returned to normal. 

Return Text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you 
will reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Tips and tricks 

BACnet properties 
The Bypass microblock is a proprietary BACnet object. If you make this object Network Visible, you can address a 
BACnet Analog Network Input or BACnet Analog Network Output microblock to access many of its configuration 
and control properties in other control programs. See BACnet object property addresses below. 

 

 
 

BACnet object property addresses 
The Bypass microblock is a proprietary BACnet object (object type 770). The format for a BACnet address is 
bacnet://device/object/property@priority.  

EXAMPLE  To set up a microblock to read the Current Value of the Duct Static Pressure from the first Bypass 
microblock in the same controller, use the following address. 

bacnet://this/770:1/4710 

In the above address, 770:1 indicates the first instance of a Bypass microblock in the controller. 
   

BACnet 
property 
identifier # 

BACnet property identifier Description Read/ 
Write 

75 PROPID_OBJECT_IDENTIFIER BACnet ID of the BP Object R 

77 PROPID_OBJECT_NAME BACnet name of the BP Object R 
79 PROPID_OBJECT_TYPE BACnet Type R 

28 PROPID_DESCRIPTION BACnet Description of the BP Object R/W 
31 PROPID_DEVICE_TYPE BACnet Device Type R/W 
168 PROPID_PROFILE_NAME BACnet profile name of the object R/W 
4132 PROPID_TAB_TECH_NAME Name of Test and Balance Tech. R/W 
4133 PROPID_TAB_ORG_NAME Name of Test and Blance Company R/W 

4135 PROPID_DISPLAY_NAME Name of Test and Blance Company R/W 
4140 PROPID_TAB_PARS_SEAL BACnet Date/Time - Used to detect writes by 

external Test and Balance software 
R/W 

4121 PROPID_LOCK_FLAGS Binary lock bits whether to apply locks R 
4105 PROPID_DAMPER_LOCK Real - lock value for Damper % open R/W 
4107 PROPID_AUTO_ZERO Boolean - indicates completion of auto-zero R 
4108 PROPID_TAB_MODE Enumeration of states of damper control whle 

Test and Balance is performed. 
R/W 

4134 PROPID_LAST_TAB_DATE Date of last Test and Balance R/W 
4111 PROPID_AIR_SOURCE_OBJ_ID Airsource BACnet Object ID R 
4109 PROPID_PAR_PRG_DEV_ID Device ID of program containing the BP Object R 
4110 PROPID_PAR_PRG_OBJ_ID Program AI of program containing the BP 

Object 
R 

4123 PROPID_SENS_CONFIG Sensor configuration R 

4124 PROPID_DAMP_CONFIG Damper configuration R 
111 PROPID_STATUS_FLAGS BACnet status flags R 
103 PROPID_RELIABILITY BACnet reliability status of Object R 
4136 PROPID_OWN_PRG_OBJ_ID Object ID for program containing this instance R 
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BACnet 
property 
identifier # 

BACnet property identifier Description Read/ 
Write 

4125 PROPID_FLOW_RAWPCT Raw counts of flow sensor R 
4127 PROPID_MOVES_TODAY Number of damper movements today R 
4128 PROPID_MOVES_YESTERDAY Number of damper movements yesterday R 

4131 PROPID_PROP_STAT_FLAGS PROPID_PROP_STAT_FLAGS R 
117 PROPID_UNITS Units used by the object R 
4141 PROPID_LOCK_FLAGS_BOOL Boolean array of lock flags R 
4142 PROPID_PROP_STAT_FLAGS_BOOL Boolean array of BACnet status flags R 
4156 APPLICATION INSTANCE The linkage application instance used by the 

microblock 
R/W 

4703 PROPID_BYP_VERSION Version number of the BP microblock R 
4704 PROPID_BYP_DSP_LOCK Real - lock value for Duct Static Press R 
4705 PROPID_BYP_COMMANDED_POSITION Value of current damper commanded position R 
4706 PROPID_BYP_AHU_MODE Value of current AHU Mode R 

4707 PROPID_BYP_LAT_OVERRIDE Value of current LAT override R 
4708 PROPID_BYP_DAMPER_MOTION Value of current Damper Move input R 

4709 PROPID_BYP_DAMPER Value of current Damper Position R 
4710 PROPID_BYP_DUCT_STATIC Value of current Duct Static Pressure R 
4711 PROPID_BYP_WKG_DSP PROPID_BYP_WKG_DSP R 
4712 PROPID_BYP_CAL_ACTIVE Value of current Cal Active output R 
4713 PROPID_BYP_DSP_WIRE DSP wire current value R 

4714 PROPID_BYP_LAT_WIRE LAT wire current value R 
4715 PROPID_BYP_DUCT_SP_SETPOINT Real - Static Pressure Setpoint R 
4716 PROPID_BYP_LAT_SETPOINT PROPID_BYP_LAT_SETPOINT R 

4717 PROPID_BYP_CALIBRATION_SETPT Real - Calibration Setpoint R 
4718 PROPID_BYP_DSP_SETPT_OVR Real - DSP Setpoint override R/W 

4719 PROPID_BYP_LAT_SETPT_OVR Real - LAT Setpoint override R/W 
4720 PROPID_BYP_CAL_SETPT_OVR Real - Calibration Setpoint override R/W 

 

 
 

Network I/O microblocks 

Network Input and Output microblocks pass information between points on the network. A network input 
microblock reads the value of a network-visible BACnet® property on the network or of an equivalent value from 
another supported protocol. A network output microblock writes a value to a point on the network. 

Read 

 Analog Network Input (page 124) 

Reads an analog value from a specific address on the network. 

 Analog Network Input 2 (page 131) 

Reads an analog value from a specific address on the network. Monitors and outputs the 
validity of network communication between the microblock and its target. 

 Binary Network Input (page 136) 

Reads a binary (digital) value from a specific address on the network. 
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 Binary Network Input 2 (page 141) 

Reads a binary (digital) value from a specific address on the network. Monitors and outputs the 
validity of network communication between the microblock and its target. 

Write 

 Analog Network Output (page 146) 

Writes an analog value to a specific address on the network. 

 Analog Network Output 2 (page 148) 

Writes an analog value to a specific address on the network. Stops writing to the target address 
when the Enable input is false (off). 

 Binary Network Output (page 151) 

Writes a binary (digital) value to a specific address on the network. 

 Binary Network Output 2 (page 153) 

Writes a binary (digital) value to a specific address on the network. Stops writing to the target 
address when the Enable input is false (off). 

Linkage 

 BACnet Collector (page 155) 

Provides a means for the control program to exchange sets of data across the BACnet network. 
Creates associations with one or more Provider microblocks and maintains: 
• An Input data array received from Provider microblocks 
• A set of Feedback data transmitted to each Provider microblock 

 BACnet Provider (page 157) 

Provides a means for the control program to exchange sets of data across the BACnet network. 
Creates an association with one Collector microblock and maintains: 
• An Output data array transmitted to the Collector microblock 
• A set of Feedback data received from the Collector microblock 

Rnet 

 BACnet Analog Sensed Value Input (page 159) 

Reads an analog value from up to 5 ZS or WS sensors, and makes the value available to the 
control program on an output wire. If the Rnet has more than one ZS or WS sensor, the 
microblock's combination algorithm determines whether the output value is the average, 
minimum, or maximum of the readings.  

 BACnet Binary Sensed Value Input (page 165) 

Reads a binary value from up to 5 ZS or WS sensors, and makes the value available to the 
control program on an output wire. If the Rnet has more than one ZS or WS sensor, the 
microblock's combination algorithm determines whether the output value is based on a single 
sensors value or all sensors having the same value.  

 Sensor Binder (page 169) 

A Sensor Binder microblock is required if your control programs is to work with ZS or WS 
sensors. This microblock is where you define up to 5 uniquely-addressed ZS or WS sensors. The 
addresses in the microblock must match the sensors' Rnet addresses. 
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Analog Network Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol    

What it does Reads an analog value from a specific address on the network.  

You can address the microblock to read any network-visible I/O point value, status or 
parameter microblock value, BACnet object property value, or an equivalent value 
from a supported third-party protocol. 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 

 

 
 

How it works 
This microblock reads the value at the Address you specify. The target value can be a network-visible BACnet 
object property value or a third-party value (if the controller supports the third-party protocol). 

For a non-BACnet target, the microblock reads the target value at the interval you specify in the Refresh Time 
field. For a BACnet target, see "Polling or BACnet COV subscription" below. 

If communication with all specified targets fails, or if you uncheck Communications Enabled, the microblock 
outputs the Default value. 

Polling or BACnet COV 
If a Network Input or Total Analog microblock's Address field references a BACnet object property, the microblock 
reads the property's value using one of the following methods. 

• Polling—The microblock reads the property at the Refresh Time interval using the BACnet ReadProperty or 
ReadPropertyMultiple service (see "Method 1: Polling" below). 

• BACnet COV (Change of Value) subscription—The microblock subscribes with the target BACnet object. An 
analog target notifies the microblock if the target's value changes by more than the target's BACnet 
COV_Increment. A binary target notifies the microblock when it changes state (see "Method 2: BACnet COV 
subscriptions" below). 
  

Method 1:   Polling  
Benefits • Allows rapid detection of a dead device or of network problems 

• Does not require additional memory 
Drawbacks • Generates unnecessary network traffic if a value does not change frequently 

• Misses value changes that occur between pollings 
• Can overwhelm the target's controller if many microblocks request the same property value 

(such as outside air temperature). The BACnet object must send the value to each 
microblock that polls for that data. 

To set up Set the microblock's Refresh Time to 30 seconds or less. 
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NOTE  The Carrier microblock will not poll at a Refresh Time interval smaller than 1 second. 
  
  

BACnet ReadProperty and ReadPropertyMultiple services 

See the BACnet specification for details on the ReadProperty and ReadPropertyMultiple services. 

ReadPropertyMultiple occurs if: 
• two or more microblocks in a controller read more than one target in the same remote controller,  
• the Refresh Time in two or more microblocks expires at the same time, and  
• the remote controller supports the service. 

  

Method 2:   BACnet COV subscriptions  
Benefits • Can decrease network traffic by preventing unnecessary updates if the target's 

COV_Increment is set appropriately. See step 2 in "To set up" below.  
Drawbacks • Can generate excessive network traffic if the target's COV_Increment property is too small. 

See step 2 in "To set up" below. 
• Can delay detection of a dead device or of network problems 

To set up 1 Set the microblock's Refresh Time to 31 seconds or more. 

2 If the microblock's Address field references an analog property, set the target's 
COV_Increment property to the smallest amount by which the value must change for the 
target to notify its subscribers. The optimal COV_Increment is large enough to prevent 
unnecessary updates but small enough to be useful to the control program(s) receiving the 
updates. 

NOTE  If COV subscription fails, the microblock reads the value at the Refresh Time interval using the BACnet 
ReadProperty or ReadPropertyMultiple service. See "Method 1: Polling" above. 
  

COV subscription details  
When an input (Network Input or Total Analog microblock) subscribes with a BACnet target (object property), the 
input sets a 21-minute subscription Lifetime in the target. The target responds with a COV notification that 
includes the target's value and time remaining from the original subscription Lifetime (TimeRemaining). The input 
resubscribes with the target every 10 minutes to keep the target's BACnet subscription service active. The Next 
Subscription field on the input's Properties page shows the time remaining until the input's next subscription. 

The target also sends a COV notification that includes the target's value and subscription Lifetime TimeRemaining 
when the target's value changes by more than the target's COV_Increment.  

If the Carrier target has one subscriber, the target sends COV notifications directly to that subscriber. If the Carrier 
target has more than one subscriber, it broadcasts its COV notifications to optimize network traffic. A third-party 
subscriber can participate in this broadcast scheme by subscribing for Unconfirmed COV notifications with a 
Process ID of 0. Otherwise, the Carrier target maintains and responds to the third-party subscription separately 
with its own Lifetime timer. 

The Carrier input compares the TimeRemaining value in each COV notification broadcast the target sends to its 
(Next Subscription time + 11) to determine whether another input has subscribed since it did. If another input has 
subscribed more recently, the input adds 10 minutes to its Next Subscription time. This allows the COV 
Subscription request from the last subscribing input to keep the subscription service active for all subscribers to 
the same data. 
  

EXAMPLE 

Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 
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Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Input 1 subscribes to target 21 (Input 1) 10   

0 Target broadcasts COV notification 
because Input 1 subscribed 

21 21 ≤ 10 + 11, 
so keep current 
value of 10 

  

2 Input 2 subscribes to target 21 (Input 2) 10 - 2 = 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value of 8 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

3   21 - 3 = 18 18 - 3 = 15 10 - 3 = 7 

0 Target broadcasts COV notification 
because value changed 

18 18 ≤ 15 + 11 
so keep current 
value of 15 

18 ≤ 7 + 11 
so keep current 
value of 7 

7   18 - 7 = 11 15 - 7 = 8 7 - 7 = 0 
resubscribe 

0 Input 2 resubscribes 21 (Input 2) 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

Input 2 keeps the subscription service active at the target with a minimum of network traffic.  

NOTE  If an input receives COV notification with a target TimeRemaining < 11, which could happen if the last 
subscribing input loses communication with the target, the input resubscribes immediately. 
  

COV notification rate 
COV notifications from a BACnet object property are controlled by that property's BACnet COV_Increment.  When 
the absolute value of the difference between the property's Present_Value and the value sent in the last COV 
notification is greater than the COV_Increment, the object broadcasts a COV notification. For Carrier controllers, 
the rate of notifications is further limited by two internal processes.  

1 The control program's execution rate determines how often the check against COV_Increment is performed. 

2 The controller's pending COV Notification task has built-in delays to prevent COV notifications from consuming 
the controller's CPU processing time. 

The built-in delays are as follows: 

If more than 15 COV notifications are pending delivery, the controller inserts a 50 millisecond delay after 
each set of 15 notifications.  Once the entire list of pending notifications is serviced, the controller inserts 
another 50 millisecond delay. This results in a maximum COV notification rate of 300 COV notifications per 
second per Carrier controller.  
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

This microblock reads a BACnet target's value using one of 2 methods depending on 
the interval you specify in the Refresh Time field. 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIPS   

• If you are integrating to multiple identical third-party devices, you can copy the 
equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "To create a control program for 
multiple identical third-party devices" in the BACnet Integration Guide. 

• A single * (asterisk) as a device name in an Analog Network Input will initiate a 
broadcasted request for any device on the network that has MyObject to 
respond. The microblock will then determine which of the responders has valid 
data for MyObject and subscribe to that device. 
NOTE  This syntax is valid when it is combined with an Object Name only. This 
syntax is not supported for Property or Priority and is supported for Analog 
Network Input and Analog Network Input 2 microblocks only. 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.   
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Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Tips and tricks 

To address microblocks using source trees 
You can address a network microblock in the Snap application to target a microblock in its parent application on 
the source tree.  

Format:  

Example: 

exp:~equipment/~<source tree reference name>/~parent/~target/<target microblock reference 
name>  

exp:~equipment/~cool/~parent/~target/supply_air_temp 

By using this format in the Snap application, the i-Vu® application will read the target microblock value from the 
parent application. This method is much faster than going to each zone individually in the i-Vu® interface to 
address the network microblocks. For example, this allows you to create generic zone applications that can be 
reused not only for all zones under a single air handler, but for all zones under any air handler. 
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To speed detection of dead device 
If a BACnet object's device loses network communication, a network input reading the object's value does not 
detect the failure until  

• the network input's next subscription (up to 10 minutes) if using BACnet COV subscription, or 

• the Refresh Time expires, if polling 

You can use a small Refresh Time to poll more often, but this can generate unnecessary network traffic under 
normal conditions.  

To use the benefits of BACnet COV subscription, but overcome the potential delay in detection of a dead device, 
send a constantly changing value from the BACnet object's control program to a network input using BACnet COV 
subscription. If the value stops changing, the network input's control program generates an alarm. 
  

EXAMPLE 

The logic in the BACnet object's control program that sends the value. The BACnet Analog Value microblock has a 
COV Increment of 0.5. 

 
 

The logic in the network input's control program that receives the changing value. The SIGNAL analog network 
input's Address field contains the address of the BACnet Analog Value microblock sending the changing signal, 
and the network input's Refresh Time is 31 seconds. 
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Analog Network Input 2 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 

   

What it does Reads an analog value from a specific address on the network. Monitors and outputs 
the validity of network communication between the microblock and its target.  

You can address the microblock to read any network-visible I/O point value, status or 
parameter microblock value, BACnet object property value, or an equivalent value 
from a supported third-party protocol. 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 

 

 
 

How it works 
This microblock reads the value at the Address you specify. The target value can be a network-visible BACnet 
object property value or a third-party value (if the controller supports the third-party protocol). 

For a non-BACnet target, the microblock reads the target value at the interval you specify in the Refresh Time 
field. For a BACnet target, see "Polling or BACnet COV subscription" below. 

If communication with all specified targets fails, or if you uncheck Communications Enabled, the microblock 
outputs the Default value.  

If communication fails with the Address target, the microblock reads and outputs the Secondary Address target 
value. 

The Valid? output is False (Off) when communication with the Address fails. When the Valid? output is False, the 
microblock outputs the Secondary Address value if communicating, or the Default value if not. 

The Valid? output is True (On) when the microblock is communicating with the Address target value or when the 
microblock's present value is locked in your i-Vu® or Field Assistant system. 

Polling or BACnet COV subscription 
If a Network Input or Total Analog microblock's Address field references a BACnet object property, the microblock 
reads the property's value using one of the following methods. 

• Polling—The microblock reads the property at the Refresh Time interval using the BACnet ReadProperty or 
ReadPropertyMultiple service (see "Method 1: Polling" below). 

• BACnet COV (Change of Value) subscription—The microblock subscribes with the target BACnet object. An 
analog target notifies the microblock if the target's value changes by more than the target's BACnet 
COV_Increment. A binary target notifies the microblock when it changes state (see "Method 2: BACnet COV 
subscriptions" below). 
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Method 1:   Polling  
Benefits • Allows rapid detection of a dead device or of network problems 

• Does not require additional memory 
Drawbacks • Generates unnecessary network traffic if a value does not change frequently 

• Misses value changes that occur between pollings 
• Can overwhelm the target's controller if many microblocks request the same property value 

(such as outside air temperature). The BACnet object must send the value to each 
microblock that polls for that data. 

To set up Set the microblock's Refresh Time to 30 seconds or less. 

  
NOTE  The Carrier microblock will not poll at a Refresh Time interval smaller than 1 second. 
  
  

BACnet ReadProperty and ReadPropertyMultiple services 

See the BACnet specification for details on the ReadProperty and ReadPropertyMultiple services. 

ReadPropertyMultiple occurs if: 
• two or more microblocks in a controller read more than one target in the same remote controller,  
• the Refresh Time in two or more microblocks expires at the same time, and  
• the remote controller supports the service. 

  

Method 2:   BACnet COV subscriptions  
Benefits • Can decrease network traffic by preventing unnecessary updates if the target's 

COV_Increment is set appropriately. See step 2 in "To set up" below.  
Drawbacks • Can generate excessive network traffic if the target's COV_Increment property is too small. 

See step 2 in "To set up" below. 
• Can delay detection of a dead device or of network problems 

To set up 1 Set the microblock's Refresh Time to 31 seconds or more. 

2 If the microblock's Address field references an analog property, set the target's 
COV_Increment property to the smallest amount by which the value must change for the 
target to notify its subscribers. The optimal COV_Increment is large enough to prevent 
unnecessary updates but small enough to be useful to the control program(s) receiving the 
updates. 

NOTE  If COV subscription fails, the microblock reads the value at the Refresh Time interval using the BACnet 
ReadProperty or ReadPropertyMultiple service. See "Method 1: Polling" above. 
  

COV subscription details  
When an input (Network Input or Total Analog microblock) subscribes with a BACnet target (object property), the 
input sets a 21-minute subscription Lifetime in the target. The target responds with a COV notification that 
includes the target's value and time remaining from the original subscription Lifetime (TimeRemaining). The input 
resubscribes with the target every 10 minutes to keep the target's BACnet subscription service active. The Next 
Subscription field on the input's Properties page shows the time remaining until the input's next subscription. 

The target also sends a COV notification that includes the target's value and subscription Lifetime TimeRemaining 
when the target's value changes by more than the target's COV_Increment.  

If the Carrier target has one subscriber, the target sends COV notifications directly to that subscriber. If the Carrier 
target has more than one subscriber, it broadcasts its COV notifications to optimize network traffic. A third-party 
subscriber can participate in this broadcast scheme by subscribing for Unconfirmed COV notifications with a 
Process ID of 0. Otherwise, the Carrier target maintains and responds to the third-party subscription separately 
with its own Lifetime timer. 
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The Carrier input compares the TimeRemaining value in each COV notification broadcast the target sends to its 
(Next Subscription time + 11) to determine whether another input has subscribed since it did. If another input has 
subscribed more recently, the input adds 10 minutes to its Next Subscription time. This allows the COV 
Subscription request from the last subscribing input to keep the subscription service active for all subscribers to 
the same data. 
 EXAMPLE 

Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Input 1 subscribes to target 21 (Input 1) 10   

0 Target broadcasts COV notification 
because Input 1 subscribed 

21 21 ≤ 10 + 11, 
so keep current 
value of 10 

  

2 Input 2 subscribes to target 21 (Input 2) 10 - 2 = 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value of 8 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

3   21 - 3 = 18 18 - 3 = 15 10 - 3 = 7 

0 Target broadcasts COV notification 
because value changed 

18 18 ≤ 15 + 11 
so keep current 
value of 15 

18 ≤ 7 + 11 
so keep current 
value of 7 

7   18 - 7 = 11 15 - 7 = 8 7 - 7 = 0 
resubscribe 

0 Input 2 resubscribes 21 (Input 2) 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

Input 2 keeps the subscription service active at the target with a minimum of network traffic.  

NOTE  If an input receives COV notification with a target TimeRemaining < 11, which could happen if the last 
subscribing input loses communication with the target, the input resubscribes immediately. 
  

COV notification rate 
COV notifications from a BACnet object property are controlled by that property's BACnet COV_Increment.  When 
the absolute value of the difference between the property's Present_Value and the value sent in the last COV 
notification is greater than the COV_Increment, the object broadcasts a COV notification. For Carrier controllers, 
the rate of notifications is further limited by two internal processes.  

1 The control program's execution rate determines how often the check against COV_Increment is performed. 

2 The controller's pending COV Notification task has built-in delays to prevent COV notifications from consuming 
the controller's CPU processing time. 

The built-in delays are as follows: 

If more than 15 COV notifications are pending delivery, the controller inserts a 50 millisecond delay after 
each set of 15 notifications.  Once the entire list of pending notifications is serviced, the controller inserts 
another 50 millisecond delay. This results in a maximum COV notification rate of 300 COV notifications per 
second per Carrier controller.  
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

This microblock reads a BACnet target's value using one of 2 methods depending on 
the interval you specify in the Refresh Time field. 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIPS   

• If you are integrating to multiple identical third-party devices, you can copy the 
equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "To create a control program for 
multiple identical third-party devices" in the BACnet Integration Guide. 

• A single * (asterisk) as a device name in an Analog Network Input will initiate a 
broadcasted request for any device on the network that has MyObject to 
respond. The microblock will then determine which of the responders has valid 
data for MyObject and subscribe to that device. 
NOTE  This syntax is valid when it is combined with an Object Name only. This 
syntax is not supported for Property or Priority and is supported for Analog 
Network Input and Analog Network Input 2 microblocks only. 

Secondary Address The address the microblock reads if communication fails with the Address field 
target. 

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  
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Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Binary Network Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol    

What it does Reads a binary (digital) value from a specific address on the network. 

You can address the microblock to read any network-visible I/O point value, status or 
parameter microblock value, BACnet object property value, or an equivalent value 
from a supported third-party protocol. 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 
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How it works 
This microblock reads the value at the Address you specify. The target value can be a network-visible BACnet 
object property value or a third-party value (if the controller supports the third-party protocol). 

For a non-BACnet target, the microblock reads the target value at the interval you specify in the Refresh Time 
field. For a BACnet target, see "Polling or BACnet COV subscription" below. 

If communication with all specified targets fails, or if you uncheck Communications Enabled, the microblock 
outputs the Default value. 

Polling or BACnet COV 
If a Network Input or Total Analog microblock's Address field references a BACnet object property, the microblock 
reads the property's value using one of the following methods. 

• Polling—The microblock reads the property at the Refresh Time interval using the BACnet ReadProperty or 
ReadPropertyMultiple service (see "Method 1: Polling" below). 

• BACnet COV (Change of Value) subscription—The microblock subscribes with the target BACnet object. An 
analog target notifies the microblock if the target's value changes by more than the target's BACnet 
COV_Increment. A binary target notifies the microblock when it changes state (see "Method 2: BACnet COV 
subscriptions" below). 
  

Method 1:   Polling  
Benefits • Allows rapid detection of a dead device or of network problems 

• Does not require additional memory 
Drawbacks • Generates unnecessary network traffic if a value does not change frequently 

• Misses value changes that occur between pollings 
• Can overwhelm the target's controller if many microblocks request the same property value 

(such as outside air temperature). The BACnet object must send the value to each 
microblock that polls for that data. 

To set up Set the microblock's Refresh Time to 30 seconds or less. 

  
NOTE  The Carrier microblock will not poll at a Refresh Time interval smaller than 1 second. 
  
  

BACnet ReadProperty and ReadPropertyMultiple services 

See the BACnet specification for details on the ReadProperty and ReadPropertyMultiple services. 

ReadPropertyMultiple occurs if: 
• two or more microblocks in a controller read more than one target in the same remote controller,  
• the Refresh Time in two or more microblocks expires at the same time, and  
• the remote controller supports the service. 

  

Method 2:   BACnet COV subscriptions  
Benefits • Can decrease network traffic by preventing unnecessary updates if the target's 

COV_Increment is set appropriately. See step 2 in "To set up" below.  
Drawbacks • Can generate excessive network traffic if the target's COV_Increment property is too small. 

See step 2 in "To set up" below. 
• Can delay detection of a dead device or of network problems 
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To set up 1 Set the microblock's Refresh Time to 31 seconds or more. 

2 If the microblock's Address field references an analog property, set the target's 
COV_Increment property to the smallest amount by which the value must change for the 
target to notify its subscribers. The optimal COV_Increment is large enough to prevent 
unnecessary updates but small enough to be useful to the control program(s) receiving the 
updates. 

NOTE  If COV subscription fails, the microblock reads the value at the Refresh Time interval using the BACnet 
ReadProperty or ReadPropertyMultiple service. See "Method 1: Polling" above. 
  

COV subscription details  
When an input (Network Input or Total Analog microblock) subscribes with a BACnet target (object property), the 
input sets a 21-minute subscription Lifetime in the target. The target responds with a COV notification that 
includes the target's value and time remaining from the original subscription Lifetime (TimeRemaining). The input 
resubscribes with the target every 10 minutes to keep the target's BACnet subscription service active. The Next 
Subscription field on the input's Properties page shows the time remaining until the input's next subscription. 

The target also sends a COV notification that includes the target's value and subscription Lifetime TimeRemaining 
when the target's value changes by more than the target's COV_Increment.  

If the Carrier target has one subscriber, the target sends COV notifications directly to that subscriber. If the Carrier 
target has more than one subscriber, it broadcasts its COV notifications to optimize network traffic. A third-party 
subscriber can participate in this broadcast scheme by subscribing for Unconfirmed COV notifications with a 
Process ID of 0. Otherwise, the Carrier target maintains and responds to the third-party subscription separately 
with its own Lifetime timer. 

The Carrier input compares the TimeRemaining value in each COV notification broadcast the target sends to its 
(Next Subscription time + 11) to determine whether another input has subscribed since it did. If another input has 
subscribed more recently, the input adds 10 minutes to its Next Subscription time. This allows the COV 
Subscription request from the last subscribing input to keep the subscription service active for all subscribers to 
the same data. 
  

EXAMPLE 

Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Input 1 subscribes to target 21 (Input 1) 10   

0 Target broadcasts COV notification 
because Input 1 subscribed 

21 21 ≤ 10 + 11, 
so keep current 
value of 10 

  

2 Input 2 subscribes to target 21 (Input 2) 10 - 2 = 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value of 8 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

3   21 - 3 = 18 18 - 3 = 15 10 - 3 = 7 

0 Target broadcasts COV notification 
because value changed 

18 18 ≤ 15 + 11 
so keep current 
value of 15 

18 ≤ 7 + 11 
so keep current 
value of 7 

7   18 - 7 = 11 15 - 7 = 8 7 - 7 = 0 
resubscribe 
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Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Input 2 resubscribes 21 (Input 2) 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

Input 2 keeps the subscription service active at the target with a minimum of network traffic.  

NOTE  If an input receives COV notification with a target TimeRemaining < 11, which could happen if the last 
subscribing input loses communication with the target, the input resubscribes immediately. 
  

COV notification rate 
COV notifications from a BACnet object property are controlled by that property's BACnet COV_Increment.  When 
the absolute value of the difference between the property's Present_Value and the value sent in the last COV 
notification is greater than the COV_Increment, the object broadcasts a COV notification. For Carrier controllers, 
the rate of notifications is further limited by two internal processes.  

1 The control program's execution rate determines how often the check against COV_Increment is performed. 

2 The controller's pending COV Notification task has built-in delays to prevent COV notifications from consuming 
the controller's CPU processing time. 

The built-in delays are as follows: 

If more than 15 COV notifications are pending delivery, the controller inserts a 50 millisecond delay after 
each set of 15 notifications.  Once the entire list of pending notifications is serviced, the controller inserts 
another 50 millisecond delay. This results in a maximum COV notification rate of 300 COV notifications per 
second per Carrier controller.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

This microblock reads a BACnet target's value using one of 2 methods depending on 
the interval you specify in the Refresh Time field. 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 141 

 

Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes state. If 
subscription fails, this microblock reads the target value at the interval you 
specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Binary Network Input 2 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 

    

What it does Reads a binary (digital) value from a specific address on the network. Monitors and 
outputs the validity of network communication between the microblock and its target. 

You can address the microblock to read any network-visible I/O point value, status or 
parameter microblock value, BACnet object property value, or an equivalent value 
from a supported third-party protocol. 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 
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How it works 
This microblock reads the value at the Address you specify. The target value can be a network-visible BACnet 
object property value or a third-party value (if the controller supports the third-party protocol). 

For a non-BACnet target, the microblock reads the target value at the interval you specify in the Refresh Time 
field. For a BACnet target, see "Polling or BACnet COV subscription" below. 

If communication with all specified targets fails, or if you uncheck Communications Enabled, the microblock 
outputs the Default value.  

If communication fails with the Address target, the microblock reads and outputs the Secondary Address target 
value. 

The Valid? output is False (Off) when communication with the Address fails. When the Valid? output is False, the 
microblock outputs the Secondary Address value if communicating, or the Default value if not. 

The Valid? output is True (On) when the microblock is communicating with the Address target value or when the 
microblock's present value is locked in your i-Vu® or Field Assistant system. 

Polling or BACnet COV subscription 
If a Network Input or Total Analog microblock's Address field references a BACnet object property, the microblock 
reads the property's value using one of the following methods. 

• Polling—The microblock reads the property at the Refresh Time interval using the BACnet ReadProperty or 
ReadPropertyMultiple service (see "Method 1: Polling" below). 

• BACnet COV (Change of Value) subscription—The microblock subscribes with the target BACnet object. An 
analog target notifies the microblock if the target's value changes by more than the target's BACnet 
COV_Increment. A binary target notifies the microblock when it changes state (see "Method 2: BACnet COV 
subscriptions" below). 
  

Method 1:   Polling  
Benefits • Allows rapid detection of a dead device or of network problems 

• Does not require additional memory 
Drawbacks • Generates unnecessary network traffic if a value does not change frequently 

• Misses value changes that occur between pollings 
• Can overwhelm the target's controller if many microblocks request the same property value 

(such as outside air temperature). The BACnet object must send the value to each 
microblock that polls for that data. 

To set up Set the microblock's Refresh Time to 30 seconds or less. 

  
NOTE  The Carrier microblock will not poll at a Refresh Time interval smaller than 1 second. 
  
  

BACnet ReadProperty and ReadPropertyMultiple services 

See the BACnet specification for details on the ReadProperty and ReadPropertyMultiple services. 

ReadPropertyMultiple occurs if: 
• two or more microblocks in a controller read more than one target in the same remote controller,  
• the Refresh Time in two or more microblocks expires at the same time, and  
• the remote controller supports the service. 
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Method 2:   BACnet COV subscriptions  
Benefits • Can decrease network traffic by preventing unnecessary updates if the target's 

COV_Increment is set appropriately. See step 2 in "To set up" below.  
Drawbacks • Can generate excessive network traffic if the target's COV_Increment property is too small. 

See step 2 in "To set up" below. 
• Can delay detection of a dead device or of network problems 

To set up 1 Set the microblock's Refresh Time to 31 seconds or more. 

2 If the microblock's Address field references an analog property, set the target's 
COV_Increment property to the smallest amount by which the value must change for the 
target to notify its subscribers. The optimal COV_Increment is large enough to prevent 
unnecessary updates but small enough to be useful to the control program(s) receiving the 
updates. 

NOTE  If COV subscription fails, the microblock reads the value at the Refresh Time interval using the BACnet 
ReadProperty or ReadPropertyMultiple service. See "Method 1: Polling" above. 
  

COV subscription details  
When an input (Network Input or Total Analog microblock) subscribes with a BACnet target (object property), the 
input sets a 21-minute subscription Lifetime in the target. The target responds with a COV notification that 
includes the target's value and time remaining from the original subscription Lifetime (TimeRemaining). The input 
resubscribes with the target every 10 minutes to keep the target's BACnet subscription service active. The Next 
Subscription field on the input's Properties page shows the time remaining until the input's next subscription. 

The target also sends a COV notification that includes the target's value and subscription Lifetime TimeRemaining 
when the target's value changes by more than the target's COV_Increment.  

If the Carrier target has one subscriber, the target sends COV notifications directly to that subscriber. If the Carrier 
target has more than one subscriber, it broadcasts its COV notifications to optimize network traffic. A third-party 
subscriber can participate in this broadcast scheme by subscribing for Unconfirmed COV notifications with a 
Process ID of 0. Otherwise, the Carrier target maintains and responds to the third-party subscription separately 
with its own Lifetime timer. 

The Carrier input compares the TimeRemaining value in each COV notification broadcast the target sends to its 
(Next Subscription time + 11) to determine whether another input has subscribed since it did. If another input has 
subscribed more recently, the input adds 10 minutes to its Next Subscription time. This allows the COV 
Subscription request from the last subscribing input to keep the subscription service active for all subscribers to 
the same data. 
  

EXAMPLE 

Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Input 1 subscribes to target 21 (Input 1) 10   

0 Target broadcasts COV notification 
because Input 1 subscribed 

21 21 ≤ 10 + 11, 
so keep current 
value of 10 

  

2 Input 2 subscribes to target 21 (Input 2) 10 - 2 = 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value of 8 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

3   21 - 3 = 18 18 - 3 = 15 10 - 3 = 7 
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Elapsed 
time 
(minutes) 

Action Target  
Lifetime 
TimeRemaining 
(minutes) 

Input 1  
Next Subscription 
(minutes) 

Input 2  
Next Subscription 
(minutes) 

0 Target broadcasts COV notification 
because value changed 

18 18 ≤ 15 + 11 
so keep current 
value of 15 

18 ≤ 7 + 11 
so keep current 
value of 7 

7   18 - 7 = 11 15 - 7 = 8 7 - 7 = 0 
resubscribe 

0 Input 2 resubscribes 21 (Input 2) 8 10 

0 Target broadcasts COV notification 
because Input 2 subscribed 

21 21 > 8 + 11, 
so add 10 to 
current value 

8 + 10 = 18 

21 ≤ 10 + 11, 
so keep current 
value of 10 

Input 2 keeps the subscription service active at the target with a minimum of network traffic.  

NOTE  If an input receives COV notification with a target TimeRemaining < 11, which could happen if the last 
subscribing input loses communication with the target, the input resubscribes immediately. 
  

COV notification rate 
COV notifications from a BACnet object property are controlled by that property's BACnet COV_Increment.  When 
the absolute value of the difference between the property's Present_Value and the value sent in the last COV 
notification is greater than the COV_Increment, the object broadcasts a COV notification. For Carrier controllers, 
the rate of notifications is further limited by two internal processes.  

1 The control program's execution rate determines how often the check against COV_Increment is performed. 

2 The controller's pending COV Notification task has built-in delays to prevent COV notifications from consuming 
the controller's CPU processing time. 

The built-in delays are as follows: 

If more than 15 COV notifications are pending delivery, the controller inserts a 50 millisecond delay after 
each set of 15 notifications.  Once the entire list of pending notifications is serviced, the controller inserts 
another 50 millisecond delay. This results in a maximum COV notification rate of 300 COV notifications per 
second per Carrier controller.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

This microblock reads a BACnet target's value using one of 2 methods depending on 
the interval you specify in the Refresh Time field. 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

Secondary Address The address the microblock reads if communication fails with the Address field 
target. 

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  
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Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes state. If 
subscription fails, this microblock reads the target value at the interval you 
specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Analog Network Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol      

What it does Writes an analog value to a specific address on the network. 

You can address the microblock to write to any I/O point value, status or parameter 
microblock value, BACnet object property value, or equivalent value from another 
supported protocol that is not marked "read only". 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 
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How it works 
At the interval you specify in the Refresh Time field, this microblock writes to the value at the Address you specify. 
The target must not be "read only". The target can be a BACnet object property or a third-party value (if the 
controller supports the third-party protocol). See To format a BACnet address (page 458) or the applicable third-
party protocol Integration Guide. 

If you want the microblock to write to its target based on COV (Change of Value), check this microblock's COV 
Enable checkbox on the equipment's Properties page Network Points tab.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

The microblock writes to its target at the Refresh Time interval unless you set up 
writing based on COV (Change of Value) in the i-Vu® or Field Assistant system. 

Make sure that the target is not marked "read only". 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

COV Increment The amount by which this microblock's input value must change before the 
microblock writes a new value to its target.  

Not used if the microblock writes at the Refresh Time interval. 

NOTE  To write based on COV, in your i-Vu® or Field Assistant system, check this 
microblock's COV Enable checkbox on the equipment's Properties page Network 
Points tab. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock writes to its target.  

Not used if you check the microblock's COV Enable checkbox on the equipment's 
Properties page > Network Points tab to write based on COV (Change of Value). 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Analog Network Output 2 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 
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What it does Writes an analog value to a specific address on the network. Stops writing to the 
target address when the Enable input is false (off). If writing to a BACnet object 
property value, when the Enable input transitions from true (on) to false (off), the 
microblock relinquishes control of the target value. 

You can address the microblock to write to any I/O point value, status or parameter 
microblock value, BACnet object property value, or equivalent value from another 
supported protocol that is not marked "read only". 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 

 

 
 

How it works 
At the interval you specify in the Refresh Time field, this microblock writes to the value at the Address you specify. 
The target must not be "read only". The target can be a BACnet object property or a third-party value (if the 
controller supports the third-party protocol). See To format a BACnet address (page 458) or the applicable third-
party protocol Integration Guide. 

If you want the microblock to write to its target based on COV (Change of Value), check this microblock's COV 
Enable checkbox on the equipment's Properties page Network Points tab. If COV Enable is selected, the 
microblock writes to its target when the Enable value transitions from off to on, and when the microblock's input 
value changes from the previous written value by at least the COV Increment amount. 

If the target is a BACnet object property, when the Enable? input transitions from true (on) to false (off), the 
microblock relinquishes control of the target property.  

For example, in a smoke control application, if smoke is detected, turn on the Enable? input and write a VFD fan 
drive to 100% at BACnet Priority 2.  After the smoke alarm is cleared, turn off the Enable? input. The microblock 
sends a relinquish default command to clear the Priority 2 command to the VFD and allow the drive to resume 
normal operation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

The microblock writes to its target at the Refresh Time interval unless you set up 
writing based on COV (Change of Value) in the i-Vu® or Field Assistant system. 

Make sure that the target is not marked "read only". 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

COV Increment The amount by which this microblock's input value must change before the 
microblock writes a new value to its target.  

Not used if the microblock writes at the Refresh Time interval. 

NOTE  To write based on COV, in your i-Vu® or Field Assistant system, check this 
microblock's COV Enable checkbox on the equipment's Properties page Network 
Points tab. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  
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Refresh Time The interval at which the microblock writes to its target.  

Not used if you check the microblock's COV Enable checkbox on the equipment's 
Properties page > Network Points tab to write based on COV (Change of Value). 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Binary Network Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol    

What it does Writes a binary (digital) value to a specific address on the network.  

You can address the microblock to write to any I/O point value, status or parameter 
microblock value, BACnet object property value, or equivalent value from another 
supported protocol that is not marked "read only". 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 

 

 
 

How it works 
At the interval you specify in the Refresh Time field, this microblock writes to the value at the Address you specify. 
The target must not be "read only". The target can be a BACnet object property or a third-party value (if the 
controller supports the third-party protocol). See To format a BACnet address (page 458) or the applicable third-
party protocol Integration Guide. 

If you want the microblock to write to its target based on COV (Change of Value), check this microblock's COV 
Enable checkbox on the equipment's Properties page Network Points tab.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

The microblock writes to its target at the Refresh Time interval unless you set up 
writing based on COV (Change of Value) in the i-Vu® or Field Assistant system. 

Make sure that the target is not marked "read only". 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock writes to its target.  

Not used if you check the microblock's COV Enable checkbox on the equipment's 
Properties page > Network Points tab to write based on COV (Change of Value). 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Binary Network Output 2 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 

   

What it does Writes a binary (digital) value to a specific address on the network. Stops writing to 
the target address when the Enable input is false (off). If writing to a BACnet object 
property value, when the Enable input transitions from true (on) to false (off), the 
microblock relinquishes control of the target value. 

You can address the microblock to write to any I/O point value, status or parameter 
microblock value, BACnet object property value, or equivalent value from another 
supported protocol that is not marked "read only". 

The target value may be in the same control program, in another control program in 
the same controller, or in another Carrier controller or third-party device on the 
network. 

 

 
 

How it works 
At the interval you specify in the Refresh Time field, this microblock writes to the value at the Address you specify. 
The target must not be "read only". The target can be a BACnet object property or a third-party value (if the 
controller supports the third-party protocol). See To format a BACnet address (page 458) or the applicable third-
party protocol Integration Guide. 

If you want the microblock to write to its target based on COV (Change of Value), check this microblock's COV 
Enable checkbox on the equipment's Properties page Network Points tab. If COV Enable is selected, the 
microblock writes to its target when the Enable value transitions from off to on, and when the microblock's input 
value changes state. 

If the target is a BACnet object property, when the Enable? input transitions from true (on) to false (off), the 
microblock relinquishes control of the target property. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Address The address of the target BACnet object property or third-party value (if the controller 
supports the third-party protocol). See To format a BACnet address (page 458) or the 
applicable third-party protocol Integration Guide. 

The microblock writes to its target at the Refresh Time interval unless you set up 
writing based on COV (Change of Value) in the i-Vu® or Field Assistant system. 

Make sure that the target is not marked "read only". 

NOTE  For a target in the Carrier controller, you can specify the network microblock's 
Address in: 
• Your i-Vu® or Field Assistant system - Select the target in the tree on the 

microblock's Properties page Details tab. The system creates the address for 
you.  

• The Snap application - In the microblock's properties 
• The SiteBuilder application - If your product supports source trees and you are 

using them, SiteBuilder creates the address for you. 
  

NOTE  You can uncheck the Editable field in the Snap Property Editor to prevent 
editing of the address in the i-Vu® or Field Assistant system. 

 TIP  If you are integrating to multiple identical third-party devices, you can copy 
the equipment for the first device and then let the system help you address the 
Network I/O microblocks in the copies. See "Create a control program" in the BACnet 
Integration Guide. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock writes to its target.  

Not used if you check the microblock's COV Enable checkbox on the equipment's 
Properties page > Network Points tab to write based on COV (Change of Value). 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Collector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblock (page 122) 

Icon and symbol 

     

What it does Provides a means for the control program to exchange sets of data across the BACnet 
network. Creates associations with one or more Provider microblocks and maintains: 
• An Input data array received from Provider microblocks 
• A set of Feedback data transmitted to each Provider microblock 

 

 
 

How it works 
The association between a Collector and Provider can be established: 

• By the Collector actively communicating with each Provider and identifying itself as the recipient of that 
Providers output data. The Collector will actively create these associations when the Number of Providers 
property is set greater than 1. 

• The Collector can be passive and wait for a Provider to send it a message to establish the association. 

NOTE  Both modes can be supported at the same time.  

The Collector creates a table, (user defined size) to hold a set of Input data. Columns represent a user defined set 
of Input data tags and rows represent instances of the Input data set received from a number of Providers. The 
Maximum Providers property sets the number of Providers the Collector is capable of receiving and storing data 
from.   

Feedback data will be transmitted to the associated Provider on a periodic basis or when a Change of Value (COV) 
occurs.  

The Collector has no input or output wires. The Collector’s data sets are configured and access through an OCL 
compatible application programming interface (API).  The API consists of functions that provide the following 
functionality: 

• Find a specific Collector 

• Define the Input and Feedback data sets 

• Read/Write the Input data set 

• Write the Feedback data set 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

   

Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name Use the default reference name unless you want a more descriptive name for graphics 
or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Application Type A numeric value representing the system application type.  

1 Air Side Linkage 

2 Water Side Linkage 

3 Outside Air Conditions 

NOTE  User can define more application types as needed. 

Application Instance A numeric value that defines the specific instance of an application. This value is 
usually set to 1. 

Number of Providers The number of Providers that the Collector should actively associate with. 

Feedback Update Time The amount of time the Collector will wait before sending successive updates of its 
Feedback values to its associated Providers. 

Input Expiration Time The amount of time in which the Collector must receive successive updates of Input 
values from a given Provider. If an update is not received in this time, the Collector will 
mark the data from the Provider as expired and exclude it from any calculations. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Tips and Tricks 

BACnet properties 
The BACnet Collector microblock is a proprietary BACnet object. If you make this object Network Visible, you can 
address a BACnet Analog Network Input or BACnet Analog Network Output microblock to access many of its 
configuration and control properties in other control programs. See BACnet object property addresses below. 
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BACnet object property addresses 
BACnet object property addresses 

The Collector microblock is a proprietary BACnet object (object type 771). The format for a BACnet address is 
bacnet://device/object/property@priority.  

EXAMPLE  To set up a microblock to read the Number of Providers from the Collector microblock in the same 
controller, use the following address. 

bacnet://this/771:1/4602 

In the above address, 771:1 indicates the first instance of a Collector microblock in the controller. 
 

BACnet property 
identifier # 

BACnet property identifier Description Read/ 
Write 

4155 APPLICATION_ID Application ID R 
4156 APPLICATION_INSTANCE Application Instance R/W 
4157 UPDATE_TIME Update Time R 
4158 EXPIRATION_TIME Expiration Time R 
4601 COLL_MAX_NUMBER_OF_PROVIDER Max Number of Providers R 

4602 COLL_NUMBER_OF_PROVIDERS Number of Providers R/W 
4603 COLL_NUMBER_OF_PROVIDER_VALUES Number of Provider Values R 

4604 COLL_FEEDBACK_VALUES Number of Feedback Values R 

 
 

Provider 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblock (page 122) 

Icon and symbol 

    
What it does 
 
 
 

Provides a means for the control program to exchange sets of data across the BACnet 
network. Creates an association with one Collector microblock and maintains: 
• An Output data array transmitted to the Collector microblock 
• A set of Feedback data received from the Collector microblock 

 
 

How it works 
The association between a Provider and Collector can be established: 

• By the Provider actively communicating to its configured Collector and identifying itself as the recipient of that 
Collectors Feedback data. The Provider will actively create these associations when either of the Collector 
Network Number or Address properties is set to a non-zero value. 

• The Provider can be passive and wait for a Collector to send it a message to establish the association. 

The Provider creates an array to hold a set of Output data. Columns represent a user defined set of Output data 
tags.  The Provider will transmit its set of Output data to its associated Collector. Data is transmitted on a periodic 
basis or when a Change of Value (COV) occurs. The Provider creates an array (user defined size) to hold a set of 
Feedback data, which is received from its associated Collector. The columns of the array represent a user defined 
set of Feedback data tags.   
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The Provider has no input or output wires. The Provider’s data sets are configured and access through an OCL 
compatible application programming interface (API).  The API consists of functions that provide the following 
functionality: 

• Find a specific Provider  

• Define the Output and Feedback data sets  

• Write the Output data set  

• Read the Feedback data set 

NOTE  Details about the Provider OCL API are covered in the OCL Reference Manual.  

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName  

Use the default reference name unless you want a more descriptive name for graphics 
or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Application Type A numeric value representing the system application type.  

1 Air Side Linkage 

2 Water Side Linkage 

3 Outside Air Conditions 

NOTE  User can define more application types as needed. 

Application Instance A numeric value that defines the specific instance of an application. This value is 
usually set to 1. 

Network Number The network number of the device that contains the Collector that the Provider should 
associate with. 

Collector Address The address of the device that contains the Collector that the Provider should 
associate with. 

Output Update Time The amount of time the Provider will wait before sending successive updates of its 
Output values to its associated Collector. 

Feedback Expiration Time The amount of time in which the Provider must receive successive updates of 
Feedback values from its Collector. If an update is not received in this time, the 
Provider will mark the data from the Collector as expired. 

Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 

 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 159 

 

 
 

Tips and Tricks 
BACnet properties 

The Provider microblock is a proprietary BACnet object. If you make this object Network Visible, you can address a 
BACnet Analog Network Input or BACnet Analog Network Output microblock to access many of its configuration 
and control properties in other control programs. See BACnet object property addresses below. 

 

 
 

BACnet object property addresses 
The Provider microblock is a proprietary BACnet object (object type 772). The format for a BACnet address is 
bacnet://device/object/property@priority.  

EXAMPLE  To set up a microblock to read the Collector Address from the Provider microblock in the same 
controller, use the following address. 

bacnet://this/772:1/4614 

In the above address, 772:1 indicates the first instance of a Provider microblock in the controller. 
  

BACnet property 
identifier # 

BACnet property identifier Description Read/ 
Write 

4155 APPLICATION_ID Application ID R 
4156 APPLICATION_INSTANCE Application Instance R/W 
4157 UPDATE_TIME Update Time R 
4158 EXPIRATION_TIME Expiration Time R 
4611 PROV_NUMBER_OF_OUTPUT_ELEMENTS Number of Output Elements R 
4612 PROV_NUMBER_OF_FEEDBACK_ELEMENTS Number of Feedback Elements R 
4613 PROV_COLLECTOR_NETWORK Collector Network Number R/W 
4614 PROV_COLLECTOR_ADDRESS Collector Address R/W 

 

 
 

BACnet Analog Sensed Value Input 

NOTE  A control program with this microblock works only with v5.5 or later systems and v5.5 or later drivers. 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 
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What it does Reads an analog value from up to 5 ZS or WS sensors, and makes the value available 
to the control program on an output wire. If the Rnet has more than one ZS or WS 
sensor, the microblock's combination algorithm determines whether the output value 
is the average, minimum, or maximum of the readings. 

If using a sensor that provides multiple values (temperature, humidity, CO2, etc.), use 
one Analog Sensed Value Input microblock for each type of sensed value 
(temperature, humidity, CO2, or VOC). Each control program must also have a Sensor 
Binder microblock (page 169). 

 

 
 

How it works 
The Valid? output is False (Off) when communication fails with all sensors that are enabled in this ASVI 
microblock. When the Valid? output is False, the microblock outputs the Default value. 

The Valid? output is True (On) when any of the sensors that are enabled in this ASVI microblock are 
communicating. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Rnet Tag 
 

All values from a ZS or WS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents.  

For a ZS sensor, it also determines how the sensor will display the value. For 
example, if you select Zone Humidity, the sensor displays  beside the value.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application. 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value that the microblock outputs when communication with all enabled sensors 
fails or during sensor startup. The default value is used for each sensor's corrected 
value in a i-Vu® or Field Assistant system when the Valid? output is False (Off). 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Sensor Configuration:  

Index/Enable The Index number corresponds to the ZS or WS sensors defined in the Sensor Binder 
microblock (page 169). Check Enable for each sensor that you want to include in the 
combination algorithm used to determine the output value of the microblock. 

Combination Algorithm If using more than 1 sensor, select how the enabled sensors' values are to be 
combined to determine the microblock's output value. When the calculation is 
performed, only sensors with a valid value will be included. 

COV Increment To reduce Rnet traffic, you can force the microblock to update its output only when 
the sensed value changes by more than the COV Increment.   

Show on Sensors Select Local Value to have each enabled ZS sensor display its individual sensed 
value, or Calculated Value to have each ZS sensor display the value determined by 
the Combination Algorithm.   

Display Resolution Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 
(example: 74.5). 

Input Smoothing If the raw value from the sensor changes frequently, you can select one of the 
following options to send out an average of several readings on the output wire. 

Select... To send out... 

None 
Minimum 
Medium 
Maximum 

The raw value 
The average of the last 2 readings 
The average of the last 5 readings 
The average of the last 9 readings 

   

ZS Sensor Display 
Configuration: 

Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 
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Input Resolution The increment by which the microblock updates the value on its output wire in a i-
Vu® or Field Assistant system. 

The Resolution format is used to truncate the microblock’s actual value. For example, 
if you enter a value from: 
• 0.1 to 0.9, the wire displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the wire displays 2 digits to the right of the decimal 
• 1 or greater, the wire displays a whole number 
The Resolution value determines the increment by which the present value is 
updated. For example, if you enter: 
• .2, the wire displays 8.4, 8.6, 8.8, ... 
• .03, the wire displays 5.09, 5.12, 5.15, ... 
• 10, the wire displays 30, 40, 50, ... 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 
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Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Trends 
  
Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 
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Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the Properties page in a i-Vu® or Field Assistant system to 
delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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BACnet Binary Sensed Value Input 
 
Microblock family Network I/O microblocks (page 122) 

Icon and symbol 

   

What it does Reads a binary value from up to 5 ZS or WS sensors, and makes the value available 
to the control program on an output wire. If the Rnet has more than one ZS or WS 
sensor, the microblock's combination algorithm determines whether the output 
value is based on a single sensors value or all sensors having the same value.  

Each control program must also have a Sensor Binder microblock (page 169). 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Rnet Tag 
(Snap only) 

All values from a ZS or WS Sensor must have an Rnet tag that defines what type of 
information this microblock's value represents.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in Snap.  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
(Snap only) 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Index/Enable The Index number corresponds to the ZS or WS sensors defined in the Sensor Binder 
microblock (page 169). Check Enable for each sensor that you want to include in the 
combination algorithm used to determine the output value of the microblock. 
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Combination Algorithm If using more than 1 sensor, select how you want the microblock's output value to be 
determined. Select: 
And to output 1 if all sensors have a value of 1, otherwise output 0 
Or to output 1 if any sensor has a value of 1, otherwise output 0 

Show on Sensors Select Local Value to have each enabled ZS sensor display its individual sensed 
value, or Calculated Value to have each ZS sensor display the value determined by 
the Combination Algorithm.  

Show on: 
(Snap only) 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 

    Home Screen (1) When more than one value is assigned to the Home screen, the values cycle from 
one to the next. Typically, the first item displays for 10 seconds and any other items 
display for 3 seconds each. 

    Information  
    Screen (2) This screen is accessed by pressing the sensor's  button.  

    Diagnostics  
    Screen (3) This screen is accessed by holding the sensor's  button for at least 3 seconds. 

Display Inactive Text The text the ZS Sensor displays when the microblock's output is off, or false. 

Display Active Text The text the ZS Sensor displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Network Visible  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled? Check to send a message when this microblock indicates an alarm condition. 

Alarm State Active - An alarm condition exists when the microblock's present value is on (true). 

Inactive - An alarm condition exists when the microblock's present value is off (false). 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Trends 
  

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of Value) 

Records the microblock’s present value only when the value changes. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset on the Properties page in a i-Vu® or Field Assistant system to delete all 
samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 
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Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Sensor Binder 

NOTE  A control program with this microblock works only with v5.5 or later systems and v5.5 or later drivers. 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Network I/O microblocks (page 122) 

Icon and symbol 
   

What it does A Sensor Binder microblock is required if your control programs is to work with ZS or 
WS sensors. This microblock is where you define up to 5 uniquely-addressed ZS or 
WS sensors. The addresses in the microblock must match the sensors' Rnet 
addresses.  

This microblock's ALARM output wire turns on any time an error is reported on any of 
these sensors. 

A control program can have only one Sensor Binder microblock. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Sensor Configuration The Index number is a reference number for each sensor that you define in this 
microblock. ASVI and BSVI microblocks refer to the sensors by the index number 
defined in this microblock. 

    Area Type an intuitive name for the sensor's location. This name will appear in the ASVI, 
BSVI, and Setpoint microblocks in the i-Vu® or Field Assistant system. 

    Network Type Select Rnet for each sensor that you define. 

    Address ZS sensors—The physical address set on the sensor's DIP switches. 
WS sensors—The Rnet ID that you get from the SensorBuilder application. 

    Lock Display Check to lock a ZS Pro or ZS Pro-F sensor's buttons. The sensor's Home screen will 

display a  icon. The lock can be overridden in the i-Vu® interface or at the sensor 
by a user that knows the override procedure.  

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

In a i-Vu® or Field 
Assistant system only: 

 

Version The product type, firmware version,and serial number of each sensor defined in this 
microblock. 

Status Each sensor's status 

Error Shows if any of the sensors are in error. 

Alarm Shows On if any of the sensors cannot communicate. 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Display microblocks 

Display microblocks communicate directly with BACnet® objects, and can be used to integrate BACnet devices 
into a i-Vu® system. They can be referenced on graphics, allowing any vendor's BACnet equipment to be 
integrated into the system's interface. 

Display microblocks differ from other microblocks: 

• They are not downloaded into a controller; they are modeled in the system database. 

• They cannot be used in a control program's control logic, although they can be the source of alarms. 

• A single microblock can read from or write to multiple properties in a BACnet object. 

  

 BACnet Modeled Analog Input (page 173)         

This microblock reads the properties from a BACnet Analog Input object in any BACnet device on 
the network and makes these values available in the i-Vu® or Field Assistant system.                      

 BACnet Modeled Binary Input (page 175) 

This microblock reads the properties from a BACnet Binary Input object in any BACnet device on 
the network and makes these values available in the i-Vu® or Field Assistant system. 

 BACnet Modeled Multi-State Input (page 178) 

This microblock reads the properties from a BACnet Multi-State Input object in any BACnet device 
on the network and makes these values available in the i-Vu® or Field Assistant system. Multi-
State microblocks are used to indicate values that have more than two discrete states. 

 BACnet Modeled Analog Output (page 180) 

This microblock reads the properties from a BACnet Analog Output object in any BACnet device on 
the network and makes these values available in the i-Vu® or Field Assistant system. 

 
BACnet Modeled Binary Output (page 183) 

This microblock reads the properties from a BACnet Binary Output object in any BACnet device on 
the network and makes these values available in the i-Vu® or Field Assistant system. 

 BACnet Modeled Multi-State Output (page 186) 

This microblock reads the properties from a BACnet Multi-State Output object in any BACnet device 
on the network and makes these values available in the i-Vu® or Field Assistant system. Multi-
State microblocks are used to indicate values that have more than two discrete states.  

 BACnet Modeled Analog Value (page 188) 

This microblock reads the properties from a BACnet Analog Parameter Value object in any BACnet 
device on the network and makes these values available in the i-Vu® or Field Assistant system. 

 BACnet Modeled Binary Value (page 191) 

This microblock reads the properties from a BACnet Binary Value Parameter object in any BACnet 
device on the network and makes these values available in the i-Vu® or Field Assistant system. 

 BACnet Modeled Multi-State Value (page 193) 

This microblock reads the properties from a BACnet Binary Value Parameter object in any BACnet 
device on the network and makes these values available in the i-Vu® or Field Assistant system.  

 BACnet Modeled Calendar (page 196) 

This microblock defines a standardized object used to describe a list of calendar dates, which 
might be thought of as holidays, special events, or simply as a list of dates and makes these 
values available in the i-Vu® or Field Assistant system. 
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 BACnet Modeled Trend (page 198) 

This microblock reads trend data from other objects in any BACnet device on the network and 
makes these values available in the i-Vu® or Field Assistant system.  

 BACnet Modeled Schedule (page 199) 

This microblock defines a standardized object used to describe a periodic schedule that may recur 
during a range of dates, with optional exceptions on arbitrary dates. The Schedule object also 
serves as a binding between these scheduled times and the writing of specified values to specific 
properties of specific objects at those times. 

 BACnet Modeled Event Enrollment (page 202) 

This microblock defines an event and provides a connection between the occurrence of an event 
and the transmission of a notification message to one or more recipients. 

 BACnet Modeled Notification Class (page 204) 

This microblock defines a standardized object that represents and contains information required 
for the distribution of alarm notifications within BACnet systems. 

 BACnet Modeled Program (page 207) 

This microblock defines a standardized object whose properties represent the externally visible 
characteristics of an application program and makes these characteristics available in the i-Vu® 
or Field Assistant system. 

 BACnet Modeled Device (page 209) 

This microblock defines a standardized object whose properties represent the externally visible 
characteristics of a BACnet device and makes these characteristics available in the i-Vu® or Field 
Assistant system.  

 

 
 

To integrate using Display microblocks 

If Display microblocks will provide the functionality you need, you must address the Display microblocks in your 
control program to retrieve data from the BACnet points of interest.  

To retrieve data from BACnet objects using Display microblocks: 

1 Get network, object, device, and address information from the vendor of the BACnet device. If this 
information is not supplied, you can discover BACnet networks, devices, and objects. 

2 In the Snap application, create a control program with a Display microblock for each property you are 
interested in.  

NOTE   Each Display microblock must match the BACnet object type it references. For example, to reference a 
BACnet analog input, use a BACnet Modeled Analog Input microblock. 

3 In each microblock, type the BACnet device's Device Instance number in the Device Alias field, then set the 
Object Instance to match the BACnet Object ID of the BACnet object it references. 

 TIPS 

○ In Snap, use Edit > Third-Party BACnet Addresses with discovered BACnet information to set the Object 
Instance for a display object. 

○ To create a re-usable program, you can use the Device alias microblock. See the BACnet Integration 
Guide 
(http://accounts.automatedlogic.com/tilib.nsf/0/16B62CAA979B5D8A8525717200678C60/$FILE/B
ACnet%20Integration%20Guide.pdf). 

 

http://accounts.automatedlogic.com/tilib.nsf/0/16B62CAA979B5D8A8525717200678C60/$FILE/BACnet%20Integration%20Guide.pdf
http://accounts.automatedlogic.com/tilib.nsf/0/16B62CAA979B5D8A8525717200678C60/$FILE/BACnet%20Integration%20Guide.pdf
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BACnet Modeled Analog Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Analog Input object in any 
BACnet device on the network and makes these values available in the i-Vu® or Field 
Assistant system. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Object Instance 
 

The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Binary Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Binary Input object in any BACnet 
device on the network and makes these values available in the i-Vu® or Field 
Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 
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The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Polarity If normal polarity, the BACnet object's value is the same as the physical sensor's 
value. If reversed polarity, the object's value is the opposite of the physical sensor's 
value. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 
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BACnet Modeled Multi-State Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Multi-State Input object in any 
BACnet device on the network and makes these values available in the i-Vu® or Field 
Assistant system. Multi-State microblocks are used to indicate values that have more 
than two discrete states. For example, a parameter may have states of High, Medium, 
and Low rather than a numeric value. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 179 

 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Number of States The number of states currently defined for the BACnet object. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Analog Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Analog Output object in any 
BACnet device on the network and makes these values available in the i-Vu® or Field 
Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Object Instance 
 

The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 
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BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Out of Service Lets you stop the BACnet object from writing to the physical sensor's value so that 
you can override the logical value in the BACnet device by changing the Present 
Value in i-Vu® or Field Assistant. 

Priority Array BACnet objects can be written to by more than one source. Each source writes at a 
specified priority, with a higher priority overriding a lower priority. The lower the 
priority number (1–16), the higher the priority.  

On this microblock's Properties page in the i-Vu® or Field Assistant interface, the 
Priority Array table shows the current value for each priority. If the present value is 
editable, you can change it and set the priority in the Command priority for writing 
field. 

To clear a value in the Priority Array table, delete or select Null in the Present Value 
field. In the Command priority for writing field, select the priority whose value you 
want to clear. Then click Accept. 

Relinquish Default The default value used for the present value when no values have been written at any 
priority. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Binary Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Binary Output object in any 
BACnet device on the network and makes these values available in the i-Vu® or Field 
Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Out of Service Lets you stop the BACnet object from writing to the physical sensor's value so that 
you can override the logical value in the BACnet device by changing the Present 
Value in i-Vu® or Field Assistant. 

Polarity If normal polarity, the BACnet object's value is the same as the physical sensor's 
value. If reversed polarity, the object's value is the opposite of the physical sensor's 
value.  



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 185 

 

Priority Array BACnet objects can be written to by more than one source. Each source writes at a 
specified priority, with a higher priority overriding a lower priority. The lower the 
priority number (1–16), the higher the priority.  

On this microblock's Properties page in the i-Vu® or Field Assistant interface, the 
Priority Array table shows the current value for each priority. If the present value is 
editable, you can change it and set the priority in the Command priority for writing 
field. 

To clear a value in the Priority Array table, delete or select Null in the Present Value 
field. In the Command priority for writing field, select the priority whose value you 
want to clear. Then click Accept. 

Relinquish Default The default value used for the present value when no values have been written at any 
priority. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 
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BACnet Modeled Multi-State Output 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Multi-State Output object in any 
BACnet device on the network and makes these values available in the i-Vu® or Field 
Assistant system. Multi-State microblocks are used to indicate values that have more 
than two discrete states. For example, a parameter may have states of High, Medium 
and Low rather than a numeric value. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Out of Service Lets you stop the BACnet object from writing to the physical sensor's value so that 
you can override the logical value in the BACnet device by changing the Present 
Value in i-Vu® or Field Assistant. 

Number of States The number of states currently defined for the BACnet object. 
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Priority Array BACnet objects can be written to by more than one source. Each source writes at a 
specified priority, with a higher priority overriding a lower priority. The lower the 
priority number (1–16), the higher the priority.  

On this microblock's Properties page in the i-Vu® or Field Assistant interface, the 
Priority Array table shows the current value for each priority. If the present value is 
editable, you can change it and set the priority in the Command priority for writing 
field. 

To clear a value in the Priority Array table, delete or select Null in the Present Value 
field. In the Command priority for writing field, select the priority whose value you 
want to clear. Then click Accept. 

Relinquish Default The default value used for the present value when no values have been written at any 
priority. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 
 

BACnet Modeled Analog Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 189 

 

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Analog Parameter Value object in 
any BACnet device on the network and makes these values available in the i-Vu® or 
Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

Object Instance 
 

The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Binary Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads the properties from a BACnet Binary Value Parameter object in 
any BACnet device on the network and makes these values available in the i-Vu® or 
Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  
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Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Multi-State Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    
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What it does This microblock reads the properties from a BACnet Binary Value Parameter object in 
any BACnet device on the network and makes these values available in the i-Vu® or 
Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status flags If this microblock is enabled as a potential alarm source, this will show Status 
checkboxes on the Alarms > Enable/Disable tab that indicate the current alarm 
status of the BACnet object.  

Event state If this microblock is enabled as a potential alarm source, this will show the current 
alarm state (Normal, Offnormal, Fault) of the BACnet object on the Alarms > 
Enable/Disable tab. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Number of States The number of states currently defined for the BACnet object. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   
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Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Calendar 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object used to describe a list of calendar 
dates, which might be thought of as holidays, special events, or simply as a list of 
dates and makes these values available in the i-Vu® or Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Date List The list of calendar periods (date, date range, or month/week-of-month/day-of-week) 
defined in the BACnet object. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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BACnet Modeled Trend 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol     

What it does This microblock reads trend data from other objects in any BACnet device on the 
network and makes these values available in the i-Vu® or Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Trend Conformance Level The BACnet protocol conformance level that the BACnet device trend supports. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Log Enable If enabled, trend data is collected for the BACnet object. 

Stop When Full If enabled, trend data will stop being collected when the maximum number of 
samples is reached. 

Buffer Size The maximum number of samples to be collected in the BACnet device. 

Log Buffer All of the data records stored in the Trend Log object.  

Record Count Number of trend samples currently in the BACnet device. 

Total Record Count Number of trend samples logged since activation. 

Object ID A combination of the Object Type and the Object Instance number. 

 

 
 

BACnet Modeled Schedule 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    
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What it does This microblock defines a standardized object used to describe a periodic schedule 
that may recur during a range of dates, with optional exceptions on arbitrary dates. 
The Schedule object also serves as a binding between these scheduled times and the 
writing of specified values to specific properties of specific objects at those times. 

Schedules are divided into two types of days: normal days within a week and 
exception days. It is assumed that the scheduler will exhibit restorative behavior in 
the event that the BACnet Device containing the schedule is restarted or the time is 
changed in the BACnet Device. The model for restoration assumes that each day's 
schedule is circular in nature. Thus, if the BACnet Device is restarted after midnight 
but prior to the first time in the list of BACnetTimeValues for that day, then the last 
value on the list for that day is used as the restoration value. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Schedule Category The category of the schedule that will run the controlled equipment. Select 
Occupancy unless you have defined a custom schedule category in the Snap and i-
Vu® applications. 
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Type The type of the schedule category you selected. Select Binary for an Occupancy or 
InterOp Occupancy schedule category. Select Any if the schedule object will return its 
own type. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Array Resize Write Index The write method that the BACnet device supports for writing exception schedules. 

Array Resize Write Past 
End 

The write method that the BACnet device supports for writing exception schedules. 

Supports Dated Weekly 
Schedules 

Check for Carrier or OEMCtrl® manufactured devices only. 

Supports Exception 
Schedule Description 

Allows Field Assistant to retrieve a holiday schedule description (if it is available) from 
the BACnet device. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Effective Period Date range that shows when the schedule object is in effect. 

List of Object Property 
references 

A list of BACnet object properties that will be affected by the schedule. 

Priority for writing BACnet objects can be written to by more than one source. Each source writes at a 
specified priority, with a higher priority overriding a lower priority. The lower the 
priority number (1–16), the higher the priority. 

Status Flags Status Flags indicate the current state of the BACnet object. 

Reliability  Indicates if there is a configuration error.  

Out of Service The schedule object that is out of service will not use any internal calculations 
(weekly/exception schedule entries) to determine the Present Value. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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BACnet Modeled Event Enrollment 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines an event and provides a connection between the occurrence 
of an event and the transmission of a notification message to one or more recipients.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Event Type Shows the status of the Event Parameter property. 

Notify Type Shows whether the notification will be sent as an alarm or an event. 

Event parameters The condition under which an event will be generated.  

Object Property 
Reference 

Defines the object for which the event enrollment will generate events. 

Event State Shows the BACnet object's current alarm status. 

Event Enable Enables notifications of the event, return to normal, or fault. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   
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Alarm 
Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Return to Normal 
Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 

condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

 

 
 

BACnet Modeled Notification Class 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    
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What it does This microblock defines a standardized object that represents and contains 
information required for the distribution of alarm notifications within BACnet systems. 

Notification Classes are useful for alarm-initiating objects that have identical needs in 
terms of how their notifications should be handled, what the destination(s) for their 
notifications should be, and how they should be acknowledged. 

A notification class defines how alarm notifications will be prioritized in their handling 
according to TO-OFFNORMAL, TO-FAULT, and TO-NORMAL alarms; whether these 
categories of alarms require acknowledgment (nearly always by a human operator); 
and what destination devices or processes should receive notifications.  

The purpose of prioritization is to provide a means to ensure that alarms or alarm 
notifications with critical time considerations are not unnecessarily delayed. The 
possible range of priorities is 0–255. A lower number indicates a higher priority. 
Priorities may be assigned to TO-OFFNORMAL, TO-FAULT, and TO-NORMAL alarms 
individually within a notification class. 

It is often necessary for alarm notifications to be sent to multiple destinations or to 
different destinations based on the time of day or day of week. Notification Classes 
may specify a list of destinations, each of which is qualified by time, day of week, and 
type of handling. A destination specifies a set of days of the week (Monday through 
Sunday) during which the destination is considered viable by the Notification Class 
object. In addition, each destination has a FromTime and ToTime, which specify a 
window, on those days of the week, during which the destination is viable.  

If an alarm that uses a Notification Class object occurs and the day is one of the days 
of the week that is valid for a given destination and the time is within the window 
specified in the destination, then the destination will be sent a notification. 
Destinations may be further qualified, as applicable, by any combination of the 3 
alarm transitions TO-OFFNORMAL, TO-FAULT, or TO-NORMAL. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Notification Class The instance number of the notification class object. 

Priority The priority (0 to 255) indicates the importance of the alarm notification (lower the 
number, the greater the importance). 

Ack Required Determines if an acknowledgment is required for Off-Normal, Fault, or Normal alarm 
notifications. 

Recipients List Shows who is to receive the alarm notifications. 

Object ID A combination of the Object Type and the Object Instance number. 
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Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Program 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object whose properties represent the 
externally visible characteristics of an application program and makes these 
characteristics available in the i-Vu® or Field Assistant system.  

In this context, an application program is an abstract representation of a process 
within a BACnet device, which is executing a particular body of instructions that act 
upon a particular collection of data structures. 

The Program object provides a network-visible view of selected parameters of an 
application program in the form of properties of the Program object. Some of these 
properties are specified in the standard and exhibit a consistent behavior across 
different BACnet devices. The operating state of the process that executes the 
application program may be viewed and controlled through these standardized 
properties, which are required for all Program objects.  

In addition to these standardized properties, a Program object may also provide 
vendor-specific properties. These vendor-specific properties may serve as inputs to 
the program, outputs from the program, or both. However, these vendor-specific 
properties may not be present at all. If any vendor-specific properties are present, the 
standard does not define what they are or how they work, as this is specific to the 
particular application program and vendor. 

The link to this device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Program state The current state (idle, loading, running, waiting, halted, unloading) of the program. 

Program Change Lets you select ready, load, run, halt, restart, or unload to change the Program state 
property. 

Status flags Status Flags indicate the current state of the BACnet object. 

Out of Service Indicates that the program object is in an IDLE state (not running) and requires 
manual intervention to start it again. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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BACnet Modeled Device 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object whose properties represent the 
externally visible characteristics of a BACnet device and makes these characteristics 
available in the i-Vu® or Field Assistant system.  

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

System Status The current physical and logical status of the BACnet device. 

Vendor Name Manufacturer of the BACnet device. 

Vendor Identifier The BACnet device manufacturer's unique vendor identification code (assigned by 
ASHRAE). 

Model Name Model of the BACnet device. 

Firmware Revision The firmware version that is in the BACnet device. 

Application Software 
Version 

The application software version that is in the BACnet device. 

Protocol Version The version of the BACnet protocol supported by the BACnet device. 

Protocol Conformance 
Class 

This obsolete property is no longer part of the BACnet standard, but is maintained for 
backward compatibility.  

Protocol Services 
Supported 

The standard BACnet services that the device supports. 

Protocol Object Types 
Supported 

The standard BACnet object types that the device supports. 

Object List A list of all BACnet objects that are in the BACnet device. 

Max APDU Length 
Accepted 

The maximum length of a message or message segment that can be accepted by the 
BACnet device. 

Segmentation 
Supported 

Indicates if the BACnet device supports segmentation of messages and if so, whether 
it supports segmented transmission, reception, or both. 

APDU Segment Timeout How many milliseconds the device will wait before resending a message segment if 
no response is received. 
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APDU Timeout How many milliseconds the device will wait before resending a message if no 
response is received. 

Number of APDU Retries The number of times the device will resend a message. 

Controller Address 
Binding 

A list of bindings (a matching of Device ID to BACnetAddress) that the device uses to 
communicate with other BACnet devices. BACnetAddress is a combination of 
Network Number and Mac Address. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

Display2 microblocks 

Display microblocks communicate directly with BACnet® objects, and can be used to integrate BACnet devices 
into a i-Vu® system. They can be referenced on graphics, allowing any vendor's BACnet equipment to be 
integrated into the system's interface. 

Display microblocks differ from other microblocks: 

• They are not downloaded into a controller; they are modeled in the system database. 

• They cannot be used in a control program's control logic, although they can be the source of alarms. 

• A single microblock can read from or write to multiple properties in a BACnet object. 

  

 BACnet Modeled File (page 212) 

This microblock defines a standardized object that is used to describe properties of data files that 
can be accessed using BACnet File Services. 

 BACnet Modeled Group (page 214) 

This microblock defines a standardized object whose properties represent a collection of other 
objects and one or more of their properties. A group object is used to simplify the exchange of 
information between BACnet Devices by providing a shorthand way to specify all members of the 
group at once. 

 BACnet Modeled Loop (page 215) 

This microblock defines a standardized object whose properties represent the externally visible 
characteristics of any form of feedback control loop. 

 BACnet Modeled Pulse Converter (page 217) 

This microblock defines a standardized object that represents a process in which measurements 
represented by pulses or counts, such as electric power, might be monitored at intervals for 
applications such as peak load management that require periodic measurements but not a 
precise accounting of every input pulse or count. 

 BACnet Modeled Accumulator (page 219) 

This microblock defines a standardized object whose properties represent the externally visible 
characteristics of a device that indicates measurements made by counting pulses. 

 BACnet Modeled Collector (page 221) 

This microblock reads properties from a BACnet proprietary collector object (BACnet object type 
771). 

 BACnet Modeled Table (page 223) 

This microblock reads properties from a BACnet proprietary table object (BACnet object type 773). 
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 Device Alias (page 224) 

This microblock works with the Device Alias field in every Display microblock to enable efficient re-
use of a control program for multiple BACnet devices. 

You define a character string, or Device Alias, for a particular Device Instance in this microblock. 
Then you use the same character string in the Device Alias field of any Display microblocks that 
you want to use the same Device Instance. At runtime, the system replaces the Device Alias 
character string in a Display microblock with the Device Instance defined in the Device Alias 
microblock to create a BACnet address. 

 

 
 

BACnet Modeled File 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object that is used to describe properties of 
data files that can be accessed using BACnet File Services. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

File Type A character string that describes the type of file. 

File Size The file length (octets). 

Modification Date The time and date the file was last modified. 

Archive Indicates whether or not the file has been archived. 

Read Only Indicates whether or not the file can be written to. 

File Access Method The method (Record Access or Stream Access) by which the file can be accessed. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 
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BACnet Modeled Group 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object whose properties represent a 
collection of other objects and one or more of their properties. A group object is used 
to simplify the exchange of information between BACnet Devices by providing a 
shorthand way to specify all members of the group at once. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value A list of all the properties in the group and their current values. 

List of Group Members A list of the BACnet objects and properties that are included in the group. If editable, 
you can add or delete objects or properties in the group. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Loop 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    
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What it does This microblock defines a standardized object whose properties represent the 
externally visible characteristics of any form of feedback control loop. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 
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Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status Flags Status Flags indicate the current state of the BACnet object. 

Event State Shows the BACnet object's current alarm status. 

Out of Service Indicates whether or not the algorithm this object represents is in service. 

Output Units The BACnet engineering unit of measurement of the microblock's present value. 

Manipulated Variable 
Reference 

The output (present value) of the control loop is written to the object and property 
designated by the Manipulated Variable Reference. 

Controlled Variable 
Reference 

Identifies the property used to set the loop object's Controlled Variable Value 
property.  

Controlled Variable 
Value 

The control loop compares the Controlled Variable Value with the Setpoint to 
calculate the error. 

Controlled Variable Units The engineering units of the Controlled Variable Value property. 

Setpoint Reference Reference to the object and property to be used as the loop object's setpoint. If no 
object is defined for Setpoint Reference, the value entered in the Value field is used. 

Setpoint The value that is used for the loop object's setpoint. This is either the real value of the 
object referenced in Setpoint Reference or, if no object is referenced, it's the value 
entered in the Value field. 

Action Defines whether the loop is direct or reverse acting. 

Priority for Writing The command priority (1-16) the loop object will use when writing the object and 
property referenced by the Manipulated Variable Reference. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Pulse Converter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object that represents a process in which 
measurements represented by pulses or counts, such as electric power, might be 
monitored at intervals for applications such as peak load management that require 
periodic measurements but not a precise accounting of every input pulse or count. 

The link to the device is established in SiteBuilder. The link to a specific BACnet object 
in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write to 
the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are actually 
needed for the intended task. Use the checkboxes in the Present column to select 
which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status Flags Status Flags indicate the current state of the BACnet object. 

Event State The current alarm state (Normal, Offnormal, Fault) of the BACnet object. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Units The BACnet engineering unit of measurement of the microblock's present value. 

Scale factor The conversion factor to turn the pulse count into the units specified for the Present 
Value. 

Adjust value Lets you enter a value that adjusts the Present Value and the Count property. 

Count The current pulse count. 

Update time The date and time of the most recent pulse count. 

Count change time The date and time of the most recent change using the Adjust value property. 

Count before change The pulse count before any change using the Adjust value property. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Accumulator 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock defines a standardized object whose properties represent the 
externally visible characteristics of a device that indicates measurements made by 
counting pulses. 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 
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Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Supports Locked Value Allows the BACnet object to be locked to a specific value in i-Vu® or Field Assistant 
and held at that value until unlocked. The locked value takes precedence over any 
priority array value. 

BACnet object properties Select the checkbox in the Present column to show the BACnet object property on the 
i-Vu® or Field Assistant Properties page. Properties that do not have a checkbox in 
the Present column are always shown.   
CAUTION  If you select a property that is not in the BACnet device, you will get an 
error in i-Vu® or Field Assistant. 

Select the checkbox in the Write to Field column to make the property editable from 
the i-Vu® or Field Assistant Properties page. 
CAUTION  If you select Write to Field for a property that is read-only in the BACnet 
device, you will get an error in i-Vu® or Field Assistant. 

The following properties are always present. See the ANSI / ASHRAE Standard 135 for a description of additional 
properties that can be enabled in Snap. 

Object Name An alpha-numeric string that is unique within the BACnet device. 

Present Value The current value of the BACnet object. 

Status Flags Status Flags indicate the current state of the BACnet object. 

Event State The current alarm state (Normal, Offnormal, Fault) of the BACnet object. 

Out of Service Lets you stop the BACnet object from reading the physical sensor's value so that you 
can override the logical value in the BACnet device by changing the Present Value in 
i-Vu® or Field Assistant. 

Scale The conversion factor to change the Present Value to a value in the units specified.  

Units The BACnet engineering unit of measurement of the microblock's present value. 

Max Pres Value The maximum limit of the present value before scaling. 

Object ID A combination of the Object Type and the Object Instance number. 

Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Collector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 
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Icon and symbol    

What it does This microblock reads properties from a BACnet proprietary collector object (BACnet 
object type 771). 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Object Name An alpha-numeric string that is unique within the BACnet device. 

Object ID A combination of the Object Type and the Object Instance number. 

Object Type  The BACnet object type. 

Address The address of the BACnet object that this microblock references. 

 
 

BACnet Modeled Table 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    

What it does This microblock reads properties from a BACnet proprietary table object (BACnet 
object type 773). 

The link to the device is established in SiteBuilder. The link to a specific BACnet 
object in that device is the Object Instance setting described below. 

A Display microblock is most often used to display information from other vendor's 
equipment on Graphics and Properties pages. The operator can then read and write 
to the equipment as appropriate. 

This microblock can be used to import multiple properties from a single object, but to 
prevent unnecessary network traffic you should import only properties that are 
actually needed for the intended task. Use the checkboxes in the Present column to 
select which properties to get. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Object Instance The instance number (0 to 4,194,303) of the BACnet object you are linking to. 

Device Alias This field represents the address of the BACnet device from which this microblock will 
retrieve its values. You can type the Device Instance of the BACnet device or the 
Device Alias character string defined in a Device Alias microblock. If you leave this 
field blank, the system will use “this” in the Display microblock’s BACnet address and 
retrieve this microblock’s values from the device to which the microblock’s control 
program is attached in SiteBuilder. 

Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Object Name An alpha-numeric string that is unique within the BACnet device. 

Object ID A combination of the Object Type and the Object Instance number. 

Object Type  The BACnet object type. 

Address The address of the BACnet object that this microblock references. 

 
 

Device Alias 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Display microblocks (page 171) 

Icon and symbol    
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What it does This microblock works with the Device Alias field in every Display microblock to 
enable efficient re-use of a control program for multiple BACnet devices. 

You define a character string, or Device Alias, for a particular Device Instance in this 
microblock. Then you use the same character string in the Device Alias field of any 
Display microblocks that you want to use the same Device Instance. At runtime, the 
system replaces the Device Alias character string in a Display microblock with the 
Device Instance defined in the Device Alias microblock to create a BACnet address.  

In another instance of the same control program, you can change the Device 
Instance field in this microblock to re-direct all Display microblocks using this 
microblock’s Device Alias to a new BACnet device. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Device Alias A character string that represents the device you are integrating with. For example, 
the model of the BACnet controller or equipment. Use this character string in the 
Device Alias field of any Display microblocks whose value will be retrieved from the 
same BACnet device. 

Device Instance The device instance of the BACnet device. At runtime, the system uses this device 
instance in the BACnet address of any Display microblocks using this microblock’s 
Device Alias. 

 

 
 

To reuse a control program 
You can reuse a control program for multiple pieces of identical third-party equipment. 
  

To reuse a control program for identical pieces of equipment: 

1 In the Snap application, open the control program you want to reuse. 

2 Add a Device Alias microblock. 

3 In the Property Editor, type a meaningful character string such as the model number or name of the third-
party device in the Device Alias field. 

4 Select Control Program > Edit Common Properties > Display Points tab. 
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5 Select the All radio button. 

6 Replace the numbers in the Device Alias column with the model number or name of the third-party device 
exactly as you typed it in step 3. 

7 In SiteBuilder, assign this reusable control program to each instance of the third-party device. 

8 In your i-Vu® or Field Assistant system, for each instance of the third-party equipment, change the Device 
Alias microblock's Device Instance number to match each specific device. 

 
 

 
 

Sys In microblocks 

System Input microblocks receive heat and cool requests, as well as other system information, editable 
properties, or constants used as input values to a control program.  

Control programs use requests to communicate their heating and cooling needs to each other. 

By using requests you can construct a software "chain" mimicking the mechanical chain of equipment in the 
building. When properly constructed, requests allow you to schedule terminal or zone equipment only, and allow 
other equipment to respond to zone requests. The equipment serving zones can use requests and the Setpoint 
Optimization microblock to constantly adjust discharge setpoints and minimize energy consumption. 
 

 Total Analog (page 227) 

This microblock gathers heating and cooling requests. The total number of requests received is the 
microblock's output. 

 Average Analog (page 229) 

This microblock calculates the average of the values read from output points. The average value is 
the microblock's output. 

 Minimum Analog (page 231) 

This microblock monitors values read from output points. The lowest value read is the output of the 
microblock.  

 Maximum Analog (page 233) 

This microblock gathers "runtime" requests. The Maximum Analog Properties can receive data from 
up to 10 addresses. The highest value read is the output of the microblock. 

 Get System Variable (page 235) 

This microblock provides information to the control program stored in each device in the network. 
This information, while available in each device, must be provided to the control program using this 
microblock. 
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 Get System Status (page 237) 

This microblock can be used to indicate Read or Write errors in certain microblocks, and whether 
any microblock within the control program is Locked. 

 Binary Parameter (page 239) 

This microblock is used to create a yes/no, on/off, open/closed, or true/false signal to be sent to 
the output wire.  

 Analog Parameter (page 240) 

This microblock specifies a numeric value to be sent to another microblock in the control program. 

 Time Parameter (page 241) 

This microblock specifies an amount of time to be sent to another microblock in the control 
program. 

 Binary Constant (page 242) 

This microblock specifies a yes/no, on/off, true/false, or open/closed value to be sent to another 
microblock in the control program. Binary Constants do not appear on the Properties page and 
should be used instead of Binary Parameter microblocks when the value of the microblock will not 
change.  

 Analog Constant (page 243) 

This microblock specifies a numeric value to be sent to another microblock in the control program. 
Analog Constants do not appear on the Properties page and should be used instead of Analog 
Parameter microblocks when the value of the microblock will not change (such as a flow coefficient 
or pi). 

 Time Constant (page 243) 

This microblock specifies a time value to be sent to another microblock in the control program. 
Time Constants do not appear on the Properties page and should be used instead of Time 
Parameter microblocks when the value of the microblock will not change. 

BACnet® 

 BACnet Binary Value Parameter (page 244) 

This microblock creates a yes or no, or on or off signal to be sent to another microblock in the 
control program. 

 BACnet Analog Value Parameter (page 248) 

This microblock specifies a numeric value to be sent to another microblock in the control program. 

 BACnet Multi-State Value Parameter (page 252) 

This microblock specifies a signal to be sent to the output wire. Multi-State microblocks are used to 
indicate values that have more than two discrete states (20 maximum). 

 

 
 

Total Analog 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 
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Icon and symbol 

    

What it does This microblock gathers heating and cooling requests. The total number of requests 
received is the microblock's output. 

The microblock can receive data from up to 10 addresses. You define the 10 
addresses using the tree control on the microblock's Properties page. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Average Analog 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol 
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What it does This microblock calculates the average of the values read from output points. The 
average value is the microblock's output.  

For example, you could use the Average Analog Properties microblock to determine 
the average temperature for a floor. 

The microblock can receive data from up to 10 addresses. You define the 10 
addresses using the tree control on the Average Analog Properties microblock's 
Properties page. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Minimum Analog 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol 
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What it does This microblock monitors values read from output points. The lowest value read is the 
output of the microblock.  

For example, you could use this microblock to determine the lowest zone 
temperature on a floor by gathering data from several Zone Setpoints. 

The microblock can receive data from up to 10 addresses. You define the 10 
addresses using the tree control on the Minimum Analog Properties microblock's 
Properties page. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Maximum Analog 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol 
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What it does This microblock gathers "runtime" requests. The Maximum Analog Properties can 
receive data from up to 10 addresses. The highest value read is the output of the 
microblock.  

For example, if it receives requests for 2 minutes, 5 minutes and 7 minutes, the 
output from this microblock is 7. 

The microblock can receive data from up to 10 addresses. You define the 10 
addresses using the tree control on the Maximum Analog Properties microblock's 
Properties page. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 
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Default Value The value that the microblock outputs when communication with all specified targets 
fails or when Communications Enabled is not checked. The default value is used 
when the Valid? output is False (Off). 

Communications Enabled Check to enable network communications for this microblock. Uncheck when 
troubleshooting.  

Refresh Time The interval at which the microblock reads the target value. 

If the target is a BACnet object property: 

• Type a value greater than 30 seconds to attempt a BACnet COV (Change of 
Value) subscription with the target object. If subscription succeeds, the target 
sends a value to this microblock only when the target's value changes by at least 
the target's COV Increment. If subscription fails, this microblock reads the target 
value at the interval you specify. 

• Type a value of 30 seconds or less to disable BACnet COV subscription and read 
the target value at the interval you specify. 
  

If using v6.00a or later drivers, you can reduce network traffic by: 

• Changing the refresh time to something greater than 10 minutes. If the refresh 
time is 10 minutes or less, the microblock will resubscribe every 10 minutes. If 
the refresh time is greater than 10 minutes, the microblock will use that value as 
the resubscription interval. 

• Entering 01 in the seconds field of any value 1 minute or greater to have this 
microblock subscribe using only confirmed COV notifications (not unconfirmed). 
For example, 1:01, 5:01, etc. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

Get System Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 
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Icon and symbol 

   

What it does This microblock provides information to the control program stored in each device in 
the network. This information, while available in each device, must be provided to the 
control program using this microblock. 
• Current time (0-1439; in minutes since midnight)  
• Current day of the week (Monday=1, Sunday=7)  
• Current day of the month (1-31)  
• Minute (0-59)  
• Hour (0-23)  
• Month (1-12)  
• Year (1981-2040)  
• Seconds (0-59) 
 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Type The Get System Variable microblock provides information to the control program 
stored in each device in the network. This information, while available in each device, 
must be provided to the control program using this microblock. Current time (0-1439; 
in minutes since midnight)  
• Current day of the week (Monday=1, Sunday=7)  
• Current day of the month (1-31)  
• Minute (0-59)  
• Hour (0-23)  
• Month (1-12)  
• Year (1981-2040)  
• Seconds (0-59)  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Get System Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol 

   

What it does This microblock can be used to indicate Read or Write errors in certain microblocks, 
and whether any microblock within the control program is Locked. 

Read Error 
If you choose read error in the Initial Type section, then the microblock has a True 
value only when a Network Input microblock or an Analog Properties microblock in 
the same control program indicates an error condition. This includes Analog Network 
Input, Analog Network Input 2, Binary Network Input, Binary Network Input 2, Average 
Analog Properties, Maximum Analog Properties, Minimum Analog Properties, and 
Total Analog Properties microblocks. 

Write Error 
If you choose write error, then the microblock has a value of True only when a Network 
Output microblock in the same control program indicates an error condition. This 
includes Analog Network Output, Analog Network Output 2, Binary Network Output 
and Binary Network Output 2 microblocks. 

Point Locked 
If you choose point locked, then the microblock has a value of True only when points in 
the same control program are currently locked. 

The microblock's value is True or False. The Get System Status function may be used 
to send notice of these conditions to Alarm microblocks. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Type The Get System Status microblock can be used to indicate Read or Write errors in 
certain microblocks, and whether any microblock within the control program is 
Locked.  

Read Error 
If you choose read error in the Initial Type section, then the microblock has a True 
value only when a Network Input microblock or an Analog Properties microblock in 
the same control program indicates an error condition. This includes Analog Network 
Input, Analog Network Input 2, Binary Network Input, Binary Network Input 2, Average 
Analog Properties, Maximum Analog Properties, Minimum Analog Properties, and 
Total Analog Properties microblocks.  

Write Error 
If you choose write error, then the microblock has a value of True only when a Network 
Output microblock in the same control program indicates an error condition. This 
includes Analog Network Output, Analog Network Output 2, Binary Network Output 
and Binary Network Output 2 microblocks.  

Point Locked 
If you choose point locked, then the microblock has a value of True only when points in 
the same control program are currently locked.  

The microblock's value is True or False. The Get System Status function may be used 
to send notice of these conditions to Alarm microblocks. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Binary Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    

What it does This microblock is used to create a yes/no, on/off, open/closed, or true/false signal 
to be sent to the output wire.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Type Select Text Defined Below to use the values in the Active Text and Inactive Text 
fields.  Or select the Inactive and Active text you wish to use from the Type droplist. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Momentary Lets the i-Vu® user change the parameter to the new state for one execution of logic. 
The i-Vu® application then changes the parameter back to the original state.  

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Analog Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    

What it does This microblock specifies a numeric value to be sent to another microblock in the 
control program.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Time Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    

What it does This microblock specifies an amount of time to be sent to another microblock in the 
control program.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Binary Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    

What it does This microblock specifies a yes/no, on/off, true/false, or open/closed value to be 
sent to another microblock in the control program. Binary Constants do not appear on 
the Properties page and should be used instead of Binary Parameter microblocks 
when the value of the microblock will not change.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name  
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Type Select Text Defined Below to use the values in the Active Text and Inactive Text 
fields.  Or select the Inactive and Active text you wish to use from the Type droplist. 

Present Value The value that the microblock uses on the control program output wire. For constant 
microblocks, this value can only be changed in the Snap application. For parameter 
microblocks, this value can be changed in a i-Vu® or Field Assistant system or in the 
Snap application. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 
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Analog Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol     

What it does This microblock specifies a numeric value to be sent to another microblock in the 
control program. Analog Constants do not appear on the Properties page and should 
be used instead of Analog Parameter microblocks when the value of the microblock 
will not change (such as a flow coefficient or pi). 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name  
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Present Value The value that the microblock uses on the control program output wire. For constant 
microblocks, this value can only be changed in the Snap application. For parameter 
microblocks, this value can be changed in a i-Vu® or Field Assistant system or in the 
Snap application. 

 

 
 

Time Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    
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What it does This microblock specifies a time value to be sent to another microblock in the control 
program. Time Constants do not appear on the Properties page and should be used 
instead of Time Parameter microblocks when the value of the microblock will not 
change. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name  
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Present Value The value that the microblock uses on the control program output wire. For constant 
microblocks, this value can only be changed in the Snap application. For parameter 
microblocks, this value can be changed in a i-Vu® or Field Assistant system or in the 
Snap application. 

 

 
 

BACnet Binary Value Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol     

What it does This microblock creates a yes or no, or on or off signal to be sent to another 
microblock in the control program.  

Any BACnet device can read or change the value of this parameter. If no BACnet 
device changes the value of this parameter, the default value is used. The value 
appears to other BACnet devices as the Present Value property of a BACnet Binary 
Value Object. 

You can assign text to active and inactive states to make it better represent the 
microblock's usage. 

You can configure this microblock to make its value available on the Rnet. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Momentary 
NOTE  A control program with this feature enabled works only with v5.5 or later systems and v5.5 

or later drivers. 

Lets the i-Vu® user change the parameter to the new state for one execution of logic. 
The i-Vu® application then changes the parameter back to the original state.  

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 
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Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 
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Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

Enable Rnet  Check to allow this microblock to communicate its value(s) to and from a sensor. 

Rnet Tag 
 

All values from a ZS or WS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents.  

For a ZS sensor, it also determines how the sensor will display the value. For 
example, if you select Fan Command (101), the sensor displays the active or inactive 
text and the number 101 in the lower left corner to identify the value is a fan 
command.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application. 

Editable Select to make this microblock's value editable on the ZS sensor.  

ZS Sensor Display 
Configuration 

 

Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 

Display Inactive Text Type the text that the ZS sensor is to display when the microblock's output is off or 
false. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen.  
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Display Active Text Type the text that the ZS sensor is to display when the microblock's output is on or 
true. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen.  

 

 
 

BACnet Analog Value Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol    

What it does This microblock specifies a numeric value to be sent to another microblock in the 
control program.  

Any BACnet device on the network can read or change the value of this parameter. If 
no BACnet device changes the value of this parameter, the default value is used. The 
value appears to other BACnet devices as the Present Value property of a BACnet 
Analog Value Object. 

You can configure this microblock to make its value available on the Rnet. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Critical Value If your control program has logic that writes a critical value to this microblock 
periodically, select this option to have the system attempt to upload this microblock’s 
value (Relinquish Default property) and preserve it through a download, controller 
restart, or power loss.  

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 
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Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   

Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

Enable Rnet  Check to allow this microblock to communicate its value(s) to and from a sensor. 

Rnet Tag 
 

All values from a ZS or WS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents.  

For a ZS sensor, it also determines how the sensor will display the value. For 
example, if you select Static Pressure Setpoint (411), the sensor displays the 
setpoint, a target icon to indicate it is a setpoint, and the number 411 in the lower 
left corner to identify the value is a static pressure setpoint.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application. 

Display Resolution Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 
(example: 74.5). 

Editable Select to make this microblock's value editable on the ZS sensor. 

Edit Increment Select how much you want each press of the sensor's  or  button to change the 
microblock's value. 

Minimum  Enter the lowest amount that this value can be changed to on the ZS sensor or in the 
i-Vu® interface. 

Maximum Enter the highest amount that this value can be changed to on the ZS sensor or in 
the i-Vu® interface. 

ZS Sensor Display 
Configuration 

 

Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 

 
 

Tips and tricks 

Preserving Critical Values  
If you use an Analog Network Output microblock to periodically write a critical value from within a control program 
to this microblock’s Relinquish Default property, and you check the Critical Value field, the system will attempt to 
upload this microblock’s value and preserve it through a download.   

In the following example, the High Peak Recorder records the highest supply temperature each day. The Peak 
Value BACnet Analog Value Parameter has a reference name of peak_value, an object instance of 4013, and 
Critical Value is checked. The Peak Value ANO2 microblock’s target address is bacnet://this/AV:4013/104. Thus, 
the ANO microblock periodically (once per minute, or based on COV) writes the day’s peak supply temperature to 
the BAV Parameter’s Relinquish Default property (104).   
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In the event of a download, the system uploads the Relinquish Default property from the BAV Parameter 
microblock, downloads to the controller, then writes the stored Relinquish Default property to the microblock with 
refname peak_value. So even if the program is edited and reloaded, the value in the BAV parameter is preserved, 
provided the BAV’s refname does not change. When the controller restarts, the Reset on start-up logic feeds the 
peak value back into the peak recorder and disables the ANO2, preserving the peak value in the High Peak 
recorder through the download and preventing the ANO2 from overwriting the previous peak until the value has 
been restored. 

 

 
 

BACnet Multi-State Value Parameter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys In microblocks (page 226) 

Icon and symbol      

What it does This microblock specifies a signal to be sent to the output wire. Multi-State 
microblocks are used to indicate values that have more than two discrete states (20 
maximum). 

For example, a parameter may have states of High, Medium, and Low rather than a 
numeric value.  

Any BACnet device on the network can read or change the value of this parameter. If 
no BACnet device changes the value of this parameter, the default value is used. The 
value appears to other BACnet devices as the Present Value property of this BACnet 
object. 

You can configure this microblock to make its value available on the Rnet. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Default Value The value the control program uses until a user changes the value in the system 
interface. 

Momentary 
NOTE  A control program with this feature enabled works only with v5.5 or later systems and v5.5 

or later drivers. 

Lets the i-Vu® user change the parameter to the new state for one execution of logic. 
The i-Vu® application then changes the parameter back to the original state.  

State Text You must define the text that will appear on the Properties page when the device is in 
each state. For Value 1, type the text in the field under BACnet Text. For each 
additional state, click Add and then type the text. 

To have a state put the BACnet object in an alarm or fault condition, select the 
appropriate option for that state under Alarm/Fault. 

If you checked Enable Rnet for ZS Sensors on the Rnet tab, type the text that you 
want to appear on a ZS Sensor display in the field under Rnet Text. The Preview field 
shows you how it will look on the sensor. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen. 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 
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Critical Value If your control program has logic that writes a critical value to this microblock 
periodically, select this option to have the system attempt to upload this microblock’s 
value (Relinquish Default property) and preserve it through a download, controller 
restart, or power loss.  

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 
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Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

Enable Rnet Check to allow this microblock to communicate its value(s) to and from a sensor. 

Rnet Tag All values from a ZS or WS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents.  

For a ZS sensor, it also determines how the sensor will display the value. For 
example, if you select Fan Speed Request (600), the sensor displays the state text 
and the number 600 in the lower left corner to identify the value is a fan speed 
request.  

NOTES   
• If you select Fan Speed Request or Zone Mode Request, the Critical Value field 

on the Properties tab is automatically enabled to prevent a parameter mismatch 
in the i-Vu® application if a user changes the values on the sensor. 

• If the Rnet tag droplist does not have the tag you want, you can create a custom 
tag in the Snap application.  

Editable Check under Occupied or Unoccupied to make each setpoint editable on a ZS 
Sensor. 

ZS Sensor Display 
Configuration 

 

Show on: 
 

Check the sensor screen(s) that you want this microblock's values displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order to define the order in which multiple 
microblock values will appear on each sensor screen. 

 

Sys Out microblocks 

System Output microblocks contain control program output values, such as heat and cool requests or other status 
information. You can make these values network-visible to other BACnet devices. 

Control programs use requests to communicate their heating and cooling needs to each other. 

Using requests you can construct a software "chain" mimicking the mechanical chain of equipment in the building. 
When properly constructed, requests allow you to schedule terminal or zone equipment only and allow other 
equipment to respond to zone requests. The equipment serving zones can use requests and the Setpoint 
Optimization microblock to constantly adjust discharge setpoints and minimize energy consumption. 
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 Prime Variable (page 256) 

This microblock identifies a single specific value from the control program that is representative of 
the entire control program, such as the current zone temperature. 

 Binary Status (page 257) 

This microblock displays a yes/no, on/off, open/closed, or true/false value from the control 
program on the Properties page. You can use this microblock to display the value of another 
microblock that would not normally appear on the Properties page. 

 Analog Status (page 258) 

This microblock displays the numeric value from the control program on the Properties page. You 
can use this microblock to display the value of another microblock that would not normally appear 
on the Properties page. 

 Time Status (page 259) 

This microblock displays a time value from the control program on the Properties page. You can use 
this microblock to display the value of another microblock that would not normally appear on the 
Properties page. 

BACnet® 

 BACnet Binary Value Status (page 260) 

This microblock displays a yes/no or on/off value from the control program. Any BACnet device can 
read the value of this microblock. The value appears to other BACnet devices as the Present Value 
Property of a BACnet Binary Value Object. 

 BACnet Analog Value Status (page 263) 

This microblock displays the numeric value from the control program. Any BACnet device can read 
the value of this microblock. The value appears to other BACnet devices as the Present Value 
property of a BACnet Analog Value Object. 

 BACnet Multi-State Value Status (page 268)  

This microblock specifies a signal to be sent to another microblock in the control program. Multi-
State microblocks are used to specify signals from devices that have more than two discrete states 
(20 maximum). 

  

 
 

Prime Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol    
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What it does This microblock identifies a single specific value from the control program that is 
representative of the entire control program, such as the current zone temperature. 

Every control program has a color and a prime variable. Their values are set in the 
control program logic by the Set Color and Prime Variable microblocks. If these 
microblocks are not present in the control program, their corresponding values will be 
zero. It is a good idea to provide meaningful values for these two numbers so that 
generic graphics or reports will have something meaningful to display for your control 
program. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 
 

Binary Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol    

What it does This microblock displays a yes/no, on/off, open/closed, or true/false value from the 
control program on the Properties page. You can use this microblock to display the 
value of another microblock that would not normally appear on the Properties page. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name  
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Type Select Text Defined Below to use the values in the Active Text and Inactive Text 
fields.  Or select the Inactive and Active text you wish to use from the Type droplist. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Analog Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol 
   

What it does This microblock displays the numeric value from the control program on the Properties 
page. You can use this microblock to display the value of another microblock that 
would not normally appear on the Properties page. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Time Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol    

What it does This microblock displays a time value from the control program on the Properties 
page. You can use this microblock to display the value of another microblock that 
would not normally appear on the Properties page. 

The microblock's value must be defined in hours and minutes. If the microblock 
receives a numeric value, minutes and seconds value, or other value, it will not be 
converted to an hours and minutes value. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

BACnet Binary Value Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol 
   

What it does This microblock displays a yes/no or on/off value from the control program. Any 
BACnet device can read the value of this microblock. The value appears to other 
BACnet devices as the Present Value Property of a BACnet Binary Value Object. 

You can assign text to active and inactive states to make it better represent the 
microblock's usage. 

You can configure this microblock to make its value available on the Rnet. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enable Check to send a message when this microblock indicates an alarm condition. 

Alarm State Active - An alarm condition exists when the microblock's present value is on (true). 

Inactive - An alarm condition exists when the microblock's present value is off (false). 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 
 

Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 
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Enable Rnet Check to allow this microblock to communicate its value to a sensor. 

Rnet Tag 
 

All values displayed on a ZS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents. It also determines how the sensor will 
display the value. For example, if you select Fan Status, the sensor automatically 

displays  on the Home screen when the microblock is active.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application.  

ZS Sensor Display 
Configuration 

 

Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. If 
you select this screen and select Maintenance or Alarm below, when the microblock 
is active, its value displays first on the Information screen. When inactive it does not 
display at all. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. If you select this screen and select Maintenance or Alarm below, 
when the microblock is active, its value displays first on the Diagnostics screen. 
When inactive it does not display at all. 

NOTE  Select Reorder > Sensor Display Order to define the order in which multiple 
microblock values will appear on each sensor screen. 

Show when active as:  

    Maintenance 
Check to have the ZS Pro sensor display  on the Home screen when this 
microblock is active. 

    Alarm 
Check to have the ZS Pro sensor display  on the Home screen when this 
microblock is active. 

Show text:  

    Display Inactive  
    Text 

Type the text that the ZS sensor is to display when the microblock's output is off or 
false. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen.  

    Display Active  
    Text 

Type the text that the ZS sensor is to display when the microblock's output is on or 
true. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen.  

 

 
 

BACnet Analog Value Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 
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Icon and symbol 
   

What it does This microblock displays the numeric value from the control program. Any BACnet 
device can read the value of this microblock. The value appears to other BACnet 
devices as the Present Value property of a BACnet Analog Value Object. 

You can configure this microblock to make its value available on the Rnet. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Units The unit of measurement of the microblock's present value. Select from the BACnet 
engineering units in this droplist. For some microblocks, you can customize the 
droplist by selecting Options > Preferences > Droplist Options. 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 265 

 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in.   
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Alarm 
Low Limit Enable Check to send an alarm when the microblock's present value remains below the Low 

Limit value for the defined Delay Seconds. 

Low Limit The value the microblock's present value must drop below to send an alarm. 

High Limit Enable Check to send an alarm when the microblock's present value remains above the High 
Limit for the defined Delay Seconds. 

High Limit The value the microblock's present value must rise above to send an alarm. 

Dead Band The amount inside the normal range by which an alarm condition must return before 
a return-to-normal notification is generated. 

EXAMPLE 

 
Delay Seconds The time the microblock's present value must remain in an alarm condition before 

the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

The properties below define how this microblock's value will display on a ZS Pro or ZS Pro-F sensor. 
  

Enable Rnet for  
ZS Sensors 

Check to allow this microblock to communicate its value to a ZS sensor. 

Rnet Tag All values displayed on a ZS sensor must have an Rnet tag. The Rnet tag defines what 
type of information this microblock's value represents and determines how the 
sensor will display the value. For example, if you select Outside Air Temp, the sensor 

automatically displays  with the value.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application. 

Display Resolution Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 
(example: 74.5). 

Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 

 

 
 

Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

Enable Rnet Check to allow this microblock to communicate its value to a sensor. 

Rnet Tag All values displayed on a ZS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents. It also determines how the sensor will 
display the value. For example, if you select Outside Air Temp, the sensor 

automatically displays  with the value.  

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application. 

Display Resolution Defines the resolution of the value to be displayed on the ZS sensor.  For example, 1 
displays only integers (example: 74) and 0.5 displays values to the nearest 0.5 
(example: 74.5). 

ZS Sensor Display 
Configuration 
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Show on: 
 

Check the sensor screen(s) that you want this microblock's value displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order in Snap to define the order in which 
multiple microblock values will appear on each sensor screen. 

 

 
 

BACnet Multi-State Value Status 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Sys Out microblocks (page 255) 

Icon and symbol    

What it does This microblock specifies a signal to be sent to another microblock in the control 
program. Multi-State microblocks are used to specify signals from devices that have 
more than two discrete states (20 maximum).  

For example, a device may have states of High, Medium, and Low rather than a 
numeric value.  

Any BACnet device on the network can read or change the value of this parameter. If 
no BACnet device changes the value of this parameter, the default value is used. The 
value appears to other BACnet devices as the Present Value property of the specified 
BACnet device.  

You can configure this microblock to make its value available on the Rnet. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

State Text You must define the text that will appear on the Properties page when the device is in 
each state. For Value 1, type the text in the field under BACnet Text. For each 
additional state, click Add and then type the text. 

To have a state put the BACnet object in an alarm or fault condition, select the 
appropriate option for that state under Alarm/Fault. 

If you checked Enable Rnet for ZS Sensors on the Rnet tab, type the text that you 
want to appear on a ZS Sensor display in the field under Rnet Text. The Preview field 
shows you how it will look on the sensor. 
NOTE  The letters K, M, Q, V, W, X do not display on the screen. 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Rnet 

NOTE  A control program that uses these Rnet features works only with v5.5 or later systems and v5.5 or later drivers. 

  

Enable Rnet Check to allow this microblock to communicate its value to a sensor. 

Rnet Tag All values displayed on a ZS sensor must have an Rnet tag that defines what type of 
information this microblock's value represents. It also determines how the sensor will 
display the value. For example, if you select Fan Speed Status, the sensor 

automatically displays the appropriate icon (such as ) to indicate the status 
and speed. 

NOTE  If the Rnet tag droplist does not have the tag you want, you can create a 
custom tag in the Snap application.  

ZS Sensor Display 
Configuration 

 

Show on: 
 

Check the sensor screen(s) that you want this microblock's values displayed on.  

Home Screen (1):  When more than one value is assigned to the Home screen, the 
values cycle from one to the next. Typically, the first item displays for 10 seconds and 
any other items display for 3 seconds each. 

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 

NOTE  Select Reorder > Sensor Display Order to define the order in which multiple 
microblock values will appear on each sensor screen. 

 

 
 

Log microblocks 

Log microblocks record system values, such as trends, alarms, and runtime values. 
  

 
Digital Trend (page 272) 

This microblock records data for trend purposes from microblocks that do not support built-in 
trending. 

 Analog Trend (page 274) 

This microblock records data for trend purposes from microblocks that do not support built-in 
trending. 

 Digital Trend with Sample Trigger (page 276) 

This microblock records data for trend purposes. When the rec input goes from off to on, the TRND 
input records the current state. Data is not recorded again until the next time the rec input 
transitions from off to on. 

 Analog Trend with Sample Trigger (page 278) 

This microblock records data for trend purposes. When the rec input goes from off to on, the TRND 
input records the current value. Data is not recorded again until the next time the rec input 
transitions from off to on. 
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 Runtime Monitor (page 279) 

This microblock monitors the amount of time that a piece of equipment has been running and 
provides an output that can be used for notification when the runtime limit is exceeded. 

 BACnet Alarm (page 280) 

This microblock transmits alarms and supplemental data from the control program to the system's 
alarm management system. An alarm generated by this microblock is time-stamped with the time 
the alarm was generated. 

 History Recorder (page 283) 

This microblock records a current and previous value from a microblock in a control program. You 
determine when the value is recorded.  

 High Peak Recorder (page 284) 

This microblock records the highest and previous highest value of a microblock in a control 
program. You determine when the values are recorded and when the highest value is transferred to 
the previous highest value. 

 Low Peak Recorder (page 285) 

This microblock records the lowest and previous lowest value of a microblock in a control program. 
You determine when the values are recorded and when the lowest value is transferred to the 
previous lowest value.  

 Runtime Accumulation (page 286) 

This microblock calculates the amount of time, in hours, that a piece of equipment has been 
running. 

 

 
 

Digital Trend 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol    

What it does This microblock records data for trend purposes from microblocks that do not 
support built-in trending. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes. 

Max samples 
 

The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the microblock's Properties page in the i-Vu® or Field Assistant 
system to delete all samples currently stored in the controller. 

Enable Trend Historian 
 

Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 274 

 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Analog Trend 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol    

What it does This microblock records data for trend purposes from microblocks that do not 
support built-in trending. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 276 

 

  
In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

Digital Trend with Sample Trigger 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 
   

What it does This microblock records data for trend purposes. When the rec input goes from off to 
on, the TRND input records the current state. Data is not recorded again until the next 
time the rec input transitions from off to on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

 

 

 



 Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 277 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 

Allocate memory for The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 
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Analog Trend with Sample Trigger 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 
   

What it does This microblock records data for trend purposes. When the rec input goes from off to 
on, the TRND input records the current value. Data is not recorded again until the next 
time the rec input transitions from off to on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Enable Trend Log Check to have the controller collect trend data for the microblock's present value. 
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Allocate memory for The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

 

 
 

Runtime Monitor 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 
   

What it does This microblock monitors the amount of time that a piece of equipment has been 
running and provides an output that can be used for notification when the runtime 
limit is exceeded. 

The microblock tracks the amount of time that its input remains on. When the limit is 
reached, the microblock's output turns on. This output may be wired to a BACnet 
Alarm microblock (page 280) to generate a runtime exceeded alarm. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Limit The microblock's output will turn on when the runtime exceeds this number of hours. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

BACnet Alarm 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 
   

What it does This microblock transmits alarms and supplemental data from the control program to 
the system's alarm management system. An alarm generated by this microblock is 
time-stamped with the time the alarm was generated. 

For the system to receive an alarm, the Potential alarm source field must be 
checked.  

The color square on the left side of the microblock indicates the microblock's status: 

Red = In alarm 
Gray = Not in alarm 
Black = Potential alarm source field is unchecked 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

   

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the 
actual privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always 
desirable. 

Inactive Text The text the system displays when the microblock's input is off (false). 

Active Text The text the system displays when the microblock's input is on (true). 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read the microblock's present value. Must 

be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Tips and tricks 
You can add a field code to the alarm text that will retrieve the value of another microblock at the time the alarm 
is triggered. Add the field code $source:<path>$, substituting <path> with the path to the value you want. 
The path can be an absolute path or a path relative to the BACnet Alarm microblock. See Defining i-Vu® paths 
(page 172) in i-Vu® Help. 

Example of alarm text: 
The conference room is hot. The temperature is 
$source:/trees/geographic/rd_facility/zone_1/lstat/present_value$ 

NOTE  Field codes are processed when an alarm is processed at the server, not when the alarm is triggered in the 
controller. For slow changing values on a fast network, this is almost equivalent to the latched data feature in a 
legacy system. The value 2 to 3 seconds after the alarm occurred will be very close to the value at the time of the 
alarm. But for fast changing values on a slow network, the value could be misleading. If the alarm is processed up 
to a minute or two after the alarm occurred, the value could be very different than the value at the time of the 
alarm.  

 

 
 

History Recorder 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 

   

What it does This microblock records a current and previous value from a microblock in a control 
program. You determine when the value is recorded.  The Properties page shows the 
current and previous values (Current cycle and Previous cycle), and the time and date 
when the recordings were made. 

The microblock's analog input receives the value that is to be recorded. When the rec 
input is on, the microblock transfers the current value of its input to its primary 
output, and the prior output value is transferred to the prev output. The value is 
recorded only once while the rec input is on.  

For example, if the microblock is used to record the zone temperature, and the rec 
input remains on while the temperature changes, only the temperature that was 
current at the time the rec input turned on will be recorded. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

High Peak Recorder 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 

  

What it does This microblock records the highest and previous highest value of a microblock in a 
control program. You determine when the values are recorded and when the highest 
value is transferred to the previous highest value. 

For example, if you want to record the highest outside air temperature for each day, 
this microblock can record today's highest temperature and retain yesterday's highest 
temperature. 

The microblock's analog input receives the value that is to be recorded. When the rec 
input is on, the microblock monitors the input value and transfers the highest value 
received to the microblock's primary output. This output value is transferred to the 
prev output when the rset input is turned on. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Low Peak Recorder 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 

   

What it does This microblock records the lowest and previous lowest value of a microblock in a 
control program. You determine when the values are recorded and when the lowest 
value is transferred to the previous lowest value.  

For example, if you want to record the lowest outside air temperature for each day, 
this microblock can record today's lowest temperature and yesterday's lowest 
temperature. 

The microblock's analog input receives the value that is to be recorded. When the rec 
input is on, the microblock monitors the input value and transfers the lowest value 
received to the microblock's primary output. This output value is transferred to the 
prev output when the rset input is turned on. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Runtime Accumulation 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Log microblocks (page 271) 

Icon and symbol 
    

What it does This microblock calculates the amount of time, in hours, that a piece of equipment 
has been running. 

This microblock records the amount of time its primary digital input is on. You can 
reset the microblock's value when you choose by using the microblock's clr input. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Preset Runtime Value lets you to define the number of hours that the microblock begins to count from. For 
example, if Preset Runtime Value is set to 5, the Runtime Accumulation microblock begins counting runtime hours 
at 5. The Reset button on the Properties page resets the microblock's value to the value indicated by the Preset 
Runtime Value setting. 

 

 
 

Control microblocks 

Control microblocks output signals that are used for control and scheduling purposes. Many of these microblocks 
generate colors, which are used to communicate control program or zone color status. 

NOTE  Make sure a control program broadcasts a single color by using one of the following: 
• 1 Setpoint microblock 
• 1 Set Color microblock 
• 1 or more Set Color If True microblocks  
  

 BACnet Setpoint (page 288) 

This microblock compares the zone temperature to the zone's effective setpoint to determine the 
zone color that represents the control program status. Other microblocks (such as the If Color = 
microblock) can use this color to perform additional control. 
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 Setpoint Optimization (page 310) 

Optimizes a single setpoint to use the least amount of energy necessary to meet the needs of the 
controlled equipment. 

 Set Color (page 314) 

This microblock defines a color (white, gray, or red) for a control program that does not use a Zone 
Setpoint or Set Color If True microblock. This microblock is used so the control program displays a 
color in the i-Vu® or Field Assistant system indicating its status. 

 Set Color If True (page 315) 

This microblock broadcasts the selected color for the control program when it is activated. 

 True if Color = (page 316) 

This microblock allows you to define control sequences based on the control program's current 
color. 

 BACnet Time Clock with TLO and Override Status (page 317) 

This microblock reads schedules from the i-Vu® or Field Assistant system and generates signals to 
tell the control program whether or not the zone is occupied and how long the zone will remain in 
its current state. 

 BACnet Multi-State Time Clock (page 322) 

This microblock reads schedules from the i-Vu® or Field Assistant system and generates values to 
tell the control program what state the zone is in, and how long the zone will remain in its current 
state. 

 

 
 

BACnet Setpoint 

NOTE  A control program with this microblock works only with v6.0 or later i-Vu® systems and drivers.  

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
   

Microblock family Control microblocks (page 287) 

Icon and symbol 

   

NOTE  The microblock's appearance depends on which options you select in the Snap 
application. The microblock above is the result if you select all options. 
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What it does The microblock compares the zone temperature to the zone's effective setpoint to 
determine the zone thermographic color that represents the control program status. 
Other microblocks (such as the If Color = microblock) can use this color to perform 
additional control.  

The zone's effective setpoints may differ from its programmed occupied setpoints 
because of the optimal start algorithm, electric demand reduction levels, or user 
setpoint adjustment from the zone sensor. 

OPTIONS 

In the Snap application, you can enable the following optional functionality and inputs 
on the microblock's Optional tab.   

• Demand Limiting: Provides HDEM and CDEM inputs that allow programmatic 
relaxation of setpoints to reduce electric demand. 

• Setpoint Adjust: Provides HADJ or CADJ inputs by which the setpoint can be 
programmatically adjusted. 

• Inhibit Setpoint Adjust: Provides ADJI input that allows your program to prevent 
the user from adjusting the setpoint at the sensor. 

• Optimal Start: The microblock will use an optimal start algorithm to adjust the 
zone setpoint before the zone is occupied, ensuring that the zone temperature is 
within the occupied setpoints by the time the zone is occupied. Also provides 
HOSI and COSI inputs by which Optimal Start can be programmatically inhibited. 

• Learning Adaptive: Adjusts (learns) zone heating and cooling capacities based on 
optimal start system performance. Also provides LRNI input by which learning 
can be programmatically inhibited. 

• Night Setback: Provides NS output that is true (on) when the zone is not 
occupied, optimal start is not in progress, and the zone temperature exceeds the 
unoccupied heating or cooling setpoint. 

• Minimum Setpoint Separation: Provides MINSP input that allows a minimum 
separation between the effective heating and cooling setpoints to be 
programmatically defined. 

• Capacity Limit: Provides HCAP% and CCAP% inputs that allow programmatic 
limitation of the zone's learned heating or cooling capacity that the microblock 
uses in the Optimal Start routine. 

• Zone Linkage: Provides OH, OC, UH, and UC outputs that are often needed to link 
zone applications with air or water sources.  In contrast to the effective setpoint 
outputs, these outputs supply the programmed setpoints and are not affected by 
optimal start, demand limiting, or other temporary adjustments. 

• Air Source Linkage: Provides USESL, L FOR, L ZONE, L OM, L OHS, L OCS, L UHS, 
L UCS inputs that are used to bypass the normal inputs to the Setpoint 
Microblock and substitute values from linkage. 

• Setpoint Adjust Limit: Provides SPADJ input that sets the maximum amount 
(degrees) by which the user can adjust the zone's setpoints from a zone sensor. 
Enabling this option disables the Setpoint Adjust Limit field on the Rnet tab. 

You can program a zone's occupied and unoccupied heating and cooling setpoints.  

A typical zone thermographic color scale may look like this: 
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How it works 

Heating and Cooling setpoints 
The microblock outputs the effective zone heating (HT) and cooling (CL) setpoints. Unless adjusted by a user in the 
zone, by the optimal start algorithm, or by electric demand reduction levels, the effective setpoints equal the 
programmed occupied or unoccupied setpoints.  All such adjustments to the programmed setpoints are 
cumulative. When the OCC input is true (on), the microblock adjusts the occupied cooling and heating setpoint 
values to generate the effective setpoints. When the OCC input is not true (off), the microblock adjusts the 
unoccupied heating and cooling setpoint values.  
  

Maintaining Minimum Setpoint Separation (Deadband) 
The microblock enforces a minimum separation (deadband) of twice the color change hysteresis value between 
the effective heating and cooling setpoints. For example, if a user or third-party BACnet system raises the heating 
setpoint to a value that is equal to or higher than the cooling setpoint, the cooling setpoint will be “pushed” to a 
higher value to prevent the heating and cooling ranges from overlapping. If locked property values or out of service 
values for any of the four setpoint objects (Occupied Heating, Occupied Cooling, Unoccupied Heating or 
Unoccupied Cooling) are set to a combination that causes the effective setpoints to overlap, the heat and cool 
setpoints are added, averaged, and the deadband is applied to either side of the averaged value to create 
effective setpoints that allow the control program to continue functioning properly. 

If the option Minimum Setpoint Separation is selected, the deadband can be increased programmatically. If the 
value on the MINSP input is less than the microblock’s minimum deadband, the microblock will ignore the input 
value and use a deadband value of twice the color change hysteresis value.  
 

Zone thermographic color 
The microblock compares the zone temperature from the ZONE input to the zone's effective setpoints and 
resulting color scale to determine the zone color output value. 

EXAMPLES 

• Unoccupied 

○ If the unoccupied zone temperature (65°) is between the unoccupied heating (55°) and cooling (90°) 
setpoints and the zone is not in optimal start, the microblock sets the color output value to unoccupied 
gray.   

○ If the unoccupied zone temperature (54°) drops below the unoccupied heating setpoint (55°), the 
microblock sets the color and output value to light blue.  
NOTE  The color thresholds between unoccupied gray and red can be seen in the i-Vu® interface. 

• Occupied 
If the occupied zone temperature (79°) exceeds the occupied cooling setpoint (76°) by more than the yellow 
color band value (2°) but less than the yellow and orange color band values (2° + 2° = 4°), the microblock 
sets the color output value to orange.  

• Optimal start 
If the zone temperature (60°) drops below the effective heating setpoint (62°), the microblock sets the color 
output value to light blue. 
If the zone temperature (85°) exceeds the effective cooling setpoint (84°), the microblock sets the color 
output value to yellow. 

• Demand level 1 
If the occupied zone temperature (68°) drops below the occupied heating setpoint minus the Demand1 
offset (70° – 1° = 69°) by less than the light blue band value (2°), the microblock sets the color output 
value to light blue. 
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Color Change Hysteresis 
The Color Change Hysteresis provides a difference between the temperature at which the zone color changes as 
the zone temperature departs from the acceptable range between the heating and cooling setpoints and the 
temperature at which the zone color changes back as the zone temperature returns to the acceptable range.  

EXAMPLE  The following graph shows the zone color that results as the zone temperature departs from and 
returns to the acceptable range in a zone with the following settings: 

• Color Change Hysteresis = 1° (applies as the temperature returns to the acceptable range) 

• Occupied cooling setpoint = 76°  

• Occupied heating setpoint = 70° 

 

Time

Temp

Occupied heating setpoint:  70°

75°

  71°

Occupied cooling setpoint:  76°
1° hysteresis

1° hysteresis

 
  

Demand Limiting (Optional) 
Electric rates can vary with electricity usage. In some locations, utilities offer incentives to customers to reduce 
electrical usage when the system-wide load threatens to exceed the grid capacity and cause brownouts. Some gas 
utilities offer incentives to customers to keep their natural gas usage below a certain level. To keep utility usage 
below peak demand levels, you can define 3 demand levels to reduce the cooling or heating load. You typically 
define these levels in your gas or electric meters' control programs. You can use these demand levels to relax 
zone occupied heating and cooling setpoints as needed throughout your system. Relaxing setpoints reduces 
equipment operation and reduces utility demand while minimizing the effects on occupant comfort. 

To use this demand reduction strategy in a zone, set up Analog Network Input (page 124) microblocks to read the 
demand levels (1, 2, or 3) from the meter's control program and connect the Analog Network Input microblocks to 
this microblock's HDEM and CDEM inputs. In an all-electric system, the demand level from the electric meter 
would typically be connected to both inputs. Other systems may require the heating and cooling demands to be 
controlled separately. When the utility meter's control program indicates a demand level of 1, this microblock 
relaxes occupied heating or cooling setpoints and all related color band thresholds by the Demand1 offsets you 
define. Similarly, a demand level of 2 relaxes setpoints by the Demand2 offset and a demand level of 3 relaxes 
setpoints by the Demand3 offset. 

By defining demand level offsets for each zone, the system can reduce utility demand with significant changes to 
the setpoints in non-critical zones and little or no change to the setpoints in critical zones. 

EXAMPLE 

Below is a typical demand offset strategy and resulting effective setpoints and color thresholds. The cooling 
demand offsets and setpoints are highlighted in this example. Heating offsets would similarly affect the heating 
effective setpoints. 
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Setpoint Adjust (Optional) 
If you select this option, the microblock exposes inputs to adjust the heating setpoint (HADJ) and the cooling 
setpoint (CADJ). These inputs can be used to programmatically adjust setpoints based on a condition in the zone.  
For example, if a conference room is scheduled to be occupied, but the zone’s occupancy sensor indicates that a 
room is no longer occupied, the heating or cooling setpoints could be set back by a few degrees to save energy 
but allow rapid return to occupied setpoints. These inputs also provide a method for a non-ZS room sensor with a 
local setpoint adjustment to affect the zone setpoints. If the sensor only has a single setpoint adjust output it is 
commonly connected to both inputs so the adjustment raises or lowers both setpoints by an equal amount.  

Adjusting either setpoint affects all related color bands by an equal amount. For example, if you raise the cooling 
setpoint by 2˚, you raise the temperature at which the color changes from green to yellow by 2˚. The 
temperatures at which the color changes from yellow to orange and from orange to red are also raised by 2˚. 

NOTES 

• You can limit the allowed amount of local setpoint adjustment for a ZS sensor using the Setpoint Adjust Limit 
on the Rnet tab. For an SPT sensor, you can limit the allowed amount of local setpoint adjustment in the zone 
sensor's microblock. 

• If using a ZS sensor, the optional HADJ and CADJ inputs are not required for the sensor to adjust the effective 
setpoint. 

• The Setpoint Adjust Inhibit option Provides ADJI input by which user setpoint adjustment from a ZS sensor 
can be programmatically prevented. However, the microblock will still allow programmatic adjustment of 
setpoint based on the HADJ and CADJ inputs.  
  

Optimal Start (Optional) 
When the zone is unoccupied, the microblock uses the outside air temperature from the OAT input and the design 
temperatures and capacities set in the microblock to estimate the time needed to warm or cool the zone from the 
unoccupied setpoints to the occupied setpoints. When the estimated time is less than the remaining unoccupied 
time indicated by the FOR input, the microblock outputs the programmed unoccupied setpoint values. When the 
estimated time to reach the occupied setpoints equals the remaining unoccupied time, the microblock transitions 
the effective setpoints to the occupied setpoints using a first-order curve that approximates system performance 
at full capacity. 
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Unocc clg Setpoint

Occ clg setpoint

Occ htg setpoint
Temp

Time

Occupied
period
begins

Heating
turns on

Zone temp

Unocc htg setpoint

 
 

Heating capacity calculation during optimal start 

t    =         = Time Remaining Until Occupancy (hr)

OAT     = Outside Air Temperature (°F)

H  = Heating Design Temperature (°F)

HCAP   = Heating Capacity (°F/hr)

H  = Unoccupied Heating Setpoint (°F)

H  = Occupied Heating Setpoint (°F)

HSP     = Heating Setpoint (°F)

design

unocc

occ

FOR
60

H         =                        x HCAP1

H         = H        +                            x (H      - H       )2

(H        - OAT)
(H        - 65°F)

design

design

H         = MAX (MIN (H   , (H      - (t x H  ))), H       )3

HSP   = H   + (H   - H       ) x (1 -                         )

unocc
(12 - MIN (t,12))

 (H   - H       )

12 occ unocc

2 occ

occ

1 unocc

unocc
unocc3

3

(H      - H       )unocc
3

 
  

NOTE  If the Capacity Limit optional input HCAP% is used, the H1 calculation is: 

H     =                        x HCAP x HCAP%1
(H        - OAT)
(H        - 65°F)

design

design  
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Cooling capacity calculation during optimal start 

t       =         = Time Remaining Until Occupancy (hr)

OAT     = Outside Air Temperature (°F)

C         = Cooling Design Temperature (°F)

CCAP   = Cooling Capacity (°F/hr)

C         = Unoccupied Cooling Setpoint (°F)

C         = Occupied Cooling Setpoint (°F)

CSP  = Cooling Setpoint (°F)

design

unocc

occ

FOR
60

C         =                         x CCAP1

C         = C        +                            x (C      - C       )2

(C         - OAT)
(C         - 65°F)

design

design

C    = MIN (MAX (C   , (C      + (t x C  ))), C       )3

CSP     = C   + (C   - C        ) x (1-                         )

unocc
(12 - MIN (t,12))

12 occ unocc

2 occ

occ

1 unocc

unocc
unocc3

3

unocc
3

 
  

NOTE  If the Capacity Limit optional input CCAP% is used, the C1 calculation is: 

C     =                         x CCAP x CCAP%1
(C         - OAT)
(C         - 65°F)

design

design  
  

  

NOTE  You can use the optimal start inhibit inputs (HOSI and COSI) to inhibit optimal start. For example, you may 
want to prevent any possible heating optimal start during the summer months or prevent optimal start from 
beginning more than 4 hours before occupancy. 
  

Learning Adaptive with Optimal Start (Optional) 
To minimize the energy required during optimal start, the learning adaptive optimal start algorithm evaluates the 
zone thermographic color at occupancy and adjusts the learned heating or cooling capacity for the next 
unoccupied period. If the zone temperature does not reach the setpoint by occupancy (the zone's thermographic 
color is not green at occupancy) the algorithm reduces the learned capacity by the adjustment value you defined 
for the zone's thermographic color at occupancy. During the next unoccupied period, optimal start begins sooner 
because the capacity is lower. If the zone temperature reaches the effective setpoint at any time during optimal 
start, the algorithm increases the learned heating or cooling capacity by the applicable green adjustment value 
regardless of the zone's color at occupancy. During the next unoccupied period, optimal start begins later because 
the capacity is higher. 

EXAMPLE   A zone's heating capacity is 5° per hour. Its light blue learning adaptive adjustment value is 0.06. If at 
occupancy, the zone's thermographic color is light blue, the microblock uses a learned heating capacity of 4.94° 
(5° – .06°) per hour in its optimal start calculations for the next unoccupied period.  

A microblock with Learning Adaptive and Optimal Start enabled calculates optimal start times more accurately and 
controls equipment more efficiently than microblocks with only Optimal Start enabled because it uses learned 
capacities in its calculations. Learned capacities are displayed on the Properties page and are available to other 
parts of the control program from the HCAP and CCAP outputs. 
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NOTES   

• The algorithm will not adjust learned heating and cooling capacities lower than 0.0625° per hour or higher 
than 15.938° per hour. 

• If a user downloads new heating and cooling capacity values to the controller, the learned heating and 
cooling capacities change to the new values. If other properties from the control program are downloaded to 
the controller but the capacities do not change, the learned capacities are not affected.  

• If a user downloads All Content to the controller, the learned heating and cooling capacities are reset to the 
microblock's programmed heating and cooling capacities. 

To prevent learned capacities from being distorted during override periods, use the learning inhibit (LRNI) input to 
prevent learned capacities from being adjusted during override periods. When the LRNI input is true (on), optimal 
start operates normally but learned capacities are not adjusted for the next unoccupied period. 

Make sure that all other control sequences in the control program, including PID loops, are tuned and functioning 
properly to prevent improper setpoint adjustment. 
  

Capacity Limit (Optional) 
If outside factors will prevent the heating or cooling system from running at 100% of its normal capacity, you can 
direct the Optimal Start routine to use only a percentage of the zone's learned heating or cooling capacity based 
on external logic using the HCAP% and CCAP% inputs. This percentage adjustment applies even if learning is 
inhibited by the LRNI input.  
  

Zone Linkage (Optional) 
The Zone linkage option allows for zone applications to link with air or water sources. In contrast to the effective 
setpoint outputs, this supplies the programmed setpoints and is not affected by optimal start, demand limiting, or 
other temporary adjustments.  

The Zone Linkage option creates additional output wires: 

OH:  Occupied Heating Setpoint 
OC:  Occupied Cooling Setpoint 
UH:  Unoccupied Heating Setpoint 
UC:  Unoccupied Cooling Setpoint 

These outputs are often needed to link zone applications with air or water sources. In contrast to the effective 
setpoint outputs, these outputs supply the programmed setpoints and are not affected by optimal start, demand 
limiting, or other temporary adjustments. 

Air Source Linkage (Optional) 
The Air Source Linkage option creates 8 additional input wires: 

Use SL:  Activates or deactivates Air Source Linkage 
L FOR:  The FOR time received from linkage 
L ZONE:  The Zone temperature received from linkage 
L OM:  The Occupancy Mode (Occupied or Unoccupied) received from linkage 
L OHS:  The Occupied Heating Setpoint received from linkage 
L OCS:  The Occupied Cooling Setpoint received from linkage 
L UHS:  The Unoccupied Heating Setpoint received from linkage 
L UCS:  The Unoccupied Cooling Setpoint received from linkage 

This option is used to bypass the normal inputs to the Setpoint Microblock and substitute values from linkage. A 
typical application is a rooftop unit that may be used as a single zone unit or as an air source to supply 
conditioned air to multiple linked zones.  
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If no other zones are linked to the unit, or if a communication failure disables the linkage, the microblock 
functions as a normal Setpoint microblock, accepting the occupied state, zone temp, and all other local inputs and 
ignoring the linkage inputs. In essence, the controller operates in a stand-alone mode, using its local schedule and 
sensor inputs instead of the linkage inputs. 

 Setpoint Adjust Limit (Optional) 
This optional input can be used if the setpoint adjust limit needs to be editable from an external source like an 
Equipment Touch or a third-party front-end, or if it needs to change because of a programmatic condition. The 
Setpoint Adjust Limit field on the Rnet tab is not used when this optional input is activated. 

 

 

 
 

Limitations 
A control program can use only one Zone Setpoint microblock. Do not use a Set Color (page 314) microblock or 
any Set Color If True (page 314) microblocks in a control program with a Zone Setpoint microblock. 

 

 
 

Inputs and outputs 

Inputs 
OAT 
Outside Air Temperature 

Optional–Present if Optimal Start is enabled. 

Current outside air temperature (degrees). 

OCC 
Occupied Schedule 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 
Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

FOR 
Remaining Time 

Minutes remaining until the zone's occupancy status changes. Connect to a time 
clock microblock (page 287) or to other logic that indicates this time. 

ZONE 
Zone Temperature 

Current zone temperature (degrees). Connect to an ASVI (page 159) for a ZS sensor, 
an RS (page 77) microblock for an SPT sensor, for to another input microblock that 
indicates this value. 

HDEM 
Heating Demand Level 

Optional–Present if Demand Limiting is enabled. 

Current heating demand level (1–3). Connect to the Analog Network Input microblock 
that reads the heating demand level. This typically comes from an electric meter's 
control program if electric heat is used or a gas meter control program if gas heat is 
used.   

CDEM 
Cooling Demand Level 

Optional–Present if Demand Limiting is enabled. 

Current cooling demand level (1–3). Connect to the Analog Network Input microblock 
that reads the cooling demand level. This typically comes from an electric meter's 
control program if cooling is provided from local DX coils or an electrically driven 
central cooling plant.  

HADJ 
Heating Setpoint Adjust 

Optional–Present if Setpoint Adjust is enabled. 

Signal from zone sensor to adjust heating setpoint (degrees). Connect to the zone 
sensor microblock's SP ADJ output. 
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CADJ 
Cooling Setpoint Adjust 

Optional–Present if Setpoint Adjust is enabled. 

Signal from zone sensor to adjust cooling setpoint (degrees). Connect to the zone 
sensor microblock's SP ADJ output. 

ADJI Optional–Present if Inhibit Setpoint Adjust is enabled. 

True (on) when the microblock should not accept setpoint adjust signals from a ZS 
sensor. This input does not inhibit setpoint adjust from the optional HADJ and CADJ 
inputs. 

MINSP 
Minimum Setpoint 
Separation 

Optional–Present if Minimum Setpoint Separation is enabled. 

Minimum separation (degrees) the microblock will enforce between the effective 
heating and cooling setpoints. If this value is less than twice the color change 
hysteresis value, the microblock will enforce a minimum separation of twice the color 
change hysteresis value.  See Maintaining Deadband in “How it Works” in this 
microblock’s help.  

HOSI 
Heating Optimal Start 
Inhibit 

Optional–Present if Optimal Start is enabled. 

True (on) when the microblock should not adjust heating setpoints for optimal start. 

COSI 
Cooling Optimal Start 
Inhibit 

Optional–Present if Optimal Start is enabled. 

True (on) when the microblock should not adjust cooling setpoints for optimal start. 

HCAP% 
Heating Capacity 
Adjusted By 

Optional–Present if Capacity Limit is enabled. 

Percentage of the learned heating capacity to use during optimal start under the 
conditions defined by external logic. 

CCAP% 
Cooling Capacity 
Adjusted By 

Optional–Present if Capacity Limit is enabled. 

Percentage of the learned cooling capacity to use during optimal start under the 
conditions defined by external logic. 

LRNI 
Learning Adaptive Inhibit 

Optional–Present if Learning Adaptive is enabled. 

True (on) when the microblock should not adjust learned heating or cooling capacity 
based on conditions when the zone transitions to the occupied state. 

USESL Optional–Present if Air Source Linkage is enabled. 

True (on) when the microblock should use the setpoints and other data provided from 
Air Source Linkage 

L FOR Optional–Present if Air Source Linkage is enabled. 

Minutes remaining until the zone's occupancy status changes, as provided by 
Linkage. This input should be connected to an Air Source Linkage output and is used 
in place of the local timeclock value when the Use SL input is true. 

L ZONE 
Linkage zone 
temperature (degrees) 

Optional–Present if Air Source Linkage is enabled. 

This input should be connected to an Air Source Linkage output and is used in place 
of the local ZONE value when the Use SL input is true.  

L OM 
Linkage Occupancy 
Mode 

Optional–Present if Air Source Linkage is enabled. 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. This 
input should be connected to an Air Source Linkage output and is used in place of the 
local OCC value when the Use SL input is true. 

L OHS 
Linkage Occupied 
Heating Setpoint 
(degrees) 

Optional–Present if Air Source Linkage is enabled. 

This input should be connected to an Air Source Linkage output and is used in place 
of the internal setpoint value when the Use SL input is true. 
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L OCS 
Linkage Occupied 
Cooling Setpoint 
(degrees) 

Optional–Present if Air Source Linkage is enabled. 

This input should be connected to an Air Source Linkage output and is used in place 
of the internal setpoint value when the Use SL input is true.  

L UHS 
Linkage Unoccupied 
Heating Setpoint 
(degrees) 

Optional–Present if Air Source Linkage is enabled. 

This input should be connected to an Air Source Linkage output and is used in place 
of the internal setpoint value when the Use SL input is true. 

L UCS 
Linkage Unoccupied 
Cooling Setpoint 
(degrees) 

Optional–Present if Air Source Linkage is enabled. 

This input should be connected to an Air Source Linkage output and is used in place 
of the internal setpoint value when the Use SL input is true. 

SPADJ Optional - Present if Setpoint Adjust Limit (+/-) is enabled. 

The maximum amount (degrees) by which the user can adjust the zone's setpoints 
from a zone sensor. The Setpoint Adjust Limit field on the Rnet tab is not used when 
this optional input is activated.  

Outputs 
Zone Color Zone thermographic color based on ZONE input compared to effective setpoints. 

Color   Status code Condition indicated 

 Red 9 Cooling alarm 

 Orange 8 Maximum cooling 

 Yellow 7 Moderate cooling 

 Light green 6 Free cooling 

 Green 5 No heating or cooling 

 Light blue 4 Moderate heating 

 Dark blue 3 Maximum heating 

 Red 2 Heating alarm 

 Gray 1 Unoccupied 

  
The microblock outputs the zone color's status code (1–9) on its zone color wire. 

HT 
Heating Setpoint 

The zone's effective heating setpoint (degrees) based upon occupancy, optimal start, 
demand limiting, and all other adjustments. 

CL 
Cooling Setpoint 

The zone's effective cooling setpoint (degrees) based upon occupancy, optimal start, 
demand limiting, and all other adjustments. 

NS 
Night Setback 

Optional–Present if Night Setback is enabled. 

True (on) when the zone is not occupied, optimal start is not in progress, and the 
zone temperature exceeds the unoccupied heating or cooling setpoint. 

HCAP 
Learned Heating 
Capacity 

Optional–Present if Learning Adaptive is enabled. 

The learned heating capacity (degrees/hour) calculated by the learning adaptive 
optimal start algorithm. See Learning adaptive optimal start in "How it works" in this 
microblock's help. 
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CCAP 
Learned Cooling 
Capacity 

Optional–Present if Learning Adaptive is enabled. 

The learned cooling capacity (degrees/hour) calculated by the learning adaptive 
optimal start algorithm. See Learning adaptive optimal start in "How it works" in this 
microblock's help. 

OH 
Occupied Heating 
Setpoint 

Optional–Present if Zone Linkage is enabled. 

The programmed setpoint, not the effective setpoint. This output is not affected by 
local setpoint adjustment, optimal start, or demand limiting. 

OC 
Occupied Cooling 
Setpoint 

Optional–Present if Zone Linkage is enabled. 

The programmed setpoint, not the effective setpoint. This output is not affected by 
local setpoint adjustment, optimal start, or demand limiting.  

UH 
Unoccupied Heating 
Setpoint 

Optional–Present if Zone Linkage is enabled. 

The programmed setpoint, not the effective setpoint. This output is not affected by 
local setpoint adjustment, optimal start, or demand limiting. 

UC 
Unoccupied Cooling 
Setpoint 

Optional–Present if Zone Linkage is enabled. 

The programmed setpoint, not the effective setpoint. This output is not affected by 
local setpoint adjustment, optimal start, or demand limiting. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

   

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Name The microblock label used in the Snap application and the i-Vu® interface. You 
can use any characters except the " character. 

Units The unit of measure, ˚F or ˚C, the setpoints are using. 
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Setpoints 
Unoccupied, Occupied, 
and Demand Level 
Setpoints 

The desired occupied and unoccupied zone setpoints (degrees), the value of each 
occupied color band (degrees), and the offsets for electric demand levels 1, 2, 
and 3 (degrees).  

A color band's value determines the threshold at which the microblock changes 
the zone thermographic color as the zone temperature departs from setpoint.  

You can use the free cooling light green color band to enable economizer 
operation. If you are not using this feature, type 0 for this band's value.  

Demand level offsets determine how much to relax the zone's occupied setpoints 
and color band thresholds under each electric demand level. When the electric 
meter's control program indicates a demand level of 1, this microblock relaxes 
occupied heating and cooling setpoints and all related color band thresholds by 
the Demand1 offsets you define. Similarly, a demand level of 2 relaxes setpoints 
by the Demand2 offset and a demand level of 3 relaxes setpoints by the 
Demand3 offset. 

EXAMPLE 

A zone thermographic color scale with typical demand offsets and resulting 
effective setpoints and color thresholds 

 
  
Optional–Demand Levels are used only if Demand Limiting is enabled. 

Color Change Hysteresis The desired difference (degrees) between the temperature at which the zone 
color changes as the zone temperature departs from the acceptable range 
between the heating and cooling setpoints and the temperature at which the zone 
color changes back as the zone temperature returns to the acceptable range. If 
you are not using zone thermographic color for equipment control, type 0. See 
Color Change Hysteresis in "How it works" in this microblock's help. 

Design Properties 
Heating Capacity Optional–Used only if Optimal Start is enabled. 

The rate (degrees/hour) at which the zone temperature changes if the outside air 
temperature is 65°F and the heating system runs at full capacity. Adjust after 
startup based on system optimal start performance. 
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Cooling Capacity Optional–Used only if Optimal Start is enabled. 

The rate (degrees/hour) at which the zone temperature changes if the outside air 
temperature is 65°F and the cooling system runs at full capacity. Adjust after 
startup based on system optimal start performance. 

Heating Design 
Temperature 

Optional–Used only if Optimal Start is enabled. 

The geographically-based outside air temperature (degrees) at which the heating 
system must run constantly in order to maintain comfort. Available in ASHRAE 
publications and most design references. 

Cooling Design 
Temperature 

Optional–Used only if Optimal Start is enabled. 

The geographically-based outside air temperature (degrees) at which the cooling 
system must run constantly in order to maintain comfort. Available in ASHRAE 
publications and most design references. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Learning 
 

Color adjustment values Optional–Used only if Learning Adaptive is enabled. 

The amount by which the microblock adjusts the zone's learned heating or cooling 
capacity when the zone is this thermographic color at occupancy. See Learning 
adaptive optimal start in "How it works" in this microblock's help. 

 

 
 

BACnet 
This microblock contains the following BACnet analog value objects. 
  

This object.... Represents... And is... 

Occupied Cooling The programmed Occupied Cooling Setpoint 
NOTE  This object becomes read-only when Air Source Linkage is 
active. 

 Writable 

Occupied Heating The programmed Occupied Heating Setpoint 
NOTE  This object becomes read-only when Air Source Linkage is 
active. 

Writable 

Unoccupied Cooling The programmed Unoccupied Cooling Setpoint 
NOTE  This object becomes read-only when Air Source Linkage is 
active. 

Writable 
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Unoccupied Heating The programmed Unoccupied Heating Setpoint 
NOTE  This object becomes read-only when Air Source Linkage is 
active. 

Writable 

Cooling Adjustment The value of the CADJ input wire Read-only 

Effective Cooling The value of the CL output wire. It is the effective cooling setpoint 
based upon occupancy, optimal start, demand limiting, and all other 
adjustments. 

Read-only 

Heating Adjustment The value of the HADJ input wire Read-only 

Effective Heating The value of the HT output wire. It is the effective heating setpoint 
based upon occupancy, optimal start, demand limiting, and all other 
adjustments 

Read-only 

Zone Temperature Trend 
Log 

A trend log of the zone temperature input.   

NOTE  This value comes from the L ZONE input when Air Source 
Linkage is active. 

Read-only 

Occupied Status Trend Log A trend log of the occupancy status.   

NOTE  This value comes from the L OM input when Air Source 
Linkage is active. 

Read-only 

  
Define the following properties for the above BACnet objects. 
  

Object Name A unique alphanumeric string that defines the BACnet object. 

Description (optional) A BACnet-visible microblock description. 

Minimum If this setpoint can be changed from a zone sensor, this is the lowest temperature to 
which a user can adjust the zone's setpoint from a sensor. 

If a third-party vendor writes a value lower than this value to the microblock's 
Present_Value, the controller returns a Property, Value_Out_Of_Range error. 

Maximum If this setpoint can be changed from a zone sensor, this is the highest temperature to 
which a user can adjust the zone's setpoint from a sensor.  

If a third-party vendor writes a value higher than this value to the microblock's 
Present_Value, the controller returns a Property, Value_Out_Of_Range error.  

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Rnet 
   

Enable Rnet Check to allow this microblock to communicate its value(s) to and from a sensor. 

Setpoint Adjust Limit 
(+/-) 

The maximum amount (degrees) by which the user can adjust the zone's setpoints 
from a zone sensor. 

Clear adjustment on 
transition to unoccupied 

ZS Pro and Pro-F sensors - Check to have the Setpoint microblock reset the sensor's 
setpoint adjustment value to 0 each time the microblock's OCC input changes to false 
(off) and leave it at 0 when the OCC input changes again to true (on) or when the 
zone enters a timed local override condition.  

If this field is not checked, the Setpoint microblock will not reset the sensor's 
adjusted value.  

ZS Plus sensor - This field does not apply. The Setpoint microblock cannot reset the 
sensor's adjusted value. 

NOTE  The Setpoint microblock does not use adjusted values during unoccupied 
periods. 

Edit Increment The amount (degrees) that the zone temperature setpoint will be adjusted by each 
press of a ZS Pro sensor's  or  button. For a ZS Plus sensor, slider adjustments 
will be read to the nearest increment. 

 

Sensor Setpoint Adjust 
Option 

Select how you want to see and adjust setpoints on a ZS sensor. 

    Disabled Prevents editing the setpoints at the sensor. 
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    1.  Adjust 
         setpoint 
         offset.  
         Center 
         display=Zone 
         Temp. Show 
         effective 
         setpoints. 

Example of sensor display: 

 
  

Results in the i-Vu® interface of adjusting setpoint offset up 1 degree: 
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    2.  Adjust 
         base 
         setpoint. 
         Center  
         display=Zone  
         Temp. Show 
         effective 
         setpoints. 

Example of sensor display: 

 
  

Results in the i-Vu® interface of adjusting base setpoint up 1 degree: 
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    3.  Adjust 
         setpoint 
         offset.  
         Center 
         display= 
         Offset value. 
         Show 
         effective 
         setpoints. 

Example of sensor display: 

 
  

Results in the i-Vu® interface of adjusting base setpoint up 1 degree: 

Same as 1. above. 

    4.  Adjust 
         setpoint 
         offset.  
         Center 
         display= 
         Offset value. 
         Hide 
         effective 
         setpoints. 

Example of sensor display: 

 
  

Results in the i-Vu® interface of adjusting base setpoint up 1 degree: 

Same as 1. above. 

    5.  Hospitality 
         mode 

Displays only the active effective setpoint or the average of the heating and cooling 
setpoints if the mode is auto. The effective setpoint is adjustable.  

 
ZS Sensor Display 
Configuration 

 

Editable Check under Occupied or Unoccupied to make each setpoint editable on a ZS 
Sensor. 

Show on: 
 

Check the sensor screen(s) that you want Occupied, Unoccupied and Effective 
Setpoints displayed on.  

Home Screen (1):  Effective Setpoints are displayed on the Home screen in the 
following locations: 

 
On the Information or Diagnostics screen, effective setpoints cycle through in the 
primary value field and show EFF in the Rnet tag field.  

Information Screen (2):  This screen is accessed by pressing the sensor's  button. 

Diagnostics Screen (3):  This screen is accessed by holding the sensor's  button for 
at least 3 seconds. 
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Trends 
This microblock contains the following BACnet trend objects. 
  

Effective Cooling 
Analog Trend 

A trend log of the effective cooling setpoint. 

Effective Heating 
Analog Trend 

A trend log of the effective heating setpoint. 

Zone Temperature 
Analog Trend 

A trend log of the zone temperature input.   
NOTE  This value comes from the L ZONE input when Air Source Linkage is active. 

Occupied Status 
Binary Trend 

A trend log of the occupancy status.   
NOTE  This value comes from the L OM input when Air Source Linkage is active. 

  
Define the following properties for the above trend objects. 
  

Enable Check to have the controller collect trend data for the microblock's present value. 

Sample every ___ 
(hh:mm:ss) 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset in the i-Vu® interface to delete all samples currently stored in the 
controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends 
for __ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 
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Optional 
  Select the optional functionality that you want this microblock to have. 
  

Demand Limiting Provides HDEM and CDEM inputs that allow programmatic relaxation of setpoints to 
reduce electric demand. See "Demand Limiting" in How it works. 

Setpoint Adjust Inputs Provides HADJ or CADJ inputs by which the setpoint can be programmatically 
adjusted. See "Setpoint Adjust" in How it works. 

Inhibit Setpoint  
Adjust from ZS 

Provides ADJI input that allows your program to prevent the user from adjusting the 
setpoint at the sensor. See "Setpoint Adjust" in How it works. 

Optimal Start The microblock will use an optimal start algorithm to adjust the zone setpoint before 
the zone is occupied, ensuring that the zone temperature is within the occupied 
setpoints by the time the zone is occupied. Also provides HOSI and COSI inputs by 
which Optimal Start can be programmatically inhibited. See "Optimal Start" in How it 
works. 

Learning Adaptive Adjusts (learns) zone heating and cooling capacities based on optimal start system 
performance. Also provides LRNI input by which learning can be programmatically 
inhibited. See "Learning Adaptive with Optimal Start" in How it works. 

Night Setback Provides NS output that is true (on) when the zone is not occupied, optimal start is 
not in progress, and the zone temperature exceeds the unoccupied heating or cooling 
setpoint. See "Optimal Start" in How it works. 

Minimum Setpoint 
Separation 

Provides MINSP input that allows a minimum separation between the effective 
heating and cooling setpoints to be programmatically defined. See "Maintaining 
Minimum Setpoint Separation (Deadband)" in How it works. 

Capacity Limit Provides HCAP% and CCAP% inputs that allow programmatic limitation of the zone's 
learned heating or cooling capacity that the microblock uses in the Optimal Start 
routine. See "Capacity Limit" in How it works. 

Zone Linkage Provides OH, OC, UH, and UC outputs that are often needed to link zone applications 
with air or water sources.  In contrast to the effective setpoint outputs, these outputs 
supply the programmed setpoints and are not affected by optimal start, demand 
limiting, or other temporary adjustments. 

Air Source Linkage Provides USESL, L FOR, L ZONE, L OM, L OHS, L OCS, L UHS, L UCS inputs that are 
used to bypass the normal inputs to the Setpoint Microblock and substitute values 
from linkage. 

Setpoint Adjust Limit 
(+/-) 

Provides SPADJ input that sets the maximum amount (degrees) by which the user 
can adjust the zone's setpoints from a zone sensor. Enabling this option disables the 
Setpoint Adjust Limit field on the Rnet tab. 

 

 
 

Programming example 
In each of the examples below, the zone control strategy does the following: 

• Allows local zone setpoint adjustment using a zone sensor 

• Inhibits optimal start from beginning more than 4 hours before occupancy 

• Uses the full (100%) learned heating and cooling capacities during every optimal start period 

• Inhibits learned heating and cooling capacity adjustments during unoccupied override periods 
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Example with a ZS Sensor: 

 
  

Example with an SPT Sensor: 
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Tips and tricks 

Optimal start 
Write the control logic for the unoccupied mode to activate heating if the zone color is light blue or cooling if the 
zone color is yellow. This will bring the zone temperature back into the desired range during optimal start. 

Color change hysteresis 
If you are using zone thermographic color for floorplan display, but not for control, set the Color Change Hysteresis 
to 0. Using zone color and hysteresis for control can confuse end users because it can prevent the zone color 
from changing at the programmed setpoints. To maintain a minimum separation between the effective heating 
and cooling setpoints with a hysteresis of 0, enable the Minimum Setpoint Separation option and provide your 
desired deadband. If you are controlling equipment based on zone thermographic color, set the hysteresis large 
enough to prevent the equipment from changing back and forth between two different states if the temperature 
oscillates near the setpoint. 

Free cooling – economizer enable 
If you are using zone thermographic color for control in small single-zone systems or unit ventilators, you can use 
the light green free cooling color band to enable economizer operation before you enable mechanical cooling. 
Otherwise, set the free cooling color band value to 0. 

 

 
 

Setpoint Optimization 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol 
   

What it does Optimizes a single setpoint to use the least amount of energy necessary to meet the 
needs of the controlled equipment. 

You set a maximum and minimum value that the setpoint will not exceed, and you 
determine whether and how often the setpoint is calculated. The microblock uses 
requests from controlled equipment to increase or decrease the setpoint, and adjusts 
(trims) the setpoint with each calculation to minimize energy use. This allows you to 
efficiently meet the building's requirements by optimizing the setpoint according to 
the needs of the controlled equipment. 

 
 

How it works 
When the go input is enabled, the microblock outputs the Initial setpoint. 

At the frequency defined by the Every value, the microblock calculates a new setpoint: 

New setpoint = previous setpoint + Trim by + lesser of (but do not respond by more than or (Respond by x req)) 

The microblock uses the Trim by value to decrease the energy consumed by the mechanical equipment when no 
requests are received. 
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EXAMPLES 

• To optimize the cooling setpoint for a VAV air handling unit receiving requests from multiple VAV boxes: 

 
If the microblock outputs 57° and 5 minutes later the req input sees 4 requests, the new setpoint is 56° = 
(57 + 1 + (-2)).  

Because (req x and respond by) = -4, the microblock calculates using the but do not respond by more than 
value. 

• To optimize the heating setpoint for a VAV air handling unit receiving requests from multiple VAV boxes: 

 
If the microblock outputs 75° and 5 minutes later the req input sees 2 requests, the new setpoint is 78° = 
75 + (-1) + (2 x 2.0) 

If the microblock outputs 72° and 5 minutes later the req input sees 0 requests, the new setpoint is still 72°. 
The microblock calculates a new setpoint of 71° = (72 + (-1) + 0). But the microblock will not output a 
setpoint lower than the Minimum value of 72°. 

 

 
 

Inputs and outputs 

Inputs 
req 
Number of requests 

Requests for setpoint adjustment from controlled equipment. Connect to a Total 
Analog or other microblock with a total number of requests for an increase or 
decrease in the current setpoint. Common uses are heating requests for an increased 
heating setpoint, cooling requests for a decreased cooling setpoint, or VAV box 
requests for an increased duct static pressure. 
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go True (on) if the control program should optimize the current setpoint.  

EXAMPLES  

• Optimize the heating setpoint if the supply fan has flow. 

• Optimize the cooling setpoint if the supply fan has flow. 

• Optimize the duct static pressure setpoint if the fan is commanded on. 

Outputs 
STPT 
Current Optimized 
Setpoint 

Calculated at the frequency defined in the Every field. 

= previous setpoint + Trim by + lesser of (but do not respond by more than or (req x 
Respond by)) 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Initial Setpoints 
Initial The initial setpoint the microblock uses when the go input is enabled. 

Minimum The minimum setpoint that the microblock will output. 

Maximum The maximum setpoint that the microblock will output. 

Setpoint Optimization 
Every The frequency at which the microblock calculates a new setpoint. Should reflect the 

response speed of the control loop.  
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Trim by The microblock adjusts the setpoint by this value at the frequency set in the Every 
field.  

For a direct acting loop (such as cooling) use a positive number. For a reverse acting 
loop (such as heating) use a negative number. 

and respond by At the frequency set in the Every field the microblock multiplies this value by the req 
input value, then adds the lesser of  

• (req x and respond by) or  

• but do not respond by more than  

to the (previous setpoint + Trim by value).  

For a direct acting loop (such as cooling) use a negative number. For a reverse acting 
loop (such as heating) use a positive number. 

but do not respond by 
more than 

The limit of the (req x and respond by) value that the microblock adds to the (previous 
setpoint + Trim by) value at the frequency set in the Every field.  

For a direct acting loop (such as cooling) use a negative number. For a reverse acting 
loop (such as heating) use a positive number. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Programming example 
For the heating and cooling setpoint optimization microblocks' configuration, see the examples in "How it works" 
above. The logic below to optimize for a VAV air handling unit's supply air temperature setpoint does the following: 

• Accepts heating and cooling requests from up to 20 zones 

• Uses net heating and cooling requests to determine whether to use the optimized cooling setpoint or the 
optimized heating setpoint 
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• Uses a ramp to prevent large jumps in setpoint when switching between heating and cooling, typical of the 
swing seasons 

 
 

 
 

Set Color 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol 
   

What it does This microblock defines a color (white, gray, or red) for a control program that does 
not use a Zone Setpoint or Set Color If True microblock. This microblock is used so 
the control program displays a color in the i-Vu® or Field Assistant system indicating 
its status.  

For example, this microblock can be used to generate a color for a piece of 
equipment depending on its status: white if the equipment is running, gray if the 
equipment is not running, and red if an alarm condition exists for the equipment. 

NOTE  Do not use the Set Color microblock in combination with any Zone Setpoint or 
Set Color If True microblocks in the same control program. There cannot be more 
than one Set Color microblock in a control program. 

When the microblock's alrm input receives an on signal, the control program's 
broadcast color is red (2), regardless of the value of the run input. When the alrm 
input is off and the run input is on, the control program's broadcast color is white 
(10). If both inputs are off, the control program's broadcast color is gray (1). 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Set Color If True 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol    

What it does This microblock broadcasts the selected color for the control program when it is 
activated. 

The microblock's input accepts an on or off signal. When the input is on, the selected 
color is broadcast. If the input is off, the microblock does not generate any color. This 
allows you to use more than one Set Color If True microblock in a control program, as 
long as only one of these microblocks is activated at a time. 

 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Color Select the color that is to be displayed with the input is on. 

 

 
 

True if Color = 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol 
   

What it does This microblock allows you to define control sequences based on the control program's 
current color.  

This microblock accepts a color value from a Zone Setpoint or Set Color microblock. If 
the color matches one of the colors selected for the microblock, the microblock's 
output is turned on.  

For example, this microblock can be used to create a signal that turns a BACnet Alarm 
microblock on when the control program's color is either red or orange. 

In the Snap application, select the color or colors that will turn the microblock's output 
on. On the Properties page, indicate the desired color or colors by changing the 
appropriate dash to an X. The dashes represent the colors in the order indicated by the 
letters (rdlggyor): red (heat alarm), dark blue, light blue, green, speckled green, yellow, 
orange, and red (cooling alarm). The dashes represented by the letters (gw) stand for 
the colors gray and white. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

True if Color = 
 

Check the color that is to be displayed with the input is on. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

BACnet Time Clock with TLO and Override Status 

NOTE  A control program with this microblock works only with v5.5 or later systems and v5.5 or later drivers.  

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol 
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What it does This microblock reads schedules from the i-Vu® or Field Assistant system and 
generates signals to tell the control program whether or not the zone is occupied and 
how long the zone will remain in its current state. 

The microblock has two outputs: the occ output, which indicates whether the zone is 
currently occupied (on) or unoccupied (off); and the timer output, which indicates the 
number of minutes remaining until the occupancy changes. The value of these 
outputs depends on the schedule entered for the control program in the i-Vu® or 
Field Assistant system.  

This microblock can optionally accept an override signal that indicates the number of 
minutes to override occupancy from either of the following: 

• A sensor if Enable Rnet is selected. 

• Another microblock if Timed Local Override on the Optional tab is selected.  

This microblock can also indicate when the zone is in an override state using the 
optional Override Status (ovr) output. The ovr output will be active only when the 
equipment is in a true override condition and works for overriding in an On state or an 
Off state, as with the Force Unoccupied feature. If an occupied schedule is running 
when a user starts a timed local override, the ovr output will not turn on until the 
schedule expires. 

You cannot set schedules using the microblock's dialog box. The Properties page > 
Summary tab shows the current occupancy status of the zone, the time when the 
occupancy is scheduled to change, and the override status. The Properties page > 
Details tab shows the override time remaining, which may be different than the time 
remaining amount. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

  

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Schedule Category The category of the schedule that will run the controlled equipment. Select 
Occupancy unless you have defined a custom schedule category in the Snap and i-
Vu® applications. 

Unscheduled Value The value the microblock assumes when no schedule has been downloaded to the 
program if: 

• The system has no schedules that affect the equipment. 

• A stand alone controller is powered up but no schedule data has been entered. 

Configuration 
Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

  

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 
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Rnet 
 
Enable Rnet Check to allow this microblock to communicate its value(s) to and from a sensor. 

Allow 'Continuous' 
Override 

Check to allow a user to force a zone into an occupied state for an indefinite amount 
of time. The override remains in effect until the schedule transitions to occupied or 
until a user manually clears it by pressing the sensor's On/Off button twice. 

Allow Force Unoccupied Check to allow a user to save energy by forcing the zone into an unoccupied state. To 
force unoccupied, a user holds a ZS sensor's On/Off button for at least 3 seconds. 
This forced state remains in effect until the schedule transitions to unoccupied or 
until a user presses the sensor's On/Off button. 

Force Unoccupied 
without Delay 

Check to allow a user to force a zone to unoccupied immediately instead of the 
normal 3-second delay. 

NOTE  This feature is unavailable if Allow TLO Set During Occupied is checked. 

Allow TLO Set During 
Occupied 

Check to allow a user to activate a timed local override while the zone is scheduled 
occupied. This allows a user to extend the zone's occupied time without the HVAC 
equipment having to go unoccupied first.  

NOTE  This feature is unavailable if Force Unoccupied without Delay is checked. 

Timed Local Override 
Increment Minutes the microblock adds to the zone's occupied time for each press of the zone's 

local override button or switch. 

Maximum Duration Maximum value (up to 960 minutes) the microblock outputs regardless of additional 
pulses from the controller's input. 

Show scheduling limits: 
 

The default limits for the Occupancy schedule category.  

NOTES 

• A schedule download will fail if you exceed these limits when creating schedules. 

• Changing these properties erases the schedule information in the controller, 
requiring you to download schedules again. 

• If you use Global Modify to change these limits, the affected devices will not be 
automatically marked for schedule download. 

     Weekly       Schedules - 
Max      Transitions Per  
     Day 

The number of transitions a weekly schedule allows in a 24-hour period. The default 
is 6, which creates 5 schedule segments. 

     Max Exception  
     Schedules 

The number of non-weekly schedules allowed in a controller. The default is 30. The 
system reserves 7 of these schedules - one for each day of the week. 

     Max Transitions  
     Per Day 

The number of transitions a non-weekly schedule allows in a 24-hour period. The 
default is 6, which creates 5 schedule segments. 
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Optional 
Timed Local Override Use for an SPT sensor or any other microblock that reads a TLO signal. For a ZS 

sensor, use the TLO options on the Rnet tab. 

Typically, for a ZS sensor, you should use the TLO options on the Rnet tab. However, 
if you do use this TLO input for a ZS sensor, it is in conjunction with the sensor's 
built-in TLO function. This microblock uses whichever TLO value is greater, the one 
from the sensor or the one from the optional input. This optional TLO input does not 
count down automatically. 

Override Status The ovr output will be On while either of the following conditions exists: 

• The schedule is unoccupied and the override time remaining from the ovr input 
or ZS sensor is greater than 0. 

• The schedule is occupied and the microblock gets a force unoccupied signal 
from a ZS sensor. 

Allow for External 
Scheduling 

This checkbox produces two binary inputs on the schedule microblock to allow the 
zone to be optionally scheduled by an external source like a binary input or third-
party front-end via a binary value parameter. The ext input tells the schedule 
microblock to use the external schedule. The cmd input tells the schedule 
microblock to be either occupied (on) or unoccupied (off). 

When external scheduling is used, the user still has the option of using the ZS 
sensor for override or for forcing it into an unoccupied state. 

 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

 

 
 

BACnet Multi-State Time Clock 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Control microblocks (page 287) 

Icon and symbol 
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What it does This microblock reads schedules from the i-Vu® or Field Assistant system and 
generates values to tell the control program what state the zone is in, and how long 
the zone will remain in its current state.  

This microblock can be used to establish a schedule that outputs different values at 
different times of the day.  

For example, it can be used to control lighting which has multiple modes such as 
normal workday, janitorial cleaning, and after-hours modes. The Multi-State Time 
Clock should be used with the system's Multi-State (not Boolean) schedules. The 
value appears to other BACnet devices as the Present Value property of a BACnet 
schedule object. 

The microblock has two outputs: the mode output, which indicates what mode the 
zone is currently in; and the time output, which indicates the number of minutes 
remaining until the mode changes. The value of these outputs depends on the 
schedule entered for the control program in the i-Vu® or Field Assistant system. Enter 
or view schedules on the Schedules page. 

You cannot set schedules using the microblock's dialog box. The Properties page 
shows the current occupancy status of the zone and the time when the occupancy is 
scheduled to change. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. 
You can use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the 
microblock's calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role 
assigned to it. You can use Global Modify (page 50) in the i-Vu® interface to 
find out what the actual privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege 
you select will be used for all properties of this microblock, which is not 
always desirable. 

Schedule Category Select the category of the schedule that will run the controlled equipment. 
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Unscheduled Value The value the microblock assumes when no schedule has been downloaded 
to the program if: 

• The system has no schedules that affect the equipment. 

• A stand alone controller is powered up but no schedule data has been 
entered. 

State Text You must define the text that will appear on the Properties page when the 
device is in each state. For Value 1, type the text in the field under BACnet 
Text. For each additional state, click Add and then type the text. 

To have a state put the BACnet object in an alarm or fault condition, select 
the appropriate option for that state under Alarm/Fault. 

Show scheduling limits: 
 

The default limits for the Occupancy schedule category.  

NOTES 

• A schedule download will fail if you exceed these limits when creating 
schedules. 

• Changing these properties erases the schedule information in the 
controller, requiring you to download schedules again. 

• If you use Global Modify to change these limits, the affected devices will 
not be automatically marked for schedule download. 

     Weekly 
     Schedules - Max      Transitions 
Per  
     Day 

The number of transitions a weekly schedule allows in a 24-hour period. The 
default is 6, which creates 5 schedule segments. 

     Max Exception  
     Schedules 

The number of non-weekly schedules allowed in a controller. The default is 
30. The system reserves 7 of these schedules - one for each day of the week. 

     Max Transitions  
     Per Day 

The number of transitions a non-weekly schedule allows in a 24-hour period. 
The default is 6, which creates 5 schedule segments. 

 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object Instance Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 
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Alarms 
 
Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if the 
alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's Alarms 
page > View tab. 

Template Universal - Allows your system to use the Alarm text and Return text defined in the 
microblock, and the Critical checkbox to determine the color of the system-wide 
alarm button when the alarm comes in. 

Alarm 
Alarm Enabled Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you will 
reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Convert microblocks 

Convert microblocks take information from other microblocks, change the data in some way, then output the 
changed data. 
  

 Zone Controller (page 327) 

Provides stable temperature control of a single-zone heating and cooling system using 2 modified 
PID control loops. 

 PID - Direct Acting (page 330) 

The PID - Direct Acting microblock calculates three values: a proportional value, integral value, and 
derivative value. These 3 values are added together with the bias to create an output percentage 
that increases as the input rises above the setpoint. 

 PID - Reverse Acting (page 333) 

The PID - Reverse Acting microblock calculates three values: a proportional value, integral value, 
and derivative value. These 3 values, together with the bias, create an output percentage that 
increases as the input falls below the setpoint. 

 BACnet PID (page 335) 

The BACnet PID microblock calculates 3 values: a proportional value, integral value, and derivative 
value. These 3 values, together with the Bias, create an output percentage that increases or 
decreases as the input changes from the setpoint depending on the PID action selected. 

 Linear Converter (page 343) 

This microblock converts a value in a range to a proportionate value in a different range. 

 Linear Converter for Variable Inputs (page 344)   

This microblock converts a value in a range to a proportionate value in a different range. 

 Enthalpy Calculator (page 346) 

This microblock accepts a dry bulb temperature and a relative humidity input and calculates a 
corresponding value for enthalpy. Enthalpy is a measure of energy inherent in the air. A high 
enthalpy value indicates a higher air temperature. 

 Dewpoint Temperature Calculator (page 347) 

This microblock accepts a dry bulb temperature and a relative humidity value and uses this 
information to calculate the dewpoint temperature. The dewpoint is the temperature at which water 
vapor begins condensing. 

 Wetbulb Temperature Calculator (page 348) 

This microblock accepts a dry bulb temperature and a relative humidity value and uses this 
information to calculate the wet bulb temperature. 

 True If = Constant (page 349) 

This microblock creates an on (or true) signal when the value of the microblock's input is equal to 
the trip point. 

 True If > Constant (page 350) 

This microblock creates an on (or true) signal when the value of the microblock's input is greater 
than the microblock's trip point. 

 True If < Constant (page 351) 

This microblock creates an on (or true) signal when the value of the microblock's input is less than 
the microblock's trip point. 
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 True If = Variable (page 352) 

This microblock accepts two analog values wired from other parts of the control program. The 
microblock creates an on (or true) signal when the value of both inputs is the same. 

 True If > Variable Input (page 353) 

This microblock creates an on (or true) signal when the value of the microblock's if > input is greater 
than the microblock's other input. The microblock accepts two analog values wired from other parts 
of the control program. 

 True If < Variable Input (page 354) 

This microblock creates an on (or true) signal when the value of the microblock's if < input is less 
than the microblock's other input. The microblock accepts two analog values wired from other parts 
of the control program. 

 Analog to Digital Converter (page 355) 

This microblock converts a numeric input to an on/off digital signal. If the input value is zero, the 
microblock creates an off signal. If the input value is any number other than zero, the microblock 
creates an on signal. 

 Digital to Analog Converter (page 356) 

This microblock accepts a digital on or off signal and converts it to a numeric value. If the 
microblock's input is on, the output value is 1.0. If the input is off, the output value is 0.0. 

 

 
 

Zone Controller 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 

 
What it does Provides stable temperature control of a single-zone heating and cooling system 

using 2 modified PID control loops. 

2 non-linear PID loops (direct-acting for the cooling output and reverse-acting for the 
heating output) make fine-tuning corrections when the system is near setpoint and 
larger corrections when the setpoint or the load changes and the system needs to 
adjust quickly. 

The microblock also optimizes performance in the night setback and morning start-up 
modes. 
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How it works 
A patented, modified PID algorithm provides responsive, stable control and reduces overshoot in zone control 
applications. 

When the zone is unoccupied, the algorithm uses proportional-only control with a large gain and bias, providing 
on/off zone heating and cooling control to minimize unoccupied run time and to maximize efficiency. For example, 
if the temperature drops below the unoccupied heating setpoint, the algorithm calls for 100% heating.  It 
maintains a 100% output until the zone temperature rises approximately 1 degree above setpoint, then turns off 
heating and remains inactive unless the temperature exceeds the unoccupied setpoint. 

When the zone is occupied, the algorithm compares the zone temperature to the setpoint and uses the Maintain 
Setpoint ± limit to determine its response.  

When the zone is occupied and the zone temperature deviates from the heating or cooling setpoint by 75% of the 
Maintain Setpoint ± limit, the algorithm calls for 100% heating or cooling to quickly bring the zone back to 
setpoint. A ± 1° limit provides excellent control in most situations. Increase this limit if the system begins to cycle. 

EXAMPLES 

• If a zone's cooling setpoint is 74 °F, Maintain Setpoint ± 1 calls for full cooling when the temperature 
reaches 74.75 °F. 

• If a zone's heating setpoint is 70 °F, Maintain Setpoint ± 1 calls for full heating when the temperature 
reaches 69.25 °F. 

When the algorithm calls for 100% heating or cooling, it uses the integral correction term's value to determine how 
much to add to the integral correction at each interval until the zone temperature returns to within 75% of the 
Maintain Setpoint ± limit. This strategy ensures that when the temperature returns closer to setpoint, the 
microblock's output is close to the value needed to keep it there. 

When the zone is occupied and the zone temperature is within 75% of the Maintain Setpoint ± limit, the algorithm 
uses a low proportional gain and adds a fixed integral correction in each interval where the zone temperature 
departs from the setpoint or remains constant. In each interval where the zone temperature moves toward the 
setpoint, the algorithm subtracts the fixed integral correction. This strategy gives faster response and better 
stability in HVAC zone applications than traditional PID control. 

 

 
 

Limitations 
This microblock is designed for zone comfort control applications such as a VAV box, unit ventilator, or single-zone 
AHU. Internal gains and sampling rates optimized for zone temperature control may not be compatible with other 
applications. 

Heating and cooling setpoints must be at least as far apart as the value of the Maintain Setpoints ±  property, and 
unoccupied setpoints must be farther apart than occupied setpoints.  

The control algorithm assumes a continuous zone temperature. Discontinuities in temperature do not happen in 
real-world systems, but they can easily occur when you simulate a control program. 
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Inputs and outputs 

Inputs 
OCC 
Occupied 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 
Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

FOR 
Remaining Time 

Minutes remaining until the zone's occupancy status changes. Connect to a time 
clock microblock (page 287) or to other logic that indicates this time. 

ZONE 
Zone Temp 

Current zone temperature (degrees). 

HTSP 
Heating Setpoint 

Heating setpoint (degrees). Connect to a setpoint microblock's HT output or to other 
logic that indicates the zone's heating setpoint. 

CLSP 
Cooling Setpoint 

Cooling setpoint (degrees). Connect to a setpoint microblock's CL output or to other 
logic that indicates the zone's cooling setpoint. 

Outputs 
CLG% 
Cooling % 

(0–100%) Amount of cooling required. Connect to the Airflow Control (page 96) 
microblock's Cooling % input or to another Output (page 31) microblock that can 
send the signal to the cooling system. You can also use this output to trigger cooling 
requests to the air handling unit. 

HTG% 
Heating % 

(0–100%) Amount of heating required. Connect to the Airflow Control (page 96) 
microblock's Heating % input or to another Output (page 31) microblock that can 
send the signal to the heating system. You can also use this output to trigger heating 
requests to the air handling unit. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Cooling Loop Gain (1 - 5). Speed of the integral action relative to the proportional action when the 
system is in a cooling mode. If the system begins cycling, decrease this value. 

Heating Loop Gain (1 - 5). Speed of the integral action relative to the proportional action when the 
system is in a heating mode. If the system begins cycling, decrease this value. 

Maintain  
Setpoints ± 

Control range (degrees). The microblock calls for 100% heating or cooling when the 
zone temperature exceeds the setpoint by 75% of this limit. See "How it works (page 
328)" in this microblock's help. If the system begins cycling, increase this value. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Programming example 
This simple VAV application has no fan and no auxiliary heat in the zone. 

 
 

 
 

PID - Direct Acting 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
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What it does PID (Proportional, Integral, Derivative) loops use industry standard algorithms to 
calculate an appropriate response for controlling a physical output, based on the 
equipment's setpoint and the input. 

The PID - Direct Acting microblock calculates three values: a proportional value, 
integral value, and derivative value. These 3 values are added together with the bias 
to create an output percentage that increases as the input rises above the setpoint. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Gain 
Proportional You can define P-gain by entering a value in this field as described below or by 

entering a value in the Input range field. Entering a value in either field automatically 
sets the other field. 

The Proportional gain (P-gain) value is used to calculate the proportional component 
of the routine. This component increases in direct proportion to the difference 
between the setpoint and the input. When the input goes up, the proportional 
component goes up. If you define only the P-gain portion of the PID microblock, the 
microblock's output value could cause the input to oscillate around the setpoint or 
possibly to never reach the setpoint (if the P-gain is too low). The proportional value is 
calculated using the following formula: P = (Input - Setpoint) x P-gain. For example, if 
the P-gain is 20, the setpoint is 65, and the current temperature is 67, the 
proportional value is 40. If the P-gain is 20, the setpoint is 65, and the current 
temperature is 70 or higher, the proportional value is 100%. So the proportional 
output increases from 0 to 100% as the input changes from 0 to 5 degrees away 
from setpoint. The Snap application sets the Input range field to 100/20 = 5. 
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Input range You can define P-gain by entering a value in this field as described below or by 
entering a value in the Proportional field. Entering a value in either field automatically 
sets the other field. 

In this field, specify the range for the input that will cause the P output to vary from 
20% to 100%. For example, if you need to maintain temperatures ±2 from setpoint, 
enter 2. The Snap application sets the Proportional field to 100/2 = 50. 

Integral The Integral gain (I-gain) value is used to calculate the integral component of the PID 
routine. The integral value accounts for the amount of time that the input and the 
setpoint have been different. The longer the input and setpoint are different, the 
larger the integral value becomes. The integral value is calculated as follows: I = 
Previous I value + [(Input - Setpoint) x I-gain] For example, if the I-gain is 2, the 
setpoint is 65, and the current temperature is 67, the integral value for the first 
interval will be 4. If at the end of the second interval the temperature is still 67, the 
integral value will increase to 8. 

Derivative The Derivative gain (D-gain) value attempts to control the rate at which the input is 
brought to Setpoint in order to prevent the Setpoint from being exceeded. This value 
uses information from the current and previous intervals and is calculated using the 
following formula: D = [(Input - Setpoint)current - (Input - Setpoint)previous] x D-gain. 
For example, if the D-gain is 3, the Setpoint is 65, and the current temperature is 67, 
the Derivative value for the first interval is 6 ([2 - 0] x 3 = 6). If at the end of the 
second interval the temperature is still 67, the Derivative value will decrease to 0 ([2 - 
2] x 3 = 0). The microblock's output percentage uses all three components as follows: 
Output (%) = Bias + P + I + D. The Bias is set on the microblock dialog or the 
Properties page. Using the examples listed for each component above and assuming 
a Bias value of 0, the Output value of the PID microblock for the first interval would 
be 50; for the second interval the value would be 48. 

Loop 
Bias The Bias value is added to the Proportional, Integral, and Derivative values calculated by 

the microblock to create the final Output value. The Bias can be viewed as a starting 
point for the calculation. When the go input is off, the microblock's output defaults to 
0. 

Interval How often (in seconds) the microblock calculates its output value. When the 
microblock's Go input is on, the output value is calculated once each interval. 

Hold I Error When checked, this setting retains the last calculated integral value when the 
microblock's go input is off. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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PID - Reverse Acting 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 

   

What it does PID (Proportional, Integral, Derivative) loops use industry standard algorithms to 
calculate an appropriate response for controlling a physical output, based on the 
equipment's setpoint and the input. 

The PID - Reverse Acting microblock calculates three values: a proportional value, 
integral value, and derivative value. These 3 values, together with the bias, create an 
output percentage that increases as the input falls below the setpoint. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Gain 
Proportional You can define P-gain by entering a value in this field as described below or by 

entering a value in the Input range field. Entering a value in either field automatically 
sets the other field. 

The Proportional gain (P-gain) value is used to calculate the proportional component 
of the routine. This component increases in reverse proportion to the difference 
between the setpoint and the input. When the input goes up, the proportional 
component goes down. If you define only the P-gain portion of the PID microblock, the 
microblock's output value could cause the input to oscillate around the setpoint or 
possibly to never reach the setpoint (if the P-gain is too low). The proportional value is 
calculated using the following formula: P = (Setpoint - Input) x P-gain. For example, if 
the P-gain is 20, the setpoint is 65, and the current temperature is 67, the 
proportional value is 40. If the P-gain is 20, the setpoint is 65, and the current 
temperature is 70 or higher, the proportional value is 100%. So the proportional 
output increases from 0 to 100% as the input changes from 0 to 5 degrees away 
from setpoint. The Snap application sets the Input range field to 100/20 = 5. 

Input range You can define P-gain by entering a value in this field as described below or by 
entering a value in the Proportional field. Entering a value in either field automatically 
sets the other field. 

In this field, specify the range for the input that will cause the P output to vary from 
20% to 100%. For example, if you need to maintain temperatures ±2 from setpoint, 
enter 2. The Snap application sets the Proportional field to 100/2 = 50. 

Integral The Integral gain (I-gain) value is used to calculate the integral component of the PID 
routine. The integral value accounts for the amount of time that the input and the 
setpoint have been different. The longer the input and setpoint are different, the 
larger the integral value becomes. The integral value is calculated as follows: I = 
Previous I value + [(Setpoint - Input) x I-gain] For example, if the I-gain is 2, the 
setpoint is 65, and the current temperature is 67, the integral value for the first 
interval will be 4. If at the end of the second interval the temperature is still 67, the 
integral value will increase to 8. 

Derivative The Derivative gain (D-gain) value attempts to control the rate at which the input is 
brought to Setpoint in order to prevent the Setpoint from being exceeded. This value 
uses information from the current and previous intervals and is calculated using the 
following formula: D = [(Setpoint - Input)current - (Setpoint - Input)previous] x D-gain. 
For example, if the D-gain is 3, the Setpoint is 65, and the current temperature is 67, 
the Derivative value for the first interval is 6 ([2 - 0] x 3 = 6). If at the end of the 
second interval the temperature is still 67, the Derivative value will decrease to 0 ([2 - 
2] x 3 = 0). The microblock's output percentage uses all three components as follows: 
Output (%) = Bias + P + I + D. The Bias is set on the microblock dialog or the 
Properties page. Using the examples listed for each component above and assuming 
a Bias value of 0, the Output value of the PID microblock for the first interval would 
be 50; for the second interval the value would be 48. 

Loop 
Bias The Bias value is added to the Proportional, Integral, and Derivative values calculated by 

the microblock to create the final Output value. The Bias can be viewed as a starting 
point for the calculation. When the go input is off, the microblock's output defaults to 
0. 

Interval How often (in seconds) the microblock calculates its output value. When the 
microblock's Go input is on, the output value is calculated once each interval. 

Hold I Error When checked, this setting retains the last calculated integral value when the 
microblock's go input is off. 
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Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

BACnet PID 

NOTE  A control program with this microblock works only with v5.1 or later systems and v4.x or later drivers. 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
 
Microblock family Convert microblocks (page 326) 

Icon and symbol 

   

NOTE  The microblock's appearance depends on which options you select in the Snap 
application. The figure above includes all options. 

What it does PID (Proportional, Integral, Derivative) loops use industry standard algorithms to 
calculate an appropriate response for controlling a physical output, based on the 
equipment's setpoint and the input.  

The BACnet PID microblock calculates 3 values: a proportional value, integral value, 
and derivative value. These 3 values, together with the Bias, create an output 
percentage that increases or decreases as the input changes from the setpoint 
depending on the PID action selected. 

 

 
 

How it works 
PID (Proportional, Integral, Derivative) loops use industry standard algorithms to calculate an appropriate 
response for controlling a physical output, based on the equipment's setpoint and the input.  

The PID microblock calculated 3 values: a proportional value, integral value, and derivative value. These 3 values 
are added together with the Bias to create an output percentage that increases or decreases as the measured 
value varies from the setpoint. The PID output is recalculated every Interval, determined by the user.  
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Deadband 
Specify a Deadband to prevent the PID controller from making small adjustments to the output when input values 
are close to setpoint. Once the control program drives the input value to setpoint, it will pause the PID calculations 
and maintain the output until the difference between the setpoint and input is greater than the Deadband. 

Calculate Continuously 
Conventional PID controls update all 3 terms at the same time; at the time Interval specified. Selecting Calculate 
Continuously allows the Proportional term to be updated continuously instead of each interval. This prevents the 
Integral term from building up too quickly (windup) if the system reacts slowly, especially if there is a long delay 
between when the control output changes and when the system begins to reactThis allows the output to change 
enough to calculate a meaningful Derivative term between updates. The Proportional term does not depend on 
the interval and there is usually no reason to wait between intervals to update. The Calculate Continuously option 
often provides better control over a conventional PID loop. 

Pause  
Locks the output to its current value when Pause input is on. Allows external logic to implement a deadband or 
otherwise pause PID calculations based on system performance. Pause is only available as an optional wire input, 
if not selected, no Pause property is visible on the Properties page.  

Proportional  
The Proportional term generates an output signal that varies based on how far the input is from the setpoint. Error 
is calculated as the difference between the setpoint and the input. A larger error value produces a larger output. A 
Proportional Gain value determines how responsive the output is to the error; higher gains increase system 
response to the error. The Proportional term is calculated each interval using the following formula. 

P     = P      (Error)out gain  

Integral  
The Integral term reduces the Error the longer the input is different from the setpoint. The accumulated error is 
looked at over time and the output is adjusted to eliminate this error. The Integral Gain value determines how 
responsive the output is to the error; higher gains increase system response to the error. The Integral term is 
calculated each interval using the following formula. 

I      = I       (Error) + Iout gain out, previous interval  

Derivative  
The Derivative term varies based on the change in the Error, slowing the rate of change as the input gets closer to 
the setpoint. This reduces overshoot. A larger change will result in a greater response. A Derivative Gain value 
determines how responsive the output is to the error; higher gains increase system response to the error. The 
Derivative term is calculated at each interval using the following formula. 

D     = D      (Error          - Error )out gain current previous  

Bias 
The Bias value is added to the proportional, integral, and derivative values calculated by the microblock to create 
the final output value. Bias can be viewed as a starting point for the calculation.   

PID     = P    + I     + D + Biasout out out out  
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Ramp Time 
The minimum allowable time (seconds) that the Output can change from 0 to 100%. This effectively "ramps" the 
Output to prevent the PID term from changing faster than a control actuator can modulate a valve, damper, or 
other controlled device. The Min Ramp Time setting limits the Integral term so it will not build up faster than the 
actuator can respond. If your system has a slow actuator, set this property equal to the actuator stroke time. 
Otherwise, set it to zero to disable this feature.   

 

 
 

Limitations 
Expected Output values may differ from calculated values due to the microblocks limitations.  

The Output: 

• Can never be less than 0% or more than 100%. 

• Is limited by the physical devices that are being controlled. Transition times for physical devices may be 
slower than the calculated times. If the calculated values cause the Output to be less than 0% or more than 
100%, the calculated Integral term may be restricted to keep it from building up too fast; this is commonly 
called "anti-windup". 

• Is limited by the minimum ramp time. 

 

 

 
 

Inputs and outputs 

Inputs 
Go When the microblock's Go input is on, the output is enabled.  When the Go input is 

off, the output value is 0. 

Setpt The desired zone temperature. 

In The current zone temperature. 

Optional Inputs 
• Pause 

• Proportional 

• Integral 

• Derivative 

• Bias 

• Interval 

• Ramp Time 

Check the optional functionality that you want this microblock to have. See "How it 
works (page 335)" for a description of each input. 

• Selecting these inputs allows the value to be automatically adjusted by control 
program logic. 

• Optional inputs selected in the Snap application change the values within the 
microblock to read only.  

• Optional inputs selected are not editable on the Properties page. 

• The microblock must be network visible for BACnet to write to these properties. 

Outputs 
Out The current calculated output value (%). 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Loop 
Action Direct action 

• Used in cooling applications. 
• The Output increases when the Input is greater than the Setpoint. 
• The Output is proportional to the Error value. 
• The Error is calculated as (Input - Setpoint). 

Reverse action 

• Used in heating applications. 
• The Output decreases when the Input is greater than the Setpoint. 
• The Output is inversely proportional to the Error value. 
• The Error is calculated as (Setpoint - Input). 
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Dead Band A range in which the input may vary from the Setpoint before the Output is updated.  

EXAMPLE  If Setpoint = 75° and Deadband = 2, the Input will vary between 73°-77°. 

Setpoint

Input

Deadband

 
 

NOTE   Once the Input falls outside the Deadband, it must reach or exceed the Setpoint 
value before the Output is paused again. 

Update Interval Determines how often the microblock calculates the Output value.  

Bias The Bias value is added to the Proportional, Integral, and Derivative values calculated by 
the microblock to create the final Output value. The Bias can be viewed as a starting 
point for the calculation.  

Min Ramp Time to 
transition between 0 
and 100% 

The minimum allowable time (seconds) that the Output can change from 0 to 100% to 
allow for physical devices to travel from its fully open to its fully closed position. This 
is also the minimum allowable time for the Output to change from 100% to 0. 

Gain 
Proportional You can define P-gain by entering a value in this field as described below or by 

entering a value in the Input range field. Entering a value in either field automatically 
sets the other field. 

The Proportional gain (P-gain) value is used to calculate the proportional component 
of the routine. This component increases in direct proportion to the difference 
between the setpoint and the input. When the input goes up, the proportional 
component goes up. If you define only the P-gain portion of the PID microblock, the 
microblock's output value could cause the input to oscillate around the setpoint or 
possibly to never reach the setpoint (if the P-gain is too low). The proportional value is 
calculated using the following formula: P = Error x P-gain. For example, in a Direct 
Acting PID loop, if the P-gain is 20, the setpoint is 65, and the current temperature is 
67, the proportional value is 40. If the P-gain is 20, the setpoint is 65, and the 
current temperature is 70 or higher, the proportional value is 100%. So the 
proportional output increases from 0 to 100% as the input changes from 0 to 5 
degrees away from setpoint. The Snap application sets the Input range field to 
100/20 = 5. 

Input range You can define P-gain by entering a value in this field as described below or by 
entering a value in the Proportional field. Entering a value in either field automatically 
sets the other field. 

In this field, specify the range for the input that will cause the P output to vary from 
20% to 100%. For example, if you need to maintain temperatures ±2 from setpoint, 
enter 2. The Snap application sets the Proportional field to 100/2 = 50. 

Calculate continually Updates the PID output based on instantaneous calculation of Proportional value 
regardless of Update interval. 
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Integral The Integral gain (I-gain) value is used to calculate the integral component of the PID 
routine. The integral value accounts for the amount of time that the input and the 
setpoint have been different. The longer the input and setpoint are different, the 
larger the integral value becomes. The integral value is calculated as follows: I = 
Previous I value + [Error x I-gain] For example, if the I-gain is 2, the setpoint is 65, and 
the current temperature is 67, the integral value for the first interval will be 4. If at 
the end of the second interval the temperature is still 67, the integral value will 
increase to 8. 

Derivative The Derivative gain (D-gain) value attempts to control the rate at which the input is 
brought to Setpoint in order to prevent the Setpoint from being exceeded. This value 
uses information from the current and previous intervals and is calculated using the 
following formula: D = [(Error)current - (Error)previous] x D-gain. For example, if the D-
gain is 3, the Setpoint is 65, and the current temperature is 67, the Derivative value 
for the first interval is 6 ([2 - 0] x 3 = 6). If at the end of the second interval the 
temperature is still 67, the Derivative value will decrease to 0 ([2 - 2] x 3 = 0). The 
microblock's output percentage uses all three components as follows: Output (%) = 
Bias + P + I + D. The Bias is set on the microblock dialog or the Properties page. 
Using the examples listed for each component above and assuming a Bias value of 0, 
the Output value of the PID microblock for the first interval would be 50; for the 
second interval the value would be 48. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

BACnet Object Details 

Object Instance 
• Loop 

• Setpoint 

• Input 

• PID Out 

Auto-assign  SiteBuilder assigns a BACnet Object ID to the Loop, Setpoint, Input, and 
PID Out objects when you attach the control program to a controller. 

Use specific value  Manually enter BACnet ID's (0 to 3999999) to these objects if you 
need specific ID's. You must assign numbers that are unique within the controller. 
Enter the numbers in the Loop, Setpoint, Input, and PID Out fields. 

NOTE  The Loop Object ID is the ID used for the BACnet PID microblock. The Setpoint, 
Input, and PID Out Object ID's are provided for compatibility with third party BACnet 
systems that use external references for these values.  

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. Must be checked for this microblock to generate alarms. 

BACnet Writable Check to control these parameters with BACnet commands. 

Units  
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Setpoint and Input The BACnet engineering unit of measurement of the microblock's present value. 

COV Increment 
• Setpoint 

• Input 

• PID Output 

An Analog Network Input (ANI) that references this microblock in its Address field 
tries to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

 

 

 
 

Trends 
 

Enable Trend Log Select to have the controller collect analog trend data for the present values of the 
Setpoint, Input, and PID Output objects. It will also collect binary trend data for the 
Loop object (On = in control, Off = not in control). The loop is considered to be in 
control if it is actively controlling the output, meaning the GO input is on, the loop is 
not paused or overridden, and the input is not within the deadband.  

Sample every ___ 
(hh:mm:ss) 
 

Records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

Sample on COV 
(change of value) 

Records the microblock’s present value only when the value changes by at least the 
COV Increment. 

Max samples The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

NOTE  Click Reset on the microblock's Properties page in a i-Vu® or Field Assistant 
system to delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends for 
__ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Write to historian: 

Every ___ trend samples 

Use default (45% of Max 
samples) 

Writes all trend data in the controller to the system database each time the controller 
collects the specified number of samples. You can select Every __ trend samples and 
enter a number greater than zero and less than the number in the Max samples field, 
or you can select Use default. The number of trends specified must be accumulated 
at least once before the historical trends can be viewed. 
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In a i-Vu® or Field 
Assistant system only: 

 

Stop When Full Check this field to stop trend sampling when the maximum number of samples is 
reached. 

Enable trend log at specific 
times only? 

Collects trend data for the specific period of time you define in the time and date 
fields. 

Store Trends Now Writes all trend data in the controller to the system database without having to 
enable trend historian. 

Trend samples 
accumulated since last 
notification 

Shows the number of samples stored in the controller since data was last written to 
the database. 

Last Record Written to 
Historian  

Shows the number of trend samples that were last written to the database. 

Delete Deletes all trend samples stored in the database for the microblock. 

BACnet Configuration The Object Name is a unique alphanumeric string that defines the BACnet object. 
Although the Object Name field can be edited, it is not recommended. The Notification 
Class is set to 1 to receive alarms generated by Carrier controllers. 

 

 
 

BACnet object property addresses 

Parameter and Status 
The BACnet PID microblock is a BACnet Loop Object (object type 12). A complete description of the properties of 
this object is documented in the ASHRAE BACnet Handbook. The following is a subset of those properties that are 
most useful for graphics, touchscreens, BACview® screens, and third-party BACnet access. Gains and other 
values can be optionally configured as wire inputs and are read only.     

Property Name Property ID Units Read/Write 

Present_value 85 0-100% Read only 

Update Interval 118 Msec R/W unless input on wire 

Action 2 Text Toggle Read only from the i-Vu® application 

R/W through BACnet 

CAUTION  Changing the action at 
runtime (from direct to reverse or 
from reverse to direct) could 
produce unwanted and possibly 
dangerous conditions in your 
system. 

Proportional Gain 93 None R/W unless input on wire 

Integral Gain 49 None R/W unless input on wire 

Derivative Gain 26 None R/W unless input on wire 

Bias 14 0-100% R/W unless input on wire 
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The format for a BACnet address is bacnet://device/object/property@priority.  

EXAMPLE  To set up a microblock to read the Deadband from the BACnet PID microblock in the same controller, 
use the following address. 

bacnet://this/12:1/4164 

In the above address, 12:1 indicates the first instance of a BACnet PID microblock in the controller. 

The following refinements to the standard PID algorithm are not part of the standard BACnet Loop Object but can 
be accessed as BACnet Proprietary Objects. 

Property Name Property ID Units Read/Write 

Continuous Proportional 4163 Binary R/W 

Deadband 4164 Same as input R/W 

Min Ramp Time 4165 Seconds R/W 

 

 
 

Linear Converter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 

   

What it does This microblock converts a value in a range to a proportionate value in a different 
range. 

For example, you can use this microblock to convert a PID output percent value to a 
3-13 psi value to operate a hot water valve. You could also use this microblock to 
establish a setpoint range for equipment based on the outside air temperature range. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Input 
From Define the beginning value for the input range. 

To Define the ending value for the input range. 

Output 
From Define the beginning value for the output range. 

To Define the ending value for the output range. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Linear Converter for Variable Inputs 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 

   

What it does This microblock converts a value in a range to a proportionate value in a different 
range.  
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How it works 
You define the starting (Input) and ending (Output) range by four inputs to the microblock. 
• A and B define the input's range 
• X and Y define the output's range 

  

 
  
where X ≤ output ≤ Y. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Programming example 
The images below show how the Linear Converter for Variable Inputs microblock can open a cooling valve as the 
day gets warmer. As the outside air temperature rises from 70 degrees to 80 degrees (user adjustable), the 
cooling valve opens from 0 to 100% (user adjustable).  
  

 
 

 
 

Enthalpy Calculator 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock accepts a dry bulb temperature and a relative humidity input and 
calculates a corresponding value for enthalpy. Enthalpy is a measure of energy 
inherent in the air. A high enthalpy value indicates a higher air temperature. 
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Limitations 
In cases where the temperature and humidity input values are very high or very low, the enthalpy calculation can 
become distorted. If the db input is below 32°F or above 104°F, it may be necessary to substitute additional logic 
in place of the Enthalpy Calculator microblock. This may also be necessary if the hum input value falls below 0% 
or goes above 100%. 

NOTE  This microblock does not support metric temperatures. If you need a metric enthalpy, convert temperature 
to °F for use by the db input, then convert the ent output to metric units. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 
 

Dewpoint Temperature Calculator 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock accepts a dry bulb temperature and a relative humidity value and 
uses this information to calculate the dewpoint temperature. The dewpoint is the 
temperature at which water vapor begins condensing. 

 
 

Limitations 
In cases where the temperature and humidity input values are very high or very low, the dewpoint temperature 
can become distorted. Use Constant High Limit and Constant Low Limit microblocks to limit the db temperature 
input between 32°F and 104°F, and humidity input values between 0% and 100%. 

NOTE  This microblock does not support metric temperatures. If you need a metric dewpoint, convert temperature 
to °F for use by the db input, then convert the dp output from °F to °C. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Wetbulb Temperature Calculator 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock accepts a dry bulb temperature and a relative humidity value and 
uses this information to calculate the wet bulb temperature. 

The wet bulb temperature lowers when the humidity is low, indicating that more water 
can be absorbed by the air through evaporation. 

 
 

Limitations 
This microblock does not support metric temperatures. If you need a metric wetbulb temperature, convert 
temperature to °F for use by the db input, then convert the wb output from °F to °C. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

True If = Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock creates an on (or true) signal when the value of the microblock's 
input is equal to the trip point. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Trip Point Type the constant value the microblock will use to determine if it should generate an 
on (or true) signal. 
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Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

True If > Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock creates an on (or true) signal when the value of the microblock's 
input is greater than the microblock's trip point. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Trip Point Type the constant value the microblock will use to determine if it should generate an 
on (or true) signal. 
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Hysteresis The Hysteresis setting indicates the amount by which the input value must fall below 
the trip point before the microblock's output is turned off. The hysteresis can prevent 
the microblock from changing its value too frequently when the input oscillates 
around the trip point. 

For example, if the trip point is 35 and the hysteresis is 2, the microblock's input 
must fall to 33 before the output turns off. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

True If < Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock creates an on (or true) signal when the value of the microblock's 
input is less than the microblock's trip point. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Trip Point Type the constant value the microblock will use to determine if it should generate an 
on (or true) signal. 

Hysteresis The Hysteresis setting indicates the amount by which the input value must rise above 
the trip point before the microblock's output is turned off. The hysteresis can prevent 
the microblock from changing its value too frequently when the input oscillates 
around the trip point. 

For example, if the trip point is 35 and the hysteresis is 2, the microblock's input 
must rise above 37 before the output turns off. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

True If = Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock accepts two analog values wired from other parts of the control 
program. The microblock creates an on (or true) signal when the value of both inputs 
is the same. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

True If > Variable Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock creates an on (or true) signal when the value of the microblock's if > 
input is greater than the microblock's other input. The microblock accepts two analog 
values wired from other parts of the control program. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Hysteresis The Hysteresis setting indicates the amount by which the input value must fall below 
the trip point before the microblock's output is turned off. The hysteresis can prevent 
the microblock from changing its value too frequently when the input oscillates 
around the trip point. 

For example, if the trip point is 35 and the hysteresis is 2, the microblock's input 
must fall to 33 before the output turns off. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

True If < Variable Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock creates an on (or true) signal when the value of the microblock's if < 
input is less than the microblock's other input. The microblock accepts two analog 
values wired from other parts of the control program. 

 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Hysteresis The Hysteresis setting indicates the amount by which the input value must rise above 
the trip point before the microblock's output is turned off. The hysteresis can prevent 
the microblock from changing its value too frequently when the input oscillates 
around the trip point. 

For example, if the trip point is 35 and the hysteresis is 2, the microblock's input 
must rise above 37 before the output turns off. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Analog to Digital Converter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock converts a numeric input to an on/off digital signal. If the input value 
is zero, the microblock creates an off signal. If the input value is any number other 
than zero, the microblock creates an on signal. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Digital to Analog Converter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Convert microblocks (page 326) 

Icon and symbol 
   

What it does This microblock accepts a digital on or off signal and converts it to a numeric value. If 
the microblock's input is on, the output value is 1.0. If the input is off, the output 
value is 0.0. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Limit microblocks 

Limit microblocks test their input values against some limit, then output either the original signal or the limit value. 
  

 Constant High Signal Selector (page 357) 

This microblock accepts a numeric value from another microblock and compares it to a constant 
value you define. The higher of the two values is the microblock's output value. 

 Constant Low Signal Selector (page 358) 

This microblock accepts a numeric value from another microblock and compares it to a constant 
value you define. The lower of the two values is the microblock's output value. 

 Variable High Signal Selector (page 359) 

This microblock accepts two numeric values from other microblocks in the control program and 
compares them to each other. The higher of the two values is the microblock's output value. 

 Variable Low Signal Selector (page 360) 

This microblock accepts two numeric values from other microblocks in the control program and 
compares them to each other. The lower of the two values is the microblock's output value. 

 Constant Low Limit (page 361) 

This microblock sets a limit that the microblock's value cannot go below. If the microblock's input 
is higher than the low limit you define, the microblock outputs the input value. If the input value is 
less than the low limit you define, the microblock outputs the low limit value. 

 Constant High Limit (page 362) 

This microblock sets a limit that the microblock's value cannot go above. If the microblock's input 
is less than the high limit you define, the microblock outputs the input value. If the input value is 
higher than the high limit you define, the microblock outputs the high limit value. 

 Variable Low Limit (page 363) 

This microblock limits a value based on another value in the microblock. The value of the 
microblock's second input is the low limit for the output. If the first input's value is greater than the 
second input, the microblock outputs the first input's value. If the first input is lower than the 
second, the microblock outputs the second inputs value. 

 Variable High Limit (page 364) 

This microblock limits a value based on another value in the microblock. The value of the 
microblock's first input is the high limit for the output. If the second input's value is less than the 
first input, the microblock outputs the second input's value. If the second input is higher than the 
first, the microblock outputs the first input's value. 

 Ramp Up/Down Control (page 364) 

This microblock limits the rate at which an analog signal may increase or decrease. When the 
microblock's go input is on, the microblock's ramp control is enabled. When the go input is off, the 
output value is equal to the input value.  

 

 
 

Constant High Signal Selector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock accepts a numeric value from another microblock and compares it to 
a constant value you define. The higher of the two values is the microblock's output 
value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant The microblock compares the input to this value and outputs the higher of the two.   

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Constant Low Signal Selector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock accepts a numeric value from another microblock and compares it to 
a constant value you define. The lower of the two values is the microblock's output 
value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant The microblock compares the input to this value and outputs the lower of the two.   

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Variable High Signal Selector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Limit microblocks (page 357) 

Icon and symbol 

   

What it does This microblock accepts two numeric values from other microblocks in the control 
program and compares them to each other. The higher of the two values is the 
microblock's output value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Variable Low Signal Selector 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock accepts two numeric values from other microblocks in the control 
program and compares them to each other. The lower of the two values is the 
microblock's output value. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Constant Low Limit 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock sets a limit that the microblock's value cannot go below. If the 
microblock's input is higher than the low limit you define, the microblock outputs the 
input value. If the input value is less than the low limit you define, the microblock 
outputs the low limit value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Low Limit If the microblock's input is:  

•  Greater than the Low Limit, the microblock outputs the input value.  

•  Less than the Low Limit, the microblock outputs the Low Limit. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Constant High Limit 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock sets a limit that the microblock's value cannot go above. If the 
microblock's input is less than the high limit you define, the microblock outputs the 
input value. If the input value is higher than the high limit you define, the microblock 
outputs the high limit value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

High Limit If the microblock's input is:  

•  Less than the High Limit, the microblock outputs the input value.  

•  Greater than the High Limit, the microblock outputs the High Limit. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Variable Low Limit 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock limits a value based on another value in the microblock. The value of 
the microblock's second input is the low limit for the output. If the first input's value is 
greater than the second input, the microblock outputs the first input's value. If the first 
input is lower than the second, the microblock outputs the second inputs value. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Variable High Limit 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Limit microblocks (page 357) 

Icon and symbol 
   

What it does This microblock limits a value based on another value in the microblock. The value of 
the microblock's first input is the high limit for the output. If the second input's value 
is less than the first input, the microblock outputs the second input's value. If the 
second input is higher than the first, the microblock outputs the first input's value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 
 

Ramp Up/Down Control 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Limit microblocks (page 357) 

Icon and symbol 

   

What it does This microblock limits the rate at which an analog signal may increase or decrease. 
When the microblock's go input is on, the microblock's ramp control is enabled. When 
the go input is off, the output value is equal to the input value.  

This microblock is often used as an additional safety measure to slow the reaction of a 
piece of equipment. This microblock can also be used in a sequence to prevent 
incoming requests from being canceled.  

For more information, refer to the appropriate request microblock description in SysIn 
Microblocks (page 226). 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Increase The amount the analog signal is to increase. 
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Every The amount of time between increases of the analog signal. 

Decrease The amount the analog signal is to decrease. 

Every The amount of time between decreases of the analog signal. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Relay microblocks 

Relay microblocks act as software relays to determine how and when an input signal should be modified before it 
is sent from the microblock or the control program. 
  

 Constant Duty Cycle (page 367) 

This microblock produces an output that cycles on and off according to the length of time you 
define for the cycle, and the percentage of that time you specify the output should be on. 

 Variable Duty Cycle (page 368) 

This microblock produces an output that cycles on and off according to the length of time you 
define for the cycle and the value of the microblock's input, which indicates the percentage of the 
cycle time the output should be on.  

 Delay On Make (page 369) 

This microblock provides a delay before passing an on signal to the next microblock. 

 Delay On Break (page 370) 

This microblock provides a delay before passing an off signal to the next microblock. 

 Maximum On Timer (page 371) 

This microblock limits the amount of time a signal remains on. 

 Minimum On/Off Timer (page 372) 

This microblock defines the minimum amount of time that a signal should remain on or off.  

 Latch (page 374) 

This microblock turns the output on when clear is off and it detects an input transition from off to 
on. 

 Toggle (page 375) 

This microblock toggles its output value when its input turns on. 

 Lead/Standby (page 376) 

This microblock is used to control two devices, where one device is a standby (backup) to the other. 
It is commonly used to control critical devices, such as two pumps in parallel, because it will 
automatically turn on the standby device if the lead device fails. 
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 Switch - Normally Closed to Variable (page 378) 

This microblock switches the microblock's output between a numeric input and a constant value. 

 Switch - Normally Closed to Constant (page 379) 

This microblock switches the microblock's output between a numeric input and a constant value. 

 Switch (page 380) 

This microblock switches the microblock's output value between two numeric inputs. 

 Digital Wire Lock (page 380) 

This microblock can lock a signal so that it remains on or off regardless of the input signal. 

 Analog Wire Lock (page 382) 

This microblock can lock a specified value so that it remains the same regardless of the input 
signal. 

 

 
 

Constant Duty Cycle 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock produces an output that cycles on and off according to the length of 
time you define for the cycle, and the percentage of that time you specify the output 
should be on.  

The microblock only cycles the output when the go input is on; if the go input is off, 
the output remains on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Duty cycle This setting determines the percentage of the cycle that the output is on. 

 

Full cycle every This is the length of the complete cycle. 

 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Variable Duty Cycle 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock produces an output that cycles on and off according to the length of 
time you define for the cycle and the value of the microblock's input, which indicates 
the percentage of the cycle time the output should be on.  

The microblock only cycles the output when the input value is greater than zero. If the 
input is zero, the output remains off. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Period This is the length of the complete cycle. 

 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Delay On Make 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock provides a delay before passing an on signal to the next microblock. 

When the microblock receives an on signal, its output remains off until the delay time 
has passed. The delay time applies only to an on signal. Once the input turns off, the 
output turns off immediately. If the input turns off before the delay period passes, the 
output does not turn on. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Delay Enter the amount of time for the delay. Maximum delay is 09:06:00. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Delay On Break 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock provides a delay before passing an off signal to the next microblock.  

When the microblock receives an off signal, its output remains on until the delay time 
has passed. The delay time applies only to an off signal. Once the input turns on, the 
output turns on immediately. If the input turns on before the delay period passes, the 
output does not turn off. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Delay Enter the amount of time for the delay. Maximum delay is 09:06:00. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Maximum On Timer 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock limits the amount of time a signal remains on.  

When the microblock's input turns on, the microblock turns its output on for a 
specified amount of time. When the time expires, the output turns off. If the input 
turns off before this time expires, the output turns off immediately. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Duration This is the maximum amount of time the microblock's output stays on. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Minimum On/Off Timer 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
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What it does This microblock defines the minimum amount of time that a signal should remain on 
or off.  

For example, this microblock can be used to prevent an on/off signal from rapid 
fluctuations that could affect equipment performance. 

When the microblock receives an on signal, the output turns on and remains on for 
the amount of time defined in the Minimum on time field. When this time expires, the 
output either remains on if the input is on, or turns off if the input is off. Likewise, 
when the microblock receives an off signal, the output turns off and remains off for 
the amount of time defined in the Minimum off time field. When this time expires, the 
microblock's output either remains off if the input is off, or turns on if the input is on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Latch 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock turns the output on when clear is off and it detects an input 
transition from off to on.  

If the clr input is on, the output will always be off. If the clr input is off, then a 
transition of the latch input from off to on will cause the output to turn on and remain 
on until the clr input is turned on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Toggle 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock toggles its output value when its input turns on.  

For example, when the toggle input turns on, the output turns on and remains on 
when the input turns off again. When the input turns back on, the output toggles off. 
When the clr input turns on, the output turns off or remains off if it is off already. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 376 

 

Lead/Standby 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 

   

What it does This microblock is used to control two devices, where one device is a standby 
(backup) to the other. It is commonly used to control critical devices, such as two 
pumps in parallel, because it will automatically turn on the standby device if the lead 
device fails. 

Swap outputs based on runtime 
On start-up, output o1 is the lead output. It turns on and off as the go input turns on 
and off. An internal runtime counter controls how long o1 remains as the lead output. 
When the counter expires, output o2 becomes the lead and turns on and off as the 
go input turns on and off. Output o1 then becomes the standby. This restarts the 
runtime counter. When the new runtime expires, o1 again becomes the lead and o2 
becomes the standby. When go turns off, both outputs turn off without switching the 
lead and standby designation. 

Swap outputs when inputs swap 
The lead and standby outputs can also be switched by sending an on signal to the 
swap input. The outputs are not affected when swap turns off again. They remain 
switched until another event, such as an on signal to the swap input, causes them to 
switch again. You should only send a pulse signal to the swap input because leaving 
swap on prevents the microblock from responding to alarm inputs. 

Swap outputs based on alarm inputs 
These inputs signal a device failure and would switch operation to the standby 
device. For example, on a pump failure, the lead pump would turn off and the 
standby pump would turn on. 

The 2 alarm inputs, a1 and a2, correspond to the outputs o1 and o2. If o1 turns on 
but the device controlled by o1 fails to start, external control logic (not internal to 
microblock) should send an alarm signal to a1, causing the microblock to turn on o2 
and turn off o1. Similarly, if o2 is on and a2 turns on, the microblock turns on o1 and 
turns off o2. 

Show lead status  
The output lstat indicates the status of the output currently designated as the lead. 
During normal operations, lstat remains on as long as the go input is on, even as the 
lead output switches between o1 and o2. If o1 is the lead and an alarm on a1 causes 
the output to switch to o2, lstat turns off because the lead output is no longer turned 
on. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program  

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Swap based on runtime? 

Swap lead output after __ 
hours 

If you want the standby output to become the lead based on runtime, check Swap 
based on runtime. In Swap lead output after __ hrs, set when the lead output's runtime 
expires. You can determine the starting runtime value using the Preset runtime value 
setting on the Properties page. 

For example, if the Preset runtime value is 100, and the Swap lead output after __ hrs 
setting is 150, the lead output becomes the standby output after 50 hours have 
passed (150 hours - 100 hours preset = 50 hours). Once the Preset runtime value is 
used, the Latch in preset value now property on the Properties page automatically 
changes to N. You must change this property back to Y to use the Preset runtime value 
again. 

NOTE  If you manually swap using the input, the swap timer will be reset. 

 TIP  If you need to have at least one of the outputs on at all times, you may want 
to use Delay on Break microblocks on the outputs to account for the possibility of lag 
time when the outputs are swapped. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 
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Switch - Normally Closed to Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 

   

What it does This microblock switches the microblock's output between a numeric input and a 
constant value. 

The microblock's output equals the numeric input unless the sw input is on. When the 
sw input is on, the output equals the constant value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant The value the microblock outputs if the sw input is on (true). 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Switch - Normally Closed to Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 

   

What it does This microblock switches the microblock's output between a numeric input and a 
constant value. 

The microblock's output equals the constant value unless the sw input is on. When 
the sw input is on, the output equals the numeric input's value. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant The value the microblock outputs if the sw input is off (false). 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Switch 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 

   

What it does This microblock switches the microblock's output value between two numeric inputs.  

The microblock's output equals the first numeric input unless the sw input is on. 
When the sw input is on, the output equals the second numeric input. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Digital Wire Lock 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock can lock a signal so that it remains on or off regardless of the input 
signal.  

You can assign a Name to the lock that appears on the Properties page. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Enable  Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Locked Value Set the value of the microblock's output. 

 

Dated The lock is effective only for the time indicated by the Begin and End fields. 

 

Begin Set the beginning date and time of the lock. 

End Set the ending date and time of the lock. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  
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Analog Wire Lock 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Relay microblocks (page 366) 

Icon and symbol 
   

What it does This microblock can lock a specified value so that it remains the same regardless of 
the input signal.  

You can assign a Name to the lock that appears on the Properties page. You can use 
any characters (including spaces) in this field, except for the " character. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Lock Present Value 
 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Enable  Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Locked Value Set the value of the microblock's output. 

 

Dated The lock is effective only for the time indicated by the Begin and End fields. 

 

Begin Set the beginning date and time of the lock. 

End Set the ending date and time of the lock. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Logic microblocks 

Logic microblocks perform logical operations on their inputs. Often these microblocks determine the conditions 
that trigger equipment starts, stops, or alarms. 
  

 And - 2 Input (page 384) 

This microblock accepts 2 on or off (digital) signals. If both inputs are on, the output is on. If either 
of the 2 inputs is off, the output is off. 

 And - 3 Input (page 385) 

This microblock accepts 3 on or off (digital) signals. If all the inputs are on, the output is on. If any of 
the 3 inputs is off, the output is off. 

 And - 4 Input (page 386) 

This microblock accepts 4 on or off (digital) signals. If all the inputs are on, the output is on. If any of 
the 4 inputs is off, the output is off. 
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 And - 5 Input (page 386) 

This microblock accepts 5 on or off (digital) signals. If all the inputs are on, the output is on. If any of 
the 5 inputs is off, the output is off. 

 Or - 2 Input (page 387) 

This microblock accepts 2 on or off (digital) signals. If either or both of the inputs are on, the 
microblock's output turns on. If neither of the 2 inputs are on, the microblock's output turns off. 

 Or - 3 Input (page 388) 

This microblock accepts 3 on or off (digital) signals. If any of the 3 inputs are on, the microblock's 
output turns on. If none of the inputs are on, the microblock's output turns off. 

 Or - 4 Input (page 389) 

This microblock accepts 4 on or off (digital) signals. If any of the 4 inputs are on, the microblock's 
output turns on. If none of the inputs are on, the microblock's output turns off. 

 Or - 5 Input (page 389) 

This microblock accepts 5 on or off (digital) signals. If any of the 5 inputs are on, the microblock's 
output turns on. If none of the inputs are on, the microblock's output turns off. 

 Exclusive Or (XOR) (page 390) 

This microblock accepts two on or off (digital) signals. If either of the two inputs are on (but not 
both), the microblock's output turns on. If none of the inputs are on, or if both of the inputs are on, 
the microblock's output turns off. 

 Not (page 391) 

This microblock produces an output opposite of its input. 

 

 
 

And - 2 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 
   

What it does This microblock accepts 2 on or off (digital) signals. If both inputs are on, the output 
is on. If either of the 2 inputs is off, the output is off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 
 

And - 3 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 
   

What it does This microblock accepts 3 on or off (digital) signals. If all the inputs are on, the output 
is on. If any of the 3 inputs is off, the output is off. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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And - 4 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 

   

What it does This microblock accepts 4 on or off (digital) signals. If all the inputs are on, the output 
is on. If any of the 4 inputs is off, the output is off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

And - 5 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383)  

Icon and symbol 

   

What it does This microblock accepts 5 on or off (digital) signals. If all the inputs are on, the output 
is on. If any of the 5 inputs is off, the output is off. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Or - 2 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 
   

What it does This microblock accepts 2 on or off (digital) signals. If either or both of the inputs are 
on, the microblock's output turns on. If neither of the 2 inputs are on, the 
microblock's output turns off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Or - 3 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 
   

What it does This microblock accepts 3 on or off (digital) signals. If any of the 3 inputs are on, the 
microblock's output turns on. If none of the inputs are on, the microblock's output 
turns off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Or - 4 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 

   

What it does This microblock accepts 4 on or off (digital) signals. If any of the 4 inputs are on, the 
microblock's output turns on. If none of the inputs are on, the microblock's output 
turns off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Or - 5 Input 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 

   

What it does This microblock accepts 5 on or off (digital) signals. If any of the 5 inputs are on, the 
microblock's output turns on. If none of the inputs are on, the microblock's output 
turns off. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Exclusive Or (XOR) 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol 
   

What it does This microblock accepts two on or off (digital) signals. If either of the two inputs are 
on (but not both), the microblock's output turns on. If none of the inputs are on, or if 
both of the inputs are on, the microblock's output turns off. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Not 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Logic microblocks (page 383) 

Icon and symbol    

What it does This microblock produces an output opposite of its input.  

For example, when the microblock's input is on, the output is off. When the input is 
off, the output is on. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Math 1 microblocks 

Math 1 microblocks perform simple mathematical operations on their inputs.  
  

 Add Constant to Variable (page 393) 

This microblock adds its input value to the Constant value. The microblock's output is the result of 
this calculation. 

 Subtract Constant from Variable (page 394) 

This microblock subtracts the Constant value from its input value. The microblock's output is the 
result of this calculation. 

 Multiply Variable Times Constant (page 395) 

This microblock multiplies its input value by the Constant value. The microblock's output is the 
result of this calculation. 

 Divide Variable by Constant (page 396) 

This microblock divides its input value by the Constant value. The microblock's output is the result 
of this calculation. 

 Modulo Divide by Constant (page 397) 

This microblock divides its input value by the Constant value. The microblock's output is equal to 
the remainder of this calculation.  

 Add 2 Variables (page 398) 

This microblock adds the values of its inputs. The microblock's output is the result of this 
calculation. 

 Add 3 Variables (page 399) 

This microblock adds the values of its inputs. The microblock's output is the result of this 
calculation. 

 Add 4 Variables (page 399) 

This microblock adds the values of its inputs. The microblock's output is the result of this 
calculation. 

 Subtract Two Variables (page 400) 

This microblock subtracts the value of its second input from the value of its first input. The 
microblock's output is the result of this calculation. 

 Multiply Two Variables (page 401) 

This microblock multiplies the values of its two inputs together. The microblock's output is the result 
of this calculation. 

 Divide Two Variables (page 401) 

This microblock divides the value of its first input by the value of its second input. The microblock's 
output is the result of this calculation. 

 Modulus (page 402) 

This microblock divides the value of its first input by the value of its second input. The microblock's 
output equals the remainder of this calculation. 

 Average (page 403) 

This microblock calculates the average of its two inputs. 
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 Change Sign (page 404) 

This microblock changes the sign of its input value by multiplying the value by -1. 

 Absolute Value (page 404) 

This microblock determines the absolute value of its input by removing its sign. 

  

 
 

Add Constant to Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock adds its input value to the Constant value. The microblock's output is 
the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant Perform the microblock's mathematical function using the input and this value. 
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Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Subtract Constant from Variable 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock subtracts the Constant value from its input value. The microblock's 
output is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Constant Perform the microblock's mathematical function using the input and this value. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Multiply Variable Times Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock multiplies its input value by the Constant value. The microblock's 
output is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Constant Perform the microblock's mathematical function using the input and this value. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Divide Variable by Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock divides its input value by the Constant value. The microblock's output 
is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 
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Constant Perform the microblock's mathematical function using the input and this value. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Modulo Divide by Constant 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock divides its input value by the Constant value. The microblock's output 
is equal to the remainder of this calculation.  

For example, if the microblock's input is 10 and the Constant is 3, the microblock's 
output is 1. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Constant Perform the microblock's mathematical function using the input and this value. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Add 2 Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock adds the values of its inputs. The microblock's output is the result of 
this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Add 3 Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock adds the values of its inputs. The microblock's output is the result of 
this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Add 4 Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 

   

What it does This microblock adds the values of its inputs. The microblock's output is the result of 
this calculation. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Subtract Two Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock subtracts the value of its second input from the value of its first 
input. The microblock's output is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Multiply Two Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock multiplies the values of its two inputs together. The microblock's 
output is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Divide Two Variables 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock divides the value of its first input by the value of its second input. The 
microblock's output is the result of this calculation. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Modulus 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock divides the value of its first input by the value of its second input. The 
microblock's output equals the remainder of this calculation.  

For example, if the microblock's first input is ten, and the second input is three, the 
microblock's output is the remainder of 10/3, or 1. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Average 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol 
   

What it does This microblock calculates the average of its two inputs.  

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Change Sign 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol    

What it does This microblock changes the sign of its input value by multiplying the value by -1.  

For example, if the microblock's input value is -32, the output value is 32. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Absolute Value 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 1 microblocks (page 392) 

Icon and symbol    

What it does This microblock determines the absolute value of its input by removing its sign.  

For example, if the microblock's input is -10, the output is 10. If the microblock's 
input is 8, the output is 8. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Math 2 microblocks 

Math 2 microblocks perform advanced and trigonometric mathematical operations on their inputs.  
  

 Sine (page 406) 

A Sine microblock accepts a value in degrees and calculates the sine of this value. The microblock's 
output is the result of this calculation. 

 Cosine (page 407) 

A Cosine microblock accepts a value in degrees and calculates the cosine of this value. The 
microblock's output is the result of this calculation. 

 Tangent (page 407) 

A Tangent microblock accepts a value in degrees and calculates the tangent of this value. The 
microblock's output is the result of this calculation. 

 Natural Log (page 408) 

A Natural Log microblock calculates the natural logarithm of its input. The microblock's output is the 
result of this calculation. 

 Log (page 408) 

A Log microblock calculates the base 10 logarithm of its input. The microblock's output is the result 
of this calculation. 

 Exponent (page 409) 

An Exponent microblock raises the value of its second input to the power of its first input. The 
microblock's output is the result of this calculation. 

 Square Root (page 410) 

A Square Root microblock calculates the square root of its input value. The microblock's output is 
the result of this calculation. 
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 Integrator (page 411) 

An Integrator microblock calculates a value over time (minutes or hours) at the rate (units/minute 
or units/hour) you select in the Snap application. 

 Round Up/Down (page 413) 

A Round Up/Down microblock rounds the input value up or down and produces a whole number. 

 Truncate (page 413) 

A Truncate microblock discards the fractional portion of its input and provides a whole number 
output. 

 

 
 

Sine 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Sine microblock accepts a value in degrees and calculates the sine of this value. 
The microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Cosine 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks  (page 405) 

Icon and symbol    

What it does A Cosine microblock accepts a value in degrees and calculates the cosine of this 
value. The microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Tangent 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Tangent microblock accepts a value in degrees and calculates the tangent of this 
value. The microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  
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• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Natural Log 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Natural Log microblock calculates the natural logarithm of its input. The 
microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Log 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
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Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Log microblock calculates the base 10 logarithm of its input. The microblock's 
output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Exponent 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol 
   

What it does An Exponent microblock raises the value of its second input to the power of its first 
input. The microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Square Root 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Square Root microblock calculates the square root of its input value. The 
microblock's output is the result of this calculation. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Integrator 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol 
   

What it does An Integrator microblock calculates a value over time (minutes or hours) at the rate 
(units/minute or units/hour) you select in the Snap application. 

For example, if the microblock's input value is constant at 10, and the selected rate is 
units per hour, the microblock's output increases at a rate of 10 per hour. If the 
microblock’s input value is constant at 10 and the selected rate is units per minute, 
the microblock’s output increases at a rate of 10 per minute. At the end of the first 
hour, the output value is 10; at the end of the second hour, the output is 20, and so 
on. When the clr input turns on, the microblock's output value is reset to zero. 

 
 

How it works 
The microblock accumulates the wire input value at every execution of the control program. If the selected rate is 
once per minute, on a one minute interval the microblock divides the total accumulated input by the number of 
executions during that minute, then increases the wire output value by the average input value for the minute. If 
the selected rate is once per hour, the microblock increases the output value every minute by 1/60th of the 
averaged input value for the minute. 

 

 
 

Limitations 
In drivers 4.x or later, the integrator microblock retains its output magnitude through a power loss, controller reset, 
or controller restart. You can reset the microblock’s output value to zero using a "true" value on the clr input, or by 
downloading to the controller. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 
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Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the actual 
privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always desirable. 

Display resolution The microblock's value is truncated and incrementally updated as follows:  

The Display resolution format is used to truncate the microblock’s actual value. For 
example, if you enter a value from: 
• 0.1 to 0.9, the system displays 1 digit to the right of the decimal 
• 0.01 to 0.99, the system displays 2 digits to the right of the decimal 
• 1 or greater, the system displays a whole number 
The Display resolution value determines the increment by which the displayed value 
is updated. For example, if you enter: 
• .2, the system displays 8.4, 8.6, 8.8, ... 
• .03, the system displays 5.09, 5.12, 5.15, ... 
• 10, the system displays 30, 40, 50, ... 

Rate Select the accumulation rate that this microblock is to use. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 
 

Tips and tricks 

Metering 
You can use the integrator microblock in combination with a peak recorder to accumulate and record meter 
demand and consumption at regular intervals. The example below records hourly accumulation. 
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Round Up/Down 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Round Up/Down microblock rounds the input value up or down and produces a 
whole number.  

If the fraction of the input value is less than 0.5, the microblock rounds the number 
down to the next whole number. If the fraction of the input is 0.5 or greater, the 
microblock rounds the number up to the next whole number. 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Truncate 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Math 2 microblocks (page 405) 

Icon and symbol    

What it does A Truncate microblock discards the fractional portion of its input and provides a 
whole number output. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

 

 
 

Misc microblocks 
  

  DO/DI Proof (page 415) 

A DO/DI Proof microblock verifies proper equipment operation by comparing the status of a digital 
input with the status of a corresponding digital output. 

 Up/Down Counter (page 416) 

An Up/Down Counter microblock counts the number of on signals it receives and produces a 
number that increases or decreases according to the input receiving the signal. 

 Text (page 417) 

A Text microblock allows you to place and format descriptive text on the Properties page. 

 Version (page 419) 

A Version microblock allows you to attach a fixed version number to a control program. 

 Sunrise/Sunset (page 420) 

A Sunrise/Sunset microblock calculates the time the sun will rise and set based on location and 
time zone information entered in the Snap application or on the Properties page. 

 OCL (page 422) (Operator's Control Language) 

OCL allows you to create your own microblock when no other microblock suits your application. You 
define the microblock's inputs, outputs, and internal calculations. 
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DO/DI Proof 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol 

   

What it does A DO/DI Proof microblock verifies proper equipment operation by comparing the 
status of a digital input with the status of a corresponding digital output.  

For example, the microblock can compare an input indicating the fan's on or off 
status with the output that turns the fan on or off. If the two inputs do not receive the 
same signal, the DO/DI Proof microblock provides two outputs that can be used to 
trigger alarms. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege 
 

Preset - Each microblock property has an appropriate privilege or role assigned to it. 
You can use Global Modify (page 50) in the i-Vu® interface to find out what the 
actual privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always 
desirable. 

Feedback Delay You can set an allowable delay between the time a digital output turns on and the 
time the digital input registers the new status. When the microblock's do input turns 
on, if the di input does not turn on by the time the feedback delay time expires, the 
alrm output turns on. 

Debounce Time The Debounce time setting is the amount of time that the di input must remain on or 
off before it is considered valid. The Debounce time should not be longer than the 
feedback delay; otherwise, an alarm will be generated each time the equipment 
starts. 
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Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Up/Down Counter 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol 

   

What it does An Up/Down Counter microblock counts the number of on signals it receives and 
produces a number that increases or decreases according to the input receiving the 
signal. 

Each time the inc input turns on, the output value increases by one. Each time the dec 
input turns on, the output value decreases by one (but does not fall below zero). 
When the clr input turns on, the output value resets to zero. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 
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Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Text 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol    

What it does A Text microblock allows you to place and format descriptive text on the Properties 
page.  

The text is entered and edited in the Snap application and cannot be edited on the 
Properties page. 

You can select types of text, line separators, or controls for expanding and collapsing 
sections. You may also hide sections of the Properties page by setting conditions. This 
lets you format the layout of the Properties page. You can control the position of the 
text and the nesting order of the formatting on the Properties page by placing the Text 
microblocks in the correct sequence as you design the control program, or by 
selecting Reorder > Edit Order. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Type Select one of the following options: 

Plain For creating plain text. 

Separator To create a horizontal line on the Properties page, often used to offset or group 
information, choose Separator as the Text Type. If you would like text to appear on the 
separator line, type the text in the Property Page Text field. 



Microblock reference 
 

i-Vu® Standard/Plus v6.5 Carrier Proprietary and Confidential CARRIER CORPORATION ©2016   
Help  All rights reserved 
 418 

 

Bold For creating bold text. 

Expand Begin Closed 

Expand Begin Opened  

Expand End 

To format a section using expanded formatting, first insert a Text microblock with the 
Text Type set as Expand Begin Closed or Expand Begin Opened, depending on how you 
want the area to display when first viewed. If you would like text to appear on your 
expandable line, type the text in the Property Page Text field. 

 
You must also insert a Text microblock with the Text Type set as Expand End at the end 
of the section you wish to group together. 

Table Begin 

Table End 
To align data in a table, insert a Text microblock with the Text Type set as Table Begin. 
To complete the table, insert a Text microblock with the Text Type set as Table End 
after the last item you want to include in the table. 

 
NOTE  When working with a table within an expanded section, make sure the table 
begins after the Expand Begin and ends before the Expand End. 

Conditional Hide Begin 

Conditional Hide End 
You can hide part of the Properties page based on a value from a specific 
microblock. For example, you can specify that the Properties page text from an Analog 
Input microblock will only appear on the Properties page if the value is above 85. 
The expression is evaluated relative to the entire control program, not at that 
particular microblock. 

Place a Text microblock with the Text Type set as Conditional Hide Begin before the 
microblock to be evaluated and another set to Conditional Hide End after it. Type a 
conditional expression in the Properties Page Text field of the Text microblock. 
Microblock properties may be referenced between the dollar signs ($), and the 
expression must be Boolean. For example, to show the microblock Properties page 
text only when the present value of the point named Zone Temp is greater than 85, 
the expression would be "$Zone_Temp/present_value$ >85". 

NOTES   

• When referring to the name of a point, use the RefName rather than the Display 
Name. 

• Technical Support does not provide assistance with writing and editing 
Javascript. See Javascript textbooks, available in most bookstores, for help with 
Javascript. 

 TIP  If you are adding the Conditional Hide formatting after the control program 
has been designed or would prefer to group all of the Text microblocks within the 
control program, use the Reorder menu to correctly place the Text microblocks. 
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Important Begin 

Important End 

These options are currently not used. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 

 
 

To correctly order Begin/End Text microblocks 
When adding Text microblocks in the Snap application that have a Begin or End text type, you must define the 
correct order for the microblocks so that the text appears correctly on a Properties page. Each Begin microblock 
must be followed by an End microblock, and you can have a set of Begin/End microblocks inside of another set of 
Begin/End microblocks. The initial order of the Properties page text is the order in which you add microblocks to 
the workspace. Moving the microblocks will not correct the Properties page order. If the microblocks are outlined 
in yellow, your Begin/End microblocks are out of order. In the example below, the order of the first and fourth 
microblocks are reversed. 
  

  
  

To correct the order, you can either change the microblocks' Type selection in the Property Editor, or select 
Reorder > Edit Order.  
 

Version 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol    
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What it does A Version microblock allows you to attach a fixed version number to a control 
program. 

This number appears only on the face of the microblock and on the Properties page of 
the device where the control program resides. The Version number can only be 
changed on the microblock dialog. The Version microblock does not interact with any 
other microblock in the control program and does not have any corresponding 
Properties page text. 

 

 
 

Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Version Type a version number for the control program. 

 

 
 

Sunrise/Sunset 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol 

   

What it does A Sunrise/Sunset microblock calculates the time the sun will rise and set based on 
location and time zone information entered in the Snap application or on the 
Properties page. 

The sunrise and sunset outputs produce today's sunrise and sunset times. The 
output values are in minutes since midnight. The daylight output turns on when the 
current time falls between sunrise and sunset and turns off when the current time is 
before sunrise or after sunset. 
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Properties 

 TIPS 

• Alt+click any value in the i-Vu® or Field Assistant interface to view property details, including its editing 
privilege and expression (location path) for use on graphics.  

• You can right-click some properties in the Snap Property Editor and select Make editable or Make read-only 
to determine that property's functionality in your system. 

 

Reference Name Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Editing Privilege Preset - Each microblock property has an appropriate privilege or role assigned to 
it. You can use Global Modify (page 50) in the i-Vu® interface to find out what the 
actual privilege is. 

 CAUTION  If you change the Editing Privilege from Preset, the privilege you 
select will be used for all properties of this microblock, which is not always 
desirable. 

Latitude/Longitude 
Degrees/Minutes Enter settings accurately to ensure that the correct sunrise and sunset times are 

calculated. See an atlas or your local weather station to determine this 
information for your area. Enter the longitude for a location in the Western 
Hemisphere (North or South America) as a negative number. 

 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

 

 
 

Simulation 
Define the value(s) the microblock will use when you simulate the control program. 

NOTE  The Latitude and Longitude settings on the General tab have no effect on simulation. 
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OCL (Operator's Control Language) 

  The information below provides a FULL description of this microblock and all of its properties. What 
information you see and what you can do with it depends on your license and the application you are in. 
  

Microblock family Misc microblocks (page 414) 

Icon and symbol 
   

What it does OCL allows you to create your own microblock when no other microblock suits your 
application. You define the microblock's inputs, outputs, and internal calculations. 

Although the OCL has great flexibility, you should not put an entire control program 
into one microblock. Break it into smaller sections, using wires and other 
microblocks. You will be able to easily see the components of the control program, 
making it easier to troubleshoot. 

 

 
 

To create an OCL microblock 
1 In the Snap application, click the OCL microblock icon in the Misc microblock menu. 

2 Click in the workspace where you want to place the microblock. 

The OCL microblock first appears as a blank gray microblock. After you define it's title, inputs, and outputs, 
the microblock will show these. 

3 In the Property Editor, type the variable declaration section (page 423).  

4 Press Enter to add a blank line. 

5 Type the programming sequence that the OCL microblock will execute. Use the following: 
• Information from the variable declaration section (page 423) 
• Predefined symbols (page 425) 
• System variables (page 426) 
• Special characters (page 426) 
• Functions (page 427) 
• Structures (page 431) 

  
NOTES   

• The OCL program is not case-sensitive. 

• A red box around the microblock indicates the program contains errors. The Property Editor turns the 
program's text red, displays a description of the error below the program's text, and highlights the line 
containing the error.  

• The outputs of an OCL program are updated only at the end of the program execution, essentially at the 
"EXITPROG" line. Changes calculated during a program loop will not be output until the execution exits the 
loop and reaches the end of the program. 
  

 TIP  To use your programmed OCL microblock in more than one control program, right-click the microblock, 
then select Add to Favorites. 
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Sample program 

 
 

 
 

Variable declaration section 
In this section, you define the microblock's: 
• Title 
• Inputs and outputs 
• Variables used in the OCL program 
• Text that appears on the Properties pages 
In the variable declaration section of your OCL program, add the following terms that will be used by the 
microblock. Type each term in upper or lower case letters, and add at least one space after the term.  Do not 
create a variable using the same name as any of the predefined symbols, functions, or commands.  
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Term Notes 

AINPUT Defines the microblock's analog inputs. Each input's name must begin with a letter and 
be no more than 32 characters (only the first 4 appear on the microblock). Separate 
multiple names with a comma. 

EXAMPLE 
AINPUT TMP1,CUR5,ENT3 

This line creates 3 analog inputs for the microblock named TMP1, CUR5, and ENT3. 

AOUTPUT Defines the microblock's analog outputs. Each output's name must begin with a letter 
and be no more than 32 characters (only the first 4 appear on the microblock). 
Separate multiple names with a comma. 

EXAMPLE 
AOUTPUT COIL,POWR,HEAT 

This line creates 3 analog outputs for the microblock named COIL, POWR, and HEAT. 

DINPUT Defines the microblock's digital inputs. Each input's name must begin with a letter and 
be no more than 32 characters (only the first 4 appear on the microblock). Separate 
multiple names with a comma. 

EXAMPLE 
DINPUT STA1,PMP2 

This line creates 2 digital inputs for the microblock named STA1 and PMP2. 

DOUTPUT Defines the microblock's digital outputs. Each output's name must begin with a letter 
and be no more than 32 characters (only the first 4 appear on the microblock). 
Separate multiple names with a comma. 

EXAMPLE 
DOUTPUT SEC7,LIG2 

This line creates 2 digital outputs for the microblock named SEC7 and LIG2. 

PAR Defines variables that are used in the OCL program, and if necessary, the text for these 
variables that appears on the Properties page. A variable can be any letter or letter 
combination as long as it is not already used by OCL.  

If the variable appears on the Properties page, type the Properties page text after the 
variable and in quotation marks. To display the value of the property, type the 
expression between $ signs. 

 TIP  To display the variable's value on the Properties page but not have the value 
be an editable field, set the editable property to false.  

EXAMPLE 
PAR E = 2.71 "E equals $E$", X = 5.0  
"$X:editable="false"$"  

OCL assigns the variable E to 2.71 and X to 5.0. The Properties page will display the text 
"E equals 2.71", with the "2.71" as an editable field. The  Properties page will also show 
"X equals 5.0", but the value "5.0" will not be editable.  

TIMER Defines timing variables. Similar to the VAR declaration, type a variable name, text in 
quotation marks, and an expression between $ signs to display the variable's present 
value.  

EXAMPLE 
TIMER T2 "Time remaining for Timer2 = $T2$ (mm:ss)"  

OCL displays the given text on the Properties page along with the present value of T2.  
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Term Notes 

TITLE 

 

Defines the microblock's title that appears on the microblock's face. The title will not 
appear if no inputs or outputs are defined. The title can be up to 8 characters.  

EXAMPLE 
TITLE ICEPLANT  

OCL assigns the name "ICEPLANT" to the microblock.  

VAR 

 

Defines variables that are used in the OCL program, and if necessary, the text for these 
variables that appears on the Properties page. A variable can be any letter or letter 
combination as long as it is not already used in the variable declaration section or by 
OCL. If the variable appears on the Properties page, type the Properties page text after 
the variable and in quotation marks. To display the value of the variable, type the 
expression between $ signs.  

EXAMPLE 
VAR Z "Z equals $Z$"  

OCL displays the text "Z equals" followed by the present value of Z.  

 

 
 

Predefined symbols 
OCL predefined symbols are terms that already have an assigned value. You can use these terms in the OCL 
program. You cannot change a symbol's value. Do not list these terms in the variable declaration section. 
  

Symbol Value Symbol Value 

GRAY 1 JAN 1 

HRED 2 FEB 2 

KBLUE 3 MAR 3 

LTBLUE 4 APR 4 

GREEN 5 MAY 5 

SPECKLE 6 JUN 6 

YELLOW 7 JUL 7 

ORANGE 8 AUG 8 

CRED 9 SEP 9 

WHITE 10 OCT 10 

TRUE 1 NOV 11 

FALSE 0 DEC 12 

ON 1 MON 1 

OFF 0 TUE 2 

OCC 1 WED 3 

UNOCC 0 THU 4 

OCCUPIED 1 FRI 5 
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Symbol Value Symbol Value 

UNOCCUPIED 0 SAT 6 

YES 1 SUN 7 

NO 0   

 

 
 

System variables 
You can use the following system variables in your OCL program to read information from the control program. 
Each variable produces a number corresponding to the variable's current value in the control program. 
  

System variable Notes 

COLOR Control program's current color (1-10) 

MDAY  Current day of the month (1-31) 

MONTH Current month (1-12) 

TIME Current time (0-1439; in minutes since midnight) 

WKDAY Current day of the week (Monday=1, Sunday=7) 

YDAY Current day of the year (1-366) 

YEAR Current year (1981-2040) 

 

 
 

Special characters 
You can use the following special characters in your OCL program. 
  

Character Use to... 

( ) Use to override order of evaluation in an expression, delineate arguments in function 
calls, and to specify a conditional expression. 

, (comma) Use to separate arguments in function calls. 

: (colon)  Use to identify labels referenced by GOSUB and GOTO keywords. 

// Use to place comments in the program. Any text following 2 slashes is ignored by the 
OCL compiler. 

H Use to represent one hour, or 3600 seconds. 

M Use to represent one minute, or 60 seconds. 

S Reserved but has no effect. The default time unit is seconds. 
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Mathematical functions 
You can use the following mathematical and logical functions in your OCL program. Each of these functions acts 
on a value or set of values in parenthesis following the name of the function. These functions can act on numbers, 
variables, or expressions to calculate the results. 
  

Function Notes 

ABS Returns the absolute value of the number, variable, or expression in parenthesis.  

EXAMPLE 
X = -10  
Y = ABS(X)  
Z = ABS(5+3)  

In this example, OCL assigns Y to 10, because the absolute value of X equals 10. OCL 
assigns Z to 8, because the absolute value of 5+3 equals 8.  

AVG Returns the average of a set of values.  

EXAMPLE 
XAN = 5  
BETA = AVG(1,4,XAN,9)  

In this example, OCL assigns BETA to 4.75. 

BETWEEN Evaluates the 3 values in parentheses and determines whether the first value falls 
between the second and third values. If the first value does fall between the second 
and third values, the function returns a value of 1.0. If not, the between function returns 
a value of 0.0.  

EXAMPLE 
STAT1 = BETWEEN(17,15,20)  
BETA = 2  
STAT2 = BETWEEN(BETA,3,5)  

In this example, OCL assigns the value of STAT1 to 1.0, since 17 falls between 15 and 
20. OCL assigns the value of STAT2 to 0.0, since BETA (which has a value of 2) is not 
between 3 and 5.  

COS Computes the cosine of the value (in degrees) in parentheses.  

EXAMPLE 
VAL = COS(45)  

In this example, OCL assigns the value of VAL to 0.707.  

DELON Calculates whether a variable or expression has been on or true for the amount of time 
specified. The time must be specified as a number, variable, or expression.  

EXAMPLE 
STAGE1 = DELON(GAS, 1:00)  

This example turns on the variable STAGE1 after the variable GAS has been on for 1 
minute.  

EXAMPLE 
STAGE2 = DELON(FLOW1 > 125, 5 H)  

This example turns on the variable STAGE2 after the value of the variable FLOW1 has 
been greater than 125 for 5 hours.  
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Function Notes 

LMT Limits a value based on the high and low limits specified. This function requires 3 
values: the first value is the value to be limited, the second value is the low limit, and 
the third value is the high limit. Each of the values can be a number, a variable, or an 
expression. If the first value falls between the low and high limits, the value is 
unchanged. If the first value is lower than the low limit, the low limit becomes the 
function’s value. If the first value is higher than the high limit, the high limit becomes 
the function’s value. 

EXAMPLE 
ZETA1 = 3 
ZETA2 = LMT(ZETA1, 5, 10) 

In this example, ZETA2 = 5, since the value of ZETA1 (which is 3) is less than the low 
limit of 5.  

LN Calculates the natural logarithm of the indicated value.  

EXAMPLE 
Y = LN(134)  

In this example, OCL sets Y equal to 4.8978.  

LOG 

 

Calculates the base 10 logarithm of the indicated value.  

EXAMPLE 
X = LOG(134)  

In this example, OCL sets X equal to 2.1271  

MAX Determines the larger number from a set of 2 numbers, variables, constants, or 
expressions.  

EXAMPLE 
SIGMA = 7  
GAMMA = MAX(SIGMA,10)  

In this example, OCL sets GAMMA equal to 10, since 10 is larger than SIGMA (which is 
set to 7).  

MIN Determines the smaller number from a set of 2 numbers, variables, constants, or 
expressions.  

EXAMPLE 
X = 2  
RHO = MIN(1+X,4)  

In this example, OCL sets RHO equal to 3, since 1+X (when X = 2) is less than 4.  

POW Calculates the first value raised to the power of the second value.  

EXAMPLE 
CHI = POW(TAU,3)  

In this example, OCL sets CHI equal to TAU raised to the power of 3 (TAU cubed).  

RATIO Converts a value in a range to a proportionate value in a different range. The first value 
in parenthesis is the value to be converted. The next 2 values indicate the current range 
that the first value belongs in. The last 2 numbers indicate the range the value should 
be converted to.  

EXAMPLE 
N=40  
DELTA = RATIO(N, 0, 100, 3, 13)  

In this example, OCL sets DELTA to 7.  
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Function Notes 

RND Rounds the specified number to the nearest whole number.  

EXAMPLE 
KAPPA = RND(3.442)  
LAMBDA = RND(10.59)  

In this example, OCL sets KAPPA equal to 3.0 and LAMBDA equal to 11.0.  

SIN Calculates the sine of the value (in degrees) in parenthesis.  

EXAMPLE 
X = SIN(90)  

In this example, OCL sets X equal to 1.0  

SQRT Calculates the square root of the indicated value.  

EXAMPLE 
Y = SQRT(81)  

In this example, OCL sets Y equal to 9.  

START Turns on the variable or variables in parenthesis. You can use as many variables as 
necessary, separating each variable with a comma.  

EXAMPLE 
START(FAN1, PUMP4, STAGE2)  

In this example, OCL turns on the variables FAN1, PUMP4, and STAGE2. 

STOP Turns off all of the variables listed in parenthesis. You can use as many variables as 
necessary, separating each variable with a comma.  

EXAMPLE 
STOP (ALARM, LIGHT2, COMP4)  

This example turns off the variables ALARM, LIGHT2, and COMP4.  

TAN Calculates the tangent of the value (in degrees) indicated in parenthesis.  

EXAMPLE 
XI = TAN(71)  

In this example, OCL sets the variable XI equal to 2.904.  
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Function Notes 

TOF Returns the amount of time in seconds that the variable or expression in parenthesis 
has been off or false.  

WARNING  Do not put this function in a conditional section of the program. It must 
execute to calculate properly. 

EXAMPLE 

//first do things that always need to be executed 

X=TOF(COMP1) 

//then do things appropriate to the state we're in, but EXITPROG each time to check the 
state 

IF (FOO) THEN 

BEGIN 

...do something... 

IF (PUMP) THEN FOO = FALSE //if pump comes on, break out of the loop 

EXITPROG //leave, knowing you'll be right back if FOO is still true 

END 

IF (X>300) THEN... 

In this example, OCL sets X equal to the amount of time in seconds that COMP1 has 
been off, and updates that time regardless of the FOO loop.  

TON Returns the amount of time in seconds that the variable or expression in parenthesis 
has been on or true.  

 WARNING  Do not put this function in a conditional section of the program. It must 
execute to calculate properly. 

EXAMPLE 

P1_TIME = TON(PUMP1) 

P2_TIME = TON(PUMP2) 

IF (PRIMARY) THEN X=P1_TIME ELSE X=P2_TIME 

IF (X>30) = THEN START(CHILLER1)  

In this example, OCL sets P1_TIME equal to the amount of time in seconds that PUMP1 
has been running, and P2_TIME equal to the amount of time in seconds that PUMP2 
has been running.  

TRN Discards the fractional portion of the value in parenthesis.  

EXAMPLE 
WEIGHT= TRN((CREQ1 + CREQ2 + CREQ3)/3)  

In this example, OCL evaluates the equation in parenthesis and truncates the value. If 
CREQ1 equals 2, CREQ2 equals 5, and CREQ3 equals 0, the value of WEIGHT is 2.  
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Programming structures 
OCL supports several programming structures that are common to many other programming languages. 
  

Structure Notes 

BEGIN...END  Groups a number of program statements. This structure is often used to group a 
sequence of statements that should be executed when a given condition is met.  

EXAMPLE 
IF (OCC) THEN  
BEGIN  
START PUMP1  
START BOILER1  
RATE = 4 * LMT(FLOW,5,10)  
END  

In this example, OCL starts PUMP1, starts BOILER1, and calculates RATE when OCC is 
TRUE.  

DELAY Halts execution for the specified amount of time. Define the time in hours (H), minutes 
(M), or seconds (the default unit).  

EXAMPLE 
DELAY 10H  

This example stops the execution of OCL for 10 hours. 

EVERY...DO  Tells OCL to execute a program statement once every time the specified time interval 
passes. Define the time in hours (H), minutes (M), or seconds (the default unit). The 
actual amount of time can be a number or a variable.  

EXAMPLE 
EVERY 10 M DO  
A = B + AVG(C, D + E)  

This example calculates the value of the variable A every 10 minutes. 

EXITLOOP Skips the remaining portion of a WHILE...DO loop if the specified condition is met.  

EXAMPLE 
WHILE (CONTENT < 90.1) DO  
BEGIN  
IF (TLO = ON) THEN EXITLOOP  
D = D + 2  
END  

In this example, OCL continues to calculate the value of the variable D until either the 
value of CONTENT becomes greater than 90.1 or the variable TLO turns on.  

EXITPROG Ends the OCL program. Place all subroutines after the EXITPROG statement to ensure 
they are not executed inadvertently.  
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Structure Notes 

GOSUB Calls a subroutine which is referenced by a label or name. Place all subroutines after 
the EXITPROG statement to ensure they are not executed inadvertently. When the 
subroutine finishes, the RETURN statement resumes execution of the OCL program at 
the point where the subroutine was invoked.  

EXAMPLE 
IF X < 23.0 THEN GOSUB TURNON  
ELSE GOSUB TURNOFF  
EXITPROG  
TURNON:  
START (LOCK1)  
START (LOCK2)  
RETURN  
TURNOFF  
STOP (LOCK1)  
STOP (LOCK2)  
RETURN  

In this example, OCL begins the TURNON subroutine, which turns LOCK1 and LOCK2 on, 
if X is less than 23. If X is greater than 23, OCL begins the TURNOFF subroutine, which 
turns LOCK1 and LOCK2 OFF.  

GOTO Transfers execution of OCL to the designated label. The GOTO structure is not 
recommended because it creates difficulties in debugging the OCL sequence.  

EXAMPLE 
IF (PH >= 6) THEN GOTO ACID  
Y = GB - X  
GOTO LAST  
ACID:  
Y = GB + X  
LAST:  

In this example, OCL jumps to the line labeled ACID if PH is greater than or equal to 6. 
After it reaches line ACID, it sets Y equal to GB + X and proceeds to the line LAST. If PH 
is less than 6, OCL sets Y equal to GB - X and jumps to the line LAST.  

IF...THEN  Tells OCL to execute a program statement if the value of the variable or expression in 
parenthesis is TRUE.  

EXAMPLE 
IF (BOILER9) THEN X = 45  

In this example, if BOILER9 is on, OCL sets X to 45 .  

IF...THEN...ELSE  Works similarly to IF...THEN but adds an alternative statement to be executed if the 
value of the variable or expression in parenthesis is FALSE.  

EXAMPLE 
IF (HUMIDITY > 88) THEN  
DEMAND = 4  
ELSE  
DEMAND = 2  

In this example, OCL sets DEMAND equal to 4 if HUMIDITY is greater than 88; otherwise 
OCL sets DEMAND equal to 2.  
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Structure Notes 

IFONCE...THEN  Works similarly to the IF...THEN structure but executes the program statement only 
once after the value of the variable or expression in parenthesis has been determined 
to be true.  

EXAMPLE 
IFONCE(PRESSURE > 178)  
THEN START (ALARM6)  

In this example, OCL starts ALARM6 if PRESSURE becomes greater than 178.  

WHILE...DO This structure tells OCL to execute a program statement provided that the value of the 
variable or expression in parenthesis is TRUE.  

EXAMPLE 
WHILE (WASTETIME>150) DO  
WASTETIME = WASTETIME - 1  

NOTE  The WHILE...DO function is provided to support existing OCL programs, but we 
recommend that you do not use it in new programs.  In some cases, each WHILE...DO 
loop can add up to a 100 msec delay. Ten WHILE...DO loops will create a 1 second 
delay. This delay affects all programs within the controller, not just the OCL program. 
Also, OCL output values will not update until the "While" condition is no longer true and 
the program exits the WHILE...DO loop. 

  
 

Operators 

Mathematical Operators  
+ (Add) 
-  (Subtract) 
* (Multiply) 
/  (Divide) 
NOTE  Do not use ** to raise to a power. Use the POW function instead. 
  

Logical Operators  
=  
>  
<  
>= (Greater Than or Equal To) 
<= (Less Than or Equal To) 
<> (Not Equal To) 
AND  
OR  
NOT  
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Examples 
This statement...  Will be true if... 

IF ((A1+A2=4) AND NOT (A1=A2)) THEN ANS = 1  A1=1 and A2=3 but not if A1=A2=2 

IF ((A1+A2=4) OR NOT (A1=A2)) THEN ANS = 1 A1+ A2=4 or if A1 does not equal A2 

IF (POW(A1,2)+A2=4) THEN ANS = 1 A12 + A2 = 4 

 

 
 

Retired microblocks 

The microblocks listed in the left column below have been retired from the Snap microblock menu. However, they 
are still supported by the Snap application, controllers, and the i-Vu® application. If you open a control program 
that contains one of these microblocks, you can edit properties in the microblock and copy and paste it to other 
applications if necessary.   

For applications to be used in v6.0 or later i-Vu® systems, use the microblocks in the right column below. These 
microblocks have configurable options that provide the functionality of the retired microblocks. 
  

Instead of this retired microblock... Use... 

 BACnet Zone Setpoint (page 435) BACnet Setpoint (page 288) 

 BACnet Time Clock (page 449) BACnet Time Clock with TLO and Override Status 
(page 317) 

 BACnet Time Clock with TLO (page 451) BACnet Time Clock with TLO and Override Status 
(page 317) 
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BACnet Zone Setpoint 
 
Microblock family Control (page 287) 

Icon and symbol 

   

NOTE  The microblock's appearance depends on which options you select in Snap. 
The figure above includes all options. 
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What it does Calculates effective heating and cooling setpoints and exposes them to BACnet. 
Calculates the zone thermographic color for single-zone equipment.  

You can program a zone's occupied and unoccupied heating and cooling setpoints. 
The zone's effective setpoints may differ from its programmed occupied setpoints 
because of setpoint adjustment in the zone, the optimal start algorithm, or electric 
demand reduction levels. The microblock compares the zone temperature to the 
zone's effective setpoint to determine the zone thermographic color that represents 
the control program status. Other microblocks (such as the If Color = (page 316) 
microblock) can use this color to perform additional control. 

A typical zone thermographic color scale may look like this: 

 
  

OPTIONS 

In Snap only, you can enable the following optional functionality on the microblock's 
Optional tab.   
• Demand Limiting 
• Setpoint Adjust 
• Optimal Start 
• Capacity Limit  

 

 

 
 

How it works 

Heating and Cooling setpoints 
The microblock outputs the effective zone heating and cooling setpoints. Unless adjusted by a user in the zone, by 
the optimal start algorithm, or by electric demand reduction levels, the effective setpoints equal the programmed 
occupied and unoccupied setpoints. When the OCC input is true (on), the microblock outputs the occupied cooling 
and heating setpoint values. When the OCC input is not true (off), the microblock outputs the unoccupied heating 
and cooling setpoint values. 
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Normally the separation between the heating and cooling setpoints is controlled by the values the user chooses 
for these setpoints; however, the microblock will not allow the heating and cooling ranges to overlap. For example, 
if a user tries to raise the heating setpoint to a value that is equal to or higher than the cooling setpoint, the 
cooling setpoint will be “pushed” to a higher value to prevent the ranges from overlapping. The effective setpoints 
will also be affected by this change, as these setpoints will maintain a separation of at least twice the value of the 
color change hysteresis. The setpoints will maintain a similar separation if a BACview or a third party BACnet 
system writes directly to the heating and cooling setpoint objects.  
 

Zone thermographic color 
The microblock compares the zone temperature from the ZONE input to the zone's effective setpoints and 
resulting color scale to determine the zone color output value. 

EXAMPLES 

• Unoccupied 
If the unoccupied zone temperature (65°) is between the unoccupied heating (55°) and cooling (90°) 
setpoints and the zone is not in optimal start, the microblock sets the color output value to unoccupied gray.   

• Occupied 
If the occupied zone temperature (79°) exceeds the occupied cooling setpoint (76°) by more than the yellow 
color band value (2°) but less than the yellow and orange color band values (2° + 2° = 4°), the microblock 
sets the color output value to orange.  

• Optimal start 
If the zone temperature (60°) exceeds the effective heating setpoint (62°), the microblock sets the color 
output value to light blue. 
If the zone temperature (85°) exceeds the effective cooling setpoint (84°), the microblock sets the color 
output value to yellow. 

• Demand level 1 
If the occupied zone temperature (68°) exceeds the occupied heating setpoint minus the Demand1 offset 
(70° – 1° = 69°) by less than the light blue band value (2°), the microblock sets the color output value to 
light blue. 
  

Color Change Hysteresis 
The Color Change Hysteresis provides a difference between the temperature at which the zone color changes as 
the zone temperature departs from the acceptable range between the heating and cooling setpoints and the 
temperature at which the zone color changes back as the zone temperature returns to the acceptable range.  

EXAMPLE  The following graph shows the zone color that results as the zone temperature departs from and 
returns to the acceptable range in a zone with the following settings: 

• Color Change Hysteresis = 1° (applies as the temperature returns to the acceptable range) 

• Occupied cooling setpoint = 76°  

• Occupied heating setpoint = 70° 
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Time

Temp

Occupied heating setpoint:  70°

75°

  71°

Occupied cooling setpoint:  76°
1° hysteresis

1° hysteresis

 
  

Demand Limiting (Optional) 
Electric rates can vary with electricity usage. In some locations, utilities offer incentives to customers to reduce 
electrical usage when the system-wide load threatens to exceed the grid capacity and cause brownouts. Some gas 
utilities offer incentives to customers to keep their natural gas usage below a certain level. To keep utility usage 
below peak demand levels, you can define 3 demand levels to reduce the cooling load and 3 demand levels to 
reduce the heating load. You typically define these levels in your gas or electric meters' control programs. You can 
use these demand levels to relax zone occupied heating and cooling setpoints as needed throughout your system. 
Relaxing setpoints reduces equipment operation and reduces utility demand while minimizing the effects on 
occupant comfort. 

To use this demand reduction strategy in a zone, set up Analog Network Input (page 124) microblocks to read the 
demand levels (1, 2, or 3) from the meter's control program and connect the Analog Network Input microblocks to 
this microblock's HDEM and CDEM inputs. In an all-electric system, the demand level from the electric meter 
would typically be connected to both inputs. Other systems may require the heating and cooling demands to be 
controlled separately. When the utility meter's control program indicates a demand level of 1, this microblock 
relaxes occupied heating or cooling setpoints and all related color band thresholds by the Demand1 offsets you 
define. Similarly, a demand level of 2 relaxes setpoints by the Demand2 offset and a demand level of 3 relaxes 
setpoints by the Demand3 offset. 

By defining demand level offsets for each zone, the system can reduce utility demand with significant changes to 
the setpoints in non-critical zones and little or no change to the setpoints in critical zones. 

EXAMPLE 

Below is a typical demand offset strategy and resulting effective setpoints and color thresholds. The cooling 
demand offsets and setpoints are highlighted in this example. Heating offsets would similarly affect the heating 
effective setpoints. 
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Setpoint Adjust (Optional) 
If you select this option, the microblock exposes inputs to adjust the heating setpoint (HADJ) and the cooling 
setpoint (CADJ). The most common use for these inputs is to provide a method for a room sensor with a local 
setpoint adjustment to affect the zone setpoints. If the sensor only has a single setpoint adjust output it is 
commonly connected to both inputs so the adjustment raises or lowers both setpoints by an equal amount. 
Adjusting either setpoint affects all related color bands by an equal amount. For example, if you raise the cooling 
setpoint by 2˚, you raise the temperature at which the color changes from green to yellow by 2˚. The 
temperatures at which the color changes from yellow to orange and from orange to red is also raised by 2˚. 

NOTE  You can limit the allowed amount of local setpoint adjustment in the zone sensor's microblock. 

Optimal Start (Optional) 
When the zone is unoccupied, the microblock uses the outside air temperature from the OAT input and the design 
temperatures and capacities set in the microblock to estimate the time needed to warm or cool the zone from the 
unoccupied setpoints to the occupied setpoints. When the estimated time is less than the remaining unoccupied 
time indicated by the FOR input, the microblock outputs the programmed unoccupied setpoint values. When the 
estimated time to reach the occupied setpoints equals the remaining unoccupied time, the microblock transitions 
the effective setpoints to the occupied setpoints using a first-order curve that approximates system performance 
at full capacity. 

 

Unocc clg Setpoint

Occ clg setpoint

Occ htg setpoint
Temp

Time

Occupied
period
begins

Heating
turns on

Zone temp

Unocc htg setpoint
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Heating capacity calculation during optimal start 

t    =         = Time Remaining Until Occupancy (hr)

OAT     = Outside Air Temperature (°F)

H  = Heating Design Temperature (°F)

HCAP   = Heating Capacity (°F/hr)

H  = Unoccupied Heating Setpoint (°F)

H  = Occupied Heating Setpoint (°F)

HSP     = Heating Setpoint (°F)

design

unocc

occ

FOR
60

H         =                        x HCAP1

H         = H        +                            x (H      - H       )2

(H        - OAT)
(H        - 65°F)

design

design

H         = MAX (MIN (H   , (H      - (t x H  ))), H       )3

HSP   = H   + (H   - H       ) x (1 -                         )

unocc
(12 - MIN (t,12))

 (H   - H       )

12 occ unocc

2 occ

occ

1 unocc

unocc
unocc3

3

(H      - H       )unocc
3

 
  

Cooling capacity calculation during optimal start 

t       =         = Time Remaining Until Occupancy (hr)

OAT     = Outside Air Temperature (°F)

C         = Cooling Design Temperature (°F)

CCAP   = Cooling Capacity (°F/hr)

C         = Unoccupied Cooling Setpoint (°F)

C         = Occupied Cooling Setpoint (°F)

CSP  = Cooling Setpoint (°F)

design

unocc

occ

FOR
60

C         =                         x CCAP1

C         = C        +                            x (C      - C       )2

(C         - OAT)
(C         - 65°F)

design

design

C    = MIN (MAX (C   , (C      + (t x C  ))), C       )3

CSP     = C   + (C   - C        ) x (1-                         )

unocc
(12 - MIN (t,12))

12 occ unocc

2 occ

occ

1 unocc

unocc
unocc3

3

unocc
3

 
 

NOTE  You can use the optimal start inhibit inputs (HOSI and COSI) to inhibit optimal start. For example, you may 
want to prevent any possible heating optimal start during the summer months or prevent optimal start from 
beginning more than 4 hours before occupancy. 
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Capacity Limit (Optional) 
If outside factors will prevent the heating or cooling system from running at 100% of its normal capacity, you can 
direct the Optimal Start routine to use only a percentage of the zone's learned heating or cooling capacity based 
on external logic using the HCAP% and CCAP% inputs. This percentage adjustment applies even if learning is 
inhibited by the LRNI input.  

Use Orphan Trend Network Visible (Optional) 
Selecting Use Orphan Trend Network controls the Network Visibility of the trend objects: 

• Zone Temp Trend Log 

• Occupied Status Trend Log 

If not selected, these trend objects will always be Network Visible. 

 

 

 
 

Limitations 
A control program can use only one Zone Setpoint microblock. Do not use a Set Color (page 314) microblock or 
any Set Color If True (page 314) microblocks in a control program with a Zone Setpoint microblock. 

Maintaining Hysteresis 
Because the objects of this microblock are visible to and modifiable through BACnet, setpoint behavior differs 
from our standard setpoint operation. The four basic setpoint objects, Occupied Heating, Occupied Cooling, 
Unoccupied Heating and Unoccupied Cooling, have locks that may affect the present values of the BACnet 
objects.  Locking one setpoint of a pair may affect the other setpoint of the pair to maintain Hysteresis.  It is also 
possible to lock both values of the pair such that the heat and cool setpoints of the pair cross. Effective Setpoints 
should never get closer than deadband (2 * hysteresis).  If locked parameter values or out of service values are 
set to invalid combinations that do overlap, the heat and cool setpoints are added, averaged, and the deadband is 
applied to either side of the averaged value to create setpoints that allow the control program to continue 
functioning properly. 

 

 
 

Inputs and outputs 

Inputs 
OAT 
Outside Air Temperature 

Optional–Present if Optimal Start is enabled. 

Current outside air temperature (degrees). 

OCC 
Occupied Schedule 

True (on) when the zone is occupied. Not true (off) when the zone is unoccupied. 
Connect to a time clock microblock (page 287) or to other logic that indicates the 
zone's occupancy status. 

FOR 
Remaining Time 

Minutes remaining until the zone's occupancy status changes. Connect to a time 
clock microblock (page 287) or to other logic that indicates this time. 

ZONE 
Zone Temperature 

Current zone temperature (degrees). 
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HDEM 
Heating Demand Level 

Optional–Present if Demand Limiting is enabled. 

Current heating demand level (1–3). Connect to the Analog Network Input microblock 
that reads the heating demand level. This typically comes from an electric meter's 
control program if electric heat is used or a gas meter control program if gas heat is 
used.   

CDEM 
Cooling Demand Level 

Optional–Present if Demand Limiting is enabled. 

Current cooling demand level (1–3). Connect to the Analog Network Input microblock 
that reads the cooling demand level. This typically comes from an electric meter's 
control program if cooling is provided from local DX coils or an electrically driven 
central cooling plant.  

HADJ 
Heating Setpoint Adjust 

Optional–Present if Setpoint Adjust is enabled. 

Signal from zone sensor to adjust heating setpoint (degrees). Connect to the zone 
sensor microblock's SP ADJ output. 

CADJ 
Cooling Setpoint Adjust 

Optional–Present if Setpoint Adjust is enabled. 

Signal from zone sensor to adjust cooling setpoint (degrees). Connect to the zone 
sensor microblock's SP ADJ output. 

HOSI 
Heating Optimal Start 
Inhibit 

Optional–Present if Optimal Start is enabled. 

True (on) when the microblock should not adjust heating setpoints for optimal start. 

COSI 
Cooling Optimal Start 
Inhibit 

Optional–Present if Optimal Start is enabled. 

True (on) when the microblock should not adjust cooling setpoints for optimal start. 

HCAP% 
Heating Capacity 
Adjusted By 

Optional–Present if Capacity Limit is enabled. 

Percentage of the learned heating capacity to use during optimal start under the 
conditions defined by external logic. 

CCAP% 
Cooling Capacity 
Adjusted By 

Optional–Present if Capacity Limit is enabled. 

Percentage of the learned cooling capacity to use during optimal start under the 
conditions defined by external logic. 

LRNI 
Learning Adaptive Inhibit 

Not available. 

 

MIN SEP        Minimum 
Setpoint Separation 

Optional  

This input affects the behavior of the heating and cooling setpoint such that if the 
user adjusts one setpoint, the other setpoint will automatically adjust (if needed) to 
maintain the specified minimum separation between setpoints. 
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Outputs 
Zone Color Zone thermographic color based on ZONE input compared to effective setpoints. 

Color   Status code Condition indicated 

 Red 9 Cooling alarm 

 Orange 8 Maximum cooling 

 Yellow 7 Moderate cooling 

 Light green 6 Free cooling 

 Green 5 No heating or cooling 

 Light blue 4 Moderate heating 

 Dark blue 3 Maximum heating 

 Red 2 Heating alarm 

 Gray 1 Unoccupied 

  
The microblock outputs the zone color's status code (1–9) on its zone color wire. 

HT 
Heating Setpoint 

Zone's effective heating setpoint (degrees). 

CL 
Cooling Setpoint 

Zone's effective cooling setpoint (degrees). 

NS 
Night Setback 

True (on) when the zone is not occupied, optimal start is not in progress, and the 
zone temperature exceeds the unoccupied heating or cooling setpoint. 

HCAP 
Learned Heating 
Capacity 

Optional–Present if Learning Adaptive is enabled. 

The learned heating capacity (degrees/hour) calculated by the learning adaptive 
optimal start algorithm. See Learning adaptive optimal start in "How it works" in this 
microblock's help. 

CCAP 
Learned Cooling 
Capacity 

Optional–Present if Learning Adaptive is enabled. 

The learned cooling capacity (degrees/hour) calculated by the learning adaptive 
optimal start algorithm. See Learning adaptive optimal start in "How it works" in this 
microblock's help. 

 

 
 

Properties 
  

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 
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Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Units The unit of measure, ˚F or ˚C, the setpoints are using. 

Setpoints 
Unoccupied, Occupied, 
and Demand Level 
Setpoints 

The desired occupied and unoccupied zone setpoints (degrees), the value of each 
occupied color band (degrees), and the offsets for electric demand levels 1, 2, and 3 
(degrees).  

A color band's value determines the threshold at which the microblock changes the 
zone thermographic color as the zone temperature departs from setpoint.  

You can use the free cooling light green color band to enable economizer operation. If 
you are not using this feature, type 0 for this band's value.  

Demand level offsets determine how much to relax the zone's occupied setpoints and 
color band thresholds under each electric demand level. When the electric meter's 
control program indicates a demand level of 1, this microblock relaxes occupied 
heating and cooling setpoints and all related color band thresholds by the Demand1 
offsets you define. Similarly, a demand level of 2 relaxes setpoints by the Demand2 
offset and a demand level of 3 relaxes setpoints by the Demand3 offset. 

EXAMPLE 

A zone thermographic color scale with typical demand offsets and resulting effective 
setpoints and color thresholds 

 
  
Optional–Demand Levels are used only if Demand Limiting is enabled. 

Color Change Hysteresis The desired difference (degrees) between the temperature at which the zone color 
changes as the zone temperature departs from the acceptable range between the 
heating and cooling setpoints and the temperature at which the zone color changes 
back as the zone temperature returns to the acceptable range. If you are not using 
zone thermographic color for equipment control, type 0. See Color Change 
Hysteresis in "How it works" in this microblock's help. 
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Design Properties 
Heating Capacity Optional–Used only if Optimal Start is enabled. 

The rate (degrees/hour) at which the zone temperature changes if the outside air 
temperature is 65°F and the heating system runs at full capacity. Adjust after startup 
based on system optimal start performance. 

Cooling Capacity Optional–Used only if Optimal Start is enabled. 

The rate (degrees/hour) at which the zone temperature changes if the outside air 
temperature is 65°F and the cooling system runs at full capacity. Adjust after startup 
based on system optimal start performance. 

Heating Design 
Temperature 

Optional–Used only if Optimal Start is enabled. 

The geographically-based outside air temperature (degrees) at which the heating 
system must run constantly in order to maintain comfort. Available in ASHRAE 
publications and most design references. 

Cooling Design 
Temperature 

Optional–Used only if Optimal Start is enabled. 

The geographically-based outside air temperature (degrees) at which the cooling 
system must run constantly in order to maintain comfort. Available in ASHRAE 
publications and most design references. 

Property Page Text 
Show Property Page 
Text 

Check to show this microblock's value on the equipment's Properties page. 

Property Page Text You can edit the microblock description that appears on the Properties page. See 
"Editing Properties page text using special characters" and "Formatting a microblock 
property" in Snap Help.  

Learning Adaptive 
Color adjustment values Optional–Used only if Learning Adaptive is enabled. 

The amount by which the microblock adjusts the zone's learned heating or cooling 
capacity when the zone is this thermographic color at occupancy. See Learning 
adaptive in "How it works" in this microblock's help. 

BACnet 
This microblock contains the following BACnet analog value objects. 
  

Occupied Cooling The programmed Occupied Cooling Setpoint. This object is writable. 

NOTE  This object becomes read-only when Air Source Linkage is active. 

Occupied Heating The programmed Occupied Heating Setpoint. This object is writable. 

NOTE  This object becomes read-only when Air Source Linkage is active. 

Unoccupied Cooling The programmed Unoccupied Cooling Setpoint. This object is writable. 

NOTE  This object becomes read-only when Air Source Linkage is active.  

Unoccupied Heating The programmed Unoccupied Heating Setpoint. This object is writable. 

NOTE  This object becomes read-only when Air Source Linkage is active. 

Cooling Adjustment The value of the CADJ input wire. This object is read-only. 
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Effective Cooling The effective cooling setpoint based upon occupancy, optimal start, demand limiting, 
and all other adjustments. This object is read-only. 

Heating Adjustment The value of the HADJ input wire. This object is read-only. 

Effective Heating The effective heating setpoint based upon occupancy, optimal start, demand limiting, 
and all other adjustments. This object is read-only. 

  
Define the following properties for the above BACnet objects. 
  

Object Name A unique alphanumeric string that defines the BACnet object. 

Description An optional BACnet property that may be used to describe the object. 

Network Visible Check to allow other BACnet equipment to read or change the microblock's present 
value. 

COV Increment An Analog Network Input (ANI) that references this microblock in its Address field tries 
to subscribe to this microblock's COV (Change of Value) service. If subscription 
succeeds, the ANI receives a value from this microblock only when this microblock's 
present value changes by at least the COV Increment. If subscription fails, the ANI 
reads this microblock's value at intervals specified in the ANI's Refresh Time field. 

Trend 
This microblock contains the following BACnet trend objects. 
  

Effective Cooling 
Analog Trend 

A trend log of the effective cooling setpoint. 

Effective Heating 
Analog Trend 

A trend log of the effective heating setpoint. 

Zone Temperature 
Analog Trend 

A trend log of the zone temperature input.   

NOTE  This value comes from the L ZONE input when Air Source Linkage is active. 

Occupied Status 
Binary Trend 

A trend log of the occupancy status.   

NOTE  This value comes from the L OM input when Air Source Linkage is active. 

  
Define the following properties for the above trend objects. 
  

Object Name A unique alphanumeric string that defines the BACnet object. 

Description An optional BACnet property that may be used to describe the object. 

Network Visible (Zone 
Temperature  and 
Occupied Status  only) 

Select to allow other BACnet equipment to read or change trend properties. These 
properties will still be exposed to BACview even if they are not Network Visible. 

Enable Check to have the controller collect trend data for the microblock's present value. 
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Interval If trending is enabled, records the microblock's present value at this interval. 

EXAMPLE  Type 00:10:00 to record the microblock's present value every 10 
minutes. 

TIP   

• For a binary trend, you can set this field to 00:00:00 to record this microblock's 
value only when the value changes. This will select the Sample on COV (Change 
of Value) field in i-Vu®.  

• For an analog trend, you can set this field to 00:00:00 to record this microblock's 
value only when the value changes by at least 1 (the default COV increment). 
Setting this field to 00:00:00 will select the Sample on COV (Change of Value) 
field in i-Vu®. You can change the COV Increment in i-Vu®. 

Allocate memory for __ 
trend samples 

The number of data samples the controller allocates memory for. Memory 
consumption is 10 bytes for each sample plus 48 bytes. For example, for 100 
samples: 

(100 x 10 bytes) + 48 = 1048 bytes of memory 

The allocated memory is constant regardless of how many samples are actually 
recorded.  

If you do not enable trending, no memory is consumed. 

Click Reset in i-Vu® to delete all samples currently stored in the controller. 

Enable Trend Historian Check this field to archive the controller's collected trend data to the system 
database after every 129 data samples. 

NOTES   

• You must check Enable Trend Log if you want to Enable Trend Historian. 

• You can change Enable Trend Historian archival settings and other trend 
properties on the Properties page in a i-Vu® or Field Assistant system. 

Keep historical trends 
for __ days 

This is based on the date that the sample was read. Set this field to 0 to use the 
system default value. 

Optional 
Demand Limiting 
Setpoint Adjust 
Optimal Start 
Learning Adaptive 
Capacity Limit 
Minimum Setpoint 
Separation 
Use Orphan Trend 
Network Visible 

Select the optional functionality that you want this microblock to have. See How it 
works for a description of each. 
 
(Not available.) 

 

 
 

Programming example 
This zone control strategy does the following: 

• Allows local zone setpoint adjustment using a zone sensor 

• Inhibits optimal start from beginning more than 4 hours before occupancy 

• Uses the full (100%) learned heating and cooling capacities during every optimal start period 
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• Inhibits learned heating and cooling capacity adjustments during unoccupied override periods 

 
 

 
 

Tips and tricks 

Optimal start 
Write the control logic for the unoccupied mode to activate heating if the zone color is light blue or cooling if the 
zone color is yellow. This will bring the zone temperature back into the desired range during optimal start. 

Color change hysteresis 
If you are using zone thermographic color for floorplan display, but not for control, set the Color Change Hysteresis 
to 0. Using zone color and hysteresis for control can confuse end users because it can prevent the zone color 
from changing at the programmed setpoints. If you are controlling equipment based on zone thermographic color, 
set the hysteresis large enough to prevent the equipment from changing back and forth between two different 
states if the temperature oscillates near the setpoint. 

Free cooling – economizer enable 
If you are using zone thermographic color for control in small single-zone systems or unit ventilators, you can use 
the light green free cooling color band to enable economizer operation before you enable mechanical cooling. 
Otherwise, set the free cooling color band value to 0. 
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BACnet Time Clock 
 
Microblock family Control microblock (page 287) 

Icon and symbol 
   

What it does Reads schedules from the running system and generates signals to tell the control 
program whether or not the zone is occupied, and how long the zone will remain in 
its current state of occupancy.  

You cannot set schedules using the microblock's dialog box. The Properties page 
shows the current occupancy status of the zone and the time when the occupancy 
is scheduled to change. 

The microblock has two outputs: the occ output, which indicates whether the zone 
is currently occupied (on) or unoccupied (off); and the timer output, which indicates 
the number of minutes remaining until the occupancy changes. The value of these 
outputs depends on the schedule entered for the control program in the running 
system. Create or view schedules on the Schedules page. 

 

 
 

Properties 
 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
(i-Vu® only) 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Unscheduled Value The value the microblock assumes when no schedule has been downloaded to the 
program if: 

• The system has no schedules that affect the equipment. 

• A stand alone controller is powered up but no schedule data has been entered. 

Configuration 
Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 
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Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

Show scheduling limits: 
 

The default limits for the Occupancy schedule category.  

NOTES 

• A schedule download will fail if you exceed these limits when creating schedules. 

• Changing these properties erases the schedule information in the controller, 
requiring you to download schedules again. 

• If you use Global Modify to change these limits, the affected devices will not be 
automatically marked for schedule download. 

Weekly Schedules - Max 
Transitions Per Day 

The number of transitions a weekly schedule allows in a 
24-hour period. The default is 6, which creates 5 schedule 
segments. 

Max Exception The number of non-weekly schedules allowed in a 
controller. The default is 30. i-Vu® reserves 7 of these 
schedules - one for each day of the week. 

Max Transitions Per Day The number of transitions a non-weekly schedule allows in 
a 24-hour period. The default is 6, which creates 5 
schedule segments. 

 

Property Page Text 
Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 

Property Page Text Enter a meaningful description of the microblock for use on the Properties page in the 
i-Vu® application. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 
 

Alarms 
 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if 
the alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's 
Alarms page > View tab. 

Alarm 
Alarm Enable Check to send a message when this microblock indicates an alarm condition. 
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Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you 
will reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 

Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

BACnet Time Clock with TLO 
 
Microblock family Control microblock (page 287) 

Icon and symbol 

   

What it does Reads schedules from the running system and generates signals to tell the control 
program whether or not the zone is occupied and how long the zone will remain in 
its current state.  

This microblock can also accept an override signal (using the ovr input) from another 
microblock that indicates the number of minutes to override occupancy. 

You cannot set schedules using the microblock's dialog box. The Properties page 
shows the current occupancy status of the zone, and the time when the occupancy 
is scheduled to change. 
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Properties 
 

Display Name The microblock label used in the Snap application and the i-Vu® interface. You can 
use any characters except the " character. 

Reference Name 
RefName 

Use the default reference name unless you want a more descriptive name for 
graphics or network links.  

Limitations: 
• lower case only 
• limited to 40 characters 
• cannot begin with a number 
• must be unique within a control program 

Description (optional) A BACnet-visible microblock description. 

Lock Present Value 
(i-Vu® only) 

Check to output the locked value from the microblock instead of the microblock's 
calculated value. 

Unscheduled Value The value the microblock assumes when no schedule has been downloaded to the 
program if: 

• The system has no schedules that affect the equipment. 

• A stand alone controller is powered up but no schedule data has been entered. 

Configuration 
Active Text The Active Text your system displays when the microblock's output is on, or true. 

Inactive Text The Inactive Text your system displays when the microblock's output is off, or false. 

Minimum off time The minimum period (seconds) that the microblock's present value will be off, 
regardless of the input signal to the microblock. 

Minimum on time The minimum period (seconds) that the microblock's present value will be on, 
regardless of the input signal to the microblock. 

Show scheduling limits: 
 

The default limits for the Occupancy schedule category.  

NOTES 

• A schedule download will fail if you exceed these limits when creating schedules. 

• Changing these properties erases the schedule information in the controller, 
requiring you to download schedules again. 

• If you use Global Modify to change these limits, the affected devices will not be 
automatically marked for schedule download. 

Weekly Schedules - Max 
Transitions Per Day 

The number of transitions a weekly schedule allows in a 
24-hour period. The default is 6, which creates 5 schedule 
segments. 

Max Exception The number of non-weekly schedules allowed in a 
controller. The default is 30. i-Vu® reserves 7 of these 
schedules - one for each day of the week. 

Max Transitions Per Day The number of transitions a non-weekly schedule allows in 
a 24-hour period. The default is 6, which creates 5 
schedule segments. 
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Property Page Text 
Show Property Page Text Check to show this microblock's value on the equipment's Properties page. 

Property Page Text Enter a meaningful description of the microblock for use on the Properties page in the 
i-Vu® application. 

BACnet Configuration 
Network Visible Check to allow other BACnet equipment to read or change the microblock's present 

value. Must be checked for this microblock to generate alarms. 

Object ID Auto-assign - A BACnet Object ID is assigned by the system. 

Use specific value - (0–3999999) Assign a number that is unique within the 
controller. 

 
 

Alarms 
 

Potential alarm source Check to make this microblock available in the system's Alarm Sources list. 

Critical Determines the color of the system-wide alarm button when the alarm comes in if 
the alarm's Template field is set to Universal. 

 = Critical       = Non-critical 

Category The category you want to use to filter this microblock's alarms on the system's 
Alarms page > View tab. 

Alarm 
Alarm Enable Check to send a message when this microblock indicates an alarm condition. 

Delay Seconds The time the microblock's present value must remain in an alarm condition before 
the microblock sends an alarm. 

Alarm text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition occurs. A relative path is useful for alarm messages that you will reuse in 
multiple i-Vu® locations because the path is relative to the item that contains the 
path. 

Alarm requires 
acknowledge 

Check to require that an operator acknowledge alarm notifications on the system's 
Alarms page > View tab. 

Return to Normal 
Return Enabled Check to send a message when an alarm condition has returned to normal. 

Return text The message displayed on the i-Vu® Alarms page > View tab when an alarm 
condition returns to normal. A relative path is useful for alarm messages that you 
will reuse in multiple i-Vu® locations because the path is relative to the item that 
contains the path. 

Return requires 
acknowledge 

Check to require that an operator acknowledge return-to-normal notifications on the 
system's Alarms page > View tab. 
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Fault 
Fault Enabled Check to send a message when a fault condition occurs, such as a misconfigured or 

non-existent sensor. 

 

 
 

BACnet Unit abbreviations and numbers 

Several microblocks have a two-part Units field—a scrolling list and a number field. If the unit of measure that you 
need is not available in the scrolling list, type the BACnet number for the unit of measure you need in the number 
field.        
 

Unit Abbreviation BACnet number 

amperes A 3 

bars bar 55 

bits per second bps  

btus BTU 20 

btus-per-hour BTU/hr 50 

btus-per-pound-dry-air BTU/lb 24 

centimeters-mercury cm Hg 60 

centimeters-of-water cm H2O 57 

cubic-feet ft3 79 

cubic-feet-per-minute cfm 84 

cubic-meters m3 80 

cubic-meters/hour m3/hr 135 

cubic-meters/second m3/sec 85 

cycles-per-hour cycle/hr 25 

cycles-per-minute cycle/min 26 

days day 70 

degree-days-Celsius dd-°C 65 

degree-days-F dd-°F 66 

degrees-angular deg 90 

degrees-Celsius °C 62 

degrees-Celsius/hour °C/hr 91 

degrees-Celsius/min °C/min 92 

degrees-Fahrenheit °F 64 

degrees-F/minute °F/min 94 

degrees-Fahrenheit/hr °F/hr 93 
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Unit Abbreviation BACnet number 

degrees-Kelvin °K 63 

degrees-phase deg 14 

feet ft 33 

feet-per-second ft/sec 76 

feet-per-minute ft/min 77 

foot-candles ft-candle 38 

gallons-imperial gal(UK) 81 

gallons US gal 83 

gallons/minute UK gpm(UK) 86 

gallons-per-minute US gpm 89 

grams-water/kg-dry-air gH2O/kg 28 

hectopascals hPa 133 

hertz Hz 27 

horsepower HP 51 

hours hr 71 

inches in 32 

inches-of-mercury in Hg 61 

inches-of-water in H2O 58 

joules J 16 

joules/degree-Kelvin J/°K 127 

joules/kilogram- K J/kg- °K 128 

joules/kilogram-dry-air J/kg 23 

kilo-bits-per-second kbps  

kilo-Byte KByte  

kilohms kOhm 122 

kilograms kg 39 

kilograms-per-hour kg/hr 44 

kilograms-per-minute kg/min 43 

kilograms-per-second kg/s 42 

kilohertz kHz 129 

kilojoules kJ 17 

kilojoules/kilogram kJ/kg 125 

kilometers-per-hour k/sec 75 

kilopascals kPa 54 

kilovolts kV 6 

kilovolt-amperes kVA 9 
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Unit Abbreviation BACnet number 

kilovolt-A-reactive kVAR 12 

kilowatt-hours kW-hr 19 

kilowatt-hours/ ft2 kW-hr/ft2 138 

kilowatt-hours/ m2 kW-hr/m2 137 

kilowatts kW 48 

liters L 82 

liters-per-hour L/hr 136 

liters-per-minute L/min 88 

liters-per-second L/sec 87 

lumens lum 36 

luxes lux 37 

megavolts MV 7 

megahertz MHz 130 

megohms MOhm 123 

Mega-bits-per-second Mbps  

Mega-Byte MByte  

megajoules MJ 126 

megajoules/ ft2 MJ/ft2 140 

megajoules/ m2 MJ/m2 139 

megavolt-amperes MVA 10 

megavolt-A-reactive MVAR 13 

megawatts MW 49 

meters m 31 

meters-per-second m/sec 74 

miles-per-hour mi/hr 78 

milliamperes mA 2 

millibars mbar 134 

millimeters mm 30 

millimeters-of-mercury mm Hg 59 

milliseconds msec  

millivolts mV 124 

milliwatts mW 132 

minutes min 72 

months mo 68 

Ohms Ohm 4 
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Unit Abbreviation BACnet number 

parts-per-billion ppb 97 

parts-per-million ppm 96 

pascals Pa 53 

per-hour /hr 131 

per-minute per min 100 

per-second per sec 101 

percent % 98 

percent/second % per sec 99 

percent-rel-humidity %RH 29 

pounds-force/inch2 psi 56 

psi/degree-Fahrenheit psi/°F 102 

pounds-mass lbm 40 

pounds-mass/hour lbm/hr 46 

pounds-mass/minute lbm/min 45 

power-factor PF 15 

radians rad 103 

revolutions/minute rpm 104 

seconds sec 73 

square-feet ft2 1 

square-meters m2 0 

therms therm 21 

ton-hours ton-hr 22 

tons (weight) ton 41 

tons-refrigeration ton 52 

volt-amperes VA 8 

volt-amperes-reactive VAR 11 

volts V 5 

Volts alternating current Vac  

Volts direct current Vdc  

watt-hours W-hr 18 

watts W 47 

watts-per-square-foot W/ft2 34 

watts/square-meter W/m2 35 

watts/ m2- K W/m2- K 141 

weeks wk 69 

years yr 67 
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To format a BACnet address 

The BACnet standard allows multiple formats for creating a valid address in each microblock that you use to read 
from or write to a third-party BACnet point. Some are shown below. 

 CAUTION  When integrating third-party devices into your system, most communication problems are caused 
by incorrect data or typing errors in the microblock's Address field. 

  

 
  

NOTE  Numeric values in a BACnet address can be entered using decimal or hexadecimal notation. Type 0x 
before a hexadecimal value. 
  

  

 
Device - Use one of the following: EXAMPLES 

 Device instance number 
  

bacnet://2010/… 

 BACnet device name 
  

bacnet://MyDevice/… 

 Network number: MAC address        
(of third-party device) 
  

bacnet://1234:35/… 
bacnet://1234:0x23/… 

 The word "this" if a network point requests a value from 
another control program in the same Carrier controller. Avoids 
network traffic. Requires v2.05 or later controller driver. 
  

bacnet://this/… 

 A single * (wildcard) that sends out a  request on the network 
for all devices that contain the Object specified in the address. 
(See Object below.) The microblock subscribes to the nearest 
responder. 

NOTES   
• You can use an * in the  address of Network Input and 

Total Analog microblocks.  
• An address with an * is restricted to the present_value 

property (the default when you do not specify a property). 
• Requires a v3.04 or later driver. 

bacnet://*/… 

 

  

 
Object - Use one of the following: EXAMPLES 

 Object type: Instance number 
(See NOTES below) 
 
BACnet object name 

bacnet://…/ai:2 
  
  
bacnet://…/MyObject 
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NOTES 

• For object type, you may type the abbreviation (not case sensitive), the full name, or the object type 
number. Some standard BACnet object type numbers are listed below. See the BACnet standard for a 
complete list.  For proprietary BACnet objects, see the object's manufacturer. 

 Use... 
ai 
ao 
av 
bi 
bo 
bv 
dev 
msi 
mso 
msv 

Or... 
analog-input 
analog-output 
analog-value 
binary-input 
binary-output 
binary-value 
device 
multistate-input 
multistate-output 
multistate-value 

Or... 
0 
1 
2 
3 
4 
5 
8 
13 
14 
19 

 • Every object in a controller has a unique instance number, regardless of its control program. 

 

  

 
Property (optional)  If you want to read or write a property other 
than present_value, type one of the following: 

EXAMPLES 

 BACnet property identifier 
 
BACnet property identifier # 
 
Property identifier (with index) 

bacnet://…/…/cov_increment 
 
bacnet://…/…/22 
 
bacnet://…/…/priority-
array(12) 

 Property identifier # (with index) bacnet://…/…/87(12) 

 NOTE  Some standard BACnet properties are listed below. See the BACnet standard for a complete list. For 
proprietary BACnet objects, see the object's manufacturer. 

 Property identifier 
change_of_state_count 
cov_increment 
derivative_constant 
event_state 
high_limit 
integral_constant 
low_limit 
max_pres_value 
min_pres_value 
out-of-service 
present_value 
proportional_constant 
reliability 
relinquish_default 
setpoint 
system_status 
trigger 
units 
vendor_identifier 

Identifier # 
15 
22 
26 
36 
45 
49 
59 
65 
69 
81 
85 
93 
103 
104 
108 
112 
205 
117 
120 
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Priority (optional)  If you want to write at a priority other than 
16, type @ followed by a priority number. 

EXAMPLE 

 Number  (1–16) bacnet://…/…/…@9 

 NOTE  Priority levels 1 and 2 are reserved for manual and automatic life safety commands. For more 
information on reserved priority levels see the BACnet standard. 

 

 

Examples of BACnet addresses: 

bacnet://MyDevice/ai:2 

bacnet://1234:0x23/analog-input:2/priority-array(12)@8 

bacnet://2499:0x00E0C90047CA/bi:3 

bacnet://2436:192.168.47.36:47806/0:2 
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Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not 
listed. 
  

 Date Topic Change description Code* 

 

 
No changes yet. 

 

 
  
*  For internal use only 
 
 

Document revision history 
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